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Chapter 1

Welcome to
QuickBooks

How do | use this
guide?

Welcome to QuickBooks! This user guide is designed
to help you learn how to use the most-common

features of QuickBooks.

The User Guide covers QuickBooks Pro, QuickBooks Premier and the QuickBooks
Premier Industry-Specific Editions. When the name QuickBooksis used, it refers to
any of these programs. When there is an important distinction between the
versions of QuickBooks, the proper name of the software is used in the text.




Where to start

If you'’re new to QuickBooks
Read the Installing & Learning to Use QuickBooks guide that came with QuickBooks. It
contains information on the following:

installing QuickBooks

hardware, software and network requirements

activating QuickBooks

setting up multiusers

introduction to some essential tasks such as adding customers, vendors, accessing the
in-product help, creating an account, tracking sales tax and setting up payroll to name
a few

Using this guide

The User Guide is meant to help you get the most out of QuickBooks. Once you have read
the Installing & Learning to Use QuickBooks guide and you have become familiar with your
software, look to this guide to get more comprehensive instructions on QuickBooks and its
features. This guide also provides some business concepts to help you better understand
some of the accounting concepts used in QuickBooks.
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Setting up a
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Decisions to make before you start

In QuickBooks, a "company file" contains all the financial records for a single business.
Before you can use QuickBooks, you need to tell QuickBooks about your business so that it
can set up your company file.

Locating an advisor to help you with QuickBooks

4

Tip:

Professional accountants and consultants can help set up your company file for you. To help
small businesses find these professionals, Intuit Canada manages a referral service through the
IntuitAdvisor program. The referral service connects small businesses working with QuickBooks
with accountants or consultants who are knowledgeable in QuickBooks. The service is free - you
simply pay the advisors’ fee for specific services you need.

These accountants and consultants possess the tools, resources, and knowledge to help you
set up and maintain, and optimize QuickBooks so that you can manage your business
better.

You can locate a QuickBooks IntuitAdvisor in your area by using our no-cost online referral
service on the QuickBooks web site (http://www.quickbooks.ca//). We suggest that you
select two or three advisors and contact each to determine who would be right for your
business. The advisor you select will provide you with information about his or her fees.

Becoming an IntuitAdvisor

If you are an accountant, bookkeeper, or computer consultant who supports small to
medium business clients, you may want to consider becoming a member of this unique
community. The program is intended to provide additional support to those people who
service the needs of small business clients. It’s a great way to learn more about QuickBooks
as well as help you build your business.

By joining the program, you will receive the latest version of QuickBooks plus all updates
for it and payroll changes, additional training materials, invitations to training courses,
informational emails, access to an online forum, and referral programs. If you like, you can
also have your name listed on our Web site to attract new QuickBooks clients. To become
an IntuitAdvisor or find one near you, visit the QuickBooks Web site
(http://www.quickbooks.ca//).

Chapter 2 Setting up a new company



How many companies should you set up?

The Canada Customs and Revenue Agency (formerly called Revenue Canada) requires that
for each business you have, you clearly show its income and expenses. For tax purposes, it’s
usually best to set up a separate QuickBooks company for each business that files its own
tax return.

For example, if you have two shops and file one tax return for each, you need to set up two
company files in QuickBooks. However, if you have a farm that grows wheat and raises pigs
and you file only one tax return for the entire operation, you only need one company file
in QuickBooks.

In cases like these, in which you have one business but need to track different segments of
it, set up one company file in QuickBooks and use classes. These are a way of categorizing
income or expenses within income or expense accounts. For example:

Use classes to track the following Industry examples
Account executives Advertising, Consulting
Partners Law firms, Consultants
Construction industry standard categories (General, Site Work, Construction contractors

Concrete, Masonry, and so on)

Departments Businesses that budget by depart-
ment, Retailers

Funds (General, Building, Outreach, and so on) Nonprofit organizations,

You could start with two main classes for restricted and unre- Religious groups

stricted funds, and then make each fund a subclass of a main

class.

Locations (if the business has more than one) Restaurants, Retailers,

Service businesses

Manufacturers or Product lines Distributors, Manufacturing reps,
Sales agents

You can set up subclasses of existing classes if you need to subtotal information about
classes on reports.

? To learn about... Search the Help index for...
@

Turning on the preference for using classes, turning on in QuickBooks

classes

Adding classes and subclasses classes, adding

Decisions to make before you start I 5



What accounting method should | use?

6

Cash versus accrual bookkeeping

There are two common methods of bookkeeping: cash and accrual. Your method
determines how you report income and expenses on your tax forms. When you begin
your business, you need to decide which bookkeeping method to use.

The Canada Customs and Revenue Agency (CCRA) requires accrual-based
bookkeeping for businesses that collect GST except for farmers, fishers, and
a few other specified businesses.

Check with your accountant or the CCRA before you make your choice.

It’s best not to switch to a different accounting system after you've selected one. However,
you can switch between cash and accrual reports in QuickBooks at any time, without
affecting your accounting records. By default, QuickBooks creates reports on an accrual
basis. To change reports (except a transaction report) to cash basis, search the Help index
for "Reports: cash vs. accrual."

Cash basis

Some small businesses record income when they receive the money and expenses when
they pay the bills. This method is known as bookkeeping on a cash basis. If you've been
recording deposits of your customers’ payments but haven’t been including the money
customers owe you as part of your income, you've been using cash basis accounting.
Similarly, if you've been tracking expenses at the time you pay them, rather than at the time
you first receive the bills, you've been using cash basis accounting.

Accrual basis

In accrual-basis bookkeeping, you record income at the time you make the sale, not at the
time you receive the payment from the customer. Similarly, you enter expenses when you
receive the bill, not when you pay it. Most accountants feel that the accrual method gives
you a truer picture of your business’s finances.

How your bookkeeping method affects QuickBooks

QuickBooks allows you to enter your transactions the same way no matter which method
you use for taxes. When you first install QuickBooks; however, it uses accrual-basis
accounting by default. For example, it shows income on a profit and loss statement for
invoices as soon as you record them, even if you haven'’t yet received payment. It shows
expenses as soon as you record bills, even if they are unpaid.

You can see any report (except transaction reports) on a cash basis by changing the
reporting preference. (For more information, search the Help index for “Reports: cash vs.
accrual.”)

Chapter 2 Setting up a new company



What accounting do | need to know?

Using QuickBooks requires very little accounting knowledge. You need to understand a
chart of accounts and the different types of accounts on it. You don’t have to know about
debits and credit, journal entries, or closing periods.

Your company’s chart of accounts

When you keep books for a business or organization, you want to track where your income
comes from, where you put it, what your expenses are for, and how you pay them. You track
this flow of money through a list of accounts called the chart of accounts. Your QuickBooks
chart of accounts can have:

Balance sheet accounts
Income accounts
Expense accounts

Cost of goods sold accounts

Non-posting accounts (includes purchase orders and estimates, which don’t appear on
your balance sheet)

Some of these accounts are created for you automatically. For example, the first time you
create an invoice or statement charge, QuickBooks automatically creates an accounts
receivable (A/R) account. You'll add other accounts, such as your chequing account, during
setup using the EasyStep Interview. You can create and modify your accounts as needed at
any time.

Types of accounts

Balance sheet accounts

Your chart of accounts includes za/azrice s/eet accounts. These accounts track the following:
®  What you have (assets)

m  What people owe you (accounts receivable)

®  What your company owes to other people (accounts payable and other liabilities)

]

The net worth of your company (equity)

Decisions to make before you start I 7



The following table describes the various types of QuickBooks balance sheet accounts.

Balance sheet
account type

QuickBooks
account type

Use to track

Asset What you have and what people owe you

Bank Transactions in chequing, savings, and money market accounts.
You can also use this type of account for petty cash.

Accounts Receivable Transactions between you and your customers, including

(A/R) invoices, statement charges, payments from customers, deposits
of customer payments, refunds, and credit memos.

QuickBooks automatically creates an A/R account when you first
create an invoice or statement charge.

Other Current Asset Assets that are likely to be converted to cash or used up within
one year, such as the value of your inventory on hand, notes
receivable due within a year, prepaid expenses, and security
deposits.

Fixed Asset Depreciable assets your business owns that aren’t liquid (not
likely to be converted into cash within a year), such as equip-
ment, furniture, or a building.

Other Asset Any asset that is neither a current asset nor a fixed asset, such as
long-term notes receivable.

Liability What your company owes to other people

Accounts Payable (A/P) Outstanding bills. When you first enter a bill, QuickBooks auto-
matically creates an A/P account.

Credit Card Credit card transactions for your business expenses. One account
per credit card.

Other Current Liability Liabilities that are scheduled to be paid within one year, such as
sales tax, payroll taxes, accrued or deferred salaries, and short-
term loans. Some businesses include the current portion of long-
term liabilities in this kind of account.

Long-Term Liability Liabilities such as loans or mortgages scheduled to be paid over
periods longer than one year.

Equity Net worth of your company

Equity

(equity = assets - liabilities)

A company builds equity from three sources:

m Investment of capital in the business by the owners

m Net profit from operating the business during the current
accounting period

m Retained earnings, or net profits from earlier periods that are
carried forward into the current fiscal year and that have not
been distributed to the owners

8 Chapter 2 Setting up a new company



Balances for balance sheet accounts

The Chart of Accounts window shows a balance for each balance sheet account (except for
the special equity account, Retained Earnings).

Fu Chart of Accounts w HowDol? I - |EI| Xl

MHame Type Balance P
4+ Chequing # |Bank 4,782 62 ;I
+ Savings # [Bank E.893.42 J
o Accounts Receivable Accounts Receivable 722683
@ Inventory Aszet Other Curent Aszet 411314
+Retainage Other Current Azzet 2.461.80
+ Undeposited Funds Other Current Aszet 0.oo
+ Truck Fixed Azzet 30,750.00
» Ciost Fixed Azzet 33.750.00
2 [ Fixed fzzat

Fayable

d

4+
+ Caldil Car

+ Direct Deposit Liabilities

+ Payroll Liabilities

@ Sales Tax Payable
+ Mote Payable

4+ Truck Loan

+ Opening Bal Equity
+ Jwner's Equity

+ Dwiner's Contribution

4 Dwrer's Draw

/ Faya
Credit Card
Other Current Liability
Other Current Liability
(Other Current Liability
Long Term Liability
Long Term Liability
E quity
Equity
Equity
E quity

16,750.00
500,00
9,000.00
15.000.00
-6,000.00 |

nt = | ctivities 'l Reports = ||_§how.~‘-\||

Income and expense accounts

| One of the first things you

should dowhenyou open a
businessis open abusiness
chequing account.

If you have multicurrency
turned on, the Chart of
Accounts also shows the
currency denomination of
the account.

For more information on
multicurrency, see “Doing
business internationally”
on page 157.

Income and expense accounts track the sources of your income and the purpose of each
expense. When you record transactions in a balance sheet account, you usually assign the
amount of the transaction to one or more income or expense accounts. For example, you
not only record that you took money out of your chequing account, but you keep track of
what you spent the money on, such as utilities, advertising, or office supplies.

There are no registers for income and expense accounts, but you can create reports to show
totals for these accounts over a period of time.

Cost of goods sold (COGS) account

Many businesses that track inventory have one cost of goods sold account, which is similar
to an expense account. A COGS account contains the cost of inventory you have sold.

Decisions to make before you start I 9



What's the best way to track my type of detail?

The following table describes situations that require a business to track a particular type of
detail. The table suggests the best way to track this detail in QuickBooks.

Situation

You need to track details of
services you're providing or
products you're selling.

You need to track multiple
jobs for the same customer.

You need to track expenses
by customer or job.

You need to track income and
expenses by fund, location,
department, or business seg-
ment. Examples: religious
and arts organizations, retail
stores with multiple locations

You have employees and
need to see detail about pay-
roll taxes and other payroll
expenses. Example: any com-
pany with employees

You need to track certain
details about your customers
and vendors. Example: pay-
ment terms, customer’s sales
tax, customer’s “ship to”
address, T4-A information,
your account number with a
vendor

How to record in
QuickBooks

Set up items on the Item list for
your services and products.

Record the sale, using the appropri-
ate items. On sales forms you can
edit the item descriptions to add
detail you want the customer or
client to see.

Set up jobs for the customer on
your Customer:Job list. When
entering any sales for a job, enter
both the job and customer name in
the Customer:Job field.

If you don’t have QuickBooks Pro or
better, turn on the preference for
tracking expenses by job. When
entering any expenses for a cus-
tomer or job, enter the customer
name or the job and customer
name in the Customer:Job field.

Turn on class tracking, and set up a
class on your Class list for each
fund. On every transaction, enter a
class as well as an account (where
appropriate).

Use the QuickBooks payroll feature
to track your payroll.

Find and fill in the appropriate field
in the New or Edit Customer win-
dow or the New or Edit Vendor win-
dow. The field you want may be on
the Additional Info tab.

Comments

You can get reports about
the items for services and
products that you have sold,
including quantities and dol-
lar amounts by item.

Reports by customer or by
job give subtotals by job and
then a total of jobs for the
customer.

You can track expenses by
customer alone if you don't
use jobs. The profit & loss by
job report lists both income
and expenses with a sepa-
rate column for each cus-
tomer and job.

The profit & loss by class
statement has a column for
each fund (class), so you can
see income and expenses by
fund.

The payroll reports show all
your payroll information.

If you set up customers and
vendors by using the Quick-
Add option, go back later, to
add missing information.

For more...

search the Help
index for:

items

Also see “Setting up
items” on page 28.

search the Help
index for:

jobs, setting up

search the Help
index for:

customers, adding
new

profit and loss
reports

search the Help
index for:

classes, turning on
in QuickBooks

See “Setting up
payroll: an over-
view"” on page 175

search the Help
index for:

customers, adding
new

customers, editing
information for
vendors, adding,
adding a vendor
vendors, editing
information for

10 Chapter 2 Setting up a new company



Situation

You want to see reports for a
particular group of custom-
ers, jobs, or vendors.

Examples: residential vs.
commercial customers;
remodeling jobs vs. new con-
struction; vendors that sell
materials vs. subcontractors

On your Item list, you want to
group similar items together.

Example: A school store
wants to group clothing items
and also group book items

You want to track information
that QuickBooks doesn’t
already track for customers,
vendors, employees, or the
items you sell. Examples:
patient’s insurance company,
item size or colour

On your profit and loss state-
ment, you want to see subto-
tals for accounts that have
something in common.
Example: A construction
company wants a subtotal for
construction income for
labour, materials, and sub-
contractors

How to record in
QuickBooks

When setting up a customer, job, or
vendor, assign a type. (Job types
are available only in QuickBooks
Pro and better.)

Set up a main, or parent, item (for
example, clothing). Then set up
subitems of the parent item (for
example, T-shirt, cap). Use the
appropriate subitem when enter-
ing a sale or purchase of items.

Set up a custom field for tracking
the particular kind of information.
Fill in the custom field, where rele-
vant, for new and existing custom-
ers, vendors, employees, or items.
To display and print the custom
field on sales forms or purchase
orders, customize the form to add
the new field.

Set up a main, or parent, account
for the subtotal (for example, con-
struction income). Then set up sub-
accounts of the parent account (for
example, labour, materials, subcon-
tractors). Use the appropriate sub-
account when QuickBooks requires
you to specify an account.

Comments

You can filter a relevant
report to limit the transac-
tions to those for customers,
job, or vendors of the type
(or types) you specify.

You can filter a report of your
Customer:Job list or Vendor
list to limit the names to
those for the type (or types)
you specify.

On reports that summarize
amounts by item, Quick-
Books provides an amount
for each subitem, and then a
subtotal for all subitems of
the same item.

You can use the same cus-
tom field for customers, ven-
dors, and employees if you
choose. Custom fields for
items are only for items you
sell or purchase (services,
parts, and other charges).
You can filter a relevant
report to limit the transac-
tions to forms that have spe-
cific text in a custom field.

On reports that summarize
amounts by account, Quick-
Books provides an amount
for each subaccount and
then a subtotal for all subac-
counts of the same account.

For more...

search the Help
index for:

customer types
job types
vendors, adding

report customiza-
tion

search the Help
index for:

subtotals, on sales
forms

search the Help
index for:

custom fields, about
estimates, customiz-
ing

search the Help
index for:
subaccounts, then
click the link “Why
use subaccounts?”

Decisions to make before you start I
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Tracking income and expenses with classes

Do you need to track income and expenses for separate parts of a business or organization?
The following table has examples of what you can track by using classes in QuickBooks.
(The word c/zss has nothing to do with teaching or learning—instead, it is a way of
classifying income or expenses 7z addition fo assigning an income or expense account.)

Use classes to track the following Industry examples
Account executives (particularly useful if you plan on using an employee incen- m Advertising
tive program linked to the employee’s business goals and profitability) m PR

m Consulting

Construction industry standard categories (General, Site Work, Concrete, m Construction contractors
Masonry, and so on)

Departments m Businesses that budget by department
m Retailers

Funds (General, Building, Outreach, and so on) m Nonprofit organizations

You could start with two main classes for restricted and unrestricted funds, and ® Religious groups

then make each fund a subclass of a main class.

Locations (if the business has more than one) m Restaurants
m Retailers

m Service businesses

Manufacturers m Distributors
m Manufacturing reps
Partners m Law firms

m Consulting
m Any other partnerships

Product lines

m Distributors
Manufacturing reps
m Sales agents

v

After you set up classes, you can enter them on any income or expense transaction
including payroll transactions.

You can'’t assign classes to transactions that involve only balance sheet accounts (for
example, transfers from chequing to savings, setup of inventory, setup of fixed assets).

You can set up subclasses of existing classes if you need to subtotal information about
classes on reports.

To learn about... Search the Help index for...
Turning on the preference for using classes, turning on in QuickBooks

classes

Entering a class on a transaction classes, assigning to a transaction

Adding classes and subclasses classes, adding
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Should | use classes, jobs, or types?

Ask yourself: Am [ trying to track income or expense activity associated with a particular
customer or group of customers or group of jobs?

If your answer is Yes, then you use jobs, customer types, or job types or track expenses by
job. The following table shows what you can do with each of these.

To do the following...

Keep track of sales for separate jobs or projects
for one customer.

Do this in
QuickBooks...

Set up and use jobs for the cus-
tomer on the
Customer:Job list.

Examples of reports
you can use

Sales by customer summary (which
shows each job separately)

See income or expenses for one type of cus-
tomer, as distinguished from another type.
Example: A PR writer wants to compare a res-
taurant with retail clients.

When entering or editing a cus-
tomer, assign a customer type.

Sales by customer summary,
filtered for one customer type
Profit & loss by job, filtered for one
customer type

(QuickBooks Pro and better only) See income or
expenses for one type of job, as distinguished
from another type. (Jobs of the same type can
be for different customers.)

Example: A construction contractor wants to

compare kitchen remodels with office remodels.

When entering or editing a job,
assign a job type.

Sales by customer summary,
filtered for one job type

Profit & loss by job, filtered for one job
type

Assign expenses to a customer (or to a particu-
lar job for a customer).

On every expense transaction
for that customer or job, enter
the customer name (or the cus-
tomer and job name) in the
Customer:Job field.

The following reports always break
down amounts by customer. If you
have jobs, they also break down
amounts by job.

Profit & loss by job

Job profitability (QuickBooks Pro and
better only)

Profit & loss budget vs. actual

If you are tracking a segment of your business that is independent of your customers and
jobs, set up a class for the particular business segment. Then enter the class name in the
Class field of every income or expense transaction for that segment.
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Reports to measure profitability

14

The value and performance of your company can be summarized by two reports: the

balance sheet and the profit and loss statement. How you set up your accounts will greatly
influence the level of detail you can get on these reports. You may also want to create the
statement of cash flows report, which details the net change in your cash during a period.

The balance sheet

A balance sheet is a financial snapshot of your company on one given date. This report is
useful when applying for a business loan or at year-end to get an account of your company’s
equity, assets, and liabilities.

Assets include what you haye and what Rock Castle Comstruction
people owe you. Examples include: Balance Sheet

- cash on hand As of March 31, 2004

® money in your chequing account

\ ASSETS
® money you are owed Current Assets
m furniture Chequing/Savings29,454.55
Accounts Receivable94,246.05
m vehicles Other Current Assets93.19

. R . Total C t A ts123,793.79
total assets = total liabilities + equity otat Cuxrent Rssets

i Fixed Assets43,900.00
Liabilities include what your company TOTAL ASSETS167,693.79
owes to other people or your company \

. N
debts. Examples include: LIABILITIES & EQUITY
Liabilities
= unpaid bills Current Liabilities
Accounts Payable44,118.16

m money you owe on credit cards Credit Cardsl,129.36

m loans Other Current
Liabilities2,655.72
m sales tax you owe Total Current

Liabilities47,903.24

Long Term Liabilities8,470.96

. . Total Liabilities56,374.20

Equity is the net worth of your company: ~—_
M Equity111,319.59

equity = assets - liabilities
TOTAL LIABILITIES & EQUITY167,693.79
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The profit and loss statement

A profit and loss statement, also called an income statement, shows your income and

expenses over a period of time.

Profit and Loss Statement
% Oct - Dec "04 L)
Ordinary Income/Expense

Income
Construction
Labour p 2996575 4
Materials 35,5401
Miscellaneous 3,002.20
Subcontractors 47 946 53
Total Construction 116, 454.79
Total Income 116,454.79
Cost of Goods Sold
Cost of Goods Sold 565138
Total COGS 565138
Gross Profit 110,503.41
Expense
Automobile
Fuel 140.35
Repairs and Maintenance 11475
Total Automobile 29510
Bad debt 3399
Bank Service Charges 10,00
Freight & Delivery 7000
Insurance
Disability Insurance 150.00
Liability Insurance 1,050.00
Work Comp §25.00
Total Insurance 2,025.00

Your cost of goods sold account always
appears after income accounts and before
any other expense accounts, so you can see
what your net income is before subtracting
your business’s indirect expenses, such as
utilities and office supplies.

Net income = income - expenses /

Page 2

Interest Expense
Finance Charge

Total Interest Expense

Job Expenses
Equipment Rental
Job Materials
Permits and Licenses
Subcontractors

Total Job Expenses

Payroll Expenses

Professional Fees
Accounting

Total Professional Fees

Rent
Repairs

Computer Repairs
Total Repairs

Tools and Machinery
WHilities
Gas and Electric
Telephone
Water
Total Wilities

Total Expense

Het Ordinary Income
Other IncomeExpense
Other Income
Interest Income

Other Income
Total Other Income

Het Other Income

l- Het Income

Interest Expense - Other

Oct - Dec '04

-5.63
538.80
534.15

&:a0.00
1839336
700.00
40,099.00

—_

60,044 26

1978038

250.00
230,00

2,400.00

0.00

1,135.00

154.40
100.71

61.85

316.96

86 854 94

SNt

2394547

9342
1250
10:5.92

10592

24,054.39
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The statement of cash flows report

The statement of cash flows summarizes your sources (inflows) and uses (outflows) of cash.
From the report, you can see how your cash position changed over a period of time.

Note: QuickBooks also has the capability to display investing activities, which show you how much was
invested in assets such as equipment and furniture.

Rock Castle Construction
121504 Statement of Cash Flows
October 1 through December 15, 2004
+ Oct 1 - Dec 15, "04 «
OPERATING ACTIVITIES
Het Income » 19,919.42 4
Adjustments to reconcile Het Income
to net cash provided by operations:
Accounts Receivable -37,251.83
Inventory Asset 411315
Retainage -2, 461.80
Accounts Payable 40,779.20
Cal0il Card 514
Paytoll Liabilities -G35.39
. Sales Tax Payable -792.50
This shows how Het cash provided by Operating Activities 15,246.09
much cash was \
provided by FINAHCING ACTIVITIES
profit-making Hote Payable 1705917
activities. Opening Bal Equity -8,863.39
Owner's EquibsOwner's Draw -6,000.00
Retained Earnings 5,563.39
This shows how=— Het cash provided by Financing Activities -23,05947
much cash was \ Het cash increase for period -7 81308
provided by
long-term Cagh at beginning of period 35,071.57
liabilities and Cash at end of period 27,258.49
equity.

QuickBooks also has the capability to display
investing activities, which show you how much was
invested in assets such as equipment and furniture.
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Setting up your company in QuickBooks

Determining a start date

Note:

New Business

If your business has no financial transactions yet (that is, you are starting up your business
at the same time you are setting it up in QuickBooks), your start date is today. You can go
on to “Information to collect” on page 18.

Existing Business

Your start date is the date on which you begin managing your business finances in
QuickBooks. It determines what information you need to enter in the Interview and
afterwards.

For example, you could choose today as your start date, in which case you will need to enter
how much money you have in each of your accounts and the amounts that your customers
owe you and you owe your suppliers. Or, you could choose an earlier date, in which case
you'll also need to enter all the business transactions you've made between your start date
and today.

The advantage of choosing today as your start date is that you don’t need to enter many
historical transactions, which saves you time. The advantage of choosing an earlier date
(and entering your business’ historical transactions) is that you’ll be able to see a lot more
detail in your business reports.

To choose a start date that’s best for your company, consider these questions:

m  When does your company’s fiscal year start?

m  How close is today to the end of your fiscal year?

m Do you have an accurate balance sheet for your current fiscal year?

]

Do you have an accurate profit and loss statement (also called an income statement)
for your current fiscal year?

m  How far back in time are you willing to enter historical transactions (old invoices, bills,
bank account transactions)

m  Will you be tracking payroll in QuickBooks?

Although you can change your start date later, your start date determines much of your setup.
I's much easier to decide on the best start date now than change it later.

If it’s almost the end of your company’s fiscal year, consider finishing it using your old
system of bookkeeping. Then set up your company in QuickBooks with a start date of your
fiscal year-end so you can use QuickBooks for the new fiscal year. You'll have the detail for
each fiscal year, and you won’t have to do a lot of work setting up.
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If it is not near the beginning of your fiscal year, decide which is more important to you:
® Do you want to have full detail in QuickBooks for the current fiscal year?

OR

m Do you want to enter relatively few historical transactions (covering the period
between your start date and today)? If you're not going to enter your historical infor-
mation for the full fiscal year, you may want to choose a start date at the beginning of
a calendar quarter, especially if you're going to use QuickBooks payroll.

If your business generates a lot of invoices, bills, or cheques, you probably don’t want to
enter more than three months of historical transactions. On the other hand, if your
business has relatively few transactions, you may be willing to enter several months of
historical detail.

Information to collect

18

Who owns your business?

First, determine how your business is owned. Is it a sole proprietorship, a partnership, or a

corporation? The differences include the tax form you file (T1 or T2), your income tax filing

deadlines, and how your profits are apportioned.

m  Sole proprietorships: A sole proprietorship is an unincorporated company owned
by one person.

m  Partnerships: A partnership is an unincorporated business owned by two or more
persons. In a partnership, each partner owns a share of all assets and liabilities. Each
partner may have invested in the partnership, and each receives a specified share of
profits. Partners do not receive salaries, but they may withdraw money against their
share of profits.

m  Corporations: A corporation is owned by its stockholders. Unlike a sole propri-
etorship or a partnership, a corporation can pay a working owner a salary.

Are you registered to collect sales taxes?

Although very small businesses are exempt, the Canada Customs and Revenue Agency
(CCRA) recommends that all businesses register to collect the GST. When your company’s
sales exceed a certain level, the CCRA requires you to register. Check with your local CCRA
office about whether your company needs to be registered, and if so, how to go about it.

Registered businesses track the GST (or HST) paid on purchases for the business and
collected from customers on sales. Usually, the business owner collects more sales tax
than he or she pays out and remits the difference to the CCRA.

Many provincial governments also require businesses to register to collect a provincial sales
tax (PST or QST). Check with your province’s Minister of Finance for the requirements for
your business.
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Other important information you’ll need

This table lists the information you'll need to complete the EasyStep Interview and where
to find it. You'll enter most of this information in the Interview, but some you’ll need after

you finish the Interview and are completing your company setup.

Information you need Where to find it v
Company legal name and address Owner, your accountant, or tax forms. |
Federal business number. You must have a business number if you Canada Customs and Revenue Agency |
m collect the GST, or (CCRA), formerly Revenue Canada.
m pay wages to employees.
The dates of your accounting period: Your records or accountant. |
m first month of your fiscal year
m first month of your income tax year, and
m your QuickBooks start date
Income tax form your business will file Your accountant, CCRA, or tax forms. |
Tip: When the EasyStep Interview asks you, select the income tax
form your company uses. QuickBooks uses this information to asso-
ciate accounts with tax form lines and create tax reports.
Chart of accounts for your business Your accountant or previous bookkeeping |
Tip: If you do not have an existing chart of accounts, dont worry. The method.
EasyStep Interview helps you choose an appropriate chart of
accounts for your industry.
Names of the people in your company who will use QuickBooks, and See “Working with multiple users” on |
which areas of your financial records you want them to have access page 122.
to.
Balances for these accounts: m Statements covering your start date up |
m Credit card to today for all bank accounts, including
®m Line-of-credit chequing, savings, and GICs.
® Loan m Alluncleared cheques, deposits, or other
® Bank items (credit card receipts, for example).

m Balance sheet prepared by your accoun-

tant.

How much GST/PST you owe. Accountant, CCRA, or provincial Minister of ]

Finance
List of types of items you sell (products and services), including: Your company records. ]
® [tem number or name
m Current sales price or hourly rates
B The tax code that is usually associated with the item
® Income account for tracking sales of the item
For inventory only:
m Purchasing cost
m Quantity in inventory
m Total value of inventory for the item
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Information you need Where to find it v

List of customers, including: Your company records. |

m Addresses

m Contact names
m Phone numbers
]

Outstanding invoices

List of vendors, including: Your company records. |

m Addresses

m Contact names
m Phone numbers
]

Outstanding bills

Value of your assets Balance sheet prepared by your accoun- ]
For fixed assets, you also need the original cost and accumulated tant.

depreciation.

Equity information Your accountant. |
All the money you have put into the company, plus the sum of the

retained earnings (the net profit or loss) for each year your company

has been operating.

Payroll information See “Setting up payroll: an overview” on |

page 175 for details.

Using the EasyStep Interview

20

The following custom editions of QuickBooks Premier come with company
files that are partially set up based on a specific industry; therefore, the
EasyStep Interview is not available in these editions.

m  Premier: Contractor
m  Premier: Retail & Repair
m  Premier: Accountant

For information on creating your company file in a custom edition of QuickBooks Pre-
mier, refer to the QuickBooks Premier Custom Edition Set Up Guide. Return to this
guide for more information on how best to set up your company in QuickBooks once it
is created.

The EasyStep Interview walks you through the process of setting up your entire business in
QuickBooks. It takes about an hour to complete, but if for some reason you need to exit the
interview, you can click Leave at any time.

Starting the Interview the first time you start QuickBooks:

The first time you start QuickBooks, it displays a window with several options. One is to
create a new company. Choose this option to start the EasyStep Interview. You can also start
the EasyStep Interview by choosing New Company from the File menu.

QuickBooks displays the EasyStep Interview window.
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Opening the EasyStep Interview at other times:

With your company file open, choose EasyStep Interview from the File menu. The interview
picks up where you left it and you can continue on.

You can’t change information by returning to the EasyStep Interview and
answering the questions differently.

If you need to change information you entered in the EasyStep Interview, change it
directly in QuickBooks. The EasyStep Interview is designed to help you with the initial
set up of your company file, not for editing it.

Getting around in the EasyStep Interview

The EasyStep Interview is broken into six sections. After you complete all the sections, your

company file contains basic information about your business.

m  General: Lets you enter company information, choose a chart of accounts appropriate
for your business, decide on QuickBooks preferences, and specify a business start date.

Complete the General section of the Interview before going on to other areas.

QuickBooks won’'t know enough about your company to ask the rest of the
Interview questions unless you fill in your basic company information and
start date first.

® Income & Expenses: Lets you review the income and expense accounts on your
business’s chart of accounts and create new accounts, if needed.

®  Income Details: Lets you specify whether your business income is from services and/or
products you sell. Based on the information provided, QuickBooks determines which
income tracking and accounts receivable features you need.

m  Opening Balances: Lets you enter information about the customers who owe you
money as of your start date, vendors to whom you owe money as of your start date, and
balances in your balance sheet accounts as of your start date.

m  Payroll: Lets you enter information like Social Insurance Number and birth date for
your employees, set how often you will pay them, and set up payroll items (which you
use to assign rates of pay, income taxes, and other deductions and additions to pay
cheques for employees).

®  What’s Next: Describes some common tasks in QuickBooks that you may want to
complete after you have finished the Interview.

Some questions ask you to make a decision that is not easily reversed.

When this is the case, you'll see a warning symbol: A
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Should | track customers and jobs?

What does QuickBooks mean by a customer?

In QuickBooks, a customer can be any of the following:

A person or company that buys products from your retail business
A company that buys products from your wholesale business

A client of your consultant business or law firm

A patient of your medical or dental practice

A homeowner who buys your home repair or remodeling services

A condominium owner who pays fees to your condo association

A renter who pays rent to your real-estate management firm

Some businesses don’t need to keep track of the names of customers. An example is a retail
store or service business that always receives payment with the sale or service.

However, here are some situations in which you would want to track customer names:
m  Customers receive your goods or services and then pay you later.

m  Customers are supposed to pay a regular monthly fee, and you want to track who has
paid and who hasn’t.

®  You want to track income (and perhaps expenses as well) by customer.

If you're using QuickBooks for an organization that receives money but doesn’t really sell
anything, you likely don’t need to set up customers. For example, a nonprofit or religious
organization with members making contributions or paying dues can track the deposits
without making the members customers. Specialized membership software can keep track
of membership details such as pledges, contribution history, and names of family members.

Recently, Intuit Canada released a version of QuickBooks for this type of business.
QuickBooks Premier Association and Nonprofit Edition is designed to help you get the most
out of your programs in achieving your organization’s goals.

For more information about this and other business-specific QuickBooks Editions, see
“Ordering QuickBooks products and services” on page 251.

What does QuickBooks mean by a job?

22

In QuickBooks, a job is a project done for a particular customer. You must always associate
a job with a customer. Use jobs if you do (or expect to do) more than one job for the same
customer. For example, Jan does freelance writing for a large company that supplies a
separate purchase order for each job. Hank’s plumbing business has to keep track of the
separate jobs it does for a general contractor.

Chapter 2 Setting up a new company



Changing

v

On the other hand, if your company never does more than one job per customer, or you do
not want to track individual jobs, you don’t have to enter job names. For example, Doug’s
printing company refers to each customer order as a “job.” However, even though Doug
gets repeat business from customers, all he cares about is whether the customer has paid, so
he doesn’t need to set up jobs for his customers.

Besides using projects for jobs, you can be creative. For example:

m If you manage several apartment buildings, set up the building addresses as customers
and the individual apartments as jobs.

If you invoice against purchase orders, set up each purchase order number as a job.

If you have a practice or organization that sends one statement to a family to cover
individual members of the family, set up the family members as jobs.

m If you have multiple estimates per customer, search the help index for “estimates, by
job”.

m  QuickBooks reports about jobs apply to customers as well. You don’t have to set up jobs
in order to use these reports. For example, the profit and loss by job report actually
applies to both customers and jobs. If you have customers but not jobs, you will still
see information about your customers.

the opening balance for a customer or job

When you first set up a customer or job, you have a chance to enter the opening (unpaid)
balance for the customer or job as of a specific date. The date should be your QuickBooks
start date (that is, the date when you enter opening balances for all accounts, customers,
and vendors).

When you enter the customer’s opening balance (in the EasyStep Interview or New
Customer window), QuickBooks creates an invoice for the amount and date you specify.
This invoice is probably the first transaction in the customer register. (There should not be
any opening balance transaction if the customer had no unpaid balance as of the start date.)

You can change the customer’s opening balance invoice by finding it in the customer’s
register and then editing it.

If you failed to enter an opening balance but want to create one now, enter an invoice dated
on or before your start date. To summarize the amount owed as of your start date, enter on
the invoice an item set up as a nontaxable other charge, and assign the account
Uncategorized Income.

To learn about... Search the Help index for...
Displaying a customer’s register customers, registers for

Editing a transaction in a register registers, editing entries

Entering an invoice invoices, creating

Setting up an other charge type of item other charge items
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Why you probably need to set up items

Items for what you sell

24

Note:

If your business provides a service—writing, haircutting, consulting, legal advice, house
painting, or any other service—you may charge by the hour and list the number of hours
and your rate on your sales forms. Or, you may simply charge a flat rate for the service.

If your business sells products or parts, you probably list them on sales forms that you give
your customers.

In QuickBooks, both kinds of businesses—service and product—can benefit by setting up
items to track the services they provide or the products they sell to customers.

In QuickBooks, “sales” is a broad term. It refers to any business action that generates income in
exchange for services or products, even if you don’t think of what you do as selling. For example,
a psychologist with patients, a graphic designer with clients, and a roofing contractor with
customers all would set up items in QuickBooks for what they sell.

Benefits of setting up items

Here are some specific benefits of setting up items:

You can use sales forms in QuickBooks to track the details of how your business earns
its income. Estimates and all sales forms—invoices, sales receipts, credit memos—
require items. So do QuickBooks statement charges, which print on statements.

(If you're a professional, you may not think of your statements as sales forms, but they
are.)

You can fill out sales forms or enter statement charges quickly. QuickBooks automati-
cally enters the description and rate or price you entered in the item’s setup window.
When you enter a quantity, QuickBooks calculates the amount.

When you record a sale (remember, it can be for a service), QuickBooks automatically
tracks the income in the appropriate income account. You can fill out a sales form (or
enter a statement charge), keep track of your sales, and keep track of income—all in one
step.

You can create reports that show total units of each service or product sold as well as
dollar amount totals.
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Items for

If you're still not sure you need items

Here are some examples of businesses or organizations that use items:

m  Rebeccais the bookkeeper for a country club where members sign for meals, drinks, and
fees and receive a statement at the end of the month. Rebecca uses items in QuickBooks
for each of these. She uses the items to enter statement charges for each member and
create monthly statements.

m  Mario is a dentist. He has items set up for the various services he provides to his
patients: cleaning, x-rays, filling cavities, and so on.

In contrast, some businesses or organizations probably don’t need items. Here are some

examples:

® John is keeping the books for his church. The church has members who pledge and
contribute money, but the church doesn’t sell anything or charge for specific services,
so John doesn’t need to create any sales forms.

m  Marina does facials in her home evenings and weekends. Her clients pay at the time of
their visit. Marina simply wants to track the income received. She doesn’t care to track
in QuickBooks how many facials she gives or to whom.

m  Rickis a commissioned sales representative. He takes orders for a manufacturer that
then invoices the customers directly. Rick tracks the orders in a spreadsheet, not Quick-
Books, because the sales are income for the manufacturer, not Rick. When Rick receives
a commission cheque, he enters it in QuickBooks as a deposit.

services or products you purchase

Once you've decided to set up items for the services or products you sell, you might want
to use items for the services and products you purchase.

If you purchase services or products for a specific customer or job, QuickBooks Pro and
better allow you to set up items that you can use for both purchases and sales. See “Items
for reimbursable costs (QuickBooks Pro and better)” on page 38.

On the other hand, if you don’t have QuickBooks Pro or better and you don't track
inventory, you should not use the same items for both purchases and sales. Instead, use
items for entering sales only.

If you purchase property such as buildings, vehicles, computers, or heavy machinery that
will contribute to the operating capacity of your company for several years, QuickBooks Pro
and better enable you to set up items that can help you track their depreciation. You need to
track the depreciation of such fixed assets both for tax purposes and to get an accurate
accounting of the worth of your business. Your accountant can give you more information
about using fixed asset items to record purchases and subsequent sales of fixed assets.
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Deciding how items should affect accounts

26

v

When you set up most items, you must specify which account it should affect when you
use the item on a sale or purchase. Then, when you record the sale or purchase, each item
on it affects the appropriate account.

In other words, while you are recording the items on a sale or purchase, QuickBooks is
adjusting all the right accounts behind the scenes.

Which are the right accounts? If you sell an item (service, non-inventory, and other
charges), you normally associate an income account with it. If you purchase the same item,
QuickBooks Pro and better provide a way to associate a second account, usually an expense
account, to be used on purchases. See “Items for reimbursable costs (QuickBooks Pro and
better)” on page 38.

To learn about... Search the Help index for...

accounts for tracking inventory inventory, accounts

If you purchase a fixed asset, you normally associate a fixed asset account with it. When
you sell a fixed asset, you normally associate a fixed asset account with the asset.

Before you set up your items, you have to decide how much detail from your sales and
purchases needs to show up in reports about your accounts. (The profit and loss statement,
for example, is a report on your income and expense accounts.)

You can see details of your sales (such as number of units and dollar amount of each item

sold) on the QuickBooks sales reports. You don’t need to have the same level of detail on

your profit and loss statement. For example:

m  Cynthia has a single income account for all sales income. She doesn’t want to see any
further breakdown on her profit and loss statement, and she doesn’t need it for her tax
returns.

m  Derek, on the other hand, wants to split up income from services and income from
materials he buys for a job and then puts on the customer’s invoice. Thus, he uses one
income account for all his service items and a second income account for all his non-
inventory part items (for his materials). Like Cynthia, he has far more items than
income accounts.
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How many different items do you need?

Every business is different, but knowing how QuickBooks works can help you decide how
specific your items should be.

First, once you use an item in a transaction, you can never delete the item unless you delete
the transaction or condense your file to remove old transactions and old items. Fixed asset
items are not condensed. Thus, if you sell unique items or a rapidly changing assortment of
items, you probably want to use more general items. If the prices vary, you can enter prices
on the sales form.

For example, Tomas has a men’s clothing store. Because his inventory of styles changes so
much, he doesn’t use QuickBooks to track inventory. To track his sales, he has more general
items such as Suit, Sports Jacket, Dress Shirt.

On the other hand, if you have two standard services or products that are similar except for
their rate or price, you can save time recording sales by having a separate item for each.
Then QuickBooks can fill in the correct rate or price on the sales form.

For example, Mali employs three stylists in her beauty salon. When she cuts a client’s hair,
she charges more than the rate for a haircut by one of the employees. So she has two
separate items for haircuts.

You can change the rate or price of any item at any time. You don’t have to create a new
item in order to raise your prices.

In QuickBooks Pro and better, you can create price levels to increase or decrease inventory,
noninventory, and service item prices. Use them on sales forms to automatically adjust the
price of an item. Price levels can be created for any customer with whom you have a special
relationship.

Finally, if there are items you purchase but never sell but that are not fixed assets (supplies
for your office, for example), you probably shouldn’t bother to put them on your Item lists.
They will lengthen your list, and you'll find it harder to pick out the items that you do sell.
However, if you plan on using QuickBooks purchase orders, you’ll need to set up the items
you purchase, even though they are only for your office use.
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Setting up items

This section is about adding items to QuickBooks. You can add items at any time—as part
of setting up QuickBooks or whenever you think of an item you need to use.

Remember, items are for the services or items you buy and sell. You also may need special
calculating items that calculate subtotals and discounts, and that apply specific sales tax
rates.

The EasyStep Interview helps you set up a few items, so you may already have some items.
Fixed asset items are not set up in the EasyStep Interview.

Where to find information about your items

When you set up an item, you enter information you can use over and over again without
retyping, such as the following:

Name or code
Description
Price per unit or rate per hour, if applicable

For items you sell, the income account to assign income from the sale; for items you
purchase, the expense account for purchases of the item

QuickBooks stores information about your items on the Item list.

On the Item list, items are
in order of item type.

Within the same item
type, they are usually in
alphabetical (or
numerical) order, but you
can change this order.

Subitems are indented
under the parent item.

Use the menu buttons to
add, edit, sort, or perform
other activities on items.

I amme Drezcription Tupe Accaolnt On Hand Frice

+Subs Subcontracted ser| Service Corstruction:St 0.00 |

@ Carpet Install carpeting | Service Conztruction: Sy n.an

# Drwwall Ingtall drywall Service Construction: 5. 0.oo

+ Electical Electrical work i ristruction: 0.00

+ Painting Painting i | 0.00]

& Plurnbing Flumbing Service Construction: Sy Q.00

+FRoofing Fioofing Service Construction: Sy n.an
+Cabinets Cabinets Irventory Part | Congtruction: b i} 0.oo

¢ Cabinet Pullz: |Cabinet Pulls Irventomy Part | Congtruction:k 418 0.oo

+Light Pine Light ping kitchen. | liwventom Part | Construction:M i} Q.00
+Hardware Inventory Part | Construction:M i} Q.00

¢ Doorknobs Ste) Standard Doaorkno| Inventory Part | Construction:M 4 000

¢ Lk Doorknobs | Locking intenior d.. | lnventore Part | Construction: b B 38.00
+Wood Door Doors Irventomy Part | Congtruction:k i} 0.oo

+Extenar Euterior wood doal|lmwventom Part | Construction:M [ 120,00

& [rterior Interior wood door [Inventory Part | Construction: M 14 F2.00 ﬂ

N ltem - | Activities ™ Reparts = | [~ Show Al
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Information about fixed assets is available in the Fixed Asset Item List. The Fixed Asset Item
List is only available in QuickBooks Pro and better.

This list shows the

fixed asset toms A T S - -5 =~ i~ row oo 1 I ToT]|
you've set up to track Purchase Date i
your fixed assets. You +2000 pickup 1 18,602,
ST +2007 delivery van 10/15/2007 2007 delivery van 44,500,00
can use this list to track +Chairs a[0zfn1f2005 Conference room chairs {103 |Furniture 475.00
all transactions having +Conference table 9|05/01/2005 Conference table Furniture 3,500,00
. . +Desks 13 [06f01/2007 Desks (7) Furniture 2,100.00
to do with your fixed +Desktop computer 6 (0540172001 Deskbop computer (13 Computers 2,000.00
, incl in n +Desktop computers 11 |05f01f2007 Desktop computers (23 Computers 5,000.00
assefs clud g any +Desktop computers-sales dept. 10{05#01 /2007 Desktop computers (5) Computers 13,000.00
repairs or +Laser printer 7 [06f01 /2001 Laser printer Computers 2,001.00
. +Metal filing cabinets 3[10f29/1998 IMetal filing cabinets (123 Furniture 1,250.00
Improvements, +Cffice building 1|0ajz2}1998 Office building Buildings 325,000.00
damage_a nything +Office land z|o9fzzi1998 Office land Land 90,000,00
that can affect their +Server 12 [05f01f2007 Server Computers 5,500.00
value and amount of
depreciation Activities ¥ l Reports ~ I I Shaw Al

? To learn about... Search the Help index for...
@

Price levels (Pro and better only) price levels

Displaying the Item or Fixed Asset Item items, list of

list

Sorting the Item list (and other lists) sorting, list entries

Moving items (and other list entries) lists, reorganizing entries
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Types of QuickBooks items

In addition to items for services or products, QuickBooks has several other types of items.
This section explains what each type of QuickBooks item is designed to do.

Tip: Use one of the Part item types for any product, not just a part of another product. If you decide
to use QuickBooks inventory to track your products, set up inventory parts for them. Otherwise,
set up non-inventory parts for your products.

Item type Use for... LEUE] EhnEe: Comments

Service

Inventory Part

Services you charge for or ser-
vices you purchase

Examples: professional fees,
labour

Products you purchase, track as
inventory, then resell
Examples: Electrical outlets, T-
shirts

on accounts

On sale: Increases
income.

On purchase: Increases
expenses.

On sale: Increases
income, increases cost
of goods sold, and
decreases inventory
assets.

On purchase: Increases
inventory assets.

In QuickBooks Pro and better, you can
set up a service item so that it can
affect either income or expenses,
depending on where you use it. Price
levels can be used on service items

Available only if the inventory feature
is turned on. Search the help index for
inventory, turning on.

Price levels can be used with inventory
parts. Search the help index for price
levels.

You can set up different units of mea-
sure for inventory-part items. For more
information on units of measure, see
“Setting up your items with different
units of measure” on page 32.

Inventory
Assembly

Assembled products you purchase
or create and build, track as inven-
tory, then resell

Examples: Gift baskets, Soaker
hose starter kits

On sale: Increases
income, increases cost
of goods sold, and
decreases inventory
assets.

On purchase: increases
inventory assets.

QuickBooks Pro or better is required to
create inventory assemblies. Available
only if the inventory feature is turned
on. Appropriate for “light” assembled
items; QuickBooks does not track
inventory through the manufacturing
process. Price levels can be used with
inventory assemblies.

You can set up different units of mea-
sure for inventory-assembly parts. For
more information on units of measure,
see “Setting up your items with differ-
ent units of measure” on page 32.

Non-inventory
Part

Products you sell but don’t pur-
chase; items you purchase and
resell but do not track as inven-
tory; items you enter on purchase
orders

Examples: Custom-made slipcov-
ers

On sale: Increases
income.

On purchase: Increases
expenses.

In QuickBooks Pro and better, you can
set up a non-inventory part item so
that it can affect either income or
expenses, depending on where you
use it. Price levels can be used with
non-inventory parts.

Fixed Asset Property that will contribute to the On sale: Decreases In QuickBooks Pro and better, you can
operating capacity of your com- assets. create fixed asset items; in QuickBooks
pany for several years On purchase: Increases ~ Basic you can view fixed asset items in
Examples: Vehicles, Computers, assets. the Item list and edit or delete transac-
Heavy machinery tions in which they’re found, but you

can’t create them.
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Usual effect

. Use for... Comments
(continued on accounts
Other Charge Other charges on a sale or a pur- On sale: Increases In QuickBooks Pro and better, you can
chase income. set up an other charge item so that it
Examples: Shipping charge, deliv- On purchase: Increases can affe.ct either income or expenses,
ery charge, finance charge expenses. depending on where you use it.
Can be either a percentage or a flat
amount.
Subtotal Calculating and printing a subtotal Subtotal items have no On sales forms, if you want to apply a
on sales forms effect on accounts. discount or add a percentage charge to
several items at once, subtotal first.
Group Fast entry of a group of individual Each item in the group Available for either sales or purchases.
items already on the list affects the same
Example: A group of services and  account it affects when
food items provided by a caterer. used by itself.
Discount Calculating an amount to be sub- Either decreases Available for sales forms only; not
tracted from a total or subtotal income or increases available for statement charges or pur-
Example: A 10% discount given to expenses (depending chase forms.
nonprofit organizations. on item setup).
Payment On invoices: Payment received at Increases the balance Available for sales forms only; not

the time of invoicing, so that
amount owed on invoice is
reduced

On sales receipts summaries: To
show totals for each type of pay-
ment (cash, cheques, credit card
charges)

of either a specific che-
quing account or the
account for undepos-
ited funds (depending
on item setup).

available for statement charges or pur-
chase forms.

Items that calculate

The table of items includes some items used to perform a calculation on one or more lines
above it on a sales form.

For example, if you need to subtotal on sales forms, then you need a subtotal item. A
subtotal item adds the amounts of the items above it on the sales form and enters the
subtotal on the form.

Finally, there are some items that can be set up either as percentages or with flat amounts,
depending on what you need. For example, Carol adds a 10 % service charge to her invoices.
She has set up an other charge item with a rate of 10 %. She uses a subtotal item before the
service charge, so that the 10 % will be based on the subtotal amount.

Steve gives a 15 % discount to certain customers. He has set up a discount item with a rate
of 15 %. He must use a subtotal item, because the discount is based on the entire amount.

For examples of how to use items that calculate, see page 42 for subtotals, page 44 for
discounts, and page 137 for sales tax.
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In this example,
Hardware is a
parent item with
two subitems
under it.

Subitems vs. group and inventory assembly items

Just as you can set up an account with related subaccounts under it on your chart of
accounts, you can have an item with related subitems. For example, Cherril keeps the books
for her symphony association’s gift shop, which sells T-shirts and other items. She has an
item called T-shirts and subitems called Adult and Child, each with its own price.

Subitems enable you to put similar items together on your Item list, so you can locate them
easily on the drop-down list in any Item field. Each subitem can have its own rate or price
and its own description. Each subitem can even have its own account, although you would
probably assign the same account to all subitems of the same parent item.

T N ~ -~ 5-” |5~
Mame Drescription Tupe Account On Hand Frice
+ Hardware Irventory Part Conztruction: M ateriz ] 0.00 =]
+ Doorknobs Std| Standard Doorknol| Inventory Part Congtruction: M aten: 4 30,00
@ Lk Doorkrnobs |Locking interiar d... | Inventory Part Conztruction: b ateriz & 33.00
«Wood Door Doorz Irventon Part Congtruction: M ateriz i] Qoo J
+ Ewterior Ewterior wood door | Inventory Part Conztruction: b ateriz 1 12000
+ |nkerior Interion wood door | lnventory Part Congtruction: M ateriz 14 F2.00 -
|Ilem """ - Activities ™ Repots = [T Show &l

On sales forms, you use subitems the same way you use other items. On reports based on
items, QuickBooks subtotals each group of subitems.

Group and inventory assembly items have a completely different purpose from subitems.
Group and assembly items allow you to enter a group of items—that is, several different
items—at once on a sale or purchase. Group items are appropriate for combining several
types of items, such as catering services and food items, on one line in a sales receipt. For
an example of entering a group of items, see page 43. Assembly items, available only in
QuickBooks Pro or better, are appropriate for indicating products you combine and sell as
a unit, such as a gift basket containing one wicker basket and three jars of homemade jam.

You can'’t group fixed assets or make them subitems of other items.

Setting up your items with different units of measure

In QuickBooks Pro and QuickBooks Premier, you can set up different units of measure for
inventory and inventory-assembly type items. You would set up items with different units
of measure if you purchased in one unit (eg., a case), but sold that item using another unit
(eg., can). For example, you can buy soda pop in cases with 12 cans to a case, and sell them
by the can. Then, when you sell one can, QuickBooks understands this transaction to mean
1/12 of your inventory.
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Turning on the units of measure preference

The units of measure preference cannot be turned off once it has been
enabled. You should only consider activating this preference if you
buy, stock or sell in different units.

Before you can set up different units of measure for items, the units of measure preference
must be turned on.

1 From the Edit menu, choose Preferences.
2 From the scroll box on the left, select Purchases & Vendors.

3 Onthe Company Preferences tab, select Inventory and purchase orders are active, and
then select Units of Measure are active. (Inventory must be turned on in order to
activate units of measure.)

What happens when units of measure is turned on?

With the units of measure preference turned on, you'll see the following changes in

QuickBooks.

® A Units of Measure button is added to the Inventory Part and Inventory Assembly type
items window. This button opens the Define Units of Measure window where you can
set up different units of measure for these items.

m A field is added to the Service and Non-inventory Part items window where you can
assign a descriptive label that represents the unit of measure used when dealing with
the item. Note that this in only a label that is used as a descriptor on various forms. You
cannot define different units of measure for Service items.

® A Unit column is added to all forms. This new column displays the item’s unit of
measure associated with the type of transaction. For example, the selling unit is used
on sales forms such as invoices and sales orders, and the purchasing unit on purchase
forms such as bills and purchase orders.

® A Unit column is also displayed on some windows such as "Adjust Quantity/Value on
Hand" and "Change Item Prices".

® A Unit column is added to display an item’s units of measure on reports to do with the
item list; and purchases, sales and inventory transactions.
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Type the unit of

Irventory Unit
measure yOL.I USe\'VI stock this item in
to stock the item

Clear this box
and type the unit
you use when

selling the item.

< [" same as Inventory
1 sell this item by

Setting up different units of measure

With the units of measure preference turned on, you can keep track of how you purchase,
stock and sell your items. You can define different units of measure for Inventory Part and
Inventory Assembly items. The association between an item'’s units of measure cannot be
changed once a transaction involving the item is recorded. Therefore, you must first set up
an item’s units of measure before entering a quantity on hand.

1 From the Lists menu, choose ltem List.

2 From the Item menu button, choose New.

3 From the Type field of the New Item window, choose Inventory Part or Inventory
Assembly, and then click the Units of Measure button. The Define Units of Measure

window appears.

of measure.

For items that are already in your inventory, you must set up the units
of measure on the Define Units of Measure window before you enter
a Quantity on Hand on the New Item Window.

Once you enter a quantity on hand for a new item, you cannot change its units

Define Units of Measure for unnamed item

Icase

r— Sales Unit

can

0K
Cancel

Help

\lit

Association to Inventory | 12 Ican per case ﬂ “
r— Purchasing Unit

¥ Same as Inventory

I purchase this item by Icase

Association to Inventory | 1 |case per case ﬂ

* Once a transaction has been created using this item, units of
measure cannot be changed

4 Click OK, and continue setting up the item.

Enter the number of selling
units that make up a stocking
unit, or vice versa.

If the purchasing unit is the same
as the stocking unit, keep this box
checked. If the purchasing unit is
different, clear the box, and set
up the purchasing unit the same
way the selling unit was set up.
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Adding items with units of measure to forms

Once units of measure are set up for an item, the item’s appropriate unit of measure is then
displayed on business forms. Sales forms show the selling units, and purchasing forms show
purchasing units. On forms, you cannot switch to a different unit of measure.

[ Expenses

$0.00 | Ttems $12.00 | Bills When entering a bill, an item’s purchasing unit is

Item

Soda Pop

Description (fy  Urit N\ Cost Tax  Met Amb Customer:Job shown. If we were to cite the example shown above,
;‘ ‘W 6.00 ‘s ;‘ 12.00 - AI you'd see that the purchasing unit for Soda Pop is a
case. QuickBooks understands this to mean 12 cans

as defined by the item’s selling units of measure.

Uit Jescriptio and Invoices
Soda Pop ~[1 " 1.50 ¥ 1.50] 5 v |4

When that same item is added to an invoice, however, the unit displayed is the selling unit.

Tip: You can enter fractional or decimal values on forms. For example,
if you purchased only half a case, you could enter .5 or 1/2 on your bill.

Assigning a label to Service & Non-inventory Part
items

A descriptive label can be added to Service and Non-inventory Part items (with units of
measure turned on) to help identify the unit of measure or rate that is used for these items.
Different units of measure cannot be tracked for these item types. These labels act only as
a title, and when created, are displayed on business forms and reports.
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Reporting in different units of measure

By default, some reports display an item’s unit of measure. The unit that is displayed
depends on the report being created. For example, a "Purchase by Item Summary" report
displays the purchasing units of measure, whereas the "Sales by Item Summary" report
displays the selling units. You can change the reports to display in the units you want
through the Modify Report window.

i sales by Item Detail

Modify Report. .,

Memorige... | Print

Hide Header Refresh

M=k

/Qates |This Month-to-date

=] From [o1josjzo02 8| To [12/09/2002 88 sort By [oefadl:

3:31 PM

If you want to see the oartzio2

purchasing unit on

Accrual Basis

Ruby's Tuesday
Sales by Item Detail

September

. . B Type o Date o llum_ Hame B Sales Price © ___Amount __ «___ Balnce
this report, click Inventory - iI
Modify Report. Soda Pop

» Invoice 10/09:2002 1 Anne Mchian 1.50 1.50 150 4
Total Soda Pop 1.50 1.50
T 150 1.50
Mndiry Report: Sales by Item Detail
TOT Display ] Filters [ Header/Footer ] Fants & Numbers ] 1.50 1.50 [
=
Report Date Range
’VDgtes [Thi From the first day of the current manth thraugh today Because this is a
From_[ntnatznnz 2| o [zmazo0z B
el | sales report, by

In the Modify Report

window, select

Units of Measure
Show by and Unit in:
Purchasing Unit to
show the item’s
purchasing unit of

" Inventory Unit
{* Purchasing Unit

iows this report calculates income and expenses.

Units of Measure

¢ Selling Unit Show Qky and Uit in:
measure. " Tnwventory Unit
~ A
i Furchasing Urit
/Date & Selling Unit
< Nurn
PO #
e Put a check mark next ko each column
| that you want ko appear in the report.
Saurce hame ] § PP i Advanced. . | Revert |
ok | el | e

The report changes
to show the items in
their purchasing
units.

default, the selling
unit is shown.

QuickBooks converts
the quantity (which in
selling units is one can)
to .08333 of a case.

fifiSales by Item Detail
Modify Report.

Memorize... | Print... | Excel.

hide Header | Refresh

Dates [This Month-to-date

"~ From [01/05/2002 8] 1o [12j09/2002 |50t B

331 PM
09112002

Accrual Basis

Inventory
Soda Pop
3 Invoice
Totsl Soda Fop

Total Invertory

TOTAL

- Type.

o Date s tum

0.08333

10082002 1 Anne Mchan

Price

Ameunt s Balance -

36

Chapter 2 Setting up a new company



Adding items to your Item or Fixed Asset Item list

As the table starting on page 30 shows, QuickBooks has several different item types. Here is
some general information about what to enter for most types of items when adding a new
item to your Item or Fixed Asset Item (in QuickBooks Pro and better only) list.

Information to
enter

Type of item

How QuickBooks uses this information

After you choose the item type, QuickBooks requests only the information it requires for that
particular item type. (Note: You cannot create fixed asset items from the Item list. Use the
Fixed Asset Item list to do so.)

After you set up an item, depending on the type, you may not be able to change it to a differ-
ent type.

Item name or code

Displays this name or number on reports of items and in the drop-down list in the Item field
(for example, on sales forms).

Item description (optional on
all but fixed assets)

Prefills the entire description in the Description field of sales or purchase forms.
Displays the beginning of the description in the drop-down list in the Item field.

You can set up some types of items to have separate descriptions for sales and for pur-
chases.

Rate or price (optional)

Prefills the rate or price in the Rate or Price fields of sales or purchase forms.
Some types of items can have a rate that is a percentage.

You can set up some types of items to have separate rates or prices for sales and for pur-
chases.

Account or accounts

Profit and loss statements report on the income or expense account associated with items
used in transactions.

You can set up some types of items to have separate accounts for sales and for purchases.

Some types of items (for example, payment items) require a balance sheet account instead
of an income or expense account. Inventory items require three separate accounts.

Default Tax code

QuickBooks applies GST/PST to the item based upon the rate(s) defined in the Tax Code list.
You can override this sales tax code on the sales form.

Subitem status

If this field appears, you can make an item a subitem of an existing item. QuickBooks dis-
plays subitems of the same item together.

Custom fields (optional)

You can set up custom fields that fill your company’s needs (for example, size or unit of mea-
sure). You can also customize sales and purchase forms to display a column for a custom
field. Then QuickBooks prefills the column with the custom field information for the item.

? To learn about...
@

Search the Help index for...

Adding a new item for one of the following:

m A service B items, services

m An assembled product that you purchase or build B items, inventory assembly
yourself

m A product or part that is not held in inventory m items, non-inventory parts

m A fixed asset m items, fixed assets

m A miscellaneous charge m items, miscellaneous charges

Adding a new item for a product or part held in inventory

items, inventory
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Items for
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Note:

v

To learn about... Search the Help index for...

Adding a new item that puts a group of several items on items, grouped together
a sales or purchase form

Adding a new item that calculates a subtotal items, subtotal types
Adding a new item that calculates a discount on a sales items, discount types
form

Adding a new item that records a customer payment or items, payment types

deposit received at the time of sale

Adding a new item that calculates the total sales tax for a items, subitems
combination of sales tax rates

Creating subitems of another item items, subitems
Creating custom fields for items items, custom fields on
Turning sales tax on sales tax, setting up

reimbursable costs (QuickBooks Pro and better)

Perhaps your business purchases services or products for specific customers or jobs, then
invoices the customer for the items (with or without markup). For example, Frank is a
general contractor who uses subcontractors and invoices for their costs at a higher rate than
what they charge him. Tina is an interior designer who buys furniture at wholesale and sells
it to the client at retail.

In QuickBooks Pro or better only, service items, non-inventory parts, and other charge
items each have a checkbox that allows you to pass through their costs at a markup and
track costs and revenues in separate accounts.

Then you can track both the expenses and the income for these items for a particular job.
(For example, the checkbox for a non-inventory part is “This item is purchased for and sold
to a specific customer:job.”)

If you don’'t have QuickBooks Pro or better, use expense accounts, not items, for reimbursable
costs.

To learn about... Search the Help index for...
using expense accounts for reimbursable reimbursable expenses, assigning to a cus-
costs tomer or job
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There are several advantages to using items for reimbursable costs in QuickBooks Pro or
QuickBooks Premier editions:

m Itis easy to associate the cost of an item with an expense account and the income with
a separate income account when you set up the item.

You can track the number of units or hours purchased or sold.
You can use items on estimates and purchase orders.

If you write a purchase order for an item, you can create a bill from the purchase order
and assign a job. Then you can invoice the customer for the item.

m  When you enter a bill, cheque, or credit card charge, QuickBooks Pro or better fills in
the description of the item and the unit cost after you choose the item from the drop-
down list on the Items tab.

®  When you invoice the customer for the cost of the item, QuickBooks Pro or better fills
in the sales description of the item and the sales price.

B You can create reports that compare costs to revenues for each item.

To learn about... Search the Help index for...

invoicing for reimbursable time and costs reimbursable expenses, assigning to a cus-
tomer or job

Services performed by subcontractors or owners

If you charge for services performed by outside subcontractors or you pay owners (or
partners) for time worked, set up a service item for each type of service. Be sure to select the
checkbox “This service is performed by a subcontractor, owner, or partner.” Then you can
designate separate income and expense (or equity) accounts, and separate descriptions for
sales and purchases.

You can enter different hourly rates for your cost and the sales price to your customer. If
you write cheques based on time tracked or enter the item on a purchase order, purchase,
or estimate, QuickBooks fills in the rate from the Cost field. If you enter the item on a sales
form, QuickBooks fills in the rate from the Sales Price field. However, if the subcontracted
service is usually billed as a flat fee, and the fee varies, leave the Cost and Sales Price fields
0.00 when you set up the item.

If you pay owners (or partners) and vendors for the same service, you need separate service
items because the accounts for the costs must be different.

To learn about... Search the Help index for...
separate service items service items, creating items for services you
sell or buy
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Tip:

Products and materials purchased for a job

If you invoice for actual costs of products and materials purchased for a specific customer
or job, set up a non-inventory part item for each type of product or service. Be sure to select
the checkbox for “This item is purchased for and sold to a specific customer:job.” Then you
can designate separate income and expense accounts, and separate descriptions for sales
and purchases.

New Item
Type 0K B
Wzl Use For goods you buy but don't track, like office You can enter different
v Part 5 oy
supplies, or materials Far a specific job that wou Cancel
charge back to the customer, rates for your cost and

&l the sales price to your

IIZm MamefMumber :-gubltem of J e ——— customer. However, If
alr s

Speling the cost of the product or
[¥ This item is purchased For and sold to a specific customer:job . .
_p — e o material varies, leave the
urchase Information Sales Information [~ Item is inactive

Desctipkion on Purchase Transactions Diescription on Sales Transactions Cost and Sales Price
fields 0.00 when you set
up the non-inventory

Cost [ o Sales Price .00 part item.

Purch Tax Code ls_j
Expense Account Wﬂ Sales Tax Code Is_j

Preferred Yendor l—j Income Account ISaIes—j

To further aid in tracking the item, you can also specify the customer and job on the purchase
order. When you receive the item, this information prefills on the item receipt or bill. Use the open
purchase orders by job report to find out which items are still on order for your customers.

Miscellaneous charges you pass on

If you invoice for miscellaneous charges incurred on a job, you can set up an other charge
item for each type of miscellaneous charge. For example, Frank has an other charge item
called Equipment Rental. Be sure to select the checkbox for “This is a reimbursable charge.”
Then you can designate separate income and expense accounts, and separate descriptions
for sales and purchases.

As with products and materials, you can enter different cost and sales prices or leave the
fields 0.00 when you set up the other charge item.
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Working with items

v

After you have set up items, use them to enter estimates, sales, purchase orders, sales orders,
actual purchases, and disposition of fixed assets. Remember, QuickBooks uses the term sz/es
broadly; it can mean the performance of services or the assessment of fees as well as the sale
of products.

You can enter all item types listed in the table on page 30 on any sales form. You can enter
all but payment items on estimates and sales orders. However, you can’t enter the following
item types on purchase orders or purchases (on the Items tab of bills, cheques, and credit
card charges):

m  Other charge items set up as a percentage
m Discount items

m  Payment items

To learn about... Search the Help index for...

Recording discounts from vendors discounts, from vendors

Entering payments to vendors vendors, paying (then Paying bills)

Using items, saving time

Enter an item in
the Item field by
typing or by
choosing from
the drop-down
list.

When you fill out a sales form, you list each service, product, or fixed asset you're selling
on its own line of the invoice or sales receipt, along with the amount the customer owes for
that item. Similarly, when you write a purchase order or receive a bill, each service, product,
or fixed asset is listed on its own line.

Because information about individual items is listed on separate lines, the items are called
“line items”. In QuickBooks, you enter line items by choosing from the drop-down list in
the Item field of a sales or purchase form. You can also type in the Item field and let
QuickBooks fill in the rest of the item’s name.

Tkern Arnounk

Drescripkion

< Add Mew =

FY

Franchises Consulking
Lessons

Biking Lessons

Hockey Lessons

3kiing Lessons

Snowboarding Lessons
Tour Design

Consulting and hea...

Biking Lessons

1 hour of hockey 1.,
Skiing Lessons
Snowboarding lessons
Tour planning and ... ﬂ

Camp Cutlery 20 Piece Camp Cutl...
Coolman Canoe Coolman 15" Canoe 3T 0.oo
Fishing psT 0.00
Dawaiee Reel Dawaiee Feel Ad 45, .,
Fishing Jacket Sportsman Fishing ... Tatal
Tackle Box Black PCE Tackle Box
Zebra Rod FRA Zebra &' Spincast ...
Freeze Dry Freeze Dry Camp Food

Hockey Jersevs
Calgary Flames

Jersey's
algary Flames Pro...
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Each item on the Item list can contain all the information you need to fill in one line. You
can always change the information, such as the description and rate, as you're filling in a
form.

When you enter a quantity, QuickBooks automatically calculates the amount for you.

When you enter
items, QuickBooks
keeps track of how

The Item column lists the item
name you entered when you
created the item.

QuickBooks multiplies the Quantity by
the Rate to calculate the Amount.

much of each item

Ikem

Description

Amounkt

Tax

you sell and to Codlman Canoe |1 Codlman 15' Canoe 499,93 499,93 | 5 A
whom. Fishing:Dawaie, ., |2 Dawaiee Reel A 456 Spinning Reel 39,93 199,98 5
Each item that you Fishing:Fishing ... |2 Sportsman Fishing Jackst 89,99 179.88| 5
sell is associated Fishing: Tackle Box |1 Black PCE Tackle Box 16,99 16.03| S
with an income Fishing:Zebra R... |2 Febra £' Spincast Rod Part #654 44,95 §9.90 5
accfount. o Custamer [Thank you For your j GaT 69.08

This association Message |husiness. psT o

allows QuickBooks to '

provide useful sales Total 1,134.87

and income reports.

You'll have separate items not only for each service rendered and each product sold, but
also for discounts, markups, sales taxes, and subtotals. If the customer makes a partial
payment at the time of the sale, you can add an item for the payment.

Using items to subtotal on sales forms

The subtotal item adds up the amounts of the items above it, up to the last subtotal.

You'll need a subtotal item if you ever want to apply a percentage discount or surcharge to
several items. Because QuickBooks calculates percentages on the line above, you'll need to
subtotal the items before entering the percentage line item.

If you use two subtotals in a row, the last subtotal will add up all the previous subtotals on

the form.

The first subtotal line shows a
total for all materials.

Cabinets Maple kitchen cabinets 789500, 7.895.00T| *

Cabhrdware  |Brass cabinet and drawer pulls 204,98 204.98T

Subtotal M aterials subtotal 8.093.98
The second subtotal shows a Labour Cabinet installation 19 40.00 7E0.00
total for all labour. Labour Cabinet delivery 3 25001 7h.00

Subtatal Labour subtotal 835.00 .
The second subtotal also ———qZubtatd B934 38 The third subtotal

. Markup Profit and overhead 22.0% 1,965.70 line adds up the

makes the third subtotal * tWo brevious
include all amounts on the Fustomer |Please call with any (3] Tex[asT B]ox 58,25 wo previou
e Message |questions. subtotals, so that a
invoice, so a percentage TOTAL 11.568.93

markup can apply to the total
sale.

markup can be
applied to the
entire sale.
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If you use very
general items,
like this one,
your reports
won't be as
useful as if you
used detailed
items grouped
together.

QuickBooks
shows you the
items in the
group onscreen,
whether you
choose to print
them or not.

Entering a group of items

The group item allows you to enter several items all at once on a sales form, estimate,
purchase order, cheque, or bill. If you often sell the same group of items together, using a
group item saves you the trouble of entering the same set of line items again and again.

When you use a group item, you can enter a quantity for the group that affects the quantity
and amount of each item in the group. You can also edit the individual quantity of each
item in the group, and edit descriptions and rates.

Using a group item to hide details on a sales form

The more detailed you are in tracking items, the more information you can get from
reports. The QuickBooks group item allows you to be very detailed in tracking the items you
sell without showing all that detail to your customers. When you set up a group item, you
specify whether to print each item or just the group item. (Of course, if you use a group item
on a purchase order, you must show the detail to the vendor so the vendor will know what
you want.)

For example, Frank has a construction company that sends invoices for full jobs, such as
complete remodels. If he used one general service item called “Remodel”, a sales report
would show his income from remodels.

QUANTITY DESCRIFTION BATE AMOUNT Tax
Fermodel i | 9,085.04 = 9.08504 2
|
Customer [Thankyou foryour business.  [= Tax |GST v |(70%) 0.00
Message
Total 9,085.04
I” Tobe printed ™ Tohbe sent ¥ Custameris Taxahle Balance Due 9.085.04
temao IFina\ imvoice, Smith family room Sawve & Close | Save & New | Clear |

However, Frank uses more detailed items, so he can learn more from his sales reports. Frank
breaks down the remodel cost and uses items such as “Lumber”, “Hardware”, “Markup”,

“Carpentry Hours”, and “Labourer Hours”.

He groups these items under one item called “Remodel”. Even though he chooses not to
print the items in the group on the invoice for his customers to see, he still has those details
on his sales reports.

Descripkion Amount Tax
Coolman Canoe (1 Coolman 15' Canoe 499,99 499,99 5~
Discount Employee Family discount 20,09 -100.00 5
Fishing: Dawaie... |2 Dawaiee Reel A4 456 Spinning Reel 99,99 199 95 5
Fishing:Fishing ... |2 Sportsman Fishing Jacket 89,99 179 95 5
Fishing: Tackle Box |1 Elack PCE Tackle Box 16,99 16,99 5 LI

Custamet | Thank vou For vaur - &7
Message |business. PaT

Tatal

55.79

63.76

916,49
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Applying a discount to one or more items

To apply a discount, you have to enter a discount item. If the discount item’'s rate is a
percentage, the item reduces the amount due by a percentage of the line above it.

To take a percentage off several items at once, you must first subtotal the items. On the
other hand, if you want to discount one particular item you’ve sold and not the entire sale,
add a discount item directly beneath the one discounted item.

. . Fintures: Tub, Jet
The first line shows a total Fistures: Washbasit
for all materials. (|
Labour: Constructio| 16.5

The second subtotal show Labour: Constnctio/8

prion
Jetted bathtub, Canadian Classic
Oval Cdn Classic washbazin, marble
M aterials subtotal
Labour [Framing)
Electrical. Plumbing
Labour subtotal

1.365.00 1.365.00

364.00 364.00
1723.00

40.00 EE0.00
75.00 600.00

Arnount

1.260.00

a total for all labour. Al abtataD Materials & Labour subtotal W0 238300
Markup Profit & Overhead 89670 S

The second subtotal also

makes the third subtotal

include the amounts on =
the invoice, so a Customer |Thank you For your - G3T 18380
percentage markup can Messane |business. psT Z10.06
apply to the total sale. Total 427956

/The third

subtotal line
adds up the
two previous
subtotals, so
that a markup
can be applied
to the entire
sale.

If you give discounts of different percentages, you can either set up a separate discount item
for each percentage or edit the amount right on the sales form.

ﬁ Don’t use a discount item for discounts that you give for early payment.

Enter discounts for early payment through the Receive Payments window. Search the
help index for receiving “payments, about”.

Showing partial payments received at the time of sale

If you receive a partial payment toward the amount of an invoice at the time you create the
invoice, you'll need to enter a payment item.

The payment item tells QuickBooks to subtract the amount of the payment from the total
invoice amount. To record the payment on the invoice, enter a payment item for the
amount you’'ve received after you've entered all the items sold.

Coolman Canoe
Down Payment

Use a payment

item when you on delivery,

Coolman 15" Canoe
50% down payment. Remainder due

Drescription

Arnount

Tax

receive a partial
Customer [irhank you for your -
payment at or Message |business.

before the time

G5T
PsT
Tatal

35.00

40.00

324,99

you create the

/s;J/ QuickBooks subtracts a
| paymentitem amount

~| from the invoice total.
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You can set up a payment item so that it automatically deposits the payment directly to a
chequing or other account. Alternatively, you can set it up so that QuickBooks
automatically puts the payment amount into your Undeposited Funds account so you can
deposit it with other funds.

To learn about... Search the Help index for...

v

Receiving and depositing payments receiving payments, Receiving payments
toward a statement

If you need to track the payment method (cheque, cash, credit card charge), you can have
different payment items for different methods of payment.

Using a payment item is not the only way to record a payment. For some types of payment,
you should use a different method:

Type of payment How to record in QuickBooks
Partial payment received at time of sale Enter payment item on invoice.
Full payment received at time of sale Use sales receipt, not invoice. No payment item is necessary, because Quick-

Books assumes sale is fully paid.

Summary of payments, by method, for Use sales receipt to summarize the daily sales. Enter a different payment item
daily sales summary for the summary of each payment method.

Payment from customer to pay outstanding Enter payment in Receive Payments window. Indicate which invoices or state-

invoice or statement ment charges have been paid by the payment.
Advance payment from customer before Use one of the following options:
work is done or sale is made. m Enter payment in Receive Payments window.

m Enter payment item on a credit memo.
m Record a retainer. See the QuickBooks and Your Industry help for law firms,
or Look in the Help Index for retainers.

ﬂ Avoid entering double payments.

If you receive payment before the sale and record a deposit before you record
the invoice, do not also enter a payment item on the invoice or you will record
a double payment.
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Changing prices or rates

v

You can change the prices or rates of many items at one time through the Change Item
Prices window. In this window, you can tell QuickBooks to raise (or lower) prices or rates
by a specified amount or percentage. You can change prices or rates for items individually,
or have QuickBooks calculate new prices or rates on several or all items of the same type at
once.

If you want to automatically apply an increase or decrease to inventory, non-inventory, and
service items, you can use price levels. Price levels allow you to automatically adjust, up or
down, the amount charged to customers with whom you have a special relationship. When
you apply a price level to an item, QuickBooks calculates the rate to reflect the increase or
decrease.

To learn about... Search the Help index for...
Changing prices or rates of items items, prices
Price levels price levels

Editing item information

46

After you've created an item, you can edit information about it at any time, subject to
certain restrictions.

Changing item type

You can change a non-inventory part or other charge item to a service, non-inventory part,
inventory part, or other charge item. However, you cannot change the item type of any
other type of item.

Hiding and redisplaying items on lists

You can hide an item on the Item or Fixed Asset Item list without deleting it by making the
item inactive. For example, you may have an inventory item on your Item list that you have
not stocked in the last six months, but which you may want to stock in the future.

When you make an item inactive, QuickBooks keeps the information associated with that
item, but hides the item on the Item list and removes it from any drop-down lists that use
items. You do not need to change or delete any transaction that uses the item. If you start
to use the item again, you can make it active at any time.

You can display all your items, including the inactive ones, on the Item list by selecting
Show All. (Inactive items still appear on reports, but never display on drop-down lists.)
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Deleting items

You can delete an item only if it is not used in any transaction or group item. To locate all
transactions that use a given item, create a QuickReport for the item for all dates.

If you condense your QuickBooks data through a specified date (to reduce the file size and
remove detail), you can also remove items that are not used after that date. Fixed asset items
are not condensed.

To learn about... Search the Help index for...
Changing item types items, changing type of

Changing information about an item items, editing information

Hiding and showing items on the Item list items, hiding and showing

and drop-down lists in Item fields

Making hidden items visible on the Item lists, hiding and showing
list as well as on drop-down lists

Deleting items items, deleting

Final steps to complete your setup

Fine-tune your accounts

Tip:

QuickBooks sets up a chart of accounts for you during the Interview. Before you begin
entering transactions, make sure your chart of accounts is complete and that it accurately
represents how your business works.

Change account names and edit, delete, or add accounts to make your chart of accounts
reflect your company’s financial activity, if you have to.

You can adjust the opening balances of the accounts in your Chart of Accounts, too. For more
information, see “Adjusting opening balances for balance sheet accounts” on page 51.

It's important to decide on an account structure that meets your needs now.

Although you can edit your chart of accounts later if you need to, it's much easier to
make changes before you start entering transactions.
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You can fine-tune your chart of accounts at any time by doing the following:
®  Add new accounts or subaccounts.

You can add subaccounts to balance sheet accounts (for example, fixed asset accounts)
as well as to income and expense accounts.

®m  Turn on and use account numbers.

QuickBooks has an option for specifying account numbers in addition to names. If the
account is one that QuickBooks added for you, it already has a number but you can
change it.

Change the name or number of an existing account.

Enter or edit an opening balance for a balance sheet account if the original opening
balance is incorrect.

®  Arrange accounts of the same type in alphabetical order (or numerical order if account
numbers are turned on).

Rearrange the order of accounts within the same account type.

Make one existing account the subaccount of another (or, conversely, move a subac-
count to a higher level).

You can drag accounts to a new position on the chart of accounts. When your accounts are
not in alphabetical or numerical order, and you add a new account, QuickBooks places the
new account above the other accounts of the same type.

v

To learn about...

Adding new accounts or subaccounts
Turning on account numbers
Changing account names or numbers

Changing or entering an opening balance
for a balance sheet account

Arranging accounts (and other lists) in
alphabetical or numerical order

Reorganizing accounts within the same
account type; also, reorganizing other
lists that allow subentries (for example,
customer:Job list)

Remove accounts from your chart of
accounts

Search the Help index for...

accounts (managing), adding

accounts (managing), numbering

accounts (managing), editing

® opening balances, changing for existing
accounts

® opening balances, entering for existing

accounts

lists, sorting entries

lists, reorganizing entries

accounts, deleting
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Using account numbers:

To better maintain your chart of accounts, develop and follow consistent account naming
and numbering conventions. For example, some accountants like you to add a numbering
scheme to your accounts:

m 1000-1999 - Assets m 2000-2999 - Liabilities
m 3000-3999 - Equity m 4000-4999 - Income
m 5000-5999 - Expenses m 6000-6999 - Other income and expenses

Adding numbers can help you identify the type of accounts, thereby speeding up your
account selection on various forms.

To learn about... Search the Help index for...

Changing your chart of accounts H accounts, adding
H accounts, editing
m accounts, deleting

Enter your company’s historical transactions

v

If you've decided on a start date that is before today’s date, you'll need to enter past trans-
actions to have complete financial records from your start date forward. Then your Quick-
Books records will be as complete as if you had started using the program on your start date.
Enter historical transactions in this order:

Invoices you've sent out since your start date

Purchase orders you've issued since your start date that have not been received in full
Cash or cheques you've received since your start date

Bills you've received since your start date

Bills you've paid since your start date

Deposits you've made to any of your accounts since your start date

NOGCGhAWN=

Any other cheques you've written (for things other than bills) since your start date

The order you enter historical transactions is important.

For example, QuickBooks won't know how to credit a customer payment unless you've
previously recorded the invoice to that customer.

Enter transactions in your bank account last, because your accounts payable and accounts
receivable affect your bank account. By the time you enter all of your historical
transactions, your cheque register will be mostly up-to-date.

To learn about... Search the Help index for... ‘

Entering historical information historical transactions
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v

Entering current transactions with historical ones

You don'’t have to enter all your historical transactions before you start using QuickBooks
for your current ones. Enter current transactions as they occur so you don’t get behind.
Then catch up with historical transactions when you can. Remember, though, that your
account balances will be off until you've entered all the past transactions.

If current and historical transactions are related, enter the earlier one first. For example, if
you receive a payment today for an invoice you have not yet entered, enter the invoice first,
then use QuickBooks to record the payment. That way, QuickBooks links your transactions
correctly to each other.

Entering historical payroll information

If you are going to use QuickBooks payroll, enter historical payroll information so
QuickBooks has complete year-to-date records of wages and salaries you’ve paid.
QuickBooks needs this information to compute accurate tax information and payroll
reports. See “Setting up payroll: an overview” on page 175 for more information.

To learn about... Search the Help index for...

Entering historical payroll information payroll setup, year-to-date amounts

Entering bank account information

If you entered all your historical transactions, your chequing account or savings account

register already contains entries reflecting bills you've paid, cheques you've written for

other purposes, and deposits you’ve received. But there are other transactions that you must

enter to make your account registers complete:

m  Cheques or other payments you created before your start date but weren’t cashed until
after your start date (for example, cheques written a few months ago but not cashed
until recently).

m  Deposits you made before your start date, but which didn’t appear on statements until
after your start date.

m  Cheques or other payments you made after your start date that were not for bills or
accounts payable (credit card payments, for example).

Deposits made after your start date that were not customer payments.

Bank charges, fees, or interest paid to your account.

To learn about... Search the Help index for...

Entering information in account registers registers, entering transactions in
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Complete your customer, vendor, and item information

Note:

v

Adjusting

Note:

After you enter information about customer and vendor open balances, you can enter more
information about them, such as addresses, phone numbers, and credit limits—though it’s
not necessary to enter this information for all customers and vendors at once.

If you use QuickBooks Pro or better and Symantec ACT! or Microsoft Outlook, you can
synchronize information about customers and vendors, such as addresses and phone numbers,
from your contact manager so that you don’t have to re-enter it. To learn about synchronizing
contact information, search the Help index for “contact management, synchronizing”.

Items are the goods, services, and other things you buy and sell. QuickBooks starts a list of
items when you go through the Interview, but you’ll want to add to this list and refine the
information you’ve already entered.

To learn about... Search the Help index for...
Adding a new customer customers, adding

Adding a new vendor vendors, adding

Iltem types and uses items, about

opening balances for balance sheet accounts

After creating your company in the Interview, you may need to enter additional opening
balances or make adjustments to the account balances you've entered.

To adjust an opening balance for an account:

From the Lists menu, choose Chart of Accounts.

Double-click the account that should have an opening balance.

Click anywhere in the blank entry at the end of the register.

Change today’s date to your QuickBooks start date.

Leave the Number and Payee fields blank.

OO0 A WN=

Enter the opening balance amount.

m  For bank accounts, enter the amount in the Deposit column.

m  For asset, liability or equity accounts, enter the amount in the Increase column.
m  For credit card accounts, enter the amount in the Charge column.

7 In the Account field, choose Opening Bal Equity from the drop-down list.

If you have not entered an opening balance for any of your accounts, you will have to create an
Opening Bal Equity account.

8 Click Record.
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These accounts may also need adjusting:

m  If you collect GST or PST, record the amount you owe as of your start date.
If you have entered your historical invoices and purchases, do not include the amount
you owe since your start date (as the GST and PST you collected is included on them).

Instead, check whether you owe more than the invoices cover, and if so, adjust your
GST or PST liability accordingly. Select GST/PST Activities from the Vendors menu,
then GST or PST Adjustment. For more information, see “Gathering income tax infor-
mation” on page 127.

To learn about... Search the Help index for...
Recording the GST or PST you owed as GST, historical data

of your start date PST, historical data

Adjusting your GST or PST liability GST, adjusting

PST, adjusting

®  Adjust the Uncategorized Income and Uncategorized Expenses accounts (if you're
using accrual-basis accounting).

When you enter unpaid opening balances for customers, the income is assigned to an
account called Uncategorized Income. Similarly, when you enter unpaid balances for
vendors, QuickBooks assigns the expenses to the Uncategorized Expenses account.

- If you keep your books on a cash basis (you record income when you receive
payment), QuickBooks does not show these two accounts on your profit and loss
statement until a customer makes a payment, which is the expected behavior. You
do not need to make any adjustments.

- If you keep your books on an accrual basis (you record the transaction when
you make a sale or incur an expense), QuickBooks does show these two accounts
on your profit and loss statement as of your start date. Your accountant may want
you to make an adjustment so that the income from all invoices and the expenses
from all bills before the start date are also tracked on an accrual basis, regardless of
whether payment has occurred. Ask your accountant if this applies to you.

To learn about... Search the Help index for...
Adjusting for Uncategorized Income and B Uncategorized Expense account
Uncategorized Expenses m Uncategorized Income account

m  Adjust for current income and expenses if your start date is not at the beginning of your
fiscal year.

If you set up your company in QuickBooks with a midyear start date and you know
what your income and expenses are from the beginning of your fiscal year to your start
date, enter adjustments for them. Then, the profit & loss statement in QuickBooks will
be accurate from the beginning of the fiscal year to any date after your start date. To
get this information, have your accountant create a year-to-date profit & loss statement
(also called an income statement) for your current fiscal year to your start date.
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? To learn about... Search the Help index for...
@

Adjusting income and expenses for mid- adjustments, income and expenses

year setup

m  Distribute earnings and equity before your start date.

After you have entered all of your opening balances and made other adjustments, you
may want to distribute the amount in your Opening Bal Equity account to other equity
accounts if you want to identify retained earnings or the equity of several owners.

To learn about... Search the Help index for...

v

Distributing earnings and equity from Opening Bal Equity account
before your start date

Equity carried over from previous fiscal equity, retained earnings from
periods
Moving the amount in the equity, transferring from Opening Bal Equity

Opening Bal Equity account to other
equity accounts

Setting up accounts to track equity details

Your company’s equity comes from two sources:
®  Money invested in your company (capital investments)

m  Profits of your company

Of course, the owner can also take money out of the company. Such withdrawals, called
owner’s draws, reduce the company equity.

QuickBooks sets up two equity accounts automatically:

m  Opening Bal Equity
For every balance sheet account you set up with an opening balance, QuickBooks
records the amount of the opening balance in the Opening Bal Equity account. (Asset
account opening balances increase the equity; liability account opening balances
decrease the equity.)

m  Retained Farnings

If you have data for more than one fiscal year, the QuickBooks balance sheet has a
balance for the Retained Earnings account equal to the net profit from prior fiscal years.
The balance for the Retained Earnings account does not display on the chart of
accounts.

Some people like to track owner investments, owner’s draws, and retained earnings prior to
the QuickBooks start date by putting them in separate equity accounts. If you decide to add
additional equity accounts, QuickBooks still adds the Retained Earnings and Net Income
lines on your balance sheet.
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Tip:

Equity accounts for sole proprietorships

Because all equity of a sole proprietorship company belongs to one person, tracking equity
can be very simple.

As of your QuickBooks start date, all equity is in the Opening Bal Equity account. You have

several options:

m  Keep the equity in this account and perhaps rename the account to something such as
Owrner'’s Lguity.

m  Transfer all the equity out of Opening Bal Equity into Retained Earnings.
This action is appropriate for companies that have built up assets as a result of earnings
prior to the QuickBooks start date. From now on, you can take owner’s draws out of the
Retained Earnings account.

m  Set up additional accounts (or subaccounts) to track owner’s investments, owner’s
draws, and earnings before your QuickBooks start date.

When setting up a new account for owner’s draws, enter a negative opening balance to show the
total draws prior to the QuickBooks start date. The negative opening balance indicates that the
draws have reduced the company’s equity. (Or, enter a zero opening balance and simply record
draws from now on.)

Things to think about after you’'re finished

Create reports to check your setup

After you've finished setting up your company in QuickBooks and making any
adjustments, create reports to check that QuickBooks has the right numbers.

In both QuickBooks and your former accounting system, create a profit and loss statement
and a balance sheet. Each report should cover the beginning of your fiscal year through to
your QuickBooks start date. For example, if your fiscal year began on July 1 and your start
date was September 1, create reports that cover July 1 to September 1.

Both reports should show the same balances for your accounts.

Maintain your previous accounting system

54

If your business existed before you began to use QuickBooks, make sure you keep your
previous accounting system complete in case the Canada Revenue Agency requires
information from your previous years of business.

You should keep any software and the hardware your former accounting system requires —
or have printouts of all the information and accounting reports.
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Set up other company files, if needed

If you use QuickBooks with more than one company, and therefore have more than one
company file, you should keep them all in the same directory.

If you update QuickBooks, download tax tables, receive tax alerts, and so forth, you may
have to download multiple copies of the new information if the company files are in
different directories.

Connect QuickBooks to the Internet

Note:

What you need

Your PC must be connected to the Internet through an Internet Service Provider (ISP). Your
work PC may be connected through a local area network (LAN). If you can read e-mail or
browse the Web, you are connected to the Internet.

Why connect QuickBooks to the Internet?

You don't need Internet access to use QuickBooks, but the ability to “go online” can easily
double the power and flexibility of your software. It allows you to take advantage of
Internet-only features in QuickBooks.

Consider these additional possibilities:

m  Explore other opportunities with QuickBooks’ connected services
From the Company menu, select Business Services Navigator.

m  Receive QuickBooks updates
Download and install QuickBooks software updates as they become available.

m  Download tax table information
If you've signed up for the QuickBooks Payroll , you can download the latest tax tables.

If you are a new user

After you install QuickBooks, you are prompted to activate QuickBooks, and if you choose
to do so online, QuickBooks helps you set up your Internet connection. It’s a good idea to
activate as soon as you can so that you can begin using all of the QuickBooks online
features.

If you did not activate your copy of QuickBooks immediately after installation, you can do so at
any time by choosing Activate QuickBooks from the File menu. (If you do not see Activate
QuickBooks under the File menu, then QuickBooks is already activated.)
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If you are an upgrader

After you install QuickBooks, you're prompted to activate QuickBooks. It’s a good idea to
activate as soon as you can so that you can begin using all of the QuickBooks online
features.

If you owned a previous version of QuickBooks, your new software uses the same Internet
settings as your previous version. If you have changed your Internet Service Provider
between then and now, or switched from using a modem to using a direct connection (for
example, cable or DSL), you can change your settings manually.

To set up an Internet connection:

1 From the Help menu, choose Internet Connection Setup.

If you have not used QuickBooks on your computer before, then the first time you go
online (for example, to activate your software), QuickBooks automatically launches the
Internet Connection Setup wizard.

2 TFollow the onscreen instructions. Click Next to move through the screens. If you need
help at any time, click Help.

3 Click Done.

Changing an Internet connection

If you already have a connection to the Internet, you can modify the connection settings.
You can also set up other ways QuickBooks can connect to the Internet. Doing so gives you
an alternate way to connect to the Internet if your regular connection is down for some
reason.

To change your Internet connection:

1 From the QuickBooks Help menu, choose Internet Connection Setup. The Internet
Connection Setup displays.

2 Select Use my computer’s Internet connection settings to establish a connection when this
application accesses the Internet.

3 Click Next.

4 In the Connection Setting window, click Advanced Connection Settings. The Internet
Properties dialogue box appears.

B To create a new dial-up networking connection, click Add.
Follow the onscreen instructions; click Next to move through the screens.

Each Internet connection profile you create, is listed on the first screen of the Internet
Connection Setup.
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If QuickBooks doesn’t detect your Internet connection (for example, you're using certain
versions of AOL or CompuServe), try the following:

m  Close QuickBooks, then connect to your Internet Service Provider (ISP).
®m  When you have successfully connected to the Internet, reopen QuickBooks.

m  Go to the Internet Connection Setup, and on the “How do you want to connect to
the Internet? screen, select Use my computer’s Internet connection settings to
establish a connection when this application accesses the Internet.

Once you have told QuickBooks that you have a direct connection, you should be able to
access QuickBooks’ Internet features by connecting to your ISP before opening QuickBooks.

Update QuickBooks to the latest release

Tip:

From time to time, Intuit provides updates to QuickBooks that are available for
downloading from the Internet. These updates might be:

® A maintenance release, which Intuit creates when a problem is discovered and fixed
after QuickBooks is delivered to customers.
® A new feature or service.

m  Timely information that is relevant to your business.

If you don’t have a company file, but want to update QuickBooks, open one of the sample
company files included with QuickBooks, then update the software as you normally would.

If you signed up for the QuickBooks Payroll , QuickBooks checks for new tax tables
whenever you check for other updates to your software.

Getting updates from the Internet

In QuickBooks, the Update QuickBooks window gives you a convenient way to download
updates from the Intuit server to your computer. To download an update, you need to have
set up QuickBooks to work with an Internet connection (see “Connect QuickBooks to the
Internet” on page 535).

There are several ways to update your version of QuickBooks through the Internet:

®  Automatic Update: This option prompts you when a new release is available for your
version of QuickBooks. If you choose to update when prompted, QuickBooks down-
loads the necessary files to your computer via the Internet in the background, with
little impact on your computer’s performance.

®  Manual Download: With this method, you decide when to download an update via
the Internet to your computer. You can use this method at any time—even if your
computer is set up to download updates automatically.

From www.quickbooks.ca/: Visit our Web site to download the latest release.

Multiuser Update: When updating multiple users, the new update is downloaded via
the Internet to a local server for each user to then download to their computer.

Update QuickBooks to the latest release I 57



58

Note:

Automatic updates

By default, QuickBooks is set to receive updates automatically. QuickBooks periodically
checks the Intuit server for new updates, and downloads the information gradually at times
when your open Internet connection is not being used by another process or application.
Some of the advantages of this method include the following:

®  You can download updates without interrupting a QuickBooks session or other tasks
you perform with your computer.

B You can download updates whether or not QuickBooks is running (as long as your
computer is connected to the Internet).

®  Youcan disconnect from the Internet at any time. When you reconnect to the Internet,
QuickBooks resumes downloading at the point it was previously halted.

To turn off Automatic Update:

1 On the File menu, select Update QuickBooks.

2 Click Options.

3 Click Off for the Automatic Update option and click Save.
4 Close the Update QuickBooks window.

Manual updates

If you choose to manually update QuickBooks, you should check for updates about once a
month. With this method, QuickBooks only begins the downloading process once you click
Get Updates in the Update QuickBooks window.

Download times for updates vary depending on the speed of your Internet connection, the
size of the update file(s), and the amount of traffic on the Internet. After QuickBooks
downloads an update, the program installs the necessary files to the correct directories or
folders on your computer.

To perform a manual update:
1 From the File menu, choose Update QuickBooks.
2 Click Update.

3  Select the updates you want to download by clicking the checkbox next to the update
name. (A check mark means the update is selected.)

4 Click Get Updates.
Manual updates can also be performed when the Automatic Update option is turned on.

Once the download process is complete, QuickBooks displays the date and time of the
download in the Last Checked column. In the File Received column, QuickBooks displays
the status of the download. Click the text in the Files Received column for additional details
about the download.
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Updates from www.quickbooks.ca/

Visit the QuickBooks web site at http://www.quickbooks.ca// to download updates. At the
site, under Quick Find, click Product Update, then see the QuickBooks Product Updates
section. There you'll find a list updates for the various versions.
Before installing the update from www.quickbooks.ca/:
1 Write down your QuickBooks license key in case you need it later.

m  To find it, select About QuickBooks from the Help menu.

2 Back up your company file(s).

To update from www.quickbooks.ca/:
1 From the Product Updates page, click the update link for the version you are using.
The File Download window opens.

By default, the “Save this program to disk” option is selected. This option saves a copy
of the update to your computer for you to later install.

Click OK. The Save As window appears.
Navigate to a folder to save the update file to or keep the default.
Click Save.

When the download is complete, the WinZip Self-Extractor opens. (If it does not start
automatically, double-click the file you downloaded.) Extract the files to a temporary
folder where you can find them again easily.

a s wWN

6 Shut down all open programs, including QuickBooks and any virus protection software
you may have. Some virus protection programs can interfere with the installation.

7 Using Window Explorer, open the folder you specified in Step 5.
8 Double-click the Setup.exe file and follow the instructions on your screen.

Sharing updates among multiple users

If you use QuickBooks Pro or better in multi-user mode, you need to install maintenance
releases on each computer that has QuickBooks installed on it.

You can either connect to the Internet from each computer that has QuickBooks installed
on it, or else download the update to one computer on your network and share it (for
example, if one or more users doesn’t have Internet access).

QuickBooks sets up a shared location to which updates are downloaded. Then, if any user
in a multi-user environment downloads and installs an update, QuickBooks detects it and
prompts each of the users—as they open the program—to install the new version.

To share updates, you need to be sure that all your users can access the location on your
networks where the updates are downloaded:
m Al of the QuickBooks computers must be properly networked.

m  Each computer must be configured to share files across the network.
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Finally, all QuickBooks users on your network must complete the following steps:

To change the download location:

1

2
3
4

Open the shared company file.
From the File menu, choose Update QuickBooks.
Click Options.

In the Options windows, click ON for the Share Download option, then click Save.

Updates from a CD-ROM

If you don’t have Internet access, you can have an update mailed to you on a CD-ROM (fees
may apply). For more information, contact Customer Service (see page 252).

When you receive the CD, install the update as you would install any other software.

Before installing from a CD...

These instructions may change from time to time. When this is the case, you'll receive up-
to-date install instructions with the Update package.

1

2

Write down your QuickBooks license key in case you need it later.
m  To find it, select About QuickBooks from the Help menu.

Back up your company file(s).

To install your QuickBooks update:

1

o h WN

Shut down all open programs, including QuickBooks and any virus protection software
you may have. Some virus protection programs can interfere with the installation.

Insert the CD-ROM in your computer’s CD-ROM drive.

Open Windows Explorer and select the correct CD-ROM drive.

Open the folder containing the installer for your version of QuickBooks.
Double-click Setup.exe and follow the instructions on your screen.

Review the Readme.txt file on your CD-ROM. It contains important information about
how your software is affected by this update, and what you should do next.

Set number, currency, time, and date formats in QuickBooks

60

Your settings in the Regional Options of Microsoft Windows affect how QuickBooks
displays numbers, currency, time, and dates.

To check your Windows Regional Options settings:

1 From the Windows Start button, select Control Panel.
2 Choose Regional Options or Regional Settings, depending on the version of Windows
you're using.
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Thank you for moving to QuickBooks! Now you need
to convert your data from your former accounting
software. You may also want to make some
adjustments to your company file to take full
advantage of QuickBooks features. In this chapter,
you'll find information about moving information

to QuickBooks.




Converting data from Quicken

Note:

This section explains how to convert your Quicken data to QuickBooks data and some of
the differences between the two programs. After you finish converting, you’ll want to make
some adjustments to your new QuickBooks company to take advantage of the QuickBooks
features that Quicken does not offer.

Before you convert to QuickBooks, back up your Quicken data file.

If you plan to continue using Quicken with this data (for example, if you have both busi-
ness and personal data in your Quicken file), make a copy of the Quicken file before you
make changes. For instructions on backing up a Quicken file, see the documentation
that came with your software.

QuickBooks data files are called company files and they are not compatible with and
cannot be converted back to Quicken data files.

Do not uninstall Quicken before installing QuickBooks and converting to it.

Preparing your Quicken data for conversion

62

Note:

To make the transition to QuickBooks as smooth as possible, you may need to make some
changes to your:
®  Quicken Account list ®  Online banking accounts

m  Memorized Transaction list m Names of customers on accounts
receivable transactions

Convert only the accounts you want to use in
QuickBooks

Before you convert to QuickBooks, delete all accounts in Quicken that you know you won’t
want in QuickBooks. (In QuickBooks, you can’t delete accounts that have transactions, but
you can in Quicken. So it’s easier to delete the accounts you know you won’t want before
you move to QuickBooks.)

All transfers to and from the deleted accounts will be converted as transactions to your opening
balance equity account to ensure that your accounts balance.

You might want to delete accounts from your Quicken file in these situations:
B You have personal accounts as well as business accounts in your Quicken file.
®  You have investment accounts in your Quicken file.

If you do not delete your investment accounts, they will be converted to QuickBooks
Other Current Asset accounts (because QuickBooks doesn’t track investments like
Quicken does). You can either:
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Note:

v

m  Keep the QuickBooks Other Current Asset accounts as a way to include the value
of your investments in your QuickBooks balance sheet. In this case, you should
continue tracking your investments in Quicken and update the balance of your
QuickBooks Other Current Asset accounts periodically.

m  Or, delete the investment accounts from your Quicken file (so they are not brought
into QuickBooks at all) and continue to track the investments in Quicken. (The
investments still appear in the copy you made of your Quicken data.)

Review your memorized and your scheduled
transactions

If you have overdue scheduled transactions in your Quicken file, record them
before converting.

For example, print any cheques you have pending.

If the QuickFill option for memorizing all transactions is turned off in Quicken, QuickBooks
converts both your memorized transactions and your scheduled transactions.

On the other hand, if the option is turned on, QuickBooks converts only scheduled
transactions and your transaction groups. It does not convert stand-alone memorized
transactions.

So, if you have memorized transactions in Quicken that you’d rather not retype in

QuickBooks, you need to do one of two things:

m  Turn off the QuickFill option for memorizing all transactions in Quicken. If your list of
memorized transactions is very long, you may want to delete the ones you won’t need
in QuickBooks, or

m  Put these transactions into a transaction group in Quicken. QuickBooks always
converts transaction groups. After the conversion is complete, you can remove the
memorized transactions from the group and use them as you did in Quicken.

For information about transaction groups in Quicken, look in your Quicken
documentation.

Memorized transactions from Quicken accounts payable will not work properly in QuickBooks
accounts payable. You should delete these before you convert your data.

To learn about... Search the Help index for...
Transactions group in QuickBooks memorized transactions, grouping
together
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Tip:

Make customer names consistent

When you convert to QuickBooks, the names in your accounts receivable register become
customers, and transactions become invoices and payments. If you accidentally used
different names for the same customer in Quicken, QuickBooks can’t link the customer’s
invoices and payments correctly.

For example, if you have a customer listed as Dan Miller, D. Miller, and Daniel Miller, you
should edit these names before you convert so that the customer goes by only one name.

If you use online banking

You can bank online with participating financial institutions through QuickBooks just as
you can in Quicken. However, not all institutions that work with Quicken also work with
QuickBooks. Contact your financial institution before converting to confirm that it
supports QuickBooks. If it does not, an online account in Quicken will not remain an online
account after the conversion to QuickBooks.

To see the current list of financial institutions that support online account access in QuickBooks,
choose Set Up Online from the Banking menu in QuickBooks, then choose Online Financial
Institutions List.

Your financial

institution... What to do

Comments

You will need to re-enable
your online accounts in Quick-
Books after conversion. See
“Re-enable your online bank-
ing accounts” on page 67.

Supports online account
access in both Quicken and
QuickBooks

Supports online account
access in Quicken, but not
in QuickBooks

You are not able to use online
account access in QuickBooks
for this account. You could con-

Select between the two
choices described in “If your
financial institution does not

work online with QuickBooks”
on page 68.

tinue to use online account
access in Quicken.

Converting your Quicken file to QuickBooks

64

When QuickBooks converts a Quicken data file, it doesn’t change it in any way. Also,
QuickBooks does not create any sort of link between your Quicken data and your new
QuickBooks company. Instead, QuickBooks creates a completely new set of files for you to
use.

m If you've been using Quicken for Windows 5.0 or earlier, Quicken for DOS, or Quicken
for Macintosh, call Technical Support for instructions (see page 253).
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Quicken XG, 2003, 2002, 2001, 2000, 98, and 6.0 for
Windows

QuickBooks can directly convert data from these products.

1 If your Quicken file is protected with a password, start Quicken, and then remove the
password. If you're not sure how, check the documentation that came with your
Quicken software for instructions.

2 Exit from Quicken if it is running.

3 Install QuickBooks. Instructions on installing QuickBooks are included in the
"Installing & Learning to Use QuickBooks Guide".

E

Open QuickBooks by double-clicking the QuickBooks icon on your desktop.

1

From the File menu, select Import, then Convert from Quicken. The Important Docu-
mentation window appears.

Click View Help for information about converting from Quicken.
Close the help window, then click OK.

Choose the Quicken file you want to convert, then click Open.

©0NO

Follow the instructions on your screen to convert your file.

Fine-tuning your data after converting to QuickBooks

After you convert your data from Quicken, you may need to make some additional
adjustments to it before you start using QuickBooks.

Edit your Other Names list

At the end of the Quicken conversion (unless you use Quicken Deluxe), you are asked to
choose which account you used for Accounts Receivable (A/R).

As the conversion finishes, QuickBooks gives you a list of names to which you made
payments but which you have not used in your accounts receivable account. This list may
contain not only the names of customers, vendors, and employees, but also descriptions
such as “Deposit,” “Transfer,” and “Interest.”

You should change the names on the list to the correct type. (If you don’t change them
now, they remain on your Other Names list so you can change them later, but you’ll have
to do it one name at a time.)

If you want to use QuickBooks account payable, be sure to move your Quicken payees
(other than employees) from the Other Names list to the Vendor list. For more information,
see “Changing to QuickBooks accounts payable” on page 69.
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.@ Once you change the type for a name, you cannot undo it.

You can move names from the Other Names list to the Vendor, Customer:Job, or
Employee lists. However, once moved, you cannot move a name again. If you're not
sure whether to change a name now, it’s best to leave it as is.

To change types for names:

m In the Change Name Types window, click the corresponding column for each name
you want to move. When all the names are marked correctly, click OK.

Change Mame Types

To change the name type for any names below, click the column for the new
name type [Custorer, Wendor, Employee] next to each name whose wpe pou
wank to change., Cancel P To restore all the

Hg

[ el ]

WARNING: Once pou click OK to change the name type, you cannot undo the Eievert : check marks to the
change. If you are not sure whether to change a name now, leave it as an — Other Name column,
iz [z click Revert.

Mame Customer Wendor Employee  Other Mame
Bayshore Auta Service J j
Bayshore Bagel Maven J
Company car
Computers

Interest earned
Friar retained earnings

LAAAANS

Service charge

i

If you have different versions of one name

If you have slightly different versions of the same name (for example, T. Stewart, Tracey
Stewart, and Tracey L. Stewart), QuickBooks puts each version of the name in the Other
Names list.

In QuickBooks, you can’t delete any name used in a transaction. However, you can merge
the names to shorten the Other Names list.

v

To learn about... Search the Help index for...

Changing the name type to a cus- other names, list of
tomer, vendor, or employee

Merging similar names merging, list entries

Fill in your company information

From the Company menu, choose Company Info, and fill in your company information. If
you want QuickBooks to track tax information for you, you must also select the tax form
you file from the drop-down menu.
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Turn on the QuickBooks features you plan to use

In QuickBooks, from the Edit menu, choose Preferences. Now you can customize

QuickBooks for your needs.

m  If you collect sales taxes from customers (such as GST, HST, PST, or QST), turn on the
GST/PST tracking preferences. For more information about tracking GST or PST, see
“Gathering income tax information” on page 127.

m  If you track inventory or write purchase orders, turn on the preferences for inventory
and purchase orders.

m  If you deal internationally, turn on the preference for multicurrency. For more infor-
mation about multicurrency, see “Doing business internationally” on page 157.

m  If you plan to use QuickBooks to pay your employees, you must sign up for the
QuickBooks Payroll . To learn more about payroll, see “Setting up payroll: an overview’
on page 175.

’

To learn about... Search the Help index for...

Settings preferences

Re-enable your online banking accounts

If you use online banking, you'll need to re-enable your online accounts after you import
them into QuickBooks.

To re-enable your online accounts:

1 From the Lists menu in QuickBooks, choose Chart of Accounts.

2 Select your online account. Then click the Account menu button at the bottom of the
window and choose Edit.

3 In the Edit Account window, click the Account Details tab.

If the account has no Account Details tab in the Edit Account window, it is not online
in QuickBooks. An account that was online in Quicken will not be online in Quick-
Books if the financial institution does not work online with QuickBooks.

m  Select Online Account Access, then click OK.

To learn about... Search the Help index for...

Enabling accounts for online banking online banking, enabling accounts

Converting data from Quicken I 67



v

If your financial institution does not work online with
QuickBooks

If your financial institution does not work online with QuickBooks, your online accounts
are converted to standard (not online) accounts.

m  Notity the financial institution that you will no longer be using its online services.

m  Alternatively, you could open an account with a financial institution that does work
online with QuickBooks.

Adjust your Opening Bal Equity account

QuickBooks automatically creates an Opening Bal Equity account for you. When you create
a new account and enter its opening balance, QuickBooks enters that amount in the
Opening Bal Equity account, so that your accounts balance. You can leave the Opening Bal
Equity total alone, or you can distribute amounts from it to other equity accounts.

To learn about... Search the Help index for...
Distributing equity from before your Opening Bal Equity account

start date

Moving the amount in the Opening equity, transferring from Opening Bal
Bal Equity account to other equity Equity

accounts

How QuickBooks converts accounts receivable transactions

68

If you answered “Yes” to converting your Quicken asset accounts to QuickBooks A/R
accounts, QuickBooks converted the transactions as follows:

This item in your Quicken A/R ...iIs converted to this in
account... QuickBooks:

Each transaction that increases your A/R bal- An invoice to a customer

ance

Each transaction that decreases your A/R bal- A payment from a customer

ance and has only one split line

Each transaction that decreases your A/R bal- A credit memo to a customer
ance and has more than one split line

Each payee A customer on your QuickBooks
Customer:Job list

Each category Both an item on your Item list and an income
account on your Chart of Accounts

QuickBooks applies payments in Quicken to a customer’s oldest outstanding invoice first.
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Changing

The conversion saves you the time of typing in all your accounts receivable transactions,
but you’ll probably want to make some changes to the converted data. For example, if the
category you used in most A/R transactions was “Sales income,” you’ll want to change the
name of the converted invoice item from “Sales income” to the product or service you
actually sell, such as “Consulting hours.” The income account; however, may be just fine
as “Sales income.”

You don’t have to make these changes now. QuickBooks makes it easy to make changes at
any time.

to QuickBooks accounts payable

You may have had an Accounts Payable (A/P) account in Quicken. QuickBooks converts the

transactions in this account into historical transactions in your journal, which indicate

what you owe and to whom. The transactions do not appear in your QuickBooks A/P

account.

m Inthis case, track payments of outstanding bills only the same way you did in Quicken.
However, enter any new bills with the Enter Bills window (QuickBooks creates a new
A/P account for you the first time you enter a bill).

If you didn't use an accounts payable account, the documentation explains how to set
Quicken up for cash-basis accounts payable and for accrual-basis accounts payable. For a
cash-basis system, Quicken recommends using a Bank account and simply postdating
cheques. For an accrual-basis system, Quicken recommends using an Other Liability
account.

The transition to QuickBooks accounts payable is the same for either system.

m  If you used postdated cheques to track your bills, treat cheques you've already entered
the same way you did in Quicken.

m If you had an Other Liability account in Quicken for accounts payable, it is now an
Other Current Liability account in QuickBooks.

No matter which method you were using in Quicken, from now on, use the Enter Bills

window to track your bills. The Enter Bills window tracks your bills in the Accounts Payable

account. To create this account, you can either:

m  Use the Other Current Liability account only for currently outstanding bills and let
QuickBooks create a new Accounts Payable account for you the first time you use the
Enter Bills window.

m  Or, you can move the transactions in your Other Current Liability account to an
Accounts Payable account (see below).
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To move your Other Current Liability transactions to the Accounts
Payable account:

1

6

In Quicken, create a report that gives you the total balance you owe each of your
vendors. Make sure the date range is set to Include all dates, then print the report for
reference.

Start QuickBooks.

From the Banking menu, choose Make General Journal Entries.

On the first line:

m In the Account field, choose Accounts Payable from the drop-down list.

m In the Name field, choose the vendor’s name.

m In the Credit field, type the open balance (you'll need to do this for each vendor).
On the second line:

m In the Account field, choose the Other Current Liability account from the drop-
down list.

m In the Debit field, type the same amount that you entered in the Credit field of the
first line.

Click Save & New.

Changing your payees to QuickBooks vendors

If you haven't already, you need to move your Quicken payees from the Other Names list
to the Vendor list. See “Edit your Other Names list” on page 65.

If a Quicken payee had a balance that you converted to QuickBooks, use Write Cheques
until the balance of your old Quicken A/P account equals zero (you've paid off all your bills
for that vendor). Enter any new bills into QuickBooks accounts payable.

You also need to delete and re-enter any memorized transactions that QuickBooks
converted for you from Quicken accounts payable, as they will not work properly in
QuickBooks accounts payable.

To learn about... Search the Help index for...
Deleting memorized transactions memorized transactions, deleting
QuickBooks accounts payable accounts payable
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Comparing QuickBooks and Quicken

Once you understand the few terminology and feature differences between the programs,
QuickBooks will feel very familiar.

Terminology differences

Quicken uses terms familiar to anyone who has used a cheque book. QuickBooks uses a few
terms that are standard in business bookkeeping and that reflect the increased power and
convenience of QuickBooks for business.

This table lists the most important differences in terms. It does not list the many completely
new QuickBooks features and terms.

Quicken QuickBooks

Definition
term term
Account Balance sheet account A grouping of records related to one kind of
asset, liability, or equity.
These accounts appear on a balance sheet.
Category Income or expense A grouping of transactions related to one kind of
account income or expense.
These accounts appear on a profit and loss state-
ment (income statement).
Category and Chart of Accounts The QuickBooks Chart of Accounts is like the
Transfer List Quicken Account list (balance sheet accounts)
plus plus the Quicken Category list (income and
Account List expense accounts).

Feature differences

The following table lists features that exist in both Quicken and QuickBooks, but that work
differently in QuickBooks than in Quicken.

Feature Quicken QuickBooks
Entering Enters most transactions in regis- Enters most transactions in forms
transactions ters. (cheque window, invoice window,
and so on).
Write Cheques Displays a cheque that looks like a Displays a business cheque with
paper cheque. voucher area (so the “split” is part

of the cheque form).
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Feature

Classes

Quicken

Uses a slash (/) to separate a cate-
gory from a class in transactions.

QuickBooks

Enters classes in separate fields. No
need for a slash (/) as a separator.
In QuickBooks, projects or jobs can
be linked to customers as part of
the Customer:Job list, so you can
use classes for different kinds of
classification.

Transfers

Uses brackets [ ] to indicate a
transfer to another balance sheet
account.

No need to use brackets. Quick-
Books handles transfers like any
other transaction.

Passwords

One password for entering and
viewing data.

Customizable password and per-
mission access for each person in
your company.

Subaccounts

Categories can have subcatego-
ries, but accounts cannot have
subaccounts.

Most accounts, even balance sheet
accounts, can have subaccounts.

Payroll accounts (if
you set up your
accounts as
described in the
Quicken manual)

A separate liability account for
each tax withheld and for every
other payroll liability.

You can continue using your old
liability accounts. However, by
using payroll items, you can put all
your payroll liabilities into a single
account.

New and renamed balance sheet accounts

QuickBooks and Quicken have similar kinds of balance sheet accounts, but QuickBooks
adds some types and uses different names for others. When you convert a Quicken file, the
program automatically creates QuickBooks accounts most like your Quicken accounts.

In some cases, you may not want to use the account that QuickBooks automatically
creates. For example, Quicken sometimes uses liability accounts instead of equity
accounts. In QuickBooks, you can make them equity accounts.

QuickBooks changes your Quicken categories and subcategories into income and
expense accounts with subaccounts.

Quicken acct. type

Converted to QuickBooks acct. type

Chequing Bank

Credit Card Credit Card

Cash Bank

Asset Other Current Asset
Liability Other Current Liability
Investment Other Current Asset

72 Chapter

3 Importing and exporting data



When you convert from Quicken

After you have converted your Quicken data file to QuickBooks, you'll notice the following
changes:

m  The Invoice Items list is converted to the QuickBooks Items list.

m  Each existing Invoice/Receivables account is converted to a QuickBooks Accounts
Receivable account of the same name.

m Existing invoices are converted to QuickBooks invoices. However, they will appear in
chronological order.

m Transactions linked to a customer remain linked.

About payments, credit memos, and refunds.

Converted Quicken payments are always applied to the customer’s oldest outstanding
invoice, so the payment links to invoices may be different after conversion.

Credit memos and refund cheques, like payments, are also applied in chronological
order based on invoice dates, so their links may also be different after conversion.

Should you continue using Quicken for some things?

QuickBooks does not change your original Quicken file in any way as it imports
information from it, nor does it create any connection between it and your new
QuickBooks company. You can continue to use your original file with Quicken.

Once you're using QuickBooks for your business, you'll probably want to continue using
Quicken for your personal finance and investment accounts.

Do not use online banking for the same account in both programs.

If you track the same account in both Quicken and QuickBooks, you can only use online
banking in one program. If you try to use online banking for the same account in two
different programs, it will not work correctly.

Here are some personal-finance activities you can perform only with Quicken:
m  Track investments

Quicken includes investment tracking and reporting. Quicken updates the market
values when you enter the latest share prices, and it reports on average annual total
return, capital gains, and investment income.

®  Amortize mortgage loans

Each time you record a payment on a loan, Quicken updates the number of payments
made and calculates the amount credited to principal and interest.

m  Create reports for personal finances
Quicken has many preset reports designed for personal use.
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Converting data from MYOB

Note:

This section explains how to convert your MYOB data to QuickBooks data, set up your
payroll, and goes over some of the differences between the two programs. After you have
finished converting, some adjustments may need to be made to your new QuickBooks
company to take advantage of the QuickBooks features that MYOB does not offer.

To convert MYOB data to QuickBooks:

1 Install QuickBooks. Instructions on installing QuickBooks are included in the
"Installing & Learning to Use QuickBooks Guide".

Before converting, verify and optimize your MYOB company file to ensure that there are no data
integrity issues with your data. If there are data integrity issues, the need to be resolved before
you can convert to QuickBooks.

2 Open QuickBooks. The Welcome to QuickBooks window appears.

3 Click the Convert from button, then select MYOB. The MYOB to QuickBooks Assistant
appears.

4 Tollow the onscreen instructions to convert the data in your MYOB file.

The assistant does not change anything in your original MYOB company file; it only

reads the data from your MYOB file.

The conversion process may take some time depending on the size of your company

file. When the assistant is done converting your data, the “Congratulations” window
is displayed. At this time, you can view the log file to see the results of the conversion.
Click the Finish button to close the assistant and start using QuickBooks.

What's Next after conversion
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Note:

If you want to set up your payroll in QuickBooks, refer to “Setting up your payroll in QuickBooks”
on page 76. You'll also need to read Chapter 7, Payroll and employees, beginning on page 173.

When the conversion is done, a new QuickBooks company file is open containing your

MYOB data and is ready for you to begin using. To help familiarize yourself with

QuickBooks, here are some things that we suggest you do.

m  Read the remainder of this guide. You'll learn the concepts of QuickBooks and what
you need to know about critical features such as collecting sales tax, working in
different currencies, and setting up a payroll system.

= Complete the step-by-step lessons-based Learning Guide. It comes with two exercise
company files you can use to practice entering transactions.

m  Complete the QuickBooks tutorial. To open it, go to the Help menu and select Quick-
Books Coach. This interactive tutorial lets you practice common tasks without
affecting any data in your company file. You can complete it in 15 minutes. You may
have to insert the QuickBooks Learning CD in your CD-ROM drive to access the
tutorial.
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Look at the help for MYOB users. From the Help menu, select Help for MYOB Users.
Here you can learn how to do, in QuickBooks, the same accounting tasks that you
preformed through the MYOB Command Centres.

Look at your Chart of Accounts (this is referred to as Accounts List in MYOB). From the
Company navigator, click Chart of Accounts.

Fachrtolfeonts A WEE
Marme £ | Type Tax Cumency | Balanes
+1-1110 - Chequing Accou Bank. Canadian D 41.487.60 |
+1-1120 - Paproll Chequing Bank Canadian D 2216184
+1-2510 - Chequing [US $) Bank. United State 750.00—
+1-2100 - Accounts Reced Accounts Receivable Canadian D E2143.48
+1-2160 - Receivables (US Accounts Receivable Urited State 4110.00
+1-1150 - Undeposited Fur Other Current Asset Canadian D E135.16
+1-1300 - Deposits Paid Other Curent Asset Canadian D
+1-3100 - Firished Goods Other Current Asset Canadian D 27066470
+1-3200 - Raw Materials Other Cunent Asset Canadian D 83,257 64
+1-5210 - Improvements 01 Other Current Asset Canadian D £5,120.00
+1-5220 - Improvements A1 Other Cunent Asset Canadian D -7B27.62
+ 16710 Fumiture & Fistur Other Current Asset Canadian D 33464.00
+1-5720 - Fumniture & Fistur Other Current Asset Canadian D £.892.00
<1120 Inventory Asset Other Current Asset Canadian D 0.00
+2-2100 - Accounts Papab Accounts Payable Canadian D 4289910
+2-1110 - American Expres Credit Card Canadian D 0.00
+2-1120 - MasterCard Credit Card Canadian D 0.00
+2-1130- Visa Credit Card Canadian D 0.00
+2-3100- G5T Collected Other Current Liabiity Canadian D 3470.42
+2-3200- GST Paid Other Cunent Liability Canadian D -4,363.08
+2-3300- PST Collected Other Curent Liabiity Canadian D 241040
+2-3400 - PST Paid Other Cunent Liability Canadian D 217.60
23500 Import Duly Faye| [ Other Curent Lisbility Canadian D 000
+2-5000 - Payroll Withholdi Other Curent Liability Canadian D 5,038.70
+2-6000 - Customer Depos Other Cunent Liabiity Canadian D 0.00
Other Curert Lisbilit Canadian D .
2 2200 - GST Pavable [ther Cunent Liabiity Caniadian D 0.00
<2240 PST Payable Other Current Liabiity Canadian D .
+3-0000 - Equity Equity Canadian D 0.00
#3-1100 - Owrer's Irve: Equity Canadian D 0.00 «|
Activities ¥ I Feportts ™ | = Show sl

If the "conversion date" you chose in the wizard is earlier than the day that the
conversion was performed, the balances in the QuickBooks Chart of Accounts may be
different than those balances from your MYOB Accounts List. This is because the
account balances in your MYOB file may include transactions that were entered after
the chosen "conversion date".

Check your customers’ and vendors’ profiles. Customers and vendors are added to
QuickBooks lists. Think of these lists as the Cards List in MYOB. To see your customer
list, open the Customers navigator and click Customers. To see a list of your vendors,
open the Vendors navigator and click Vendors.
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m  Check out the QuickBooks navigators. Navigators gather information from your data
and display it in one location so you can manage your business more effectively. Navi-
gators are to QuickBooks what Command Centres are to MYOB. The tasks that you
accessed from Command Centres in MYOB, similarly, can be accessed from Quick-
Books navigators.

SI=
Ble Edt View Lsts Company Customers Vendgrs Employses Banking Reports Window Help
H R B B @ 4 & 2 B % &4 2 ¢
3 Invoice Cust  Item MemTx Vend Cheque il Reg Accnt Rmnd  Find  Support Backup
The navigators are ——— B3 * customer Navigator

Navigators
Customers

listed here. To open a
navigator, click the
name of the navigator

Related Activities
[ Vendors P == ;
g B QuickBooks Credt Card Service
|22 Employees S 2 >
Banking Estiinetes. f Invoioes e & QuickBooks Secure Dacument Defvers Service

in this list. 2 Business Services &l = P , B Pinlucices
[, Reports Eic, &b =)
B
5 Help & Support Flunce  Statements _Refunds & AddaCusiomer
Charges and Credits

What' (i (@ Customer Cenbe..

The QuickBooks
Customers navigator,

Open Windows Sales, & Customer Detsil Centie.
Receipts

. .. Ay R g ) 4 3 Memorized Reports _Help |
shown here, is similar s Fomelx T @ e it JVpr—
Services. Register Letters  Centre Customer Balance Detail
to the Sales Command - Dl once Sunnen
. Customer Solutions Dpen Inveices
Centre in MYOB. The /
. Handle out of stock situstions by orders For your customer

flow chart depicts S —— Nt

activities related to / Get paid faster Email invoices and receive pa m;p( orline L

dealing with customers. // —
In this area, QuickBooks Here, you have easy access to reports
provides suggestions for related to customer activities. You can
working with your also customize this by adding reports
customers. that you've memorized.

Setting up your payroll in QuickBooks
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Because of security reasons, accounting software restricts access to various components of
your accounting data. Payroll data is one such component. As a result, QuickBooks can
convert some of your payroll data, but not enough of it to continue dispersing payroll to
your employees. Before you can pay your employees using QuickBooks, you need to
complete the following steps to set up the payroll system to fit your needs, and transfer your

payroll data (such as employees’ year-to-date summaries) from MYOB so that your payroll
tax information remains up to date.

These steps teach you how to quickly set up your employees in QuickBooks. For details on
how to use QuickBooks payroll features, read Chapter 7, Payroll and employees, beginning
on page 173 We recommend that you read this chapter in its entirety before you remit your
first payroll cheque. You can open the manual from under the Help menu. You can also

search the Help index, or click F1 on any window in QuickBooks for context-sensitive help.
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1 Gather payroll information that QuickBooks needs from your MYOB company file.

When you convert your MYOB data to QuickBooks, the information displayed on each
employee’s Profile tab is copied into QuickBooks. General payroll information, such as
the province in which your company operates, and your business number are also
converted to QuickBooks.

P Card Information M=l E3
Profile Card Details Payroll Details Payment Details Contact Log Jobs History Each employee in MYOB is
added to the Employee List
Card Type:[Emplopee. =1 Designation: | Individual =] I Ingetive Card in QuickBooks.
Last Name: | Stewart First Wame: | Tracey
Card ID: | "Mone
Address Info ] Additional Info [ Payrall Info ]
Location; | Address 1 =
Addiess: [123412 Ave Phoreil: (7801234 pr /Ms./ Print &5 [Tiacey Stewart
Phenet2: ]
e E P [ Fisthame [Tracey M.I Phone  [Fe0-123-4567
Province: | AR Pastoode: | TS) 142 Fae| | LestMams [Stowart Aph |
Country: | Canada +7 E-mail 1 E-mal |
. W
Sautaion: || Address [1z3412 802 SIN |
| Emp. Mo, |
City [Edm DOB | E
e Piint 3 Letter Province: Postal Code  Hired |12,421 2001 E
4B :Iv T5) 142 Released I E

Before you can start paying your employees; however, QuickBooks requires additional
data about your payroll in order to keep your payroll tax information correct. You can
get this data from the following MYOB reports. (Print these reports as you'll need them
when you complete your employee set up in step 5.)

m  Employee Payroll List-report listing employee information, tax status, and pay basis
From the Index to Reports window, click the Payroll tab, select Payroll List, then click
Display.

m  Payroll Register (Detail)-report listing the year-to-date amounts for each employee
From the Index to Reports window, click the Payroll tab, select Register Detail, then
click Customize. In the Period field of the Report Customization window, select Year-

to-date, ensure the date range is from the beginning of the payroll year to the date you
started using QuickBooks, then click Display.

m  Employer Accrual Expense Balance (detail)-report totalling expenses, such as vacation
pay, that the employer has yet to pay out to his or her employees

From the Index to Reports window, click the Payroll tab, and under Employer Accruals,
select Accrual Balance Detail, then click Customize. In the Period field of the Report
Customization window, select Lifetime, and click Display. The amount on this report
shows the outstanding accrual balances for each employee.
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2 Turn on the payroll feature.

Open the newly-converted QuickBooks company file (if it isn’t already), and from the
Edit menu, select Preferences. In the Preferences window, click Payroll & Employees
from the scroll bar on the left, click the Company Preferences tab, then select Full
payroll features. Click OK. All QuickBooks payroll features are now visible.

3 Compare QuickBooks’ payroll items to MYOB payroll categories to ensure they fit
with your payroll system.

MYOB payroll categories are similar to payroll items in QuickBooks. Payroll items are
the building blocks of the QuickBooks payroll system. QuickBooks creates some
standard payroll items in the Payroll Item list when you first turn on the payroll
feature.

Compare these default payroll items in QuickBooks to your MYOB payroll categories.
You may need to create new payroll items to match the way you paid your employees
in MYOB. For example, if you paid your employees hourly, you need to create an
hourly wage payroll item.

Note: For more information on how to do this, refer “Setting up your payroll items” on page 179.

4 Merge MYOB payroll withholdings and payroll expense accounts with QuickBooks
default payroll accounts.
When the payroll feature in QuickBooks is turned on, two accounts are added to the
Chart of Accounts: Payroll Expenses, and Payroll Liabilities. QuickBooks uses these
payroll accounts to track payroll transactions. In order for the MYOB payroll liability
(withholdings) and expense balances that were brought over during conversion to be
tracked using the QuickBooks’ payroll accounts, all the MYOB payroll liability (with-
holdings) accounts must be merged with the QuickBooks “Payroll Liabilities” account,
and all MYOB payroll expense accounts must be merged with the QuickBooks “Payroll
Expenses” account. If you are not clear on what MYOB payroll liability and expense
accounts that you need to merge, talk to your accountant.

? To learn about... Search the Help index for...
@

Merging accounts merging, accounts

5 Complete your employee set up

You'll need the reports that you printed in Step 1 to help with the set up of your
employees.
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?

@

Note:

Set up employee defaults (optional)

On the employee defaults window, you can set up payroll information that most or all
of your employees have in common, such as life or dental insurance benefits or union
dues. These defaults will then show up on every new employee’s payroll profile, thus
removing the need to enter the same data over and over again for each employee.

To learn about... Search the Help index for...

Setting employee defaults employee defaults, creating

Display the Employee List (from the Employees menu, select Employee List).

On the Employee List window, click the Employee button and select Employee
Defaults.

m  On the Employee Defaults window, in the “Additions, deductions, and company
contributions” box, enter additional adjustments you make to the gross or net pay
that apply to most of your employees. Employee defaults for payroll taxes, accrual
hours or vacation pay will not be applied to your existing MYOB employees that
were brought over during the conversion. These properties must be set up when
you customize each employee.

Enter employee year-to-date amounts

For each employee (both current and former) that you paid during the current payroll
year, you must enter a summary of his or her earnings, income taxes, and other
amounts from January 1 to your QuickBooks start date, otherwise your employee’s T4
amounts will be incorrect. Year-to-date amounts for your MYOB employees are
available from an employee’s last payroll stub, or from the Payroll Register (detail)
report that you printed in step 1.

For more information on year-to-date amounts, refer to the section “Summarizing amounts for
this year to date” on page 194.

m  Open the Set Up YITD Amounts wizard (from the Employees menu, select Set Up
YTD Amounts).

m  Click the Next button. On the following two windows, enter the dates as
appropriate. You should be entering the date that you converted to QuickBooks.

®m  When you get to the Employee summary information window, select the
employee whose year-to-date summaries you want to add, and click Enter
Summary. (If a message pops up asking if you want to set up sick hours accrued,
click Later. You'll be setting this up when you customize each employee’s profile.)
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L]

¥5 2003 YTD Acjustment for Tracey Stewart

Each employee’s year-to-date amounts are

totalled on this MYOB report. Enter the totals
you see on this report into QuickBooks. For
details on how to generate this report, refer to

step 1. Year-to-date amounts can also be

retrieved from the last payroll stub that you

printed for an employee.

The date range should be — ]

from the beginning of the

payroll year to the date you

converted to QuickBooks.

On the 2003 YTD Adjustment window, enter the employee’s year-to-date amounts

[ ]
using the totals from each employee’s last payroll stub, or the Payroll Register
(detail) report (as shown in the example below) with the exception of accrued
vacation pay (see the step below for instructions on vacation pay).

i i =]
Payroll Register {(Detail)
|
Year-to-Date
6/26/2003 Page 1
4:48:25 PM
Employee  Category 1st Quarter 2nd Quarter 3rd Quarter 4th Quarter YTD Total
stewart, tracey *hane
Wages
Base Hourly §0.00 §400.00 §1,200.00 $0.00 §1,600.00
Hours: 40 120 160
Total: §0.00 $400.00 §1,200.00 $0.00 §1,600.00
Taxes
CPP - Employee Contribution §0.00 §15.64 $46.92 $0.00 $62.56
El- Employee Contribution §0.00 $8.80 $26.40 $0.00 $35.20
Income Tax $0.00 $97.65 §252.85 $0.00 $38060
Total: §0.00 §122.08 $366.27 $0.00 §488.36
Expenses
CPP - Employer Contribution $0.00 $15.64 §46.92 §0.00 FE2.56
El - Employer Contribution $0.00 $12.32 F36.96 Sﬂl]l]}l/ §45.28
Total $0.00 $27.96 §83.88 £0.00 W

x|
99  NestPeiod |

Tor Tracey Stewart

Memo

Date U6/26/2003

¥ 1111.64

{¢  Frey Period

0K
Cancel

Salary and Hourly Wagss

Help

Item Name

Period Amount

hourly

Hours for Period
1.600.00 160:00 ~

Accounts Affected...

Shaw Wage Bases

= Historical Pay

Dther Employse and Company Payroll ltems Cheque

Ttem Mame Fetiad Amount From— [m701/2003
CFF - Compary
CPP - Employes 256 06/25/2003 B
EI - Company 43.28
El - Employes 35.20
FederalIn 7l 390,60

A the end of this wizard, youll be asked if pou want to create an Employee
Earnings Summary Report, ou should compare it ta the information you

enter here.

m  If you still owe vacation pay that an employee has accrued, you need to add this
outstanding balance to the “VacPay-Accrued” payroll item. Look to the Employer
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Accrual Expense Balance (detail) report that you printed in step 1 to determine
how much accrued vacation pay that you still owe an employee,

FT 2003 YTD Adjustment for Alison Logan-5mith Click OK when you're done entering year-
sz =] wtperos | / to-date summaries for this employee.
Prev Permd/
Date 01/15/2003 .
T s el x| This gmployee .has $?34 of accrued .
Memo P vacation pay still owing to her at the time
e of the conversion. An employee’s
Salary and Hourly Wages . .
Toom ame Feriod mountTours o Pariod pccouts Aot outstanding accrued vacation pay must be
Hourly L,6m0.00 160:00 T added to the Set Up YTD Amounts wizard.

Do not use the accrued vacation pay

=l pay Period
mary amount shown in the Payroll Register

Other Employes and Campany Payroll Items Summary
Ttem Hame Perigd Amount From  [oyjoijza0s @) (detail) report as this amount does not

YacPay-Accrued 234.00 .
CPP - Company .56 S f1j1572005 | include any
CFF - Employes 62.56 .

71 <l outstanding
EI - Company 49.28 307:08 . i :’
1 - Emplayee. = 3.20 Andrew’s Bike Shop accrued vacation
Federal Income Tax 390.60 - .

| || Employer rual Expense Balance (Detail) pay carried

forward from

Page 1 previous payroll
Amount years.

Logan-Smith, &lison *None

4% Vacation Pay Accrued $234.00

Taotal: $234.00

[T} [ ;ILI

At the end of this wizard, you'l be ssked I you want ko create an
Employee Earnings Summary Repart. You should compare it to the
information you enter here.

Employee

When you've entered year-to-date summaries for all your employees, click Next.

On the Enter prior payments window, click Create Payment, and enter the total
liability payments that you made in this payroll year for each liability item. There
are many ways to retrieve the total liability payments you’ve made thus far from
your accounting records.

In this example, we created a Tax Liabilities report covering the period of time
when we remitted our tax liability payments to the government. You could also
get this information from your PD7A forms. If you are not sure where to get the
payroll liability payment amounts you’ve remitted so far, contact your accountant.
Don't forget to include non-tax payroll liability payments, such as union dues.
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When all the liability payments have been entered, click the Accounts Affected
button, and select Do not affect accounts., click OK, then click Done.

Andrew's Bike Shop il
Tax Liabilities
17112002 To 6/30f2002
7172002 Page 1

3:07:08 PM
Category Amount

Incame Tax
Income Tax $5132.18
$5132.16

CPP
CPF - Employes Contribution
CPP - Emplayer Contribution

$1316.64
$1316.64

Prior Payments of Taxes and Liabilities

Payment Date DE/SDIZDUZE For Period Ending Us/gg;ggggy B %  MetPayment I
Erev Faymen |
Tases and Lishilties €{  PrevPaymen

This report represents the total amount of tax
liability payments you’ve remitted to the
government so far this payroll year (be sure to
check these totals with your accounting records).
These payments, in addition to other non-tax
payroll liability payments, must be entered into
QuickBooks.

Ttem Hame A Memo U Done I

$2633.28

El

$361.44
$505.92

El- Employvee Caontribution
El- Emplover Contribution

$867.36

Grand Total Liabilities $8632.80

Federal Income Tax

CPF - Employes
El - Company
El - Employes

513218 d
191664 Cancel I
131664

505.92 Agcounts Affected I

361.44

K L =l
®m  On the last window, click Finish.
Customize payroll information for each employee.
m  Display the Employee List (from the Employees menu, select Employee List).
m  For each employee, double-click their name on the list to open the Edit Employee
window. On the Address Info tab, enter their date of birth in the DOB field, their
SIN., and other information as required. This information is available from the
Employee Payroll List report in MYOB.
Employee Payroll List report from MYOB
Andrew's Bike Shop :’
Employee Payroll List
Fi4i2002
3:34:36 PM
Matne:  Tracey Stewart
CardID: *None TaxTable: AB
FirstAddress:  1234-12 fve Hire Date: 1272152001
Terminate Date
City.  Edm CostperHr
Province: AB Base Pay.  §$20,000.00
Postal Code:  TaJ1A2 PayBasis: Salan
Country;  Canada #Pay Periods: 532 | Address Info I ANditional Info I Payroll Info ]
Phane #1:  780-123-4567 Federal Allowances: §7)
Ph #2: Federal Extra Withheld:  §0
Phg:z #3 ;rg\:iicialgln\nlvanses 57 Mr Mz Frint &z ITlacey Stewart
e First Name [Tracey [ Prone  [Fad1za4ger
HERLES Last Name IS[awan Alt. Ph, |
——
E-mail
Al —dddme  [1234124ve L&l |12%
'\ Emp. Mo,
City [Edm 0B [05/26M973 @D
Province Postal Code  Hired 12/21/2001 E
4B j‘ 5! 182 Fieleased I E
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m  On the Payroll Info tab, in the Earnings box, select how this employee is paid
(salary or hourly for example) and then enter the annual rate if the employee is on
a salary, or an hourly rate if paid on an hourly basis. In the Pay Period field, select
how often you issue pay cheques to the employee. This information is available
from the Employee Payroll List report.

Enter agdltlonaladjus.tments you make to the gross or net pay Andrew's Bike Shop :I
here, with the exception of tax adjustments. Such R
adjustments can include payments to a retirement plan, or Employee Payroll List
union dues, company contributions for dental or life ;f;{fggZPM
insurance to =
\ Address Info ] Addjtional Info I Payroll Info I MName:  Tracey Stewart SIM: 123456789
name afew. If
. Sasdll "Mone Tax Table: AB
you set up Earnings irst Address: e Hire Date: 122152001
ltem M Hourly/8nnual Bat Pay Period Termmate Date
emploVee Salary 20,000, Dﬂj — City Co
defaUItsl FnstaCnde' . :----—.w:mu'
= [ I - Gountry Canad

these I _I - J PhDDﬂuEng TE?ET—? 283—4557 Federal a quarl‘qEnlei B34.00
adjustments Use lime data to create pay cheques Phane #2: Federal Extra Withheld: 3000

) Additions, Deductions. and Compary Contributions Phone #3: Provincial Allowances:  §7 886.00
may already Tiem Hame Bmourt Ciit. E—T— s
be set. A

\ Accrual Hovrs. Birth Date: /261973
Wacation Pay... | J »
LI Direct I eposit |

m  To adjust the payroll tax information for this employee, click the Payroll Taxes
button. Click OK when you’re done.

m  To set up how your employee will accrue time for such things as sick days or time
off in lieu of overtime, click Accrual Hours.

B You do not need to add accrued vacation pay because you've already added
vacation pay accruals in the Set Up YITD Amounts wizard.

QuickBooks now has all the information it needs to continue paying your employees
through to the end of this payroll year. To ensure that you entered your payroll data
accurately, refer to the checklist in the section “Making sure your payroll data is complete”
on page 199.

Taxes for Tracey Stewart _ —

Tar Table 7142002

e . 3:34:36 PM
[¥ Federal Income Tax Federal TD1 I?,834.DD Cancel

Mame: Tracey Stewart
Additional Tax [0.00_—" Help
CardID: *None
¥ Employment Insurance El Factor 14 g FirstAddress: 123412 Ave

Andrew's Bike Shop f’
mployee Payroll List

SIN: 123456783

JTaxTahle: AB
ireCate. 12/2142001
Terminate Date

[¥ Canada Pension Plan Provincial TO1 TEE6.00 Edm CostperHr:
\ Base Pay.  $20,000.00
L F'ay Basis: Salary

r~ Other Tanes Federalmluwances §7,634.00

Phane #2

e Hams prree Tt Fhone 22 deral Extra Withheld W‘UU :
= Fax#
E-rnail
LI R
Birth Date:  S/26/1873

i o
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Importing from / exporting to other software

Importing from other software

84

Note:

v

Note:

QuickBooks can import information directly from some bookkeeping packages. To start the
import wizard, from the File menu, select Import, then the software you are importing from.
For help, click the Help button in the wizard.

If you use QuickBooks Pro or better, with a few clicks, you can import your contacts from
Microsoft Outlook or Symantec ACT! (see page 85).

For all other software, QuickBooks imports data in a format called IIF (Intuit Interchange
Format), a special type of ASCII text file with headings to tell QuickBooks the type of
information it contains. (This format is different from .QIF, used by Quicken.)

If you want to import data from other software programs, you need to create an IIF file from
it or reformat data you already use to conform to IIF standards.

Creating an IIF file from scratch or changing data from another accounting program into an IIF
file is not recommended unless you have programming experience. However, you do not need to
learn about the IIF format to export lists and import them back into QuickBooks (see below).

To learn about... Search the Help index for...

Creating an IIF file importing data

Transferring lists between QuickBooks companies

You can transfer a list (like the Customer:Job list) from one QuickBooks company to
another by exporting it to an IIF file, then importing it into the new company.

When you import a list into an existing QuickBooks company, QuickBooks replaces any duplicate
entries with ones from the import file.

If you import customers or vendors from an IIF file, you’ll need to edit each one to add
information such as payment terms. Also, if you have unpaid balances for a customer or
vendor, you must enter an invoice or bill that at least tells the total amount owed.
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Exporting to other software

When you export a list from QuickBooks, it is automatically formatted as an IIF file. You
can then import the IIF file into spreadsheets, word processors, database programs, or other
QuickBooks companies. You can’t export transactions from QuickBooks, but you can
create a report based on transactions and print it to a file that another program can import.

Method What it does Advantages Disadvantages

Print to disk Makes a copy of a list or You can import the file Only lists and reports can be
report in a format com- into a spreadsheet or printed to disk.
mon to other software word-processing program. QuickBooks cannot read files
programs printed to disk.

Export Puts lists into a file in IIF Share lists with other company QuickBooks can export only

format, with one record
per line and one column
for each field

files or databases, word proces-
sor, or spreadsheets. Add to the
list, then import it back into
QuickBooks.

lists, not transactions or
reports.

v

v

To learn about...

Exporting lists to another QuickBooks

company

Search the Help index for...

exporting data

Transferring information to Microsoft Word, Excel,
Outlook, or Symantec ACT!

If you use QuickBooks Pro or better, you can easily export data to Microsoft Word or Excel
and synchronize your contacts with Microsoft Outlook or Symantec ACT!

m  If you use Microsoft Word as your word processor, you can use customer, vendor,
employee, and other names in letters.

m If you use Microsoft Excel, you can export your QuickBooks report data to Excel for
further customization and filtering.

m  If you use Outlook or ACT!, you can synchronize your contact information with Quick-

Books.

To learn about...

Writing letters

Exporting data to Excel

Synchronizing contact information

Search the Help index for...

letters

reports, exporting to Microsoft Excel

a contact manager

contact management, synchronizing with
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Give your accountant permission to access your QuickBooks
file remotely

If your accountant has QuickBooks Premier: Accountant Edition, they can use the
QuickBooks Remote Access to work with your file directly from their computer. This can
save your accountant the time and expense of a visit to your site, and you don’t have to
worry about preparing a disk for your accountant.

To work this way, set up a time with your accountant to start the session. Your accountant
gives you an Internet address and license key. When you go to the address and enter the
number, your accountant can begin the remote access session.

During the session, your accountant controls QuickBooks on your computer. Every action
your accountant takes is shown in real time on your screen. Your accountant has access
only to your QuickBooks software and programs that integrate with it.

Exporting data for your accountant (Accountant’s Review)

86

The Accountant’s Review' feature allows an accountant to make certain kinds of changes
in a special copy of your company file. Meanwhile, you can continue to enter daily
transactions in the original (master) company file. After the accountant has made the
changes, you merge them into the master company file.

; Merge your
Start by creating an Continue using your accogntznt’s
Accountant’s company file for day- ; ;
Y Review copy of vour [PEIIR7 LS b/ adjustments into
ou py oty | P to-day business >

data for your your QuickBooks
: tasks. company file.

accountant.
AOpens the, Reviews your data Saves the
Your EESUITETS and makes adjustments to one
Review copy in — ; —>
accountant QuickBoc?IZIs. adjustments. or more disks.

Note: Changes cannot be made to foreign-currency accounts in an Accountant’s Review file. Therefore,
if your accountant needs to edit foreign accounts in your company file, give him or her a copy of
your company file as opposed to the Accountant’s Review copy. Note that while the accountant
is editing a copy of your company file, you cannot make changes to the master file that you have.
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Note:

To learn about...

Setting up your accountant as a user
with all privileges (if you have set up
users)

Creating an Accountant’s Review copy
of your current company file

Merging the accountant’s file into the
master company file

Making the accountant’s revised copy
your master company file

Cancelling an Accountant’s Review
copy

Search the Help index for...

permissions

accountant’s review copy

accountant’s review copy

restoring data

accountant’s review copy

What can and can’t be changed

The Accountant’s Review feature may not be right for everyone. The accountant can make
some kinds of changes but not others. The advantage of using the Accountant’s Review
feature is that you can continue to work normally with your master company file (that is,
the regular company file from which you make the Accountant’s Review copy). After the
accountant has made changes, you can merge the changes into your master file.

If you have set up users for your company (see “Working with multiple users” on page 122), your
accountant will need the user name and password of the QuickBooks Administrator.

The table shows what an accountant can and can’t do while using an Accountant’s Review
copy of your file, and any restrictions on you while this copy is out.

Your accountant Your accountant
can... cannot...
= View all existing m Enter transactions other than

transactions and lists

® Add new items to the Chart of
Accounts, Item list, To Do [
Notes list, and Memorized
Transaction list (general jour- m
nal
transactions only)

general journal

transactions

Add new items to the
Payroll Item list

Memorize transactions other
than general journal transac-
tions

You cannot...

m Delete any items from
lists

m Reorganize lists (move
items, make one item a
subitem of another)
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Your accountant
can...

Create, edit, and print PD7A,
T4, and Relevé 1 forms

Edit existing account names
and numbers

Edit account and tax
information for existing items
on the Item list

Enter general journal transac-
tions

Reconcile new trans-actions
Adjust inventory values or
quantities

Create reports

Change preferences
temporarily

Print T4A report

Your accountant
cannot...

Edit existing payroll items
Edit or delete existing trans-
actions, including pay
cheques

Reorganize lists (move items,
make one item a subitem of
another)

Rename accounts or items
Make items inactive

Edit names of existing items
on ltem list

Adjust payroll liabilities
Enter or edit employee YTD
payroll setup trans-actions
Export changes to prefer-
ences

Memorize reports

Change a non-inventory part
type to an inventory part type
Merge new inventory part
items with previous, existing
inventory part items

You cannot...

v

Setting up your accountant as a user
with all privileges (if you have set up

To learn about...

users)

Creating an Accountant’s Review copy
of your current company file

Merging the accountant’s file into the
master company file

Making the accountant’s revised copy
your master company file

Cancelling an Accountant’s Review

copy

Search the Help index for...

permissions

accountant’s review copy

accountant’s review copy

restoring data

accountant’s review copy
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For accountants only:
working with an Accountant’s Review copy

The Accountant’s Review copy of a company file (which your client should create from his
or her master company file) is a compressed, special type of company file. It has a .QBX
extension instead of the usual .QBW or .QBB. When you start working with these files for
the first time, QuickBooks decompresses them to a .QBA file.

You cannot make changes to foreign-currency accounts in an Accountant’s Review copy of
a company file. If your client has foreign-currency accounts that you need to make
adjustments to, have your client send you a copy of their company file instead of the
Accountant’s Review copy. Note that the client cannot work on his or her company file
while you are editing the copy that they gave you.

If your client has set up users and passwords, you'll need to find out the user name and password
assigned to you or the QuickBooks administrator.

Once you have opened an Accountant’s Review copy, it remains the current QuickBooks
company unless you open a different company or you close the company. If you try to
record a change that is not allowed, QuickBooks tells you that it cannot record the change
in an Accountant’s Review copy.

If your computer’s system date and time is earlier than the date and time that
your client created the Accountant’'s Review copy, you will not be able to
open that copy.

To correct the problem you’ll need to determine which computer has the incorrect date
and time, change the date and time, and try to reopen the copy. You may need to have
your client cancel the first review copy and create another one for you.

When you export your work from an Accountant’s Review copy, the changes to his or her
company file are saved in a .AIF file. You should return this file to your client as soon as
possible so it can be reintegrated with his or her .QBW file.

To learn about... Search the Help index for...
Creating a file to give to your accountant’s review copy
client
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Getting around in QuickBooks

QuickBooks gives you many ways to get to the information or feature you want.

About the Getting Started window

When you first open QuickBooks, the QuickBooks Getting Started window appears (usually
itis underneath the Automatic Update window). The Getting Started window lists the steps
you need to complete to finish setting up your new company file, tells you how to find the
information you'll need while you’re working, and gives you some useful tips on managing

your business.

QuickBooks also provides information about resources for your business, product news, and
how to get help, if you need it. Look under the Help menu for these options.

Navigating in the working area

Navigators are
an easy way to
workin one area
of QuickBooks.

Each Navigator
shows the tasks
for one area of
your business.

As you use
QuickBooks, the
Open Window
list keeps a list
of the areas
you’'ve worked
in.

Get your
questions
answered with
1-2-3 Help.

QuickBooks makes it easy to access the feature or information you want. There are several
ways to get around in most areas of QuickBooks — just choose the one that best fits your

work style. Also, many parts of QuickBooks, such as the Icon bar, are customizable to fit the
needs of your business.

7% Sample Mountain Sports Equipment - QuickBooks Premier 2005: Accountant Edition

File Edit View Lists Accountant Company Customers vendars Employess Banking Reports ‘window Help

Cust. Item

D & A &

MemTx Vend Cheque Bl Reg

e

Acck Rmind
Customer Navigator

Customers

a 2

= 7

Find  Support Backup ST Liablity  Purchase Order

4

Deposits

(" Look for help In QuickBooks

Cuystamer

witem =l
=
Estimates | Invoies Reseive
i . Payments
= -
- |"y 7 & o
3 Safes /
S X ers =% &p =)
Finance  Statements _Refunds
ey Chenes and Credits
Help & Support e
Frd § ; Sm
Search _Look Online  _(Contact Us Receipts
T A @ ﬂi’f
Baask) =|ff | ) e Y \j .
Powsred by WiexTech Asmerlliorks CEOES ERe WEEEs Eﬁfgl,mff e,

Searchthe help by entering key 7|

Follow-Me Help x
dbluc ae
Print
Zearch "Pi this Lapic
Index in place (stop
the Fallou-me
Bkt help here)

Using the "Follow-Me" Help

Search - Click this button to open
Up the Help Search interface in the
Find window,

Certre

Hal

verview

£4) Collect and pay GST/PST?

) Customize sales foms?

—

Related Activities
& Pint Invaices...
& fdd a Customer.
& Customer Centre...

68 Customer Detal Centre,

Customer Solutions
FEATURED SERVICES

%'@ QuickBooks Technical

Support
W Getback to business fester

and maximize pour
effectiveness with
QuickBooks by qetting swpert
help wihen you need it. Leam
maie about our QuickBooks
support plans today

& Intuit Supplies
&) Sove e snd moven wih

QuickBooks certified
chenues, business forms,
stationery and

“y, Fenind me later

T, Femind me later

Memorized Reports _Help

Customers =

A/ Aging Suramary
Customer Balance
Detail

Customer Balance
Summary

Open Invoices

Dizplay er Print this Group

Memorized Report List
Report Finder

The customizable
Icon bar gives you
one-click access to
the features you use
most.

The Customer
Navigator, shown
here, contains
customer-specific
tasks like creating an
invoice.

For more on the
Navigators, see
“Getting information
aboutyourcompany”
on page 100.

The Follow-Me Help window displays help related to what you are doing in QuickBooks. For
more on Help, see “Using the Help system in QuickBooks” on page 96.
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Moving between windows

If you'd like to be able to see multiple windows open at the same time, from the View menu, select
Multiple Windows.

QuickBooks maximizes your workspace by displaying one window at a time at its full size.
Because QuickBooks keeps a list of the windows you have open, you can quickly switch
between windows as you work.

To learn about... Search the Help index for...
Customizing and using the Icon bar Icon Bar

Displaying the navigators navigators

Displaying and using the Open Win- windows, list of open

dow list

Showing, hiding, or customizing items desktop

on the QuickBooks desktop

Using lists, forms, and registers

When you're working in QuickBooks, you'll spend most of your time using a form, a list,
or a register. Since these are the basic elements to QuickBooks so take a few minutes to
become familiar with them.

Using lists

Lists store information about customers, vendors, employees, items or services you sell, and
so on. They save you time and help you enter information consistently and correctly.

You fill out most QuickBooks forms by selecting entries from a list. For example, when
you're filling out an invoice form, you select a customer name from the Customer:Job list.
QuickBooks then fills in the customer’s name, address, payment terms, and other data.

To re-sort the This list includ h
list by name, \ #, Customer:Job List Aisk a help question | Ask = How Do l?m Is fistinc ud _esbeacd hei
C”Ck the & | Mame = Balance Motes Job Status Estimate Total \ customel: andjob an their
s Holowka, Kelly 0.00 0.00 a outstanding balances.
column header. oHoward Poon 0.00
i . Jones, Rob 0.00
An “X" beside a Ttres, Tordsn 0.00
name shows °Eﬁ|m£‘;assagﬁ Therapy g-gg You can create notes
«Kim, Glen b .
P . sKlepace, Catherine 0.00 on many lists.
It's inactive. ¢Lessans By Livia 0.00 Y
sLin, Jeffrey 862,50
+Lucas, Kim 0,00 H
Use the menu e s Lol g To show the items marked
buttons at the ¢MacDonald, Katrina 0.00 “inactive,” tick Show All. To
. +Madrid, Jennifer 0.00 ) "o )
bottom of lists A T S hide these items, clear the
. +Marchant's Sports Emporium .
for a variety of < Fehlaughton Quttiers 0.00 checkbox.
tasks: creating ™ |ustomarges 7] eees v| — v||_5th o —

new entries,

editing existing ones, creating reports about items on the list, and using them in transactions.
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Using forms

You record most of your daily business transactions on a QuickBooks form, which looks just
like the paper forms you're used to. After you fill it in, QuickBooks does the accounting.

ﬁErevious I*Next ‘aF\nd lIﬁ}-ﬂ_story [E Journal
@ gl Credi

[+ Eill Received

When you record a bill and then write a cheque

dendor  Bitz's ki School = Dats 12/15/2003 @ (using the Pay Bills window) to pay for the business
Blous 21/14200¢ @] expense, QuickBooks enters transactions in your
Discount Date  12/25/2003 Amount Due  § 5,743.01

accounts payable register to show the expense you
Terms 2% 10Met 30 j Ref, Mo, 586 N
— — incurred and the payment you made.

Mema |

Expenses 5325475 [T e It als_o records the cheque in your chequmg e}ccount,
Account Tax et Amt Memo Customer:Job B9 Class keeplng yOUI’ reCOrdS Up to date and prOVIdlng a
Sales:Lessons 5 3,254.79 Petersan, Deb = running balance of what you owe at any time.
|
GST [227.84
PST |260.38
Clear Spits | Recalculate SavesClose | Save&New | clear |

Using registers

Just as you use the paper register that comes with your cheques to record the transactions
in your chequing account—cheques you've written, withdrawals you've made, and
deposits—QuickBooks uses electronic registers to record the activity in its accounts. The
register shows every transaction for that account, as well as the account balance.

Although you usually would use forms for entering and viewing transactions, you can also
do so directly in registers. Here’s an example of a register for an accounts receivable account.

= nocome revovaie o aumia i R OL A
The register 2 Golo <G Pint.. EAEdit Transaction  {=] QuickReport you V.e re?elve against
shows Date Number Customer | ltem Oty Fiate Amt Chig At Paid | your invoices.
. . Type Description Billed D ate Due Date ‘ .
information 12/04/2002 Michel L HeLreux 51750 & At the bottom-right of
about invoices PMT the register, you see a

) 12/05/2002 1026 | Dine DeGuzman 743.45 .
written to e 1210672002 running balance, or
customers — 12012/2002 {1027 Peter Kazak 571.09 ending balance as it is
1NV 1241272002 f dtoi
the date of the 124132002 |[1028 | Chuistine Gend 1.228.16) referred to in
invoice, the Iy 12/13/2002 QuickBooks, of all your
., 12/15/2002 Fioy Uchman 121613 R
date it's due, BT accounts receivable, so
the name ofthe BfNumber [Customer Fliten i [ Rate Lt Chig }J you always know how
Description Clazs ™ =] E -/ ,

customer, and - much you're owed.
the amount. ™ 1line I~ Show open balance Ending balance 5.648.29

Sotby  [Date, Type. Number/Riel ¥ Record Restore I

For foreign accounts, registers show their transaction
amounts in the currency denomination of the account.

94 Chapter 4 QuickBooks basics



QuickBooks Keyboard Shortcuts

General Key Activity Key
To start QuickBooks without a company file CTRL+double-click Account list, display CTRL + A
To suppress the desktop windows ALT QuickFill and Recall (type first few letters abc TAB
(at Open Company window) (while opening) of name and press Tab, name fills in)
Display information about QuickBooks F2 Copy transaction in register CTRL+ O
Cancel ESC Customer:Job list, display CTRL +J
Record (when black border is around OK, Next, | g Delete cheque, invoice, transaction, CTRL+D
or Prev button) or item from list
Record (always) CTRL + 4 Edit lists or registers CTRL+E
Cheque, write CTRL + W
Dates Key Find transaction CTRL +F
Next day + (plus key) Go to register of transfer account CTRL + G
Previous day — (minus key) Help in context, display F1
Today T History of A/R or A/P transaction CTRL+H
First day of the Week w Invoice, create CTRL + |
Last day of the weeK K List (for current field), display CTRL + L
First day of the Month M Memorize transaction or report CTRL+ M
Last day of the montH H Memorized transaction list, display CTRL+T
First day of the Year Y New invoice, bill, cheque or list item CTRL+ N
Last day of the yeaR Paste copied transaction in register CTRL + V
Date calendar ALT + down arrow Print CTRL + P
QuickZoom on report o]
Editing Key QuickReport on transaction or list item CTRL + Q
Edit transaction selected in register CTRL+E Register, display CTRL+R
Delete character to right of insertion point DEL Show list CTRL+ S
Delete character to left of insertion point BACKSPACE Use list item CTRL+ U
Delete line from detail area CTRL + Del
Insert line in detail area CTRL + Ins Moving around a window Key
Cut selected characters CTRL + X Next field Tab
Copy selected characters CTRL+C Previous field SHIFT + TAB
Paste cut or copied characters CTRL +V Report column to the right Right arrow
Increase cheque or other form number by one |+ (plus key) Report column to the left Left arrow
Decrease cheque or other form number by one |- (minus key) Beginning of current field HOME
Undo changes made in a field CTRL+Z End of current field END
Line below in detail area or on report Down arrow
Help window Key Line above in detail area or on report Up arrow
Display Help in context F1 Down one screen PAGE DOWN
Select next option or topic TAB Up one screen PAGE UP
Select previous option or topic SHIFT + TAB Next word in field CTRL + —
Display selected topic [} Previous word in field CTRL + «
Close popup box ESC Close active window ESC or CTRL+F4
Close Help window ESC First item on list or prev. month in register CTRL + PAGE UP

Last item on list or next month in register

CTRL + PAGE
DOWN
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Using the Help system in QuickBooks

Sidebar Windows

Find: Use this

WindOW tO get Mew Features
all your

questions
answered.

Follow-Me Help:
This window
tracks your
moves, and
displays help
about what you
are doing.
Show-Mevideos
and How Do I?
links appear
here as well.

~ *

QuickBooks provides a variety of ways for you to obtain useful information and answers to
your questions. These include tutorials in the Learning Center, Follow-Me Help, and an
exhaustive search engine (referred to as 1-2-3 Help) that searches not only the help, but our
online knowledge base.

How Do I? menus: Show-Me

Help main menu R .
P videos are listed here

Search the Help

% buil's - QuickBooks Premier Edition 2005 == x|
Fle EditN\gew Lists Company Customers vendors Employees Banking Reports Window Help
B\m B B 4 & 2 @ % Q 2 \
Inwnire _ Cist Nbem  MemTy  Wend Chequs Bl Reg  Acct  Rmnd  Find  Support Backup
[BEa] k5 Create Invoices

Wprevious Puext <perng - Edemal | BFind @opeling TaHistory Bl Joumal £ TmefCosts. .
Template Custamize
| [Nttt Service Imvaice | ™ |

B Dt
Invoice 06/07/2004 )| |1

Custamer:Job

Flnd
Search _ Look Online ; CanmclUx,«
L Look for help In QuickBooks
g ask| ~|
Pouered by WexTach Answerllforks

Them

Search the help by entering key
words or a question, such as
"R dn T reset v rhens el

<l D\Q’J!Qé’l?%:
T —

1. From the Customers menu,
chooss Create Invoices E |

2. Fillin the name of the
customer or job.

TF multicurrency is turned an, =l
the currency that is assigned Customer - GsT 0.00

to the customer determines Message I—l -

the currency that s Lsed in

the form. For example, if the
ivoice is for an American
customer, then the dolr

Total

i Balance 0,00
values reflected on the form | P2 Tobe prinked
will be in U5, dollars.
3, (Optional) Memo | Save & Close Save & New Clear
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Context-sensitive help

In QuickBooks 2006, we have added many ways in which you can access our context-
sensitive help system.

Follow-Me Help
Follow-Me Help "follows" you as you work in QuickBooks and displays the topics that are

related to what you are doing. If you have an Invoice form open, you will see help on how
to create an invoice with "How Do I?" links listed underneath.

Index: opens the Search: opens the search
Index in the Find engine in the Find (1-2-3
(1-2-3 Help) window. Help) window.
Print: prints the help topic.
x Make sure the help you
Back/Next: moves q | o | 5] -|:|\ want printed is expanded

(i.e., click [ to expand the

backwards or forward | e e \ | -] dan(
text before you print it).

through help topics
that have already been

displayed in this ElHowDol.. N
window. Creabe an invoice (Show-Me Yideo \
Handle GSTIFST Pin: anchors a help topic or

Create invoices .
Invoice For reimbursable time ar stops the window from

: Edit_an invaice following your activities.
Topiccontentappears Custamize my Forms (Show-Me vid

here. Customize my invoices

This tool is useful when

. it irve o ou need to open several
The [ (plus) icon w i Yo p
means that there is hende windows, but want the help
H Pleceive pavments an Sndis . .
help content hidden. Track sales inFormation to remain on one topic.

When you click the

plus icon, the help <| | _>|_I

topic expands so you
can read it.

The Follow-Me Help sidebar window is located, by default, at the bottom of the sidebar area
on the left-hand side of the QuickBooks work space. You can move this help window
anywhere you like by dragging it to the position you want. When you drag it back to the
sidebar window area, the window automatically docks in the sidebar. You can also close the
Follow-Me Help window altogether.

To close and open the Follow-Me Help window:
m  To close the Follow-Me Help window, click the x in the upper right-hand corner of the
window.

To open the Follow-Me Help window, go to the View menu and select Follow-Me Help.

To reset the sidebar area to the default layout, go to the View menu and select Reset
Sidebar Windows.
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How Do I? menus

Throughout QuickBooks, you'll find windows with a How Do 1? drop-down menu in the
upper-right corner. These menus provide quick access to information and instructions for
the window you're working in. The help topic is usually displayed in the Follow-Me Help
window. How Do I? menus also list any show-me videos that may be available for that
window or activity.

F1 key

You can get explanations about features of most windows by pressing the F1 key or the Help
key on your keyboard. The help topic is displayed in the Follow-Me Help window.

Some windows also have a Help button. When you click a Help button, the help is usually
displayed in a separate help window and not the Follow-Me Help window.

Getting your questions answered

98

Using the index

To find help on a particular subject, choose Help Index from the Help menu or click the book
icon on the Follow-Me Help window. The Index appears in the Find window. Type the word
that best describes what you need information on. If you can’t find what you want from
the Index, try using the 1-2-3 Help.

Searching for answers

In most windows, next to the How Do I? drop-down menu, there is a search feature where
you can type your question and search the in-product help system.

You can also use the 1-2-3 Help to not only our help system, but to search the knowledge
base located on our Web site. The knowledge base is a grouping of Frequently Asked
Questions (FAQs) that come from our customers. It contains hundreds of tips and tricks.
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Using 1-2-3 Help to answer your questions

With 1-2-3 Help, you can get all of your questions answered at the click of a button.

search /  Click Search, type your question in the box, then
click Ask. The search engine searches all the in-product
help topics and displays the results underneath the box.

Look online ¢ = Click Look Online, type your question in
the box, then click Search. The search engine searches

Search: kel Thovieailly all the FAQs on our Web site and displays the results
(L Look for help n QuickBooks in the QuickBooks workspace in a separate window.
| Q ask
P d by liexTech Answerififo: . .
pusrs by HEHTE S contact Us) : As a last resort, if you still haven’t found the answer
Search the help by entering key you're looking for, click Contact Us to display a list of contact
words or a question, such as "how H H
do T reset my cheque numbers?” numbers for Intuit Canada. Note that service charges may apply.

and then clicking Ask.

The 1-2-3 Help is located in the Find window. The Find window, by default, appears above
the Follow-Me Help sidebar window. You can move this window anywhere you like by
dragging it to the position you want. When you drag it back to the sidebar window area,
the window automatically docks in the sidebar. You can also close the Find window
altogether.

To close and open the Find window:
m  To close the Find window, click the x in the upper right-hand corner of the window.
m  To open the Find window, go to the View menu and select Follow-Me Help.

m  To reset the sidebar area to the default layout, go to the View menu and select Reset
Sidebar Windows.

Learning with the QuickBooks Learning Center

Exploring

The fastest way to get started in QuickBooks is to learn with the QuickBooks Learning
Center that include many tutorials on some common tasks in QuickBooks.

To start the QuickBooks Coach:
m  From the Help menu, choose Learning Center.

QuickBooks with a sample company

Use the sample company that comes with QuickBooks to get familiar with the software:
explore the features, enter test data, and run reports.

To view the sample company:

1 From the File menu, choose Open Company.

2 In the Open a Company window, choose sample.qbw.
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Getting information about your company

Navigators are the best starting point to see how your company is doing at a glance. They
gather information from your QuickBooks data and display it in one location so you can
manage your business more effectively. There are six navigators: Company, Customers,

Vendors, Employees, Banking, Reports.

The flowchart—_|
shows activities
for dealing with
one customer.

Click the icons
forquick access.

In this area;
QuickBooks\
provides you
with suggestions
for working with

your customers.

Customers

A

ks e 5
Estimates Invvaices Receive Deposits
ey . . . Payments
" | y ST 7
Sales %) & z =
Orders - % = 4 {)

Finance  Statements  Refunds
_mﬁlp-‘-? ¥ Charges and Credits
Sales
Receipts
S5 Ly 5 X7 4
Custorners  Items & Temnplates Custarner Wite Custémer
Services Reqister Letters Centre

Related Activities
BuickBooks Credit Card

! Service

& QuickBooks Secure /
Document Delivery Service

% Frint Invoices. ..
8 Add a Customer...
3 Customer Centre...

62 Lustormer Detail Centre...

Y Customer Solutions

Manage vour business more efficiently uzing cheques quaranteed to

work with QuickBooks!

Handle out of stock situstions by cresting sales orders for your
custamer

Find out how you can accept credit card payments directly into
QuickBooks.

online.

Send important or confidentisl documents securely with QuickB ooks
Secure Document Delivery.

Get paid fasted Email invoices from QuickBooks and receive payments

Memorized Reports _Help

ICustomers ;'I

AR Aging Summary
Customer Balance
Detail

Customer Balance
Surnrnary

Open Invoices

Dizplay or Print this Group

Memarized Repart List

Beport Finder

Click these icons for quick
access to features you use
to manage all your
customers.

1 Use this drop-down list for

convenient access to
reports you've added to
the memorized reports list.

v

Using the Company Centre
Using other QuickBooks centres

Decision Tools

To learn about...

Company Centre
centres

decision tools

Search the Help index for...
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Creating reports

Choose a report
category and
view a general
description of
your choice.

The specific
reports available
in the category
you selected are
listed here.

v

QuickBooks provides a wide variety of preset reports and graphs designed to give you quick
and easy access to your company’s information. In addition, you can create your own
customized reports that have a different look and layout as well as scope of information.

Finding the right report

With the Report Finder, you can quickly review and choose among the many preset reports
that QuickBooks provides. To help you choose an appropriate report, the Report Finder
displays a sample of each report, as well as a summary of what the report conveys about

your business.

TiReport Finder
Select a bype of report.
N

Company & Financial

Select a repart.

Ask a help question | Ask @ = How Do 1?7

These reports provide information about the Financial position of
YOUF COMParTy.

rofit & Loss Standard

———

—

Profit & Loss Detail

Frofit & Loss ¥TD Comparison
Frofit & Loss Prev Year Comparison
Frofit & Loss by Job

Profit & Loss by Class

Profit & Loss Unclassified
Income by Customer Summary
Income by Customer Dekail
Expenses by Yendor Summary
Expenses by Yendor Detail
Income and Expense Graph
Balance Sheet Standard
Falance Sheet Detail

Set the date range.

Profit and Loss
Ordinary Income/Expense
Incarme
Labwour
Construction
Subcortractors
Total Constructio
Tatal Incom
Gross Profit

-

4,242.00

1308438
1308438

540.00
1,302 36
A 1,852 26
LI Total Expense 1.852.26
Met Ordinary Income 1,232 12
Met Incorne 11,232 12

IThis Month-to-date

From To

P N g W i N
what vou'll learn
How much money did I make or lose over a specific period of time?

[t2jor/z003 @| [1z/15/2009 &)

Modify Report, .. | /

QuickBooks provides details about a report’s content to help
you decide whether the report is appropriate for your needs.

Display

Print. .. Excel...

View a
thumbnail
picture with
sample data
to get an idea
of a report’s
content. You
cancustomize
a report
before or after
you generate
it.

To learn about...
Finding a report
Creating a report

Preset reports

Search the Help index for...
reports, finding
reports, creating

report types, all
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Customizing the look of a report

Most reports can be customized for unique presentation of your data. For example, you can
do the following:

m  Change the typeface (font) and how numbers display
Add or remove columns and adjust their width

m  Create or change subtotal groupings
m  Change the sort order of transactions
m  Change the units of measure for reports on your items, purchases, sales and inventory
transactions (QuickBooks Pro and QuickBooks Premier only); refer to “Reporting in
different units of measure” on page 36
Ifiunpaid Bills Detail
Click Modify Report to customize/ ™ Modify Report... Mematize. .. | Pring.yl— Excel... Hide Header Refresh
a report for your needs. Dates [Today ﬂns of [12/15/2003 B |Sort By [DeFaul |
Mountain Sports Equipment
Unpaid Bills Detail
If you are using QuickBooks Pro or—""| As of December 15, 2003
better and Microsoft Office you £ Type & Date + Hum <+ Due Date <+ Aging + Open Balance -«
t rts t Mi ! ft Anderson 's Jersey City
can export reports 1o a Microso P tem Receipt 1022003 1,855.00 4
Excel spreadsheet. tem Receipt 10M7/2003 1.150.00
Total Anderson 's Jersey City 3,105.00

MacKeen Office Sohtions

Bil 1142102003 1202112003 38387
The Mod |fy Repo rt Modify Report: Unpaid Bills Detail 12004 250.00
window is divided up Display | Fikers | BesterfFoctsr | Fodts &tumbers | 543.97
in to tabs. Each tab /7 Report Dats Rangs
covers different Dates [Today 7| Taday only 2003 14 2@1380
1O.EUStEI’nIZEltIOH options From [12/1512009 @| 1o [12/15/2003 | 12003 1,996.40
or the report. 451620
— Calumns ' ’
For example, the || [Fert mera) =| sortty [oefaur =]
Display tab allows you | frae # & s
to choose the columns bt vt SR S:[si:gzquj:;r : fanns e
) Last modified by ) “ 115.00
you want visible on the /Date
report that you are e 8,680.17
1 S I,
currently working on. e
Hame City
M P
Naw poelCos B ket o ey
Mame Contact =l ¥ B B Adyanced... | Revert |
0K Cancel I Help I

After you have customized a report, you can save the settings for future use. Saving report
settings is called memorizing. The next time you run the report, QuickBooks recreates the
format of the report, but uses your latest financial data.

When you memorize a report, QuickBooks adds it to the Memorized Report List. To display
this list, from the Reports menu, choose Memorized Reports, then choose Memorized Report
List.
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Changing the scope of the information in a report

Creating your own version of an existing report can also include filtering, or changing the
scope of the information that displays on a preset report.

T Collections Report [ x|
todify Report.. tMemorize... | Print... | Excal... Hide Header Fefresh
Detes |Today ~|frens2003 @) Pestaue]l  SorBy[Defaut
8:51 AM
1271503 Collections Report
As of December 15, 2003
@ Type ¢_Date +_ Terms < Due Date <« Aging ¢+ Open Balance <
Cook, Brian -
Kitchen
Brian
415.555.2248

415555 0220
» Invaoice
Tatal Kitchen

Total Cook, Brian

Jacobsen, Doug
Kitchen
Doug or Lind4g
4155554411
Invaice
Total Kitchen

We encourage you to explore /
the extensive list of filters.

Your options here will include
filtering for data you entered in
your custom fields.

Brian (work n Modify Report: Collections Report

Filters

— Choose Filter

Customer Type

Aging

= Al Customner Types
Billing Status I L

Due Date
Entered/Modified

— Customer Type Filter
Chooze the customer type from the drop-down list. To
select several customer types, choose 'Selected customer
types.'

Paid Status

Al accounts receivabl
Today
»1

Cusztom
Open

?

Changing date ranges

Customizing a report

Adjusting, adding, or deleting

columns on a report

Tailoring the data in the report

(filtering)

Changing headers and footers

To learn about...

reports, dates in

report customization

Search the Help index for...

report customization, columns

reports, changing the scope of

report customization, headers
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What does “Other” refer to on reports?

If you use subaccounts, subitems, or jobs, then sooner or later you will see the word “Other”
on a report:

Profit and Loss
October through December 2003
S Oct - Dec "03 £
Expense

Automobile e The $18.45 expense for Automobile-Other is
Fuel 140.35 for the Automobile main account and not
Repairs and Maintenance 11475 for either of the subaccounts
Automobile - Other 1545 :

Total Automobile 27355

QuickBooks shows the word “Other” when you create a report for an account that has
subaccounts (or items that have subitems, customers that have jobs, and so on) and there
is a transaction associated with the main account. Generally, if you are using subaccounts
(or subitems or jobs), you should associate transactions only with the subaccounts instead
of the master account.

Tip: To remove the “Other” line or column on a report, double-click its dollar amount to see the
transaction and adjust it. When QuickBooks displays a report listing one or more transactions,
double-click each one in turn. In the transaction itself, replace the problem name with the correct
subaccount, subitem, or job.

Understanding QuickBooks file types

QuickBooks uses several types of files. Here are some of the more common ones:

B .QBW: Your company file. This contains your company set-up, and all the information
you enter (customers, vendors, transactions, etc.) for your company.
.QBB: A compressed backup of your company file.
.QBX: A compressed version of an Accountant’s Review copy of your company file. See
“Exporting data for your accountant (Accountant’s Review)” on page 86.

® .QBA: An Accountant’s Review copy of your company file that’s not compressed (that
is, what your accountant gets when he or she opens the .QBX file you provided).

®  .AIF: A special file containing the changes your accountant made to your company’s
books in the .QBX file you provided. You merge the information from this file back into
your regular company file (QBW).
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Customizing your forms

Tip:

Note:

You can customize any sales or purchase form (template) and create any number of
versions to suit your business needs.

If you plan to print your invoices or statements on preprinted forms from Intuit, you should make
only minor adjustments to the Intuit templates. For example, adding a logo, adding your company
name and address, or changing fonts still allows you to use preprinted forms and double-window
envelopes you purchase from Intuit. You can’t; however, add, change, delete, or move columns
unless you have purchased custom designed forms.

For each form you customize, you decide which fields (including custom fields) and
columns to include, what they are labelled, and where to place them.

Once you've created your forms, you can save them to use whenever you want and modify
them whenever you want. You can also purchase custom forms to match.

To purchase custom forms, see “Ordering QuickBooks products and services” on page 251.

To customize a form (template):

1 With any sales or purchase form open (for example, an invoice or purchase order), click
the Customize button located at the top of the form.

2 Select the template you want to customize and click Edit. The Customize window
appears.
Or...

If you want to customize an Intuit template, select the one you want to customize and
click New. Don't forget to give your new template a name.
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The following diagram shows the areas of the form that you can change using various tabs
of the Customize window.

Header —— || 1ms comymonn Invoice || Format
Use the Header tab to Bayshore, CA 34326 g% Use the Format tab to add your
change the title of a G == | logo and to change fonts,

including font style (italic, bold,
etc.) and size.

form or other
information in this part

of the form.
~
oMrRaCT R CEREH TERME DL OATE N/ Columns
) ——

Fields _A| Use the Columns tab to change
Use the Fields tab to e EmErRn e it the order in which columns
change the information display. The Amount column
shown on this part of always displays furthest to the
the form. right.

You can also rename, add, or
Footer delete columns.

You can enter up to
1,000 characters in the
Long text area on the
Footer tab to print on

your custom form. \
o - \ Printer

This information could
include legal Use the Printer tab to
disclaimers or warranty EP S R —r——— change the page
information. Total orientation.

? To learn about... Search the Help index for...

)

Creating custom business forms customizing forms, about
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Backing up your company data

Note:

Note:

Your data is valuable! No recovery technique can repair all possible file damage or protect
against theft or natural disasters.

To guard against and minimize data loss, you should make regular backup copies of your
QuickBooks company (or companies). In the event of data loss, you can restore your data
from the backup.

When it comes to backing up your company file, you have several options. You can backup
to

®  your hard drive m  tape

m 3.5 floppy disks ®  asecure server on the Internet, if
you subscribe to the QuickBooks

= CD-Ror CD-RW Backup Service.

m  Zipdisk

QuickBooks Backup Service is an online backup through the Internet. It’'s fast and convenient,
and stores a copy of your company file on secure, third-party server away from the physical
location of your company.

The QuickBooks Backup command doesn’t just copy your company file. Instead, it
compresses the data into a compact backup file which only QuickBooks can open. You can
give the backup file any name you want. QuickBooks automatically gives your backed file
the extension .QBB.

For a description of the various file types QuickBooks creates for your company file, see “Quick-
Books Keyboard Shortcuts” on page 95.

It’s a good idea to store at least one recent backup off-site. That way, in case of theft or
natural disaster, you'll have a copy of your company data in a safe place.

You must be in single-user mode to backup your company file.

In single-user mode, only one person at a time can access and work with your company
file. If you have QuickBooks Basic, you are always working in single-user mode and do
not need to worry about switching.

If other people are working with the company file, ask them either to close the file or
exit QuickBooks. Then, from the File menu, choose Switch To Single-User Mode.
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Recommended backup routine

?

@

If you use QuickBooks Pro or better in multi-user mode, you must switch to single-user
mode to create a backup. For more information on single-user mode, see “Working with
multiple users” on page 122.

Prepare several sets of backup media.
If you're using 3.5 floppy disks to backup, you may require multiple disks, depending
on the size of your company file.

Label the backup media “QuickBooks Backup Monday,” “QuickBooks Backup
Tuesday,” etc.

If you're using 3.5 floppy disks to backup and you require more than one disk, label the
disks “Monday, Disk 1,” “Monday, Disk 2,” and so on.)

By having one set of backup disks for each business day, you likely won’t lose more
than one day’s records if a disaster strikes.

Each day, back up onto that day’s disks and keep them in your office.
At least once a week, make a second backup to keep off your premises.

Alternate between two sets of media for your weekly off-set backup. If a disaster strikes
your office, you'll want a reliable record of your data to fall back on.

Periodically, replace your backup media with new media on your machine.

If you back up your company file to a floppy disk, you should be aware that
there are risks involved in this type of data storage.

Not all floppy disks are created equally. Some disks can be re-used several times and
retain their integrity for a long period of time. While others can be re-used only a few
times and can become corrupt for no obvious reason. Because of the volatility of floppy
disks, we least recommend this type of data storage.

m At the end of the fiscal year, make an archive copy of your data to keep off your
premises.

To learn about... Search the Help index for...

Backing up your company data backups
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Backing up to a CD-R or CD-RW

Tip:

v

Although Windows XP can write data directly to a CD-R or CD-RW, we
strongly recommend that you use third-party CD writing software to back
up your company file instead.

Because of a limitation in the CD writing program that comes with Windows XP, it may
not allow QuickBooks to back up directly to a CD. Instead, it may display an error
message such as "Unable to access the disk." Also, if Windows XP does allow Quick-
Books to access the CD, Windows XP may not transfer your company file backup from
the CD Writing Tasks area to your CD properly.

Instead, you should first save the backup to your hard drive, then copy it to your CD with
reliable third-party software.

To back up to a CD-R or CD-RW:
1 Insert the CD into your CD-R drive.

2 From the File menu, choose Back Up and ensure the Back Up Company File tab is
selected.

3 Click Browse.
4 Navigate to a place on your hard drive that you can easily find again.

®  QuickBooks may warn you that you are backing your data up to your hard disk.
5 In the File name field, type a name for your backup.

We recommend that you give a new name for each backup, for example, the date of this backup.
This prevents you from overwriting the previous backup should there be a problem during the
backup process (for example, a power failure).

6 Click Save.
7 (Optional) Select the backup options you want:

m  Verify data integrity: Select to verify your data before backing up.

m  Set Defaults: Click to specify the defaults for backing up manually.
8 Click OK. QuickBooks creates a backup file of your company data.

9 Start your CD writing software and use it to copy the backup file from the location you
saved it to your CD.

For those users who are very comfortable working around the limitation in Windows XP’s
built-in CD writing software, the help file includes information about setting up Windows
XP so that you can back up your company files directly from QuickBooks to a CD.

To learn about... Search the Help index for...
Setting up Windows XP so you can backups, CD using Windows XP

back up to CDs directly from Quick-

Books
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Backing up to a Zip drive

To backup to a Zip disk:

1 Insert the Zip disk into your Zip drive.
2 TFrom the File menu, choose Back Up and make sure the Back Up Company File tab is
selected.
3 Click Browse.
4 Navigate to your Zip drive.
5 In the File name field, type a name for your backup.
Tip: We recommend that you give a new name for each backup, for example, the date of this backup.

This prevents you from overwriting the previous backup should there be a problem during the
backup process (for example, a power failure).

6
7

8

Click Save.

(Optional) Select the backup options you want:

m  Verify data integrity: Select to verify your data before backing up.

m  Set Defaults: Click to specify the defaults for backing up manually.
Click OK. QuickBooks creates a backup file of your company data.

Backing up to a tape

110

To backup to a tape:

1 Insert the tape into your tape drive.
2 From the File menu, choose Back Up and make sure the Back Up Company File tab is
selected.
3 Click Browse.
4 Navigate to your tape drive.
5 In the File name field, type a name for your backup.
Tip: We recommend that you give a new name for each backup, for example, the date of this backup.

This prevents you from overwriting the previous backup should there be a problem during the
backup process (for example, a power failure).

6
7

Click Save.

(Optional) Select the backup options you want:

m  Verify data integrity: Select to verify your data before backing up.

m  Set Defaults: Click to specify the defaults for backing up manually.
Click OK. QuickBooks creates a backup file of your company data.
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Backing up to a 3.5 floppy disk

Tip:

Tip:

If you decide to backup your company file to a floppy disk, you should be
aware that there are risks involved in this type of data storage.

Not all floppy disks are created equally. Some disks can be re-used several times and
retain their integrity for a long period of time. While others can be re-used only a few
times and can become corrupt for no obvious reason. Because of the volatility of floppy
disks, we least recommend this type of data storage.

Formatting your floppy disk

Formatting removes any old data that may be on the disk and prepares the disk to receive
new data. Even if the disk is labelled as preformatted, it's a good idea to fully format a new
disk before using it. Sometimes new disks can be stripped of their formatting during
shipping.

For your convenience, QuickBooks can format disks during the backup process.

We recommend you keep multiple backups on different sets of disks and that you periodically
replace the disks with new disks.

To backup to a 3.5 floppy disk:
1 Insert a disk into your floppy disk drive.

2 From the File menu, choose Back Up and ensure the Back Up Company File tab is
selected.

3 Click Browse.
4 Navigate to your floppy disk drive.
5 In the File name field, type a name for your backup.

We recommend that you give a new name for each backup. For example, the date of this backup.
This prevents you from overwriting the previous backup should there be a problem during the
backup process (for example, a power failure).

6 (Optional) Select the backup options you want:

m  Verify data integrity: Select to verify your data before backing up.

m  Set Defaults: Click to specify the defaults for backing up manually.
7 Select Format each floppy disk during backup.

8 Click OK. QuickBooks prepares to format the floppy disk. The format dialog box
appears.

9 Click Start. A warning appears that all the data on the floppy disk first be erased.

10 Click OK. The floppy disk is formatted.

11 When formatting is complete, click OK, then click Close to close the Format dialog box.
QuickBooks begins to backup your company file to the floppy disk(s).
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Note: If you need more than one disk, QuickBooks asks you to insert an additional disk as each disk
fills up. Label the disks so that you'll know which one was first, which was second, and so on.
This will help you if you ever need to restore the data from the disks.

If you selected to format before backing up the disk, QuickBooks formats sequential disks as you
place them into the drive.

Testing your backup

Due to the volatility of floppy disks, we recommend that your test the data that you've
stored on your floppy disk.

You'll use the Restore feature to test your backup. This procedure uncompresses your
backup file and creates a new company file using the data from the backup.

Unfortunately, testing the backup data doesn’t ensure the integrity of your
A floppy disk.

There is still a risk of your backed up data becoming corrupt. Corruption can occur due
to age, environmental changes, over-use, or for reasons beyond your control.

To test the data you’ve backed up:

1 Insert the 3.5" floppy disk that contains your backup file, or if you're restoring from
multiple disks, insert the first disk.

2 From the File menu, choose Restore.

3 In the Get Company Backup From section, select Disk; then click Browse to navigate to
the file on your floppy disk drive and click Open.

4 In the Restore Company Backup To section, click Browse and navigate to a folder where
you can store the restored file temporarily. Don’t save the restored file in the same
folder where you normally store your company file. For example, navigate to the
Windows temp folder.

5 In the File name field, type a name for the restored file. For example, test.

6 Click Save.

7 Click Restore.

If you're restoring from multiple disks, QuickBooks prompts you to insert the
sequential disks as QuickBooks extracts the compressed data.

8 QuickBooks lets you know if the restore was successful. Click OK. QuickBooks opens
your restored company file.

The next time you open QuickBooks, ensure that you're opening your main
A company file and not your this restored file.

By default, QuickBooks remembers the last file you worked on.
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Using the QuickBooks Backup Service

The QuickBooks Backup Service is a scheduled backup service. You don’t have to do
anything once you've set everything up. Although, if you do want to do a backup manually,
you still can by simply launching the QuickBooks Backup Service software.

Before you can use the QuickBooks Backup Service, you’ll need to sign up for it. An Internet
connection is required to use the QuickBooks Backup Service.

To sign up for the QuickBooks Backup Service:

1

o

From the File menu, choose Back Up and ensure the Back Up Company File tab is
selected.

Select Online, then click Tell me more. The QuickBooks Backup Service overview opens.
Click Get Started Now. The QuickBooks Backup Service Web site opens.

In Service Level Options table, click Download Now for the level of service you want:

®  QuickBooks File Backup: Select to protect up to 100 MB of data, including your
QuickBooks files, with this low cost backup solution. Your QuickBooks files will
automatically be selected for backup. Additional individual files can be selected
manually.

®  Premium Data Backup: Select to protect all of the company files on your PC, up to
4 GB.

®  Premium Plus System Backup: Select to protect all files and software applications
on your PC and automatically heal your PC from virus attacks, corrupted applica-
tions or files, up to 10 GB.

You're prompted to open the installation file.
Click Open, then click Install. The installation begins.

Follow the prompts as they appear. Once you've signed up, you're prompted to start
the backup process.

When the back up is done, you'll receive a report about the back up and if there were
problems. The QuickBooks Backup Service also displays your next scheduled back up.
To perform a backup manually, click the icon on your desktop to launch the Quick-
Books Backup Service software.

Searching for your backup file

If for some reason you can’t locate your backup file (.QBB), you can use the Windows’
search feature to help you find it.

To search for the backup file:

1
2

3

From the Windows Start button, select Search, then choose For Files or Folders.
In the Search Results window, type *.QBB in the “Search for files named” field.
The asterisk symbol acts as a substitute for zero or more characters.

Choose a drive or folder in the “Look in” field.

Click Search Now.

Backing up your company data I 113



Restoring your backup file

Note:

v

If you need to restore your company file from a backup, use the Restore command. Because
QuickBooks backup files are compressed, simply copying the backup file to your
QuickBooks directory won'’t give you access to your data.

Because your backup copy is in a compressed file format, you must use the
Restore command to bring the data back into QuickBooks. Do not use the
Copy command from Windows Explorer or the DOS prompt.

If your hard disk has malfunctioned, you first need to reinstall QuickBooks on the
repaired or new hard disk. For instructions, see the "Installing & Learning to Use Quick-
Books Guide" that came with your software.

If QuickBooks locates a company file with a name that is the same as the one you're restoring,
QuickBooks asks you whether you want to replace the existing file.

If you answer “No,” QuickBooks returns you to the Restore window. You must then give a different
name to the restored file, and when the process is finished, you will have two different versions
of your company data.

If you are restoring your company file because your computer or hard drive malfunctioned,
we recommend that after the hardware repairs are done, you reinstall QuickBooks and any
updates, before you proceed.

To learn about... Search the Help index for...

Restoring your company data restoring from a backup

Condensing your company file

114

If your company file has grown very large, you can reduce its size by condensing the older
transactions that you no longer need much detail about.

For example, you might want to condense the transactions your company completed two
years ago or more, especially if your company file has grown quite large (more than 75 MB).
Condensing large company files can sometimes improve the performance of QuickBooks.

When you condense data, you can specify an ending date for the period of time you want
to condense. Transactions dated #/7zr'your selected ending date are not affected. For
example, if your ending date is 12/31/03, all transactions dated 01/01/04 and later remain
intact in your company file.
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When you condense your company file based on transactions as of a specific date,
QuickBooks deletes only closed transactions. Open transactions are retained. Therefore, to
condense the most possible transactions, try to complete any unpaid bills or uncleared
transactions you have before starting. It is best to choose an end date that is six months or
more in the past.

If you select Remove ALL transactions, all transactions regardless of their dates are removed.

If you report financial information to the Québec Minister of Revenue (MRQ),
you must keep the archive file the Condense function creates in case you
need to refer to it during an audit.

Doing so helps you comply with legislation from the MRQ. The legislation states that
your accounting software cannot allow you to modify or delete data without keeping a
record of the original data.

If you use payroll

If you use QuickBooks to pay your employees, QuickBooks will not condense payroll data
for the current payroll year or the previous one.

For example, if you choose to condense your company file in March, 2004, QuickBooks
would not condense payroll data from 2004 or 2003. It would condense payroll
transactions from the date you started using QuickBooks through to December 31, 2002.

You must keep the archive file the Condense function creates in case you
need to refer to your payroll transactions during an audit.

The Canada Revenue Agency (CRA) requires that you keep your payroll transactions for
seven years. Since an archive file contains your payroll transactions for a given period,
you must keep it.

Also, you should make sure you have printed records of your most important payroll
transactions before you condense your data and create an archive.

Examples of transactions that would be deleted

m If an invoice has been paid in full, QuickBooks deletes the details and includes the
amount in a summary transaction showing income accounts. Neither the customer
name nor the items sold are retained. However, if an invoice is not printed, unpaid,
partially paid, or marked as pending, QuickBooks leaves the invoice in your file so you
can apply payments to the invoice.

m If you have QuickBooks Pro or better, condensing deletes only those estimates that are
dated on or before the ending date and that have a job status of Closed. If an estimate
has any other job status (Pending, Awarded, In Progress, Not Awarded, or None),
QuickBooks retains the estimate regardless of its date.

m  Only if you choose the option in the Condense preferences: if you have paid a bill for
a reimbursable expense, QuickBooks deletes the bill regardless of whether you have
invoiced the customer for the expense.
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Note:

Examples of transactions that would be retained

The following table gives examples of the situations that cause QuickBooks to retain
transactions dated on or before your specified ending date.

When you follow the steps in the Archive & Condense Data wizard, you'll have an
opportunity to remove old transactions and unused items to further reduce the size of your
company file. However, QuickBooks always retains transactions that meet the following
criteria.

When QuickBooks retains a . .

. . . Example of retained transaction

transaction with earlier date

The transaction is linked to another transac- An undeposited customer payment that you

tion that has an opening balance. applied to an invoice. Even though the invoice is
paid, QuickBooks retains the invoice because it
has a link to an open transaction (the
undeposited payment).

The transaction is linked to a transaction
after the condense date.

Summary transactions

The summary transactions that QuickBooks creates appear in the registers of your balance
sheet accounts (Bank, Accounts Receivable, Accounts Payable, and so on).

Each balance sheet account has one GENJRNL summary transaction for each month in
which QuickBooks deleted transactions. The transaction amount is the total of the
transactions that QuickBooks deleted for the month.

For a given month, the register may also show other transactions that QuickBooks did not
delete. These are transactions that could be affected by transactions you have yet to enter.

When opening a register, you can spot the summary transactions by looking for GENJRNL
in the Type field.

To view a breakdown of amounts by account, select a GENJRNL transaction and click Edit.
The General Journal Entry window shows the breakdown of amounts by account for all
summarized transactions for this month.

You cannot edit or delete a GENJRNL summary transaction.
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How condensing data affects your reports

Account balances

After you condense your data, you can still create reports that summarize financial activity
for the period of time you condensed. For example, if you condense last fiscal year’s data,
you can still create profit and loss reports that compare last year’s results to this year’s. This
is because QuickBooks adds summary transactions to your company file to preserve
monthly account balances.

Transaction detail

After you condense your data, you won'’t be able to create reports that show daily detail for
the period of time you condensed. This is because QuickBooks has deleted the individual

transactions that would have provided the detail. In addition, you won't be able to create
reports that show balances for individual customers or vendors over that period of time.

As a result, the totals for sales revenue on GST/PST liability reports will be incorrect. As a
precaution, QuickBooks creates a backup file in case you need access to the deleted
transactions later.

Cash basis reports

After you condense your data, you won'’t get an accurate cash basis report for data that
includes a condensed time period. This is because QuickBooks has deleted the individual
transactions that would have provided the information about whether transactions were
paid. As a result, the totals will be incorrect.

To learn about... Search the Help index for...
Condensing QuickBooks company file condensing data
Restrictions for condensing data if you're condensing data

using the QuickBooks Payroll
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Reconciling bank and credit card accounts
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You should plan to reconcile your bank (chequing, savings, and money market accounts)
and credit card statements on a regular basis to make sure your records and the bank'’s agree.

Situation

You haven’t recon-
ciled these accounts
for a month or more.

What to do in QuickBooks

Reconcile each month you skipped. Balance each month separately,
starting with your earliest statement since you’ve been using Quick-
Books, through your most recent statement.

You added earlier
transactions in
QuickBooks.

After you add earlier transactions, and you want to reconcile past
months, you should reconcile month by month only if you’ve never used
the QuickBooks reconcile feature.

However, if you've already reconciled one or more months, you should
reconcile forward only, that is, reconcile months after your start date.
Use the previous months’ data for reporting only. You need to mark all
older transactions as cleared to reconcile future months.

You are reconciling
for the first time.

Enter all uncleared transactions in your account.

Update the Opening Balance transaction to reflect the amount actually in
your account when you began using QuickBooks.

You cancel in the
middle of reconcil-

ing.

QuickBooks keeps track of the items you’ve marked as cleared with an
asterisk (*) in the cleared column of the account’s register. This indicates
that the items are still pending and reconciliation wasn’t complete.
When you start reconciling again, you’'ll need to re-enter your ending
balance and your service charges and interest earned. You’'ll also need to
check off additional payments and deposits.

When you reconcile, be sure to add any bank service charges, interest earned, and finance

charges.

To learn about...

Search the Help index for...

Reconciling a bank account reconciling, bank statements

Reconciling a credit card account reconciling, credit card statements

Adjusting for differences

reconciling, adjusting for differences
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Matching bank deposits and credit card deposits (QuickBooks
Credit Card Service users)

As a QuickBooks Credit Card Service user, you can use QuickBooks to help match your

customers' credit card payments with the lump sum deposit on your bank statement, as well
as account for banking fees.

To do this, in the Receive Payments or Enter Sales Receipts window, select the “Group with
other undeposited funds” option.

In the Make Deposits window, you can display credit card payments views grouped by

credit card type, which lets you see the individual credit card transactions that make up
each lump sum deposit.

Often, the bank deposit total is less than the payments you received from individual
customers due to credit card transaction fees. QuickBooks calculates the difference for you
automatically and lets you assign the transaction fee to an expense account.

fit Make Deposits [ %]
&Erevious I*Next @Prin; v| Payments Journal

Deposit To ISecond Bank. j Date ID?IIZIZDDS @ Memo IDeposit

Click Payments to select customer payments that you have received., List any other amounts ko
deposit below,

Received From From Account Memo Chg Mo, Pk Meth, Amount
Tommy Sands Undeposited Funds Visa 4,17 i‘
Tommy Sands Undeposited Funds Visa 14,46
Sandy Preston Sales:Merchandise Visa 10,52
Wilma E. Nelson Sales:Merchandise MasterCard 622.26

=l

Deposit Tokal 651,41

Ta get cash back From this deposit, enter the amount below, Indicate the account
where you want this money to go, such as your Petty Cash account,

Cash back goes to Cash back memao Cash back amount
A |

Deposit Tokal 651,41

Save & Close Save & MNew | Rewvert
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Setting up online banking (account access and
payment)

QuickBooks online banking encompasses account access. Before you can start using online
banking, there a few things you'll need to do as described in the following table.

What to set up

Internet access through an ISP if you
haven’t already set this up for another
QuickBooks feature

Comments

Choose Internet Connec-
tion Setup from the Help
menu.

Look in the Help
Index for...

Internet connections

If you don’t already have an account
(chequing, savings, money market,
credit card) at a financial institution
that provides online banking through
QuickBooks, you'll need to open one.

online banking, financial
institutions

Submit an application for online bank-
ing to your financial institution.

Application information
can be accessed over the
Internet or contact your
institution directly. There
may be a waiting period

until you get confirmation.

online banking, setting
up

Select an online service for setup, by
completing the “apply Now” section
of the Online Banking Setup interview

Enables you to submit an
application for online
banking at your financial
institution.

online banking, setting
up

When you receive your confirmation
and a PIN/password from your finan-
cial institution, complete the “Enable
Accounts” section of the Online Bank-
ing Setup interview.

Verify that the information
sent to you by the finan-
cial institution is correct.

online banking, enabling
a QuickBooks account

To start using online banking in QuickBooks:

1 From your bank’s Web site, select the "Download to QuickBooks" option. (This option
looks different for each bank.)

2 Choose Create a new QuickBooks account, and type the name of your account in the
field provided, then select Continue.

Going online for the first time
You should use online banking within the first month of enrolling for online services. The

first time you go online, we recommend that you download the most recent transactions
that have cleared at your financial institution.
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Financial institutions use WebConnect for online banking connections. WebConnect
offers online integration through the financial institution’s Web site (accessible from
QuickBooks or any browser). With WebConnect, you can go directly to your bank’s Web
site for online banking services.

Reconciling online accounts

Reconciling your online accounts is a three-phase process.

1

2

3

To download your transactions, go to the Online Banking Centre, select your financial
institution from the drop-down list, and Click “Go Online.”

Match transactions.

View a QuickStatement for the account. The QuickStatement includes all transactions
that have cleared your financial institution since the last time you downloaded,
including deposits, cheques, transfers, and ABM withdrawals, as well as any transac-
tions that were downloaded previously but not been matched.

When you click Match, QuickBooks automatically matches downloaded transactions to
those in your account register. For the unmatched transactions, select one of the trans-
actions from the downloaded statement, click Add to Register, and follow the onscreen
prompts until the transaction appears in the register. Assign an account from the
Account Drop Down list and click Record to enter the transaction in the register.

Match Transactions fisk & help question | Ask ] How Do I2
o Goto.. | SHPrint... | EAEdit Transaction =] QuickReport
Match QuickStatement transactions to those already in QuickBooks,
¥ show Register [ 1-line Accaunt: Chequing
Date MNumber Payes Payment S Deposit Balance ‘
Ex.Rate Type Account Mema ‘
11/15/2004 SEND Jacobs's Tile & Brick 4,765, 44| -5,541.35
BILLPMT |[Accounts Receivable
10j03(2004 Elitz, Richard:Kitchen 13,560.39 5,019.04
FMT Accounts Payable
07f16f2004 Crutf, Tracy:Bathioom Re-tile 7,633.28 17,652 32
PMT Accounts Recelvable
B||nurber ||Paves > ||Pavmnent Deposit ‘
A ccount Ll Mema ‘
Add to regisker | Record Restore | Ending Balance 12,652.32
P As of 12/18/2004 Balance = $5,035.66 Sort Statement By [pate < |
Status Date Cheque # Payee Payment Deposit
Unmatched 11/12 /2003 Funds Transter 5,000.00]
Unmatched 11/25/2003 ABM Withdrawl 200.00
Unmatched 11/17}2003 Deposit 2,080.11
Unrmatchad 11/22}2003 Bark Service Charge 9.00
F7 show Matched Match Unmatch | Done | Cancel |
Has it been a challenge to obtain a benefits plan for vour emplovees?

When you receive your bank statement for the account, use the Reconcile window.

Note: With QuickBooks, you can reconcile only to the paper statement you receive from your financial
institution. With Quicken, you can reconcile to either the online or paper statement.

Setting up online banking (account access and payment) I 121



v

To learn about... Search the Help index for...
Downloading and matching online trans- transactions, online

actions

Account reconciliation m reconciling, bank statements

m reconciling, credit card statements

Working with multiple users

In all versions of QuickBooks, you can set up your company file so that different users
have different access to features. You can set up as many users as you want. See “Users and
passwords” on page 123.

In QuickBooks Pro or better, several people can work with your company file at the same
time over a computer network. In QuickBooks Pro and QuickBooks Premier editions, five
users can access your company file simultaneously.

Sharing company files with QuickBooks Pro or
better

While QuickBooks Pro and QuickBooks Premier can network together to share one com-
pany file, QuickBooks Enterprise Solutions will only network with other copies of Quick-
Books Enterprise Solutions to share a company file.

Using QuickBooks on a network is basically the same as using it on a single computer.
When several users are allowed to work in the company file simultaneously, the file is in
multi-user mode.

However, for some activities, only one person at a time can use the company file. The other
users must log off, close the company file, or exit QuickBooks. Then the person who wants
to perform the activity must switch the file to single-user mode. After finishing the activity,
the person can switch back to multi-user mode, and the others can log back on or open the
company file again.

Single-mode activities include:

m  File operations such as backing up, condensing, or exporting data
m  Some types of changes to lists

m  Adjusting inventory

m  Activities involving an Accountant’s Review copy

There is also a third category of activities. Although all the networked QuickBooks users
(with the correct permissions!) have access to these features, only one person at a time can
use them. (For information about restricting access to features, see “Setting up the
Administrator and users” on page 124).
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Feature-locked activities include:

m  Paying bills

®  Running payroll

m  Setting up new users or maintaining existing ones

Refreshing after entering data

If you are creating reports while others are working in the company file, you can use the
Refresh button to make sure you have the most current information on your reports. The
Refresh button updates your screen with the information that others have entered into
QuickBooks since you started the report.

You can refresh lists or forms as you work by pressing F5 on your keyboard or right-clicking
the item and selecting Refresh.

To learn about... Search the Help index for...

Switching between modes multi-user mode
single-user mode

Your refresh options Refresh button

Users and passwords

The QuickBooks password feature provides a basic degree of protection for
your data, but it is not a complete security system.

For example, it will not prevent someone using Windows Explorer from deleting your
company file.

Some parts of your company’s data are more sensitive than others. You can use passwords
to make sure that each employee you have can only access those parts of QuickBooks you
want him or her to use.

Areas you can protect include sales and accounts receivable, purchases and accounts
payable, chequing and credit cards, inventory, time tracking, payroll, sensitive accounting
activities, and sensitive financial reports.

In this way, you maintain the security of your business data even when several people
access your company file simultaneously. Until you set up users (and passwords) in your
QuickBooks company file, any person who accesses the file will have full access to all
features of the program.
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Setting up the Administrator and users

About the QuickBooks Administrator

When you create a QuickBooks company file, QuickBooks creates a user called “Admin”.
This user is the QuickBooks Administrator for the company file. You can set up a password
for the Administrator. When you assign a password to the Administrator, QuickBooks
prompts you to log on when you open the company file.

Do not forget the Administrator’s password. Once you’ve decided on a
A password for the Administrator, write it down and store it in a safe place.

An Administrator’s password, if forgotten, cannot be recovered. If you forget this pass-
word, you'll have to send your company file to Intuit (there may be a fee for this service).

The QuickBooks Administrator has unlimited access to the entire company file and is the
only person who can add additional users and change access privileges. For each user he or
she sets up, the Administrator designates:

m A password. The password can contain up to 16 letters and numbers and is not case
sensitive. The user can change the password later, but the Administrator will still be
able to make changes to the user’s access privileges and can assign the user a new
password, if necessary.

m  Full access, selective access, or no access to each area of QuickBooks.

Setting up and customizing users

After you’ve set up the Administrator, you can add new users. Use the New User Setup
Wizard to select the parts of QuickBooks you want the new user to use.

m  From the Company menu, choose Set up Users.

You can set up as many users as you want. However, only five users can access the company
file simultaneously.

Note: In Windows 2000 and XP, using the Users and Passwords control panel, you can set up each
employee with a log-in profile. Be sure that Windows XP users have at least Standard user rights
and that Windows 2000 users have Power Users Group rights, or QuickBooks won’t run properly.

When the Wizard finishes, a summary screen for all your users appears:

Set up user password and access

Access for user: Drell Page 10 of 10

= You have finished setting this user's access rights and password
Below is & summary of this user's access rights. Click the Finish button
& tocomplete this task

Area Create Print  Reports
Sales and Accounts Receivable ki M
Purchases and Accounts Payable N
Chequing and Credit Cards n'a
Invventory N
Time Tracking
Payrall
Sensitive Accounting Activities
Sensitive Financial Reports
Changing or Deleting Transactions
Changing Closed Transactions

N
N
N
nis
n'a néa
nfa n/a

R
zzzzzz =z
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To learn about... Search the Help index for...
The different access areas of QuickBooks passwords, access areas

The role of the QuickBooks Administrator admin

Setting up users with passwords and users, adding

access

Changing passwords passwords, changing

Deleting passwords passwords, deleting

Using permissions to close an accounting period

Unlike most other accounting systems, QuickBooks does not require you to “close the
books” at the end of an accounting period. Closing books is often a complicated process
that involves transferring information from one ledger to another and summarizing it. You
can ask QuickBooks for reports at any time, not just at the end of a period.

However, you may want to restrict access to the transactions of prior accounting periods to
be sure the transactions are not changed without your knowledge. By requiring permission
to delete, add, or edit any transaction before a chosen date, you can discourage accidental
or casual changes to “closed” periods, but still make corrections in them when necessary.
For example, you may want to prevent your staff from making changes to old transactions
after you‘ve paid the GST or PST liabilities for them.

You can grant or deny access to older

transactions when vou set up a user. To Should this user alzo hawe the ability to change or delete tranzactions
y " 'P T that were recorded befare the clozing date?

deny users access to “closed” periods, do

not grant them permission to Change or

Delete Transactions recorded before the & No

closing date.

" Yes

Then enter the closing date in the User List window (from the Company menu, select Set
Up Users).

To learn about... Search the Help index for...
Using permissions to “close” your closing periods
books
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Recording who changed what in the Audit Trail

The “Current
Transaction”
entry shows
what the
transaction is
like now; the
“Previous
Transaction”
shows what it
was like before
the change.

You can also
see who made
the change and
when.

v

QuickBooks can record all changes made to transactions and the name of the user who
made the changes. Then you can review the changes in the Audit Trail report.

To keep an ongoing record of changes to transactions, you must make sure the audit trail is
turned on and keep it on. If the preference is turned off for a period of time, QuickBooks
does not keep a record of changes, if any, to the transactions in that period.

FEAudit Trail

Ask a help question Askl * How Do 1?7 -

Refresh Choose the date

~(From [12/15/2005 8|10 [12/152005 | ) range you want to

Mountain Sports Equipment see on the report.
Audit Trail

All Transactions

Madify Report. ..

Date Entered|Last: Modified

9:29 AM
12115103

Trans # ¢ Type < Entered/Last Modified < Last modified by < Date £ Hame
Current Transaetion ;I
1215/2003 10:28:15 Admin 12152003 Receiver Genersl
Receiver General _I
Deleted Transaction by Admin on 10/08/2002 23:03:34
170 Depost 10/03/2002 22:59:55 Admin 0373172003
Zairng, Alison
Henrig's Hurting ...
Buff it Up
Brault, Martin
Previous Trangaction
10M02/2002 05:28:37 Adin 0343142003

Early, Martha
Zairng, Alison

Henrig's Hurting a;lll
»

ol |

If you report financial information to the Québec Minister of Revenue (MRQ),
we strongly recommend that you turn on the Audit Trail feature permanently.

Doing so helps you comply with legislation from the MRQ.The legislation states that

your accounting software cannot allow you to modify or delete data without keeping a
record of the original data.

To turn on the Audit Trail permanently, install QuickBooks according to the instructions
in the "Installing & Learning to Use QuickBooks Guide". Then, when you start Quick-
Books, click Yes when QuickBooks asks if you report any information to the MRQ.

If your computer is older or you make a lot of changes to existing transactions, QuickBooks
may slow down slightly when the Audit Trail is on. Also, the size of your company file may
increase more rapidly than it has in the past.

These changes occur because instead of writing over transactions you change, QuickBooks
records both the original transaction and all changes to it. However, for most users, the
performance of QuickBooks should not change.

To learn about... Search the Help index for...

Using the audit trail feature audit trail
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Gathering income tax information

You are responsible for consulting a tax advisor or the Canada Revenue
Agency about your tax circumstances.

Tax laws change often, and their application can vary based on the specific facts of your
business. This information is not intended to be exhaustive.

How QuickBooks tracks tax information

As you set up your company in QuickBooks, you select which tax form your business uses:
m  The T1 General form, for individuals, unincorporated businesses, and partnerships; or
m  The T2 form, for incorporated businesses.

Creating New Company

Flease enter your company name, addiess, Mext
and the first month of your fiscal year —

| Cancel
|

Company

Legal Name Help

Addiess

Fhone # You can select a tax form either in the EasyStep

Interview (as you set up your company) or in the
Company Information window (from the
Company menu, choose Company Information).

I
FaX [
I

E-mail

webSite |

First manth in your fiscal year January =

First manth in yout incame tas vearfJanuary =]

Gnl:nme Tax Form Used A |
Default Provinee used for Sales Ta® |Ontario -
Business Mumber

It's important to select the correct tax form for
your business as you set it up in QuickBooks —
changing it later can be very time consuming.

Later, you choose the type of industry your business falls into. When you do, QuickBooks
sets up a suggested Chart of Accounts for your company and maps the accounts in it to the
most appropriate lines of your tax form.

If you change your tax form (for example, from T1 to T2), all the mapping
between your accounts and tax lines is lost.

You'll need to reassign the appropriate tax lines to your accounts. It's best to select the
correct form as you set up your company.

QuickBooks uses CRA standards to map the accounts in your Chart of Accounts to the best
tax line on your return. If you select the T2 tax form, QuickBooks uses the General Index of
Financial Information (GIFI). GIFI is a “standardized” financial statement that allows the
CRA to compare industries more easily. It simply classifies the accounts you use (and that
you list on the financial statement you file along with your tax return each year — usually,
a balance sheet, a statement of retained earnings, and an income statement).
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You may have noticed that, as you choose an industry type Tl
for your business in the EasyStep Interview, QuickBooks Esgzmt;onftontracting
lists “GIFI for Small Business Corp.” as an option. If you Faming/Ranching |
choose it, your business’ Chart of Accounts will contain m@ﬂ’w

most of the GIFI accounts that the CRA specifies, and you aphie s nng hd
can delete the ones you don’t need. However, no matter

what type of industry you choose in the EasyStep Interview, QuickBooks uses GIFI to match
the accounts for that industry to your T2 tax form.

3

As you create new accounts, you must manually map them to the correct tax line.
Otherwise, your income tax data will not be correct. If you are unsure about what tax
line you should map an account to, consult a tax professional or the CRA for advice.

-7 Edit Account

Tupe Other Current Asset i

| HowDal? | B

114 |

Cancel |

Name [GST Payable

™ Subaccount of j

Liezcription I

._Accuuntis

e / The choices that appear in the Tax
Line menu as you edit an account
depend on which tax form you

select for your company.

Bank Acct Mo |

ED g

( Tax Line |<Unasswgned>

As well as letting you export tax data to Intuit Canada’s tax products, mapping your
accounts properly lets you generate accurate tax reports, which keep you informed about
your tax situation and help you prepare your income taxes.

After your accounts are mapped to the correct tax lines, QuickBooks tracks tax-related
transactions as you enter them. At any time, you can create reports and financial statements
that show your company’s tax status and meet the requirements of the CRA.

To learn about... Search the Help index for...

Setting up accounts to track tax- income taxes, setting up for

related income and expenses

What QuickBooks can track for you

QuickBooks can track information for various tax forms and schedules:

QuickBooks tracks

Income tax information, including information
for the T1 General, T2 for Incorporated Busi-
nesses, Schedule 3, Schedule 4, T777, T2124,
T2124C, T2032, T2042, T2121, Rental, and
Medical Expenses. This list is not exhaustive.
Your options will vary depending on your busi-
ness.

Output created

A report detailing the amounts to be recorded
on each line of the tax form you chose when
you set up your company.

Much of this information can also be imported
into QuickTax® and ProFile™.
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Setting up income tax tracking

Use this checklist to make sure income tax tracking is set up properly. You may have set up
some parts of income tax tracking when you created your company, but not others.

Task

Comments

Search in the /
Help Index for...

Check that the first month of
your company’s income tax
year is set properly.

Likely, you or your accountant will have
determined the best income tax year for
your business before you set up your com-
pany in QuickBooks. If you are not sure
what your tax year is, check last year’s
return.

You can use either the calendar year or a
fiscal year as your income tax year, but
you must be consistent from year to year.

company, changing infor- |
mation about

Check that the income tax
form for your company is set
properly:

m Use the T1 for individuals,
unincorporated busi-
nesses, and partnerships.

m Use the T2 for incorpo-
rated businesses.

Important: If you change the tax form you
use, all associations between accounts
and tax lines are reset to <unassigned>.
You'll need to reassign the appropriate tax
line to each of your accounts.

® company, changing the d
tax form you file
®m accounts, tax lines

Choose a tax line for each
account in your Chart of
Accounts.

You may want to add or edit your
accounts to more closely match your tax
forms.

m accounts, tax lines |
m accounts, adding to your
chart of accounts

Check your tax situation with
income tax reports and trans-
fer your tax data to QuickTax.

For more information on this
step, see “Reporting income
tax information” (following).

Create an Income Tax Detail or Income
Tax Summary report (see “Reporting
income tax information” on page 129). Be
sure that the “To” and “From” dates cover
your last income tax year correctly.

Follow the instructions that came with
QuickTax to import data from QuickBooks.
(Note that QuickTax imports data from the
last company file you opened with Quick-
Books.)

m report finder |
® QuickTax

Reporting income tax information

Once you've assigned tax lines to your accounts, QuickBooks tracks tax-related income and
expenses automatically throughout the year. To check your business’ tax situation at any
time, use QuickBooks’ income tax reports. These reports show your accounts, the tax lines
you've associated with them, and the amount to be recorded on your tax form, and can be
printed for later reference.
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Use the Report Finder (under the Reports menu) to create income tax reports. In the Report
Finder, select Accountant and Taxes from the drop-down menu, then choose the income tax
report you want from the list. Remember that the “To” and “From” dates must cover your
last income tax year correctly!

To make completing your income tax return even simpler, you can transfer your tax
information from QuickBooks to one of Intuit Canada’s tax products (see “Transferring tax
information to Intuit tax products” on page 131).

Getting the numbers you need to file your income
taxes

Whether you fill out your income tax forms by hand, pass your company’s tax information

on to your accountant, or transfer your tax data from QuickBooks to one of Intuit Canada'’s

tax products, complete the following steps to make sure your numbers are correct.

m  Check the tax line assignments for your accounts. The accuracy of your tax reports
depends on each tax-related account being assigned to the correct tax line (see “How
QuickBooks tracks tax information” on page 127).

An easy way to check that all your accounts are assigned to the proper tax lines is to
create an Income Tax Preparation report. It lists the accounts in your Chart of Accounts
and which tax lines are assigned to them.

m  Check that the amounts in your Income Tax Summary report are correct.

One way to check is to compare your Income Tax Summary report to your Trial Balance
(make sure they cover the same period of time!). Check that the account totals (Trial
Balance) are the same as the matching tax line totals (Income Tax Summary report). If
they’re not, an account may not be mapped properly to a tax line. (Remember, too, that
you may have more than one account mapped to a tax line. If so, the sum of the
account totals should be the same as the tax line total.)

To learn about... Search the Help index for...

Checking tax line assignments to income taxes, filling out tax forms
ensure the accuracy of your income
tax summary report

Checking the amounts distributed to income taxes, filling out tax forms
various accounts

Income Tax Summary report

The Income Tax Summary report shows the amount associated with each tax line for the
tax form you specified during setup.

Chapter 4 QuickBooks basics



Note:

v

Income Tax Detail report

The Income Tax Detail report shows the amount associated with each tax line for the tax
form you specified during setup, and includes individual transactions.

Many businesses find this level of detail is the most convenient for filling out income tax
forms.

Make sure the reporting preference is set to the accounting method you use
for tax reporting: Accrual or Cash.

From the Edit menu, choose Preferences, then Reports & Graphs, and then click the
Company Preferences tab.

Income Tax Preparation report

The Income Tax Preparation report shows the accounts in your Chart of Accounts and
which tax lines are assigned to them.

Transferring tax information to Intuit tax products

If you use a current version of QuickTax or another Intuit tax product to prepare your tax
return, you can transfer your tax data from QuickBooks directly into it in a few minutes.

QuickBooks only exports information to Intuit tax products. For more information about these
products, visit http://www.intuit.com/canada/ or http://www.quickenstore.ca/

Your Intuit Canada tax product will have instructions on transferring information from
QuickBooks. It will import data from the last company file you opened with QuickBooks.

To learn about... Search the Help index for...
Transferring tax information from ® QuickTax
QuickBooks to your tax software m ProFile
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Solving printing problems

If you're having trouble printing, try checking these areas before you call technical support.
You can also visit http://www.quickbooks.ca/ for information about specific printers.

When should | reinstall my printer driver?

If your printer has any of these problems, you may have to reinstall your printer driver in
Microsoft® Windows or contact the printer’s manufacturer for assistance:

Your printer isn’t printing at all, from any program.

Your printer prints “garbage” from any program.

Your printer won't feed paper correctly.

Nothing happens when you try to print

There are several things you can try:
Make sure the printer is turned on and is online.

Try printing from another application to verify that Windows can still communicate
with the printer.

Check for stalled printing jobs on your printer:

a

b
c
d

From the Start menu, select Settings, then Printers.
In the list, double-click the printer you're using.
Select the stalled print job in the list.

From the Document menu, select Cancel.

The form is clipped on the top, bottom, left, or right

132

Likely, you only need to adjust the form’s margins and alignment. However, some printers
can’t print the entire width needed for the standard forms that come with QuickBooks. In
this case, you'll need to customize the form in QuickBooks to have larger margins.

To adjust the margins for forms:

1
2
3

In QuickBooks, from the File menu, choose Printer Setup.

Choose the form you want from the Form Name drop-down list.
Click the Margins tab.

If there is no Margin tab, you need to adjust the form’s alignment instead. See “To
adjust the alignment of forms:” on page 133.

Set the margin you want in the Left, Right, Top, and Bottom fields.

QuickBooks displays the margins in inches, but you can enter margin sizes in inches
(in), millimetres (mm), centimetres (cm), points (pt), or picas (pi).
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If you find that QuickBooks leaves larger margins than you entered, your printer may
be unable to print outside a specific area. Most printers cannot print with margins

smaller than .25 inches. Many require margins no smaller than .5 or .67 inches. Check
your printer manual or contact the printer manufacturer if you have such a problem.

If you're using a continuous printer, you may have to slide the paper clamps over to get
the printer to start at the position you want.

5 Click OK to save the changes.

To adjust the alignment of forms:

Coarse alignments:

This adjustment is only needed for continuous-feed (dot matrix) printers. Use it when the
printing on your forms is off vertically by more than a line or two.

1

G hWN

0 NO

If the text does not
line up properly on
the form, determine
the closest number
to the pointer line,
rounding up.

In this example,
you'd enter 81.

Make sure your printer is turned on and is online, with blanks of the forms you want
to print inserted to the printer’s paper feeder.

From the File menu, choose Printer Setup.

Choose the form you want from the Form Name drop-down list.

Click Align. (If the Align button is not available, that form cannot be aligned.)

If a list of templates appears, select the one you want and click OK.

QuickBooks displays a window where you can choose coarse or fine adjustments.
Click Coarse.

Click OK to print a sample form.

Look at the pointer line that QuickBooks prints across the middle of the sample form.
Determine the number that it points to. Do not adjust your printer at this time.

= 36 Labour hours, drywall instal

PR 222 22¢ POINTER LINE
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9

Type the number in the Pointer Line Position field in the window that appears, then
click OK.

Coarze Alignment x|

Do not adjust your printer! Find the clozest
number in the margin to the Pointer Line. Enter
that number and click OF.

0K

) ) Cancel
If necessary the paper will automatically be
moved and another zample will be printed.

Help
Fainter Line Positior: IS‘I

il

If necessary, QuickBooks advances the paper in the printer to correct the alignment,
and then prints another sample.

10 Note the correct position of the form for future positioning.

11

Visually line up part of your printer, such as the sprocket cover or print head, with one
of the position numbers along the edge of the form. Make a note of this spot, so you
can use it in the future as an alignment cue to position your forms visually.

Even if your printer has an “autoload” or “park” feature (the printer puts the paper in
the same place each time you load it), you need to manually line up your forms for
coarse alignment using a visual cue. QuickBooks cannot remember placement relative
to your printer’s autoload point.

(Optional) In the Align window, click Fine to make further adjustments, then go on to
Step 5 of the Fine-alignment process (below).

Fine-alignment adjustments:

This method of adjustment is available for all type of printers.

1

o h WN

N

Make sure your printer is turned on and is online, with blanks of the forms you want
to print inserted to the printer’s paper feeder.

From the File menu, choose Printer Setup.

Choose the form you want from the Form Name drop-down list.

Click Align. (If the Align button is not available, that form cannot be aligned.)

If a list of templates appears, select the one you want and click OK.

If you are using a continuous-feed (dot-matrix) printer, QuickBooks displays a window
where you can choose coarse or fine adjustments. Click Fine.

Click Print Sample.

QuickBooks prints the form with a small alignment grid (1/10 inch squares) on it.
Check the horizontal and vertical alignment of the text in the alignment grid.

Enter amounts in the Vertical and Horizontal fields to move the printed text to align

it. (The alignment values are in hundredths of an inch. For example, 25 means 0.25 of

an inch.)

m  For continuous-feed printers, if the printing is off to the left or right by a large
amount, move the form over in the printer to correct the problem. Use the Fine
Alignment window for changes of less than 0.25 inch only.
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Fine Alignment

Click Print Sample to uze the Alignment
Tid.

Enter amount to mave the text in 1/100

inch increments.

Eertical:l [ : Cancel
Horizantal: I 04 Help

FErint Sample

0K

il

Problem

The text prints too
high.

Solution

Decrease the number in the Vertical field. For example, if the text is
printing 2 squares (that is, 0.2”) too high, type -20 in the Vertical field.

The text prints too
low.

Increase the number in the Vertical field. For example, if the text is print-
ing 1 1/2 squares (that is, 0.15”) too low, type 15 in the Vertical field.

The text prints too far
to the left.

Increase the number in the Horizontal field. For example, if the text is
printing a 1/2 square (that is, 0.05”) too far to the left, type 5 in the Hori-
zontal field.

The text prints too far
to the right.

Decrease the number in the Horizontal field. For example, if the text is
printing 1 square (that is, 0.1”) too far to the right, type -10 in the Hori-
zontal field.

10 Click Print Sample to see if the form is now aligned correctly.

11 When you are finished making adjustments, click OK.

QuickBooks saves the horizontal and vertical alignment adjustments.
12 Click OK in the Printer Setup window.

Dates and the bottoms of letters are clipped on forms

Note:

The font you're using may be too large. In the Printer Setup window, click Font. Try a font

size of 10 points or less.

Changing fonts

1 From the File menu, choose Printer Setup.

2 Choose the form you want from the Form Name drop-down list.

You can’t change the fonts on some forms here. You can’t change the fonts on some forms here.
You can change the fonts on these forms by clicking the Customize button on the forms.

3 Click the Fonts tab and then the Font button.

Solving printing problems I 135



4 Choose the font you want.

Not all options are available for all fonts.

Select Font E .
Choose the font. ————— Font: Fort Style: T You can change to italic, bold,
Times New Foman IHeguIar IS LI or a combination.
Em . Cancel - ch . . Most
Select one or both of these % Hupliel3cript o [l i Choose a point size. Mos
checkboxes to strikeout & Orys MT =l |eodiaic =l f1z =] people prgfer a size between 9
and underline text. \ bl and 12 points.
™ Effect: Sample
™ Stikeout _L— You can see what the font
Choose a colour (not I” Undeine BTz = looks like here.
available for cheques). ——— Cala:
If you have a colour [ Eiack =l Thisis an OpenType font, This same font wilbe ——— A description for the selected
printer, you can print used on bath your printer and pour screen. font type appears here.

any other form in colour.

5 Click OK in the Select Font window and the Printer Setup window to save the changes.

Printing is slow

There are several things you can try:

m  Lower the print resolution for your laser printer: In the Settings tab of the QuickBooks
Printer Setup window, click Options. Then click the Graphics tab and set a smaller
number of dots per inch.

m If you're printing on blank paper or letterhead, do not choose to print lines around
each field. In the Settings tab of the QuickBooks Printer Setup window, clear the Print
Lines checkbox.

m  Make more computer memory (RAM) available by closing down programs you don’t
need.
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How to collect
and pay the right

amount of GST
and PST

There are several types of sales tax in Canada: the
Goods and Services Tax (GST), the Harmonized Sales
Tax (HST), and provincial sales taxes. The sales tax
feature of QuickBooks handles all of these. It helps
you determine how much sales tax to collect on the
sales you make, how to record the sales tax you pay
on business purchases, and how to pay what you owe

when it is due.

You are responsible for consulting a tax advisor about the sales taxes
that apply to your business.

For information about the GST and HST, contact the CRA. For information
about your provincial sales taxes, contact your provincial Minister of Finance.
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Sales tax information for upgraders

138

Changes in how sales tax due is calculated

QuickBooks has improved the way sales tax is reported. Previously, in order to prepare a
sales tax return, you needed to generate a GST/PST Summary report. Now, QuickBooks
automatically calculates the sales tax due (or refundable) and generates a tax return based
on that amount. The sales tax amount is calculated based on the transactions you have
entered into QuickBooks but which have not been included in a sales tax return yet: all
these "unfiled" transactions from any period will now be automatically included in the
current period’s tax return.

Updating from earlier versions of QuickBooks

Because QuickBooks will now incorporate all "unfiled" sales tax transactions in the current
period’s tax return, if you have unfiled sales tax transactions in your company file and
upgrade to QuickBooks 2006, you’ll need to know the ending dates of your GST/HST return
and/or your PST/QST return you last filed.

Not sure what the ending date is? If today were February 15, 2004 and the last return that
was filed for GST/HST was for the period October 1, 2003 to December 31, 2003, then the
ending date of your last filed GST/HST return would be December 31, 2003.

What happens to the "unfiled" transactions when |
upgrade?

QuickBooks takes the ending date you enter and marks as filed all entries that were made
on or before that date. That is, it assumes your sales tax accounting is correct as of your last
GST return. Then, later on, when you need to file your sales tax return for the current
period, open the Files Sales Tax window to see a summary of all entries to the sales tax
accounts that haven’t been filed yet -- including any that you may have "back-dated". This
prevents any missed entries in your sales tax returns.

You can view the filing status of transactions by looking at their entries in the register of
the sales tax account. Filed transactions are marked with an 'F’.

"Uncategorized" transactions eliminated

Previously, amounts could appear as "uncategorized" in GST/PST reports and in the File
Sales Tax window. QuickBooks labelled transactions as uncategorized when forms or items
were used in different ways from how they were intended to be used. For example, some
users incorrectly use the Make Deposits window to enter a cash sale instead of using a sales
receipt. This type of transaction entry would result in an uncategorized amount.
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Now, QuickBooks automatically categorizes all transactions affecting your sales tax liability
account. This means:

m  you'll no longer have to manually categorize these types of transactions,

m  when you generate GST/PST reports, your sales tax liability amount will now be
accurate, and

®  uncategorized amounts will no longer appear in the File Sales Tax window or in your
GST/PST reports.

What happens to the uncategorized amounts when |
upgrade?

If you previously had uncategorized amounts, these transactions will automatically be
updated and categorized when you install QuickBooks 2006. QuickBooks takes the ending
date you enter and marks all uncategorized amounts on or before that date as filed so they
won'’t affect your sales tax liability. Uncategorized amounts after the ending date will be
categorized as tax on sales or purchases so that they correctly affect your sales tax liability
account. The next time you file a sales tax return, QuickBooks will include these newly-
categorized transactions properly with all other unfiled transactions.

If you had uncategorized amounts in earlier versions of QuickBooks and didn’t adjust your
GST/PST returns for them, consult your accountant to see if you should file an adjustment
now.

Why are the From and To fields missing from the GST &
PST Liability reports?

We changed the model of the GST and PST Liability reports in QuickBooks 2004. In earlier
versions of QuickBooks, the reporting period of these two reports was specified using a
"From" and "To" field meaning that the reports typically represented one reporting period.
Now, when you create these reports, they calculate your sales tax liabilities as of a particular
date beginning from your QuickBooks start date.

If you insist on generating a GST or PST Liability report using the older model, you can
modify the current report to meet your needs. When you have customized the report to
your needs, memorize it so you can create it again quickly.

1 From the Reports menu, choose Vendors & Payables, then GST or PST Liability.

2 On the report, click the Modify Report button.

3 On the Display tab, in the From and To fields, specify the reporting period.

4 Click the Filters tab.

5 From the Current Filter Choices table, select the Filed filter, and click Remove Selected
Filter.

6 Click OK.
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Does your business need to be registered?

Although very small businesses are exempt, the Canada Revenue Agency (CRA)
recommends that all businesses register to collect the Goods and Services Tax (GST) or, in
provinces where the provincial sales tax has been combined with the GST, the Harmonized
Sales Tax (HST).

Registered businesses track the GST or HST collected from customers on sales and paid on
purchases for the business. Usually, you collect more sales tax than you pay out and must
remit the difference to the CRA. (Occasionally, you may pay out more than you collect and
claim a refund.)

Many provincial governments also require you to register to collect a provincial sales tax
(PST or, in Québec, QST). In most provinces, for provincial sales taxes, you track only the
amount you collect (instead of the amount you collect and the amount you pay) and remit
that amount to the government.

In Québec; however, the QST works much the same way as the GST: businesses may be able
to deduct the amount of QST paid on business-related purchases from the amount of QST
collected from customers, then remit the difference.

Check with the CRA, your province’s Ministry of Finance, or your accountant about how
your business should handle federal and provincial sales taxes.

How QuickBooks calculates the GST and PST
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QuickBooks uses your company address to determine what rates of GST and PST apply in
your province and assigns these rates to default sales tax codes.

It then calculates the GST and PST separately for each item on sales or purchase forms
according to the sales tax code you assign to it. QuickBooks displays the GST and PST totals
in boxes at the bottom of the form, then adds these amounts to the total. The HST is
calculated as one rate in the GST field.

Tax amounts are tracked in your GST Payable and PST Payable liability accounts. When you
make a sale, QuickBooks records the GST on the transaction as an increase in your GST
liability because you must remit the amount of tax to the government. When you make a
purchase, the GST on the transaction is a decrease in your GST liability because you can
claim the expense as an input tax credit.

Similarly, the PST on sales is recorded as an increase in your PST liability. However, whether
you record the PST you pay on purchases as a decrease in your PST liability depends on
whether your provincial government allows you to claim input tax credits for it.

At regular intervals, you must file GST and PST returns and create cheques to remit the
amount you owe to the federal and provincial governments. As your business grows, you
have to file GST/PST returns more often. Once a sales tax entry is included on a GST or PST
return that you've filed, it is marked as reported. If you enter a transaction from a previous
reporting period after you've already sent your return, it will automatically be included in
the next return you send.
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Setting up sales taxes

If your province
uses the
Harmonized
Sales Tax (HST),
only track the
GST. You do not
need to track
PST as well.

If you have
customers with
special tax
status, check
this box. You
will then be able
to assign a tax

code to his or her customer profile. On sales forms, the tax

One of QuickBooks’ very useful features is its ability to track the GST (or HST) and your
province’s sales tax, if it has one. After you turn on sales tax tracking, QuickBooks
automatically applies the correct taxes to sales and purchases and records the tax in the
appropriate accounts.

To turn on sales tax tracking
1 From the Edit menu, select Preferences.
2 Select GST/PST from the scroll box, then click the Company Preferences tab.

3 Set the preferences according to your business needs, then click OK.

% - [y Preferences Company Preferences I oK
Finane Do you wish bo sek up taxes? * ves Mo =]
Charge Goods and Services Tax Preferences

Are vou regiskered For the G5T? % yes  No  Business Mumber Help

You can enter the

/ business numbers
that are assigned

to you by the CRA

and your
provincial Minister

Record G5T separately on purchases? F yes € N I RTIDDDI
Reporting Period IQuarterIy hd

IMar;’Jun,l’Sep,l’Dec -

Return due |15 day(s) after the reporting period ends

Default

GOVErnment Tax Agency

IRecaiver General j

E=R Also See:

General

]

Provincial Sales Tax Preferences
Are you registered For a PST? @ yes (" No Registration Mumber

Record kax separately on purchases?  yes % No I 7

RN 1:

Inteqrated of Finance here.
Pipplications Reporting Period Quarterly x Government Tax Agency
ﬂ" Ending IMar)’Jun,l’Sep,l’Dec - IMinister of Finance j

Jobs & . .

Extimatos Return due |15 day(s) after the reporting period ends
—~—
% [V Mark kaxable amounts when printing Default Tax Code Is j
Orline (l_ Allow customer bax codes, Default customer Tax Code IS j ) I This code is
(=l assigned to all

new items by
default.

code you assign to customers overrides the tax codes you

assign to items.

Should | track my provincial sales tax separately?

When you buy an item for your business, in most provinces, you are either exempt from

paying the PST on it if the item is to resell or else you cannot claim the PST you paid on it
as an input tax credit (unlike the GST). That means that, for accounting purposes, you can
consider the PST on an item you buy as part of its cost and not bother tracking it separately.

However, if you can claim back the PST you pay on items for your business (as in Québec)
or want to record the amount of PST you pay for your own information, you can track the
PST separately. In the first case, the PST you pay is assigned to your PST Payable account to
reduce your PST liability to the government; in the second case, the PST you pay is assigned
to a PST expense account for your information only.
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To change your GST/PST reporting period:

1

2
3

Make sure you are working in the appropriate area: either the Goods and Services Tax
Preferences or the Provincial Sales Tax Preferences.

Select either Monthly, Quarterly, or Annually next to "Reporting Period."

Select the ending date for each reporting period from the Ending drop-down list.

To change the accounting basis of your sales tax reporting:

In Canada, the accounting basis for GST and PST is accrual (not cash), by law. The Accrual
or Cash setting in the Reports and Graphs section of the Preferences window does not affect
how QuickBooks tracks GST and PST, it only affects how the reports display.

Entering sales tax liabilities as of your start date
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If your business collected the GST or your provincial sales tax before you began using
QuickBooks, you need to enter the amount you owe the government for each tax (that is,
your sales tax liabilities) as of your QuickBooks start date.

1

2

o

00

From the Vendors menu, select Sales Tax, then choose Adjust Sales Tax Due. The Sales
Tax Adjustment window appears.

In the date field, type your QuickBooks start date or click E to select it from the Quick-
Books calendar.

(Optional) You can keep track of this adjustment by entering a number in the Entry
No. field.

Select the vendor (government agency) that you are adjusting for, from the Sales Tax
Vendor list.

Select whether this is a tax transaction on items bought or items sold.
Enter the Adjustment Amount:

m If you owe sales tax, enter the amount as a negative number. Your Sales Tax
Account (for example, GST Payable) will record the amount under the Increase
column.

m  If you're entitled to a refund, enter the amount as a positive number. Your Sales
Tax Account (for example, GST Payable) will record the amount under the
Decrease column.

Select Opening Bal Equity from the Adjustment Account drop-down list.

Click OK.
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Changing the default tax codes

In rare cases, you may need to adjust the default sales taxes that QuickBooks sets up.
For example, if your province charges an increased amount of sales tax on an item your
business sells, you may want to set up a new sales tax code for the higher rate.

To create a new tax code:

1 From the Lists menu, choose Tax Codes List.

& Tax Code List Ask a help question | Ask ¥ * How Do I?

Tax Code Description G5T PST Pigay A check mark in this column means
. <Mot Used = 0.0% 0,0% H
5 S s T // that thg PST is calculated on the
g ggTTgnllv ;g; ggﬁ sale price after the GST has been
nly 0% 0% e
5 |standard 7.0% 8.0% added to it (“piggybacked on the
Z Zero Rated 0.0% 0.0% GST” )

If the column is clear, the PST is
calculated on the sale price
independently of the GST.

i TanCode ~i| Reports ¥ |I7 5how sl

2 Click the Tax Code menu button, then choose New.

3 Fill in the information for your new tax code.

Enter a unique ElNew Tax Code !E[E
letter or number _ |
to identify this = E_°d_e (N 0K |
tax code and a IDESC"Dt'Dn Cancel | - If either the GST or PST does not apply
description. . paT Mest to a new tax code you're setting up,
Rate Rate select its Tax Exempt box.
Codei . . .

Enter the GST — | I 0.0% I u.uz/ i Note that selecting this box is not the
and PST I™ Tax Exempt I™ Tax Exempt same as leaving the percentage at

zero. (See “What the Zero Rated (Z) tax
percentages for [ Calculate Provincial Tax on G5ST (PigayBack] ( " . @)
this tax code. code is for” following.)

If the PST is to be calculated “on top of” the GST (that is, the GST is calculated
on the sale, added to the total, and the PST is then calculated on this new
total), select the Calculate Provincial Tax on GST (Piggyback) checkbox.

4 Click OK.
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Note:

What the Zero Rated (Z2) tax code is for

Under the GST, certain goods and services are taxed at a rate of 0% instead of the usual 7%.
These items are called Zero Rated.

(To see whether the items you sell are Zero Rated, you should check with the CRA or your
accountant. Some examples are basic groceries such as milk, bread, and vegetables;
agricultural products such as grain, raw wool, and fish for human consumption;
prescription drugs and medical devices; and items manufactured for export.)

Zero Rated items are not tax exempt, and should not be assigned the Exempt tax code (E).

If you sell a Zero Rated item, you charge your customers 0% GST on it. This means that you
do not collect any GST to remit to the government. However, because the item is taxable,
you can claim input tax credits (the GST you paid on the materials you needed to produce
the item) for it. When you file your GST return, you receive a refund based on these credits.

Assigning tax codes to items

144

Tip:

v

To let QuickBooks know how to tax the items or services you sell and purchase for your
business, assign each a tax code as you set it up in the Item List. Some items require both
the GST and PST; others, just the GST or PST; and some are tax exempt. If you are unsure
what taxes apply to the items you sell and buy or the services you provide, check with your
accountant, the CRA, or the office of your provincial Minister of Finance.

Once you have assigned tax codes to items, QuickBooks applies the correct sales taxes to
them on sales and purchase forms. You can override an item's tax code on a sales form, if
you need to. Also, customer tax codes (see “Assigning tax codes to customers” on page 145)
override item tax codes.

To assign tax codes to items:
1 From the Lists menu, choose Item List .
2 Select the item you want in the list, then choose Edit from the Item menu button.

3 If you buy the item for your business, select the correct tax code from the drop-down
list next to "Purch Tax Code" in the Purchase Information area.

4 If you sell the item to customers, select the correct tax code from the drop-down list
next to "Sales Tax Code" in the Sales Information area.
5 Click OK.

In the preferences window, you can choose a default tax code. This code will be assigned auto-
matically to all new items you create. Choosing a default sales tax code does not affect the sales
tax codes assigned to items already in your ltem list.

To learn about... Search the Help index for...

Assigning tax codes to items items, assigning tax codes to
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Assigning tax codes to customers

v

If you have regular customers who have special tax status (for example, who are exempt
from paying the GST or PST), you can assign them customer tax codes that override item
sales tax codes on all forms.

First, ensure the Allow customer tax codes is selected in the GST/PST preferences. Then you
can add the tax code to the customers’ profile in the Customer:Job list.

To learn about... Search the Help index for...
Turning on the Customer Tax tax codes, turning on

Codes

Setting up customers customers, adding new

Using tax codes on sales and purchases

& Create Invoices - Accounts Receivable Ask a help question | Ask. ¥ How Do I?
ﬁErevious I#Next @Prm; - @Email - ‘ éFind Spelling % History Journal @ TimeCosts...

Once you have assigned tax codes to the items you sell and buy and assigned customer tax
codes to customers with special tax status, QuickBooks automatically applies the correct
taxes as you fill in forms. The tax code appears to the right of the Amount column and the
amount of tax above the total.

If you need to apply a different tax code to an item, you can change the item’s tax code
from the form. In the rare event that you need to adjust the amount of tax on a transaction
manually, adjust the amount directly in the GST or PST box.

KSR 2KS

Custome|
Message|

Dave Ludwick
5455 Rue De Terrebonine
Ottaves, ON

Custamer: Job

Ludwick, Dave j

Invoice

Tour Design

Class Account Template  Customize |

The tax code that is being applied to this item
— is shown in the TAX column. QuickBooks gets
Dave Ludick this tax code from the Item List where you

e e e Tortomne assign a default tax code to items.

KSR 2KS

Description
Tour planning and research

If you need to create a
new tax code, you can do
so from the Tax Codes
List under the Lists menu.

Custamer

1t's been a pleasure - G5T 12,60
i youl M
s PsT \

Message |servin

14,40

Accepting credit cards means customer convenience.

o : .
Exchonn Ectarae ] o — \\ These fields can bTI edited,

7 Tobey Rt so you can manually

weo [ change the amount of tax

Save & Close Save & New Cear |

that QuickBooks calculates

for you.
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Charging GST/PST to out-of-province customers

Generally, you should charge GST and PST to all your in-country customers, regardless of
where they live. Customers who are exempt from the GST and PST can usually claim a
refund directly from the CRA (formerly the CCRA) or your provincial Minister of Finance.

However, each province has different regulations regarding Provincial Sales Tax (PST).
Depending on the number of business locations you may have across the country, Intuit
recommends that you contact your provincial Minister of Finance for specific instructions
on charging PST to out-of-province customers.

You do not have to charge GST if your company is registered for GST (you have a GST
number) and you sell to a foreign company.

Howv sales taxes are affected by a discount added to
an invoice

QuickBooks applies discounts before calculating the GST or PST. When you use a discount
item on an invoice, you must decide if you want the discount to apply only to one item on
the invoice or to all items on it.

m If the discount applies to only one item, use the discount item immediately after the
item you want to discount.

m  If the discount applies to more than one item, enter them on the invoice first, then use
a subtotal item, then use the discount item.

Discount items should have tax codes: When you create a discount item, remember to
assign it a tax code. Then, when you apply the discount to an item, match its tax code to
the item's. QuickBooks will then recalculate the affected sales tax(es) correctly.

Percentages vs. dollar amounts: If you enter a specific dollar discount instead of a
percentage, the sales tax might appear less than you expect because the discount gets spread
proportionally over all the line items appearing above it. If you enter a percentage discount,
it applies only to the line item directly above.

To learn about... Search the Help index for...

Using a tax code on a form tax codes, changing on forms
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Finding and paying your sales tax liabilities

If you collect sales tax from customers, you also have to make periodic payments of it to the
government. You can check what your sales tax liability is to the CRA and your provincial
Ministry of Finance by creating GST and PST Liability reports.

Creating GST and PST Liability reports

These reports provide complete information about the sales tax your company has collected
on sales, paid out on business-related purchases (where applicable), and owes to (or will be
reimbursed from) the government for a particular period.

The CRA requires businesses to report the GST on an accrual basis, so the GST Liability
Report isn’t affected if you change your accounting basis to Cash in the Reports and Graphs
preferences window.

You create GST and PST Liability reports the same way. Provinces that use the HST only
need to create GST reports as their provincial sales tax is included in it.

m  From the Reports menu, choose Vendors & Payables, then GST Liability or PST Liability.
Make sure the date accurately reflect the end of the reporting period.

This report includes the following information for the Goods and Services Tax Return you
file at regular intervals:

m  Total sales and other revenue not including GST or PST (Line 101: Sales & Other
Revenue).

m  Total purchases, which is subtracted from Sales & Other Revenue to calculate your Net
Sales.

m  Total GST collected and collectible on sales (Line 103: GST Collected and Collectible).

The Canada Revenue Agency considers invoices due on the date you issue them. So, for
any given reporting period, unpaid invoices with GST must still be included in the GST
“collected and collectible” for that period.

m  Total input tax credits (Line 106: Input tax credits).
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Recording reductions in PST (compensation or commission)

Some provinces give certain small businesses a reduction in the amount of provincial sales
tax they are required to remit. In Ontario, this reduction is called compensation; in British
Columbia, Saskatchewan, and Manitoba, it is known as commission.

You can track compensation or commission by entering it as you create a cheque to pay

your PST liability.

1 Create a PST return as you normally would (see “Remitting your tax liability to the
government” on page 148).

® Do not adjust your PST return for the compensation or commission.
2 Create a cheque to pay your PST liability as you normally would.
m  Atthe end of the process, create and save the PST liability cheque, but do not print
it yet.
3 From the Banking menu, select Use Register, then select your PST Payable account from
the drop-down menu and click OK.
4 In the PST Payable register, locate the cheque you created in Step 2.

m Ifyou created the cheque with today's date, it is likely the last entry at the bottom
of the register. Otherwise, you may have to search for the cheque.

5 Select the Expenses tab below the cheque.

o

Click the first line below the PST Payable entry and select the income account you use
for PST compensation.

7 Inthe amount column, enter the amount of compensation for this return as a negative
number.

m  For example, if you received compensation of $250, enter -250.
8 Click the Recalculate button and confirm that the cheque amount is now correct.

9 Save the cheque, then print it as you normally would.

Remitting your tax liability to the government

148

Note:

Use the File Sales Tax function to create cheques for the sales tax you’ve collected, which
you can then print and send in to the CRA or your provincial Minister of Finance, along
with your return.

You must file a return for each reporting period, even if you do not owe money or expect a
refund. For reporting periods with no business transactions, file a nil return.
1 From the Vendors menu, choose Sales Tax, then File Sales Tax.

2 In the File Sales Tax window, QuickBooks shows the last day of the previous month in
the "Show Sales tax through" field. Enter the date that the current sales tax period ends

3 Select which tax agencies (Vendors) to pay, by clicking in the Pay column.
The Payment Account field shows your chequing account.

To draw the cheque on a different account, just select it from the drop-down menu.
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4 If you want QuickBooks to print a cheque, select To be printed. If you are writing a
cheque by hand, select Assign cheque no.

5 Click Next.

QuickBooks displays your tax return. You can make adjustments directly on the form,
with the exception of lines 103 and 106. To adjust the amounts on these lines, click the
Adjust button beside the line, then click OK.

7 Click Next. The tax return is displayed, after any adjustments, ready for printing.
Click Print.

QuickBooks creates and records the cheque to the Receiver General or Minister of
Finance. You can now print the cheques, by choosing Print Forms from the File menu,

then choosing Cheques. It also updates your Liability reports and Payable registers to
show that you’'ve made a payment.

o

(<]

Paying sales tax liabilities by installments

The government requires certain businesses to prepay sales tax in regular instalments.
(Check with your accountant, the CRA (formerly the CCRA), or your provincial Minister of
Finance to see what rules apply to you.)

You do not need to create a GST or PST return each time you create an instalment payment.
Instead, record each instalment payment in an Other Current Liability account, then enter
them on your sales tax return when you file it.

To create a sales tax instalment payment:

1 From the Banking menu, choose Write Cheques.

2 In the Bank Account field, choose the chequing account you use to pay this sales tax
liability.

3 In the "Pay to the Order of" field, choose the vendor you pay this tax to (such as the
Receiver General for the GST).
QuickBooks may warn you about creating a cheque for a sales tax vendor. Click OK.

4 Enter your account number with this tax vendor in the Memo field (such as your
business number for the GST).

5 Select the Expenses tab below the cheque.

6 In the first blank line, select the Other Current Liability account you use to record
instalments for this sales tax.

7 In the Net Amount column, enter the amount of this instalment payment.

8 Save the cheque, then print it as you normally would.

QuickBooks records the amount of this payment in the instalment account. However, the
payment does not appear in your GST or PST Liability report. That's because sales tax reports
calculate how much you owe based on the entries in your GST or PST Payable accounts and
do not include subaccounts. To see your current balance owing, create a Balance Sheet
Standard report (from the Reports menu, select Company & Financial, then Balance Sheet
Standard).
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To record instalments in a sales tax return:

At the end of the fiscal year, in your sales tax return, enter the total of the instalments you

paid:

1 From the Lists menu, choose Vendor List.

2 Right-click the tax agency, then select QuickReport.

3 Set the "From" and "To" dates to your sales tax period (usually the past fiscal year), then
click Refresh.

4 Add up the instalment payments you made during the sales tax period. (Tip: the Split
column shows cheques to the vendor that were created using your sales tax instalment
account.)

5 Open the File Sales Tax window and fill it in as you usually would, then click Next.

6 In the Instalments line of the return, enter the amount you noted in Step 4.

For example, if you made three instalment payments of $500 each towards your GST
liability, your total should be $1500, which you enter in line 110 of your GST return.

7 Finish processing the return as you usually would.

If you receive a sales tax refund

You create and file a sales tax return the same way in QuickBooks regardless of whether you
have to remit tax or you have a refund due. When you file your sales tax return, if you are
receiving a refund, QuickBooks:

sets up the tax agency as a customer (if it isn’t set up already) so that it appears on both
your customer and vendor lists. Use the entry on the Vendor list to pay your sales tax
liability and the one on your Customer list to deposit a sales tax refund. Note that the
name on each list is slightly different (such as "Receiver General" on the Vendor list and
"Receiver General - ¢" on the Customer list.)

creates an invoice for the amount of the refund using the pre-generated "Receiver
General - Receivable" item. When you receive the refund, you should enter the amount
as a payment received against this invoice.

To receive a sales tax refund (after filing a return):

1

From the Customer menu, select Receive Payments.

In the 'Received From' drop-down list, select the sales tax agency that gave the refund.
For example, for a GST refund, select "Receiver General - c".

In the Amount field, enter the amount of the refund.

In the Applied To area, confirm that QuickBooks has selected (with a ) the correct GST

Refund invoice for this payment.

m  Note: the amount of the refund should exactly match an invoice in this window.
If it does not, review your last sales tax return and contact the sales tax vendor.

Select the bank account to deposit the refund into or group it with other undeposited
funds.

Click Save & Close.

Chapter 5 Tracking and paying sales taxes



Recording penalties or interest on late GST/PST
payments

If you pay a sales tax liability late, the government may assess a penalty against you or
charge late-payment interest on the amount you owe. You can record a penalty or late-
payment interest by entering it on the cheque you use to pay your sales tax liability.

1

ONO OGO A

Create a sales tax return as you normally would (by selecting Sales Tax, then File Sales
Tax from the Vendor menu).

® Do not adjust your sales tax return for the penalty. At the end of the process, create
and save the sales tax liability cheque, but do not print it yet.

From the Banking menu, select Use Register, then select the sales tax account from the
drop-down menu and click OK.

In the sales tax payable register, locate the cheque you created in Step 1.

m  If you created the cheque with today's date, it is likely the last entry at the bottom
of the register. Otherwise, you may have to search for the cheque.

Select the Expenses tab below the cheque.

Click the first blank line and select the expense account you use for the penalty.
In the amount column, enter the amount of the penalty or interest for this return.
Click the Recalculate button and confirm that the cheque amount is now correct.

Save the cheque, then print it as you normally would.

Adjusting your GST Payable or PST Payable account

From time to time, you may need to make adjustments to your GST Payable or PST Payable
account, either increasing or decreasing the amount you must remit.

These adjustments may include writing off the GST amount of a bad debt. For example:

Taxable items on invoice $200.00
GST due 14.00
PST due 18.00
Total $232.00

GST reported in the 4/1/2004 - 6/30/2004 reporting period
PST reported in the 4/1/2004 - 6/30/2004 reporting period
No payment received on invoice in 2004

Write off bad debt in 2004

Claim a GST adjustment of 7/107 x $214 = $14

Claim a PST adjustment of 9/109 x $218 = $18
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To adjust your GST Payable or PST Payable account:
1 From the Vendors menu, choose Sales Tax, then choose Adjust Sales Tax Due.
2 On the Vendors menu, select Sales Tax, then click Adjust Sales Tax Due.

3 Select the Sales Tax Vendor from the drop-down list (usually, the Receiver General for
GST or the Minister of Finance for PST).

4  Select the Sales Tax Account from the drop-down list (usually GST Payable for GST or
PST Payable for PST).

5 Select an appropriate adjustment account from the drop-down list. (It should be an
expense account.)

o

Enter the adjustment. To make a negative adjustment, enter a negative amount.

7 Select the Tax on Purchase or Tax on Sales option. Selecting Tax on purchase will make
an adjustment against sales tax paid on purchases. Selecting Tax on sales will make an
adjustment against sales tax collected on sales.

m  The table below shows how the selections affect your sales tax balance:

Positive Negative
Adjustment Adjustment
'Tax on purchase' option Decreases what you owe Increases what you owe
'Tax on sales' option Increases what you owe Decreases what you owe

8 Click OK.

Working with filed and unfiled transactions

By default, the GST and PST Liability reports show all transactions that are not marked as
filed up to the date of the report. For example, if you create a GST Liability report for March
31st, it shows all transactions that are not marked as filed from the start date of your
company up to and including March 31st.

Then, when you complete your GST return for March 31st, all transactions included with
the return are marked as filed (F). Any transactions entered subsequent to March 31st --
even if they are back-dated -- will not be marked as filed and will show up in your GST and
PST Liability reports.
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Manually filing or unfiling transactions

You can change a transaction's status, if you need to. For example, you may need to
manually change the status of transactions from filed to unfiled if there was a problem on
a sales tax return you created but did not yet send to the CRA (formerly the CCRA). In this
case, you could mark all transactions included on the return as unfiled, correct the problem,
and create the return again.

Note that unfiling a transaction from a return without recreating the return will result in
your sales tax reports not matching the actual balance owing in your sales tax payable
account. Also, your sales tax payable account not balancing to zero properly when you file
a sales tax return. Because unfiling a transaction may mean adjusting the sales tax you
owe, contact your accountant for guidance.

To manually mark a transaction as filed or not filed:

1 Open the original transaction and note its date, reference number, and the amount of
GST or PST on it.

2 From the Lists menu, choose Chart of Accounts.
3 Double-click the sales tax account to open its register.
m  The default sales tax accounts in QuickBooks are GST Payable and PST Payable.

E

Locate the GST or PST entry in the register that matches the original transaction:
B In the transaction, right-click the ¥ column:

m Ifthe transaction is unfiled, the column is empty. From the right-click menu, select
File. QuickBooks will no longer use this transaction to calculate your sales tax
liability -- it will no longer appear in the GST or PST Liability reports that show
what you owe as of a certain date. Manually filed transactions are given a filing
date of 01/01/1901.

m  If the transaction is filed, it shows an F in the column. From the right-click menu,
select Unfile. After you manually unfile a transaction, it appears with other unfiled
transactions as part of your sales tax liability -- that is, it appears in GST and PST
Liability reports that show what you owe as of a certain date. The transaction will
marked as filed when you pay your sales tax liability as normal.

6 Click Record to save your changes.
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Editing transactions marked as ‘filed’

QuickBooks allows you to edit filed transactions. For example, you might need to change a
filed transaction if it contains a mistake about what items were bought or sold, the customer
or vendor name, the account that an amount was assigned to, or another issue not related
to the dollar amounts in the transaction. However, we strongly recommend that you do
not change dollar amounts in a filed transaction without consulting an accountant.
Otherwise, the amount QuickBooks shows you owe in sales tax reports will not match the
actual balance owing in your sales tax payable account. When you file a sales tax return,
the sales tax payable account may not balance properly.

To avoid amounts in your tax payable account that don't appear on tax reports, leave the
amounts in the original transaction as they are and create a second transaction for the
difference. For example, suppose that three months ago, you accidentally entered $30 for
widgets on a bill when you should have entered $20, and that you have since created a GST
return for that period. Instead of changing the original transaction, enter a credit for the
$10 difference (by selecting Enter Bills from the Vendor menu, then selecting the Credit
option on the form).

Changes that do not involve dollar amounts in a transaction show up immediately in
reports, customer or vendor registers, or the other area of QuickBooks you usually use to
track this information.

If you do change a dollar amount in a filed transaction, QuickBooks shows the change like

this:

m  GST and PST Liability reports (Vendors & Payables section of the Reports menu): by
default, these reports only show unfiled transactions, which determine how much sales
tax you owe. The change does not appear in these reports because the transaction is still
marked as filed (so the reports do not include it).

m  Prior GST and PST returns: to ensure that your records agree with the CRA's (formerly
the CCRA), sales tax returns do not change once they are filed. For this reason, they do
not show changes to transactions.

m the Sales Tax Detail report (when viewing prior sales tax returns): this report shows the
transactions that were marked as filed by a particular sales tax return. Since the trans-
action you changed is included in this report, the report will show the change to the
transaction. That means this report will disagree with the sales tax return for the same
period by the amount of the change.

m  Registers for tax liability accounts: the register reflects all transactions, filed and
unfiled, and all modifications to them. If you change an amount in a filed transaction,
you are creating a difference between the transactions marked as filed and the
payments (or refunds) you have made to the tax agency. This difference will not be
picked up by the GST or PST Liability reports. For this reason, sales tax registers are a
good place to help reconcile sales tax issues.

When you edit a filed transaction, it remains marked as filed.
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Locking older transactions after paying your GST/PST liabilities

v

After you've paid your GST and PST liabilities for a given period, you won’t want your
employees to change any of the transactions that affected your payment. QuickBooks lets
you restrict access to these older transactions to be sure they are not changed without your
knowledge. By requiring permission to delete, add, or edit transactions before a chosen
date, you can discourage changes to these “closed” accounting periods, but still make
corrections when necessary.

To deny users access to “closed” periods, when you set up user names and passwords for
your staff, do not grant them permission to Change or Delete Transactions recorded before
your closing date. Then enter a closing date that is later than the date of your payment. For
more information about setting up user names and passwords, see “Users and passwords”
on page 123.

To lock older transactions after paying sales tax liabilities:

1 To set up or edit user names for your staff, from the Company menu, select Set Up
Users.

2 Do one of the following:
m  Select an existing user name from the list, then click Edit User, or
m  Click Add User to create a new user name.

3 If you do not want this user to have access to your historical transactions, give him or
her access only to “Selected areas of QuickBooks” when the wizard prompts you.

4 Work through the wizard until you reach the Changing or Deleting Transactions
screen.

5 Select No to the question, “Should this user also have the ability to change or delete
transactions that were recorded before the closing date?”

6 Work through the rest of the wizard for this user, then any other users in your user list
or that you are adding.

7 At the bottom of the user list, click Closing Date.

m  If you closed the user list, from the Company menu, select Set Up Users.
8 Type the date up to which your books are closed, then click OK.
9 Click Close to close the user list.

To learn about... Search the Help index for...
Using permissions to “close” closing, books
your books
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Multicurrency: an overview

Note:

In QuickBooks Pro or better, you can record transactions in currencies other than the
Canadian dollar. With the multicurrency feature turned on, QuickBooks tracks foreign
transactions and accounts for them correctly, regardless of the currency you use. For
example, if you sell goods to the United States, you might enter some transactions in US
dollars and others in Canadian dollars. Tracking these foreign-currency transactions is as
easy as selecting the foreign customer or vendor from your customer:job list; QuickBooks
takes care of everything else.

With multicurrency, you can also set up a fixed foreign price for items, or enter prices in
your home currency and then have QuickBooks calculate the foreign price based on the
current exchange rate. See “Set up foreign prices for items” on page 162 for more
information on setting up foreign prices.

The home currency refers to the currency that is used in the country in which your business
is located. QuickBooks selects the Canada Dollar as the home currency by default. In
registers and forms, home-currency transactions are displayed in the home currency,
whereas foreign transactions are displayed in their foreign currency. On most reports;
however, foreign balances are converted into the home currency.

Once multicurrency is turned on, you cannot turn it off. We recommend that you make a backup
of your company’s file before turning multicurrency on. For more information, see “Backing up
your company data” on page 107.

A note about exchange rates

Exchange rates of currencies change daily, and these fluctuations can generate a gain or loss
in your books. QuickBooks accounts for these gains and losses by tracking them in the
Exchange Gain/Loss expense account which is created automatically when multicurrency
is turned on (see “Exchange rates and how they affect your transactions” on page 165 for
more information.)

Setting up multicurrency
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If you deal in a currency other than the Canadian dollar, you need to turn on the
multicurrency feature. This feature is turned off by default, as many businesses deal only
with Canadians using Canadian dollars.

After multicurrency is turned on, you will need to assign a currency to each of the
customers and vendors with whom you deal on an international basis. Customers and
vendors that were created before you turned on the multicurrency feature are automatically
assigned your home currency (by default, "Canada Dollars"). The home currency is used to
determine the value of all other currencies, and its exchange value is fixed at 1. Once a
home currency is selected and you have recorded a transaction, it cannot be changed,
unless you delete the associated transactions and edit the associated customers.
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Each foreign currency you deal in must have a matching Accounts Receivable or Accounts
Payable account in the same currency. This allows you to track transactions specific to each
currency that you set up in QuickBooks. You can also set up foreign-currency Bank and
Credit Card accounts.

To setup multicurrency, you need to complete these tasks:
1 “Turn on the multicurrency” on page 159.

2 “Set up foreign accounts” on page 160.
3 “Create foreign customers and vendors” on page 161.
4

(Optional) “Set up foreign prices for items” on page 162.

Turn on the multicurrency

If you invoice, receive payments or pay bills in a currency other than the Canadian Dollar,
you should turn on the multicurrency feature. You can do so in one of two ways: in the
EasyStep Interview as you create a new company, or in the Preferences window.

Once multicurrency is turned on, you cannot turn it off. We recommend that you back up
your company file before turning multicurrency on. That way, you can go back to the way
your company was, if for some reason you don’t want to use the multicurrency feature
anymore.

To turn on multicurrency from the Preferences window:

1 From the Edit menu, choose Preferences.

2 TFrom the scroll box on the left, select Accounting.

3 On the Company Preferences tab, select Use multicurrency.

Preferences w HowDao I?I x|
Eé [ My Preferences ] Company Preferences I oK |
fEiE Account Humbers Multicurrency Caia] |
[ Use account numbers ¥ Use multicurrency Help |
é = Show lowest subaccourt only Home curency I Canada Dollar j
Chequing Default |

™ Use fareign proces on items
W Require accournts Sl

L i ] Fareign item | j Also See:

[ Use class tracking CUMmency
Deskto A
View F v Use audit trail Sl
v Autornatically azsign general joumnal entry number
Finare-

4 Click OK. Multicurrency is now turned on, and the home currency is set to "Canada
Dollar".

Setting up multicurrency I 159



160

Note:

v

You can now:
m  Assign a foreign currency to a customer and vendor.

m  Use a currency list which includes many common currencies and the latest
exchange rates as of QuickBooks’ release.

Generate a report to calculate unrealized and realized gains and losses.

Quickly convert foreign dollars to Canadian dollars or Canadian to foreign dollars
with the Currency Calculator.

m  Use the "Exchange Gain & Loss" expense account to track gains and losses due to
fluctuations in exchange rates.

Set a foreign price for items you sell frequently to foreign customers.

Locate multicurrency transactions with two new filters in the "find" function.

Set up foreign accounts

You can choose a foreign currency for Bank, Credit Card, Accounts Receivable (A/R) and
Accounts Payable-type (A/P) accounts.

You do not need to set up foreign Bank and Credit Card accounts to track foreign
transactions. However, for each foreign currency you deal in, you must create an A/R
account (if you have customers), an A/P account (if you have vendors), or both in that
currency. For example, if you have customers in the USA and England, you’ll need two
additional A/R accounts: one in US Dollars and the other in UK Pounds. You cannot use
the same A/R and A/P accounts you use for your Canadian-dollar transactions because
the Canadian dollar and other currencies rarely trade as equals.

Once a transaction is recorded in an account, the account’s currency cannot be changed.

To set up a foreign account:
1 From the Company menu, select Chart of Accounts. The Chart of Accounts appears.
2 On the Chart of Accounts window, click the Account menu button, and choose New.

3 Create an A/R or A/P account for each currency in which you want to deal. See the
online help for information on how to set up a new account.

When you select a currency, the Exchange field shows its exchange rate. If you want to
update the exchange rate, do it from the Currency List. See “Using the currency list” on
page 163 for more information.

To learn about... Search the Help index for...

Setting up accounts accounts
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Note:

Create foreign customers and vendors

After you've set up foreign A/R and A/P accounts, you can set up the foreign customers or
vendors who will be using these accounts. To do so, create the customer or vendor as you
normally would and choose the correct currency from the drop-down list in his or her
profile. Once a currency is assigned to a customer or vendor, all future transactions
involving him or her are recorded in the currency you assigned, with the exception of bill
and credit card payments (in this situation, the account you use to pay determines the
currency of the transaction).

Existing customers or vendors (that is, ones you set up before turning on the multicurrency
feature) are automatically assigned the Canadian-dollar currency. If you want to use a
different currency for these individuals, you'll need to create new customer or vendor
profiles in the correct currency.

Once a transaction has been recorded for a foreign customer or vendor, you cannot change the
currency assigned to him or her. You cannot assign a foreign currency to the Receiver General
and Minister of Finance vendors.

To create a new foreign Customer, Vendor, or Other Name:

Open a new profile and fill it in as you normally would with the following exceptions noted
on the graphic below.

[ Neweostomer_——————— COEICEERIIT RALTPRG Mi=IES
1 (Optional) Enter an __Customer
Op : : - \< perEE f Houw dol deteinine. 0K
opening balance if Lpening Halance—] 2 0f[05/17/2002 8| e opening balence? p—
. ANCE|
appllca ble Address Info Additional Info I Bayment Infa ] JobInfo ] = |
=T M
Categorizing and Defaults Price Level [ j s =
. - uslqmsr Is
Once a transaction ITWE— | Cusomrie =
H UEncy
is recorded for a Tems [Nethertands . ¥ | 2 Select the currency you
> . .
customer, you IHED -] B /; want to associate with
cannf)t enter an ) | — feies 7 this profile. If the currency
opening balance in . .
this wind you want is not in the
IS window. drop-down list, select
- <Add News> to create a
Business Defing Fields
I new currency.
Also, if the exchange rate
is out-of-date, update it.

Only one currency can be associated with a Customer, Vendor, or Other Name. If you deal
with a customer or vendor in more than one currency, you'll need to create an additional
customer or vendor profile for each currency in which you do business.
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Set up foreign prices for items

By default, items in the Item List are priced in the Canada-dollar currency. What that means
is when an item is used in a foreign transaction, the price of the item is calculated by
multiplying the home-currency amount with the foreign currency’s exchange rate. Because
the price is converted based on an exchange rate, there is a possibility that the price of an
item may go up or down if the exchange rate changes.

QuickBooks allows you to set up a fixed foreign price on items you sell frequently to one
particular country. By doing this, the foreign price of the item will not change due to
fluctuations in exchange rates. You can only select one other currency besides your home
currency to assign to item prices.

To turn on foreign pricing:

1 From the Edit menu, choose Preferences.

2 From the scroll box on the left, select Accounting.

3 In the Company s tab, select Use foreign prices on items.

4

From the "Foreign item currency" drop-down list, select the currency you want to use
as a fixed foreign price on items. If you deal with more than one foreign currency,
choose the currency you deal in the most.

5 Click OK.
b HowDoI?l |

Iy Preferences I Company Preferences I DK |
Account Mumbers Multicurrenicy Eamaal |
[~ Use account numbers ¥ Use multicunency Help |
[T Show Jowest subaceount anly Harne curency Il:anada Dallar j
Chequing i . Default |
: ¥ Use foreign prices on items
[V Require accounts e R S T SR
fua - ] i . Farsign item  [Matherands Guildsr j Also See:
Use class tracking curmency RIS
DS?::UUD v Prompt to assign classes eral
B (o Australia Dollar
v Use audi frail Canada Dollar
) v Automatically assign general jofirmal ety number Eura
Finance France Frane
Charge Clozing Date Germany Deutsche Mark
— Hamg Fong Dallar
= Drate through which books are cfazed Jaagn Yeng
A— - Metherls Jilder
Switzerland Franc
United Kingdom Pound
United States of Amernica Dallar

Once the foreign pricing is turned on...
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w HowDol?

™ Subitern of

Mon-irventary Part [ |

Iterm Mame/MNumber

Type

A

™ This item is purchased for and sold to a specific customer:job

_ O x

119

ancel

Frice ﬁoreign Frice

| 008 | 0.00
Sales Tax Co

-

Drescription

Account

A

Mext |

Custom Fields

Spelling |

[ Item is inactive

... you'll see an extra field in the
New Item window where you can
enter a fixed foreign price for an
item.

QuickBooks uses an item'’s
Foreign Price in transactions
where the currency matches the
currency that you chose in the
foreign pricing.

Using the currency list

The Currency List is a list of all the currencies that are set up in QuickBooks. We’ve included
a total of 44 currencies (including Canadian currency) in the Currency List. The list
contains information about each currency such as its exchange rate, currency symbol, and

hotkey.

When a foreign transaction is recorded, QuickBooks uses the exchange rate from the
Currency List to convert the foreign amount into the home-currency amount. You should
rarely need to make changes to the Currency List, except to add and delete currencies, and
update exchange rates. You cannot delete your home currency.

To create a currency:

1 From the Lists menu, choose Currency List.

Canada Dollar 1.000000
Euro 1.353400
France Franc 0.207200
Germany Deutsche Mark 0.695000
Hong K.ong Dollar 0.197300
Japan Yen 0.013850
Metherlands Guilder 0.616900
Switzerland Franc 0.900700
United Kingdom Pound 2214600
United States of America Dollar 1.543800

D0Om @S- IZTnmojy

Hotkeys help you convert foreign
amounts to your home currency quickly.

To use them, on any form, select the
foreign amount you want to convert,
then type that currency’s hotkey.
QuickBooks multiplies the foreign
amount by its exchange rate, which gives
you the amount in your home currency.

Cumency = ||_§ v AJE

~

Inactive currencies are not shown in this list. There are
more than 40 currencies defined in QuickBooks. To display
all currencies, click the "Show All" checkbox.
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v

2 At the bottom of the Currency List, click the Currency menu button and select New.
The New Currency window appears.

Mew Currency M=l B3

. Faormat
Currency Mame: || Seme 5545500 (1] 4 |
Caurntry: I . |
S Symbaol Position WZ' LCaneel

Currency Code: I

Decimal Separatar I Mext |
Currency Symbal: I —

Decimal Places - i
T E =

Thouzand I =
Exchange Fate: |1 z

Select this checkbox to make a currency inactive. This hides
the currency from the list as opposed to deleting it entirely.

Minimizing the Currency List makes it easier to read from
drop-down lists on forms.

3 On the New Currency window, fill in the currency options (at the very least, the
Currency Name, Country Code, and Country fields must be filled in):

m  Currency Name: the name of the currency.

Country: the country in which the currency is used.

Currency Code: the internationally-recognized code for the currency.
Currency Symbol: the symbol (such as $) to represent this currency on forms.

Hotkey: a unique letter or symbol to use by pressing the key to multiply an
amount by the currency’s exchange rate.

m  Exchange Rate: the value of one unit of the foreign currency in your home
currency. In order to keep your foreign transactions accurate, you should update
the exchange rate on a regular basis.

Format options

m  Symbol Position: select where you want the currency symbol placed. Your
options include Leading (in front of the dollar value) or Trailing (behind the dollar
value).

m  Decimal Separator: enter the symbol you want to use on forms to represent the
decimal placeholder. The default is a period (.).

m  Decimal Places: select the number of decimal places you want to use on forms.
You can select zero through 2.

m  Thousand Separator: enter the symbol you want to use on forms to represent
the thousand placeholder. The default is a comma (,).

4 Click OK. The new currency is added to the Currency List and is available on forms.

To learn about... Search the Help index for...
Creating, editing, or deleting a m currencies, creating
currency m currencies, editing
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Using the currency calculator

The currency calculator is a handy way to convert a dollar amount into a foreign currency
or vice versa.

m  From the Company menu, choose Currency Calculator.

EonencylSalculaton (D] ] 1 Type the dollar value you
1
2 Select the currency of the dollar ~ Walue: [50.00 - want to convert.

amount you want converted.

3 Select the currency you want —""|

[ Convert From: IEanada Dallar j
L~ Convert To: IUnited States of America j

| 4 Click here to copy the converted

the dollar amount converted to. amount to the clipboard. Then,
/" Converled 3333 use the paste command
A read-only field that displays (CTRL+V) to paste the amount

the result of the conversion. Cliphoard | Clase | into a field on a form.

Exchange rates and how they affect your
transactions

Tip:

The exchange rates provided in QuickBooks Pro or better were accurate at the time your
software was released. However, because currencies fluctuate in value, you should update
the exchange rates of your currencies often—every week or possibly more frequently,
depending on the volatility of the currency. (The easiest way to update exchange rates is by
using the Currency List. See “Using the currency list” on page 163 for more information.)

An exchange rate field also appears on some forms so that you can enter the latest exchange
rate "on the fly", without having to go to the Currency List. You should (when reconciling your

chequing accounts, for example) update the exchange rate used for cheques and deposits to

reflect the actual rate that was used by your bank at the time the cheques were processed or

your deposits accepted.

It is these changes in exchange rates that can affect the profits you make from foreign sales
and your costs for foreign purchases. Basically, as a business owner, you want to track the
potential effect of exchange rate changes on foreign transactions that haven’t been
completed (referred to as unrealized gains and losses) as well as the actual effect of the
changes on transactions that have been completed (referred to as realized gains and losses).
QuickBooks provides a report to help you track both types of gains and losses.
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Unrealized gains and losses

When you create a foreign transaction, the foreign currency is worth a certain amount in
your home currency, which is determined by its exchange rate on the day of the
transaction. However, the exchange rate likely changes before the transaction is closed.
Until the transaction closes, the difference between the value of the foreign currency when
you created the transaction and its current value as of today is your unrealized gain or loss.

For example, say a customer purchases an item from you for $100 US dollars, which is $130
CDN at the time you issue the invoice. Before the customer pays you, the Canadian dollar
falls, and the US dollar exchange rate climbs to 1.5 from 1.3. The $100 US that the customer
owes you is now worth $150 CDN, so your unrealized gain is $20 CDN. (You won’t know
how much money in Canadian dollars the customer actually pays you until you receive his
or her payment and deposit it in a bank. At that point, the bank converts it to Canadian
currency, and your gain or loss is "realized".)

Many accountants prefer you take your unrealized gains and losses on open foreign
transactions (invoices and bills) into account when you create reports about your
company’s net worth, as doing so gives a more accurate picture of the value of your
company on that date. Check with your accountant to see what he or she recommends.

To determine your unrealized gains and losses and make a home
currency adjustment:

To ensure your net worth reports show the true value of your foreign currency accounts
(and therefore your company) at the end of a reporting period, your accountant should
make a home-currency adjustment in the general journal.

1 Create an "Unrealized Gains and Losses" report:
a  From the Reports menu, select Multicurrency, then Unrealized Gain and Loss.

b In the Exchange Gain/Loss window, update the exchange rates for the purpose of
this report. (Note that doing so does not update the Currency List.)

¢ Click OK. QuickBooks summarizes open foreign transactions and the potential
gains or losses on them.

Il Unrealized Gains & Losses =] E3
odify Report.. Memarize... | Print... | Excel... Hide Header Refresh On repOrtS, foreign
Dates [20 j Fram [ E To| ETotaI By [Uniealized Gain#Lcﬂ amounts are
126 PM BRATS Landscaping Design displayed in the
13m0 Unrealized Gains & Losses home currency.
A 1 Basi: i .
el Baste All Transactions In this example, the
< Current balance < Adjusted balance < Gain/Loss k3 .
Account home currency is
us AR ’ 34333 4 44339 100.00 Canadian; therefore,
US Accounts Payable -36035 -400.35 -40.00

these amounts are in
Canadian dollars.

TOTAL UNREALIZED GAIN & LOSSES E0.00
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Select this checkbox |2

2 Use the information in the report to create a home-currency adjustment in the General
Journal entry to account for your gain or loss. Select the Exchange Gain/Loss expense
account as the other account that will be affected by this entry.

In this example, the Unrealized Gains and Losses report shows a currency gain for the

US A/R account, and a currency loss for the US A/P account. Therefore, the entries in
the General Journal should be recorded as follows.

to ensure these
amounts are
recorded as an
adjustment to the
home currency
without affecting
the foreign balance
of that account.

Exchange Gain/L... | 100, |]|:||
us a/m 100.00

Exchng Customer

=

Fievert I

Smounts Ine [Cap =

Save & Close Save & New |

™ Home Cunency Adustment

[ S~ -+~ [~ T PRlel]|  , You need to specify a
d@Pevious SPMext &5 Pring . 8 History ] Joumal customer name when a
IWB»’HQDDU E Entry Mo Enchangs Rate IW lm journal transaction is
= - - = entered for an A/R
Count D ebit Credit Memo I ame =)

account (or vendor name
for an A/P account).

When making home-
currency adjustments,
create a phony customer
or vendor to which you

can assign unrealized
gains & losses.

Account [ bt Credit ko Narne

Exchange GainsL.. 40,00
US Accounts Pay. 40.00

3 Create your net worth reports.

4 Reverse the General Journal entry to remove the unrealized gain or loss from your
books.

Realized gains and losses

A gain or loss on a foreign transaction because of changes in the exchange rate becomes
realized once the transaction is either partially paid or paid in full. When you close the
transaction, QuickBooks compares the value of the foreign amount when the transaction
began to its value when the transaction closed. QuickBooks enters the difference (gain or
loss) in the Exchange Gain/Loss account (which is created automatically when
multicurrency is turned on.)

For example, if you owe a vendor 500 French Francs, and the dollar/franc exchange rate
changes from 0.25 when you ordered the products to 0.20 when you pay the bill, your
realized gain is $25 CDN. That is, when you ordered the products, you owed $125 CDN, but
you actually paid only $100 CDN because the franc fell relative to the Canadian currency.
QuickBooks balances the transaction by assigning the $25 gain to the Exchange Gain/Loss
account.

To determine your realized gains and losses over time, use the "Realized Gains and Losses"
report. This detailed report shows the original amount of each foreign transaction in your
home currency, the actual exchange rate when the transaction was closed, and the resulting
gain or loss to you.
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To print a realized gains and losses report:

m  From the Reports menu, select Multicurrency, then Realized Gain and Loss.

il Realized Gains & Losses _[Of x|

todify Report... Frint... | Excel...

temaorize...

Hide Header Refregh

Realized Gains & Losses

Dates I_ = | Fiom [ E Tol @ Total By [Redlized GainfLUs:ﬂ
11:08 AM BRATS Landscaping Design
114300

On reports,

Accrual Basis All Transactions foreign
2 Type @ Date @ Hame @ Amount + Actual Rate - GainlLoss @ bala nces are
Account converted to
» Paymerit 131172000 Girard Camping Ex... 118.39 1.34 -11.56 4 th e hO me
Payment 144112000 Girard Camping Ex... 95.57 1.45 -1.42
Bil Pt Cheque  O7A1M000  Bottortf Designs 5444 147081 0.00 currency.
Payment 13/1/2000  Graham Highcock 713.88 1.50 13.89
TOTAL REALIZED GAIN & LOSSES 776.40 0.91

Dealing with foreign customers

QuickBooks handles customers who pay in foreign currencies in much the same way as

customers who pay in your home currency. You create an invoice and receive payments in
exactly the same way. The only difference is that the currency you assign to the customer
in his or her profile becomes the currency of the transaction (see “Create foreign customers

and vendors” on page 161).

Creating invoices for foreign customers

1 Select a foreign
customer such as
this US customer.
QuickBooks selects
an A/R account that
matches the e
currency of the
selected customer. If
one doesn't exist,
QuickBooks prompts
you to create one.

> L E:;iang& Total $57.98
2 Update the exchange .
. 7 Tobepined [~ Tobesent Balance $67.95
rate if necessary.
Mema I Save & Close Save &k New Clear |

168

Before you can create an invoice for a foreign customer, you must set him or her up in the
customer:job list and create a foreign A/R account. Then you can create an invoice as you

normally would. As you do, you also need to:

& Create Invoices - US A/R [_ O] <]
ﬁElevious lﬂﬂext @Pmn; - Spelling Qh Histary Journal @ Time/Costs...
rTOstomer Jo0 ECounT Form Template
US Customer j |US AR |Intu|t Service Ihvoice j

Date

06/11/2000 &

Invoice

skiing lessons

Customer - G5T 0.0
Message I—E’

The price of the item is
converted into the customer’s
currency (US dollars) using the
exchange rate. In this example,
the rate for "skiing lessons" is
$50 Canadian, but when the
item is added to the invoice, the
rate is converted to $33.99 US.

If you don’t want the price
converted using the latest
exchange rate, set up a foreign
price. See “Set up foreign
prices for items” on page 162.
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Note:

to it, the tax code is not brought over to the invoice.

Receiving payments from foreign customers

When you create an invoice for a foreign customer, and add an item that has a tax code assigned

You receive payments from foreign customers as you normally would. As you do, you also

need to:

#: Receive Payments

ﬁErevious I*Next %H\_story -

Journal

M[=1 E3

SE@Prink Credit Mema

1 Select the foreign

Customer Payment

customer from whom
you are receiving the

Received From American Imparks Ltd.

"/(Account |US Accounts Receivable j)
—/ 'l Customer Balance: US$180.75

payment; in this case,
it is a US customer.
QuickBooks selects an
A/R account that
matches the currency
of the selected
customer. If one
doesn’t exist,
QuickBooks prompts
you to create one.

Fill out the "Receive
Payment" window as

Prt Method Cheave  [v|

Memo

03/30/2001 B
180.75
134

Date
us$
Ret / Chg Mo,

Amaurt

Applied To:

" Show discount and credit information

At Due Payrnent
180 16

180.75 180.75

Set Discount Set Credits Clear Selections

GoTa Unuszed Payment

¥ Group with other undeposited funds

[~ Frocess credit card payment when saving

Unused Credits U.V
Exchange Rate [ 5438

7

The customer
determines the currency
of the transaction, and
seeing that this
customer is American,
the amounts on this
form are in US dollars.

2 Update the
exchange rate
if necessary.

you normally would.

" Deposit To j Save k Close | Save & New I Clear I

Ezplore the Business Services Directory bo leam how QuickBooks can help you run pour business.

Depositing foreign money

1

2

o

From the Banking menu, choose Make Deposits. The Payments to Deposit window
appears.

In Currency drop-down list, select the currency in which you have received payments
and want to deposit. You can only deposit payments from one currency at a time.
Then, from the list of payments you've received, select the payment(s) you want to
deposit.

Click OK. The Make Deposits window appears.

In the Deposit To field, select the account to which you want to deposit the payment.
You can deposit foreign money into a home currency account (the amount is

converted using the currency’s exchange rate, or a foreign bank account as long as it
matches the currency of the deposit).

In the Exchange Rate field, update the exchange rate if necessary.

Fill in the remaining fields as you normally would. If you are getting cash back from a
foreign deposit, you need to set up a Petty Cash account that matches the currency of
the money you are depositing and account for the holdback in it.
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Dealing with foreign vendors

Working with foreign vendors is much the same as working with vendors in your home
currency. The steps involved in making purchases and paying bills doesn’t change. The
only thing that is different is the currency of the transaction, which is determined by the
vendor. See “Create foreign customers and vendors” on page 161 for instructions on how
to create a foreign vendor.

Creating purchase orders for a foreign vendor

170

Before you can create a purchase order for a foreign vendor, you must set him or her up in
the vendor list, create a foreign A/P account, and have the purchase order turned on.

Create a purchase order for a foreign vendor as you normally would. As you do:

1 Select a foreign vendor. Because B Create Purchase Orders [Tolx]
the CurrenCy Of th's Vendor iS US ﬁErEVlDus ‘Mexl @anl - Spelhng %H!sluw Quumal
Dollars, for example, the currency Vendor Ship To Form Templale
Of the transaction will aISO be US Bottorff Designs j I j ICulem Purchase Or... j
[rate P.0. Mo,
Dollars. Purchase Order

QuickBooks selects an A/P account ERATS Landscaping Desion

that matches the currency of the
selected vendor. If one doesn’t
exist, it prompts you to create one.

[esription Amount

Fill out the "Create Purchase Order"
window as you normally would.

Wendor  [needed by Dec. 15 GST 0o
Message ST

0an

2 Update the exchange rate if ———— E:;clzgange Todl $105.00

necessary.

¥ Tobe printed

Intemal |
Mema

Save & Close Save k New Clear

As you enter items on foreign purchase orders, their prices are converted to the vendor’s
currency. If the item has a foreign price and its currency matches the vendor’s, the foreign

price is used instead (see “Set up foreign prices for items” on page 162 for more
information).
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Paying bills from foreign vendors

Often, you will receive bills in a foreign vendor’s currency and be expected to pay in the
same currency. If you make purchases from a foreign vendor, you should consider opening
a bank account in the vendor’s currency.

You can only pay bills in one currency at a time.

1 Open the Pay Bills window as you normally would.

2 In the A/P Account drop-down list, select the A/P account that matches the currency of
the bill you want to pay. For example, if you are paying a bill from a US vendor, select
your US A/P account.

You can only display bills in one currency at a time. The currency is
determined by the A/P account that is selected. In this case, we've selected
a US A/P account, therefore the bills listed here are from US vendors.

- Pay Bills Ask aMelp question | Ask w HowDol? 8 _ [Of x|

— Select Bills to be Paid Z
Shaw bills & Dug on or before |2Df1 1/2000 @ (AHP Account |L|S Accounts Pavable j)
" Show all bills Sort Bills By Wﬂ Exchange Hate|1_45 ——— Update the exchange rate.
J  Date Due Vendor  Ref Mo, Digc. Date  Amt Due  Disc. Used Credits Used Amt To Pa If the exchange rate
g 70.00| 0.00] 0.00| 70.00 B changes between the time
you entered the bill from
the time you paid the bill,
a gain or loss is
generated. QuickBooks
accounts for it by making
Tatals 245.00 70.00 an entry in the Exchange
Gain/Loss expense

— Discaunt & Credit [nformatian for Highlighted Bil
“endor  Bottorff Designs Terms Murber of Credits 0 account.
Bill Fef. No. Sugg. Discount $0.00 Total Credits Available $0.00
Go ko Bill | Set Digcount | Set Credits |
— Pagment Account————— — Payment Methad—————————— ~ Payment Date
hequi - I—El & To be printed
[ohecuing bt | s ) 10/11/2000 |
Ending Balance \ 1.238.79 " Assign cheque na.

Clear Selections | Pay & Cloze | Pay & Hew | Clear |

Select the account from which the payment will be taken. If the bank account is not set up as foreign,
QuickBooks calculates the amount in the home currency that is to be withdrawn using the exchange rate.

? To learn about... Search the Help index for... ‘
@

Payments using your credit card credit cards
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Transferring foreign funds

You can transfer money from a home-currency bank account to a foreign bank account or
from a foreign account to a home-currency account. However, transferring money between
two foreign bank accounts can only be done if the currency of the accounts are the same.

1

2 With the Transfer Funds Between Accounts window open:

Update the exchange
rate to match the rate
of exchange on the
day of the transfer.

From the Banking menu, choose Transfer Funds.

AN

Transfer Funds Between Accounts _|Of x|

@Previous EpNext E] Jounal

Date 13/11/2000 @

Trarsfer Funds From |BEEES SRR

N
N Exchange Rate

I‘I 47081

Transfer Fundz Ta IUS Chequing Account j

Ending Balance Cang

Ending Balance $US 3,399.49
Vi

Transfer &mount 5,000.00

Transfer Currency IM | 4

Transfer Funds

21.384.68

Memo |Funds Transfer

Save & Cloze | Save & New |

Revert |

Fillinthe rest of the window as

you normally would.

Enter the amount of the
transfer.

™ Select the currency

denomination of the
amount you want to
transfer.

For example, if you know
the transfer amount in
Canadian dollars, select
Can$, then enter the
Canadian amount. If you
know the transfer amount
in US dollars, then select
$US to specify the amount
in US dollars.

172

Chapter 6 Doing business internationally



Chapter 7

Payroll and
employees

Payroll: before 174

you begin... H OW tO pay
Setting up 175 employees aﬂd

payroll: an
overview

create payroll
payroll items fo rms

Setting up 189
employees

Setting up your 179

Running payroll 205
and paying taxes QuickBooks helps you track employee information

Payi Il 209 . .

oy and compensation. With the payroll features, you
filing payroll o .

forms can create pay cheques and administer vacation pay,

Creating vear 213 honuses, benefits, end-of-year payroll forms such as

Relevé 1 slips

T4 and Relevé 1 slips, and more.

To pay your employees with QuickBooks, you must be a member of
the QuickBooks Payroll . (Some versions of QuickBooks include a
membership in the service.)

b

This convenient, hassle-free service provides you with the latest tax tables and
payroll forms whenever the federal or a provincial government changes them,
plus a new version of the software whenever Intuit updates it.

To sign up, from the Employees menu, select Set Up QuickBooks Payroll
Service, then Sign up Now. For more information, turn to page 174.
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Payroll: before you begin...

Membership in the QuickBooks Payroll

?

Before you can use QuickBooks to pay your employees, you must become a member of
the QuickBooks Payroll . Some QuickBooks products include either a full or limited
membership. If you receive a limited membership, you must become a full member to
continue to pay your employees with QuickBooks when the limited membership expires.

Your membership in the Payroll Service ensures that you receive updated tax tables from
Intuit whenever income tax, Employment Insurance, Canada Pension Plan / Québec
Pension Plan, or other payroll rates or payroll forms change. The Payroll Service also helps
you make the most of your software investment by keeping it current. While you are a
member, you receive all updates and upgrades that Intuit releases for your software at no
additional charge.

To become a member of the QuickBooks Payroll , select Set Up QuickBooks Payroll from
the Employees menu, then Sign up Now. Intuit will assist you in updating your
QuickBooks user licence to show your membership.

You can get information about your membership by selecting My License from the Help
menu. You can get information about your tax table by selecting Set Up QuickBooks
Payroll from the Employees menu, then About the Payroll Service.

To learn about... Search the Help index for...
Signing up for the QuickBooks QuickBooks Payroll
Payroll

If you don’t use the payroll feature in QuickBooks

174

v

If you are not a member of the QuickBooks Payroll , you can still turn the payroll features
on. That’s because you must still track your payroll expenses and liabilities in QuickBooks
even if you use an accountant or payroll company to pay your employees rather than the
QuickBooks Payroll . Otherwise, your accounts will not be correct. However, you cannot
create pay cheques for your employees without a full membership.

With the payroll features turned off, the Employee list allows only very basic information
about each employee — his or her name, contact information, Social Insurance Number,
hire and release dates, and custom information you define.

To learn about... Search the Help index for...
Using an external payroll service payroll services, other than Intuit
If you have employees, but aren’t payroll, not using

using QuickBooks payroll
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Setting up payroll: an overview

v

The amount of time it takes to enter your payroll information into QuickBooks varies with
the size of your company. Often, it can take from one to two hours.

If you have never operated a payroll system before or are using a Premier Edition of Quick-
Books, we recommend that you set up payroll outside of the EasyStep Interview. If you are
familiar with payroll systems, you can use the EasyStep Interview to set up your employees
and their year-to-date payroll amounts quickly.

To set up your payroll system:

Become a member of the QuickBooks Payroll . You cannot use the payroll features of

In the Payroll & Employees preferences, check that the payroll features are turned on

For example, you can choose how you want your Employee list sorted and what prints

Confirm that the payroll liability and expense accounts that QuickBooks creates for

®  Your payroll items (see “Setting up your payroll items” on page 179).

m  The employees’ year-to-date amounts (see “Summarizing amounts for this year to

1

the product unless you sign up for this service (see page 174).
2

and are configured properly for your needs.

on employee pay cheques and vouchers or pay stubs.
3 Gather the information you need to set up payroll (see page 176).
4

you meet your needs (see page 179).
5 Set up (in this order):

®  Your employees (see “Setting up employees” on page 189).

date” on page 194).

6

If you have not already done so, protect your company and employee payroll data from
unauthorized access by setting up users and permissions (see “Users and passwords” on
page 123).

To learn about...

Search the Help index for...

Setting up payroll

Signing up for the QuickBooks
Payroll

Getting payroll updates
Setting payroll preferences

Setting up users and permissions
for a payroll system

payroll setup, required information

QuickBooks Payroll

payroll, updating
preferences, payroll

permissions
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Collecting the information you’ll need

If you paid employees before you set up your company in QuickBooks, you'll need to get
information from your previous accounting package or your accountant.

Information you need Where to find it
Company
How often you pay your employees Your accountant or company records

Your policies on vacation pay and sick time  Your accountant or company records

Contact information for the agencies you Your accountant or company records
remit money to after withholding it from
employee payments (e.g. the CRA)

Start date for using payroll Your company records

Tax information

Your business number Your company records or the CRA
Current tax tables covering payroll with- You can download them through
holding amounts such as El premiums and QuickBooks after you sign up for the
CPP/QPP contributions Payroll Service

Compensation, benefits, and other payroll
items

How you pay your employees and officers: ~ Your accountant or company records
hourly wages, salaries, and/or commissions

Things you add to your employees’ pay Your accountant or company records
cheques
m Examples include bonuses, travel

expenses, employee loans

Things you deduct or withhold from your Your accountant or company records
employees’ net pay.
m Examples include union dues, repay-

ments of employee loans or advances,

health or life insurance paid by the

employee, deductions for pension plans

Expenses your company pays that are Your accountant or company records
based on employee pay cheques (company
contributions)
m Examples include health or life insurance
paid by the company, your portion of
Employment Insurance, etc.
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Information you need

Employees

Where to find it

Employee name, date of birth, and Social
Insurance Number (SIN)

Contact information for the employee,
including the province of employment

Federal and provincial TD-1 forms for the
employee, completely filled out

(see “Entering information from employee
TD1 forms” on page 192)

Employee’s rate of pay or salary and pay
cheque additions, deductions, and com-
pany contributions (if any)

Employee’s vacation pay and accrued time

Employee

Employee and/or company records

Employee

Pay cheques, reports, or payroll ledger

Pay cheques, reports, or payroll ledger

Year-to-date amounts

Each employee’s payroll amounts from the
beginning of the calendar year to the date
you started using QuickBooks.

= That is, the total amount you’ve paid out
to the employee so far this year, and

m The total amounts you withheld from
each of the employee’s payments and
what for.

Your payroll liability amounts from the
beginning of the calendar year to the date
you started using QuickBooks.

= That is, the total amounts you withheld
from all pay cheques you issued this
year, and

= How much you already remitted to the
government, benefits providers, etc. as a
result of these liabilities.

Copies of employee pay cheques, pay
stubs, payroll reports, payroll service,
accountant, payroll ledger

Copies of liability cheques, payroll
reports, payroll service, accountant,
payroll ledger

Direct Deposit

For each employee using the service:
m Direct deposit request

= Bank number(s)

= Transit number(s)

m Account number(s)

Employee’s direct deposit request form
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Payroll expense and liability accounts

v

When you turn on payroll, QuickBooks adds two accounts to your Chart of Accounts:
m  Payroll Expenses (an Expense account)
m  Payroll Liabilities (an Other Current Liability account)

To keep your balance sheet and your profit and loss statement accurate, QuickBooks
associates each payroll item with the appropriate account or accounts.

Whenever you create a new payroll item, QuickBooks helps you assign it to the correct
account or accounts by prefilling the account name to use. However, you can use a different
account if you like. For example, an accountant for a corporation may want to create
subaccounts of the Payroll Expenses and Payroll Liabilities accounts to report expenses for
officer salaries separately from non-officer salaries.

Some types of payroll items should be assigned to different accounts. For example, payroll
items for employee loans (advances) should be assigned to an asset account, not the payroll
expense account. Payroll items for employee loan repayments should be assigned to the
same asset account as the payroll item for the loan.

To learn about... Search the Help index for...
Payroll Liabilities account payroll liabilities, account
Payroll Expenses account payroll, expenses account

Customizing payroll accounts
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You may change the names of the payroll liability account and payroll expense account
that QuickBooks provides. If you use numbered accounts, you may change the account
numbers QuickBooks provides.

You can also use subaccounts of Payroll Liabilities to see more detail on your balance sheet
for payroll liabilities, and subaccounts of Payroll Expenses to see more detail on your profit
and loss statement of your payroll expenses. For example, corporations may need to report
expenses for officer salaries separately from those for non-officer salaries.

To learn about... Search the Help index for...
Adding new accounts accounts (managing), adding
Changing account information accounts (managing), editing
Subaccounts subaccounts
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Setting up your payroll items

The importance of payroll items

?

Payroll items are the building blocks of your payroll system. When you create any kind of
payroll transaction in QuickBooks—whether it’s a pay cheque, a payroll liability payment,
or an adjustment at setup time or later—you use payroll items to do it (in the same way that
sales forms use service and inventory items).

There are payroll items to track employee compensation (salaries and wages), amounts you
withhold from employee pay cheques (income tax and other liabilities), employer-paid
expenses (such as company-paid benefits), and additions and deductions (such as bonuses
and loan repayments). QuickBooks uses payroll items to track both the individual amounts
on a pay cheque and accumulated year-to-date amounts for each employee.

QuickBooks displays your payroll items on the Payroll Item list. The names of the payroll
items are what you'll see on pay cheques and in payroll reports.

QuickBooks identifies payroll transactions by their use of payroll items:

m  Payroll reports include only transactions that use payroll items.

m  Payroll liability balances are based on transactions that use payroll items.

m  Employee year-to-date amounts are based on transactions that use payroll items.

When the payroll feature is turned on, QuickBooks creates the Payroll Item list with some
standard payroll items. You can add payroll items to this list.

To learn about... Search the Help index for...

Payroll items payroll items, defined

About the default payroll items

When you first turn on the payroll feature, QuickBooks creates the Payroll Item list with
some standard payroll items. These include:

Payroll item

name Type Use for

Sick Salary Yearly Salary Accrued time (such as sick time) paid out
to a salaried employee

Vacation Salary Yearly Salary Vacation pay paid out to a salaried
employee who is on vacation

Sick Hourly Rate Hourly Wage Accrued time (such as sick time) paid out

to an hourly employee
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Payroll item
name

Vacation Hourly Rate

Type

Hourly Wage

Use for

Vacation pay paid out to an hourly
employee who is on vacation or who left
the company

VacPay - Accrual
Paid Out

Vacation Pay

A specific amount of vacation pay paid
out to an employee, for example, when he
or she leaves the company

VacPay - Accrued

Vacation Pay

Earned (but not yet paid out) vacation pay
for an employee

VacPay - Paid Out

Vacation Pay

Vacation pay paid out to an employee
who is paid out every pay period

Federal Income Tax

Payroll Taxes

Federal income tax withheld from the
employee. Also includes provincial
income tax, except in Québec.

CPP - Company

Payroll Taxes

Canada Pension Plan, company
contribution

CPP - Employee

Payroll Taxes

Canada Pension Plan, employee
contribution

El - Company Payroll Taxes Employment Insurance, company
contribution
El - Employee Payroll Taxes Employment Insurance, employee

contribution

QPP - Company

Payroll Taxes

Québec Pension Plan, company
contribution

QPP - Employee

Payroll Taxes

Québec Pension Plan, employee
contribution

Québec Income Tax

Payroll Taxes

Québec income tax withheld

Creating new payroll items

180

As you set up your payroll system, you will need to create new payroll items to match how
you pay your employees. To create new items, use the Add New Payroll Item wizard.

To start the Add New Payroll Item wizard:
m  With the Payroll Items list open, click the Payroll tem menu button, then select New.
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Payroll item type

Yearly Salary

Use for

m Compensation to employees whose annual salary is
independent of the number of hours actually worked.

m Compensation to salaried corporate officers (with
expenses assigned to an expense account for corporate
officer salaries).

m Paid sick time for salaried employees.
m Vacation pay for salaried employees.

Hourly Wage

= Compensation based on the number of hours worked.
m Paid sick time for hourly employees.
m Vacation pay for hourly employees.

Commission

Compensation based on a percentage of another quantity
(such as 7% of sales) or a flat amount times a quantity (such
as $8 times units sold).

Deduction

Any deduction from gross or after-tax (net) pay. Examples
include union dues, loan repayments, and employee-paid
insurance.

Deductions can be flat amounts or calculated on a quantity
such as the hours the employee works.

Bonus

One-time compensation awarded at the discretion of the
employer.

Addition

Any addition to gross or after-tax (net) pay. An example is a
recurring profit-sharing payout.

Additions can be flat amounts or calculated on a quantity
such as the hours the employee works.

Company Contribution

Any company-paid benefit or expense that you want to
track with each pay cheque. Examples include employee
benefits such as pension plans or health and life insurance.
Company Contributions can be flat amounts or calculated
on a quantity such as the hours the employee works.

Other Tax

Miscellaneous taxes based on employee wages. These
taxes may be paid by the company or the employee.
Examples include payments to the Workers Compensation
Board, the Ontario Employer Health Tax, and the Québec
Health Services Fund.

Other Taxes can be flat amounts or calculated on a quantity
such as the hours the employee works.

You can limit payroll items to a maximum amount, either annually (e.g. an employee’s
union dues cannot be more than $150 per year) or absolutely (e.g. an employee’s loan
repayment cannot ever be more than $2000, the amount of the loan).
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Note:

v

As you create an item in the Add New Payroll Items wizard, you should:

m  Confirm that the expense and liability accounts assigned to it meet your needs and
change them, if you need to.

m  Choose how to track the payroll item on T4 and, in Québec, Relevé 1 forms, if it’s
an addition, deduction, or company contribution. If you are not sure how to tax a
payroll item, check with the Canada Revenue Agency, your provincial Minister of
Revenue, or your accountant.

From the Tax Tracking Type drop-down menu, you can choose tracking options for T4 forms only
(listed first), for both T4 and Relevé 1 forms (listed next), or for Relevé 1 special cases (last).

m  Accept the default setting for how to track the payroll item on Record of
Employment forms, unless you fully understand the guidelines from Human
Resources Development Canada and the effect that changing the payroll item will

have.
To learn about... Search the Help index for...
Changing the name of payroll payroll items, editing
items
Adding payroll items payroll items, adding
Adding a payroll item for a payroll items, other tax

miscellaneous tax

Payroll items and expenses

An expense is a debt that you pay as soon as you owe it. Common payroll expenses include
gross pay (e.g. wages before taxes), company-paid payroll taxes (e.g. the employer’s part of
Employment Insurance), and company-paid benefits for employees (e.g. premiums for a
company-paid health plan).

For all payroll expenses, QuickBooks suggests using the Payroll Expenses account. When
you run your payroll, QuickBooks keeps track of your company’s expenses for each
employee. You can then see totals for your expenses on the Payroll Summary report
and on the Profit and Loss Statement.

Keeping track of payroll expenses

You can break down company-paid payroll expenses by job, class, and service item.
Expenses you can break down include:

m salary wages, hourly wages, commissions, and bonuses

® additions and company contributions (employee benefits)

® company-paid payroll taxes
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QuickBooks prorates the employee’s company-paid payroll expenses (i.e. the company’s
portion of CPP/QPP) in the same proportion as the employee’s earnings.

Tracking expenses by customer and job

Some businesses like to see which customers and jobs create the most work and so the most

expenses for them. To track payroll expenses by customer and/or job, do the following:

® In QuickBooks Basic, turn on "Use customer:job tracking" in the Accounting prefer-
ences. (In QuickBooks Pro or better, this option is always enabled.)

Turn on the following Payroll & Employees preference: “Report all payroll taxes by...”

Review your addition, and company contribution payroll items to make sure the
checkbox for “Track Expenses by Job” is selected. (This option is always on for salary,
hourly wage, commission, and bonus payroll items.)

m In QuickBooks Pro and better, set up each employee to use time transfers by selecting
the "Use time data to create pay cheques" checkbox in the Payroll Info tab of their
employee profiles. Then have them assign their work to customer:jobs as they go.

m  When you create a pay cheque for an employee, select the correct customer:job or jobs
from the drop-down menu for all earnings payroll items you enter.

Tracking expenses by class

Some businesses prefer to classify expenses, such as not-for-profit organizations that need
to do fund accounting. To track payroll expenses by class, do the following:

m  Turn on “Use class tracking” in the Accounting preferences.

m  Turn on the following Payroll & Employees preference: “Report all payroll taxes by....”
Then choose whether you want to assign one class to an employee’s entire pay cheque
or to each of the earnings payroll items you use on the pay cheque.

m  Review all of your addition and company contribution payroll items to make sure the
checkbox for “Track Expenses by Job” is selected. (This option is always on for salary,
hourly wage, commission, and bonus payroll items.)

m  When you create a pay cheque for an employee, either select the correct class for the

entire pay cheque or assign a separate class to each earnings payroll item on the pay
cheque, according to the Payroll & Employee preference you chose.

Tracking expenses by service item (QuickBooks Pro and
better only)

Some businesses track expenses by service item to see what types of work they are doing
for customers. (A service item is what you use on sales forms to charge your customers for
services you provide, like labour.) To track payroll expenses by service item, do this:

m  Turn on the following Payroll & Employees preference: “Report all payroll taxes by...”

m  Review your addition and company contribution payroll items to make sure the
checkbox for “Track Expenses by Job” is selected. (This option is always on for salary,
hourly wage, commission, and bonus payroll items.)

Setting up your payroll items I 183



184

v

m In QuickBooks Pro and better, set up each employee to use time transfers by selecting
the "Use time data to create pay cheques" checkbox in the Payroll Info tab of their
employee profiles. Then have them assign the service items they use to customer:jobs
as they go.

m  On each pay cheque you write, associate the service items for the employee with the
customer:jobs he or she worked on.

To learn about... Search the Help index for...

Tracking payroll expenses by cus- payroll, tracking expenses
tomer:job, class, or service item

Payroll items and liabilities

Often, you have to deduct an amount from an employee’s payment and pass it on to the
government or another institution. For example, when you pay an employee, you hold
back the income tax that the employee owes the government and remit that money to the
government later.

These types of deductions are not expenses because the money you pass on comes from the
employee, not your company. Instead, because you temporarily keep someone else’s
money, these deductions are liabilities. Payroll items for liabilities are usually assigned to
the Payroll Liabilities account.

When you do your payroll, QuickBooks calculates how much you owe the government or
other agency for each tax, deduction, and company contribution payroll item and records
it in the Payroll Liability account. With each pay cheque you write, the balance of this
account increases.

When you pay your payroll deductions and other payroll liabilities in the Pay Payroll
Liabilities window, QuickBooks decreases the balance of the liability account.

Combinations of expenses and liabilities

Some payroll items are a combination of liabilities and expenses. For example, the
portion of Employment Insurance (EI) that you withhold from an employee’s pay
cheque is a liability, while the portion that you pay is an expense.

Payroll items for company-paid taxes and company contributions are usually assigned to
both a liability account and an expense account.
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How to set up common payroll items

Payroll Taxes

Fed Qué ROE
. Gross T4 or GSTor ROE ROE
Payroll item Type or Net Inc. CPP  El Inc. QPP RL-1 HST Earn. Hrs. For
Tax Tax orlin
Ontario Employer Health Tax
Québec Health Services Fund Other
Manitoba Payroll Tax Tax N N N N N N N N n/a
Northwest Territories Payroll
Tax
Non-benefit payroll deductions and additions
Fed Qué ROE
. Gross T4 or GSTor ROE ROE
Payroll item Type or Net Inc. CPP  El Inc. QPP RL-1 HST Earn. Hrs. For
Tax Tax orlin
Advance on wages
This payroll item should be
assigned to an asset account,  Add'n Net N N N N N N N N N n/a
not a payroll expense
account.
Advance repayment
This payroll item should be
assigned to the same asset Ded'n Net N N N N N N N n/a
account as the payroll item
for advances on wages.
Alimony or maintenance .
payment (tax deductible) Ded'n Gross Y N N Y N N N n/a
Alimony or maintenance .
payment (not tax deductible) Ded'n Net N N N N N N N n/a
Canade.l Savings Bond payroll Ded'n Net N N N N N N N n/a
deduction
Charitable donation payroll , Box
deduction Ded'n Net N N N N N 46N N n/a
Garnisheed wages Ded'n Net N N N N N N N n/a
Labour-sponsored fund Ded'n Gross Y N N Y N N N n/a
R L B
Reimbursement (one-time Add'n Gross v v v v v ox N N N n/a
repayment) 14/A
. Box
Union Dues Ded'n Gross Y N N Y N N n/a
44/F
Tax allowances and Benefits
Fed Qué ROE
5 Gross T4 or GSTor ROE ROE
Payroll item Type or Net Inc. CPP El Inc. QPP RL-1 HST Earn. Hrs. For
Tax Tax orlin
. Box
Automobile allowances Add'n Gross Y Y Y Y Y 0L N Y N In
Automobile standby charge Co. Box
and operating cost benefits Ctrb'n n/a Y Y N Y Y 34/| Y N N n/a
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Fed Qué ROE
. Gross T4 or GSTor ROE ROE
Payroll item Type or Net Inc. CPP  El Inc. QPP RL-1 HST oy Hrs. For
Tax Tax orlin
Board and lodging, if cash Co Box
earnings paid in the same pay Ctrb.'n n/a Y Y Y Y Y Note 1 Y N For
period 30/H
Board and lodging, if no cash
. Sy Co. Box
earnings paid in the same pay . n/a Y Y N Y Y Note 1 N N n/a
period Ctrb'n 30/H
c Nl ices, incash  .C%, / Y Y Y v Y Box  \ote2 v N |
ounselling services, in cas Ctrb'n n/a a0/L ote n
Counselling services, non- Co. Box
cash Ctrb'n n/a Y Y N Y Y a0/L Note 2 N N n/a
Discounts on merchandise Co. Box
and sales commissions Ctrb'n n/a Y Y N Y Y 40/L Y Y N In
Educational allowances for Co. Box
children Ctrb'n n/a Y Y Y Y Y 40/L N Y N In
i B
Gifts, awards, bonuses, and g, Gross Y Y Y v Y ox N % N In
social events, in cash 40/L
i B
Gifts, awards, bonuses, and g, Gross Y Y N Y % ox Y N N n/a
social events, non-cash 40/L
Group term life insurance Co Box
policies, employer-paid Ctrb.‘n n/a Y Y N Y Y N N N n/a
premiums (Note 7) 4oL
Housing, rent-free or low- Co. Box
rent, in cash Ctrb'n n/a Y Y Y Y Y 30H Note 3 Y N For
Housing, rent-free or low- Co. Box
rent, non-cash (Note 4) Ctrb'n n/a Y Y 4 Y Y 30/H Note 3 N N n/a
Interest-free and low-interest Co. Box
loans (Note 5) Ctrb'n n/a Y Y N Y Y 36/L N Y N In
. . Co. Box
Medical expenses, in cash Ctrb'n n/a Y Y Y Y Y 401L Note 6 Y N In
Medical h co. / Y Y N Y Y Box  \ote6 N N /i
edical expenses, non-cas Ctrb'n n/a a0L ote n/a
Moving expenses and Co. Box
relocation benefits, in cash Ctrb'n n/a Y Y Y Y Y 40/L Y Y N In
Moving expenses and Co. Box
relocation benefits, non-cash Ctrb'n n/a Y Y N Y Y 40/L Y N N n/a
Moving expenses, non- Co Box
accountable allowance over Ctrb.'n n/a Y Y Y Y Y N Y N In
$650 40/L
Municipal officer's expense Co. Box
allowance (Note 7) Ctrb'n n/a Y Y N Y Y 40/L N Y N In
Parking, in cash co. / Y Y Y Y Y Box Y % N |
arking, in cas Ctrb'n n/a a0/L n
Parki h co. / Y Y N Y Y Box Y N N /i
arking, non-cas Ctrb'n n/a 0L n/a
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Fed Qué ROE
. Gross T4 or GSTor ROE ROE
Payroll item Type or Net Inc. CPP  El Inc. QPP RL-1 HST Earn. Hrs. For
Tax Tax orlin
Public health care,
hospitalization, or Co. Box
medical insurance Ctrb'n n/a Y Y N Y Y 40/L N N N n/a
plans, employer-paid
Private health care,
hospitalization, or Ded'n Net N N N N N N N n/a
medical insurance
plans, employee-paid
Private health care,
hospitalization, or Co.
medical insurance Ctrb'n n/a N N N Y Y N N N N n/a
plans, employer-paid
. . Co. Box
Professional fees, in cash Ctrb'n n/a Y Y Y Y Y a0/L Note 8 Y N In
Professional fees, non-cash Co Box
(not taxable if a job Ctrb.'n n/a Y Y N Y Y Note 8 N N n/a
requirement by the company) 4oL
. T Co. Box
Recreational facilities, in cash Ctrb'n n/a Y Y Y Y Y a0/ Y Y N In
Recreational facilities, non- Co. Box
cash Ctrb'n n/a Y Y N Y Y a0/L Y N N n/a
Recreational facilities, club Co. Box
membership dues Ctrb'n n/a Y Y N Y Y 40/L Y N N n/a
Registered Pension Plan , Box
(RPP), employee-paid Ded'n Gross Y N N Y N 20D N n/a
Registered Pension Plan Co. Box
(RPP), employer-paid Ctrb'n n/a Y N N Y N 40/L N N N n/a
Registered Retirement Box
Savings Plan (RRSP), Ded'n Gross Y N Y Y N N n/a
employee-paid 4oL
Registered Retirement Co Box
Savings Plan (RRSP), Ctrb.'n n/a Y Y Y Y Y N Y N In
employer-paid 40/L
Registered Retirement
Savings Plan (RRSP), Co Box
employer-paid but Ctrb.‘n n/a Y Y N Y Y N N N n/a
considered a non-cash 4oL
benefit
Reg_istered Retirement Co. Box
Savings Plan (RRSP), Ctrb'n n/a Y Y Y Y Y Note 8 N N n/a
administration fees 40/L
. . Co. Box
Scholarships and bursaries Ctrb'n n/a Y Y Y Y Y 40/ N Y N In
Spouse's travelling expenses, Co. Box
cash allowance Ctrb'n n/a Y Y Y Y Y 40/L N Y N In
Spouse's travelling expenses, Co. Box
non-cash Ctrb'n n/a Y Y N Y Y a0/L Y N N n/a
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Fed Qué ROE
. Gross T4 or GSTor ROE ROE
Payroll item Type or Net Inc. CPP  El Inc. QPP RL-1 HST oy Hrs. For
Tax Tax orlin
. Co. Box
Stock options (Note 9) Ctrb'n n/a Y Y N Y Y 3L N N N n/a
. Co. Box
Subsidized meals Ctrb'n n/a Y Y N Y Y 30H Y N N n/a
Travel assistance in a Co. Box
prescribed zone (Note 10) Ctrb'n n/a Y Y Y Y Y 32/K Y Y N In
Travelling allowance to part- . Box
time and other employees Add'n Gross Y Y Y Y Y s01L N Y N In
Tuition fees, in cash co. / Y Y Y v Y Box  \otes v N
uition fees, in cas Ctrb'n n/a s0/L ote In
Tuition fees, non-cash c B
e 0. ox
(not taxable if a job Ctrb'n n/a Y Y N Y Y Note 8 N N n/a
requirement by the company) 40/L
Uniforms and special Co. Box
clothing, in cash Ctrb'n n/a Y Y Y Y Y 40/L Y Y N In
Uniforms and special Co. Box
clothing, non-cash Ctrb'n n/a Y Y N Y Y 40/L Y N N n/a
Wage-loss replacement or Co Box
income-maintenance non- | n/a Y Y N Y Y N Y N For
. Ctrb'n 40/L
group plan premiums
) Co. Box
Other taxable benefit Ctrb'n n/a Y Y Y Y Y a0/ N Y N In
Payroll items for GST/HST and QST on benefits
Fed Qué ROE
5 Gross T4 or GSTor ROE ROE
Payroll item Type or Net Inc. CPP El Inc. QPP RL-1 HST Earn. Hrs. For
Tax Tax orlin
GST/HST on Benefits Co.
QST on Benefits Ctrb'n n/a Y Y N Y Y  None na N N na

T The rent portion of the lodging benefit is subject to GST/HST if the dwelling is occupied for less than one month;
the utility portion is subject to GST/HST unless municipality-supplied.

2 Certain counselling services are subject to GST/HST. If the services you pay are subject to GST/HST, include it in
the value of the benefit.

3 The rent portion of the housing benefit is subject to GST/HST if the dwelling is occupied for less than one month;
the utility portion is subject to GST/HST unless municipality-supplied.

41 it is a non-cash benefit, it is insurable if it is received by the employee in addition to cash earnings in a pay
period. If no cash earnings are paid in the pay period, it is not insurable.

5 Enter the home relocation loan deduction under code 37.

6 Some medical expenses are subject to GST/HST. For more information, contact any tax services office or tax
centre.

7 Enter the exempt amount under code 70.

8 Certain fees are subject to GST/HST. If the fees you pay are subject to GST/HST, include it in the value of the
benefit.

9 Enter the amount of the stock option and shares deduction under code 39 or 41, as applicable.

10 Enter the amount of medical travel assistance under code 33.
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Setting

up employees

Use payroll only to pay employees, not subcontractors or owners.

To pay subcontractors, set them up as vendors, have them bill you, and pay them with
the Pay Bills feature. Then you can create a T4A or (Contractor Edition) T5018 report.

To pay owners, use an owner’s draw from an equity account.

Generally, an employee is a person you pay on a regular and ongoing basis to perform
services for your company, using materials and equipment you provide.

If your business is a sole proprietorship or an unincorporated partnership, owners and
partners are not usually employees. If your company is incorporated, corporate officers who
work in the business are usually employees.

If you're not sure whether a person providing services for you is an employee, owner, or
subcontractor, contact the Canada Revenue Agency or your accountant.

To set up employees for payroll, you need to:

m  (Optional but recommended) Set up your employee defaults.

®  Add new employees to your Employee list, or add payroll information for employees
already on your Employee list.

Employee defaults: entering common employee information

Note:

The employee defaults help you set up payroll for several employees quickly. You enter
payroll information that most employees have in common. These defaults then show up
every time you enter information for a new employee. If the information isn’t right for a
particular employee, you can change it for him or her.

You can set up the following information as employee defaults:

m  Salary or hourly wage or commission payroll items (with or without rates of pay)

m  Pay period

m  C(lass, if you're using classes to track your employees

]

Whether you want to record time data for the employee and base pay cheques on it
(QuickBooks Pro and better only)

m  Additions, deductions, and company contributions that appear on pay cheques for
most employees

The order in which you enter payroll items in the Addition, Deductions, and Company Contri-
butions area can affect how QuickBooks calculates each item and income taxes.

m  The province in which your employees work and what payroll taxes they are subject to
m  TDI1 and, in Québec, TP-1015.3 basic amounts

m  How employees will accrue time (such as sick time or time-in-lieu) and vacation pay
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Setting up employees

Note:

Before setting up your employees in QuickBooks, you should create the payroll items you
need for your business (see “Setting up your payroll items” on page 179).

Also, if you've already set up your employee defaults (see “Employee defaults: entering
common employee information” on page 189), QuickBooks can prefill much of the
information when you set up individual employees.

The Employee list contains the names of all your employees. When you add or edit an
employee, you may fill out three sections:

®  Address Info: the employee’s contact information, Social Insurance Number, date of
birth, hire and release dates, and similar information.

If you do not enter an employee’s correct date of birth, QuickBooks cannot calculate Canada
Pension Plan or Québec Pension Plan contribution amounts for him or her.

CPP contributions for an employee will be zero if he or she is not between 18 and 70. (In the year
the employee turns 18 or 70, QuickBooks prorates the calculation according to CRA guidelines.)

QPP contributions for an employee will be zero if he or she is younger than 18.

®  Additional Info: custom fields for tracking any information you prefer.
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m  Payroll Info: this employee’s salary or hourly wages and any additions, deductions, or
company contributions that apply to him or her. You'll need payroll items for most of
this information, which you select in the Item Name column of the tables. If you have
not already set up all the payroll items you need, QuickBooks gives you a chance to add
them as you work.

This tab also contains four buttons for setting up other important parts of the
employee’s payroll information:

Payroll Taxes: the employee’s payroll deductions for income tax, Employment
Insurance, Canada Pension Plan / Québec Pension Plan, and any other payroll
taxes he or she might have to pay. The information from the employee’s TD1 form
goes here (see “Entering information from employee TD1 forms” on page 192).

Direct Deposit: the employee’s bank account number and routing number.

Accrual Hours: how the employee accrues time (such as sick days or time off in lieu
of overtime). Use this window to track how much accrued time an employee has
available and how much he or she has used this year. (See page 195 for important
information about entering Accrual Hours year-to-date amounts.)

Vacation Pay: how the employee accrues vacation pay. Use this window to track
how much vacation pay an employee has available and how much he or she has
used this year. (See page 195 for important information about entering Vacation
Pay year-to-date amounts.)

QuickBooks also provides a “notepad” in which you can make notes about an employee.

To learn about... Search the Help index for...
Adding new employees employees, adding
Changing information about an employees, editing

existing employee

Setting up payroll information for employees, payroll information
an employee

How the order of payroll items pay cheques, affecting amounts
affects amounts on your
employee’s pay cheques

Categorizing employees by class employees, grouping by department
or location
Adding notes for an employee employees, notes about
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If you pay on commission (QuickBooks Pro and better)

If your employees earn commissions for items they sell, after setting them up on the
Employee list, you should also set them up on the Sales Rep list.

When you enter an invoice, sales receipt, or estimate, select the employee’s initials from the
Rep drop-down list on the sales form to give him or her credit for the sale. Then you will
be able to produce reports showing sales by employee.

Pay commission employees with commission payroll items on a pay cheque, not a "regular"
non-payroll cheque. For more information, turn to “Previewing, adjusting, and creating
pay cheques” on page 206.

To track commission sales for owners or partners, add them to the Sales Rep list like
employees, but pay them with an owner’s draw instead of a pay cheque.

To learn about... Search the Help index for...

Paying the owner(s) of a business owners’ draws

Entering information from employee TD1 forms

The Canada Revenue Agency (CRA) requires you, as an employer, to keep a current federal
and provincial TD1 form on file for each of your employees. For Québec employees, you
must keep a federal TD1 form and a provincial TP-1015.3 form on file.

TD1 and the Québec TP-1015.3 forms help employees calculate the personal tax credits they
will claim when they file an income tax return. The totals from these forms tell QuickBooks
how much income tax it should deduct from the pay cheques you create for an employee.

Most employees should fill in both the federal TD1 form (Personal Tax Credits Return) as

well as the TD1 form for the province they work in. Employees who work in Québec should
fill in a federal TD1 form and a provincial TP-1015.3 form. You can download blank TD1

forms from the CRA web site (http://www.ccra-adrc.gc.ca/) and blank TP-1015.3 forms from
the Québec Minister of Revenue web site (http://www.revenu.gouv.qc.ca/).

Some employees who are paid on commission and who claim their business expenses may
ask to use Form TD1X (Statement of Commission Income and Expenses for Payroll Tax
Deductions). In this case, you should consult your accountant as you will have to perform
special payroll calculations for this employee.

An employee’s TD1 and/or TP-1015.3 forms must be updated within a week of any change
in his or her tax status. You and your employee share the responsibility for keeping these
forms current. An employee should fill in new personal tax credit forms when:

m they are hired.

m the employee wants to change the tax credits he or she is claiming. For example, say
that an employee becomes a student and wants to claim the student tax credit. He or
she should complete new tax credit forms within a week of the change.
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m the federal or provincial tax credit amounts change. In this case, QuickBooks notifies
you that your employees' TD1 and TP-1015.3 claim amounts need to be updated, and
you should update the forms as soon as possible.

According to the CRA, it is a serious offence to knowingly accept a Form TD1 that contains false
information. If you think an employee is entering incorrect information, contact the CRA.

After your employees have completed these forms, you need to copy the total claim
amounts from them into QuickBooks. QuickBooks will then withhold the correct amounts
of income tax from their pay cheques.

To enter an employee’s TD1 tax credit claim into QuickBooks:

1 In the employee's profile, click the Payroll Taxes button (in the Payroll Info tab).

2 From the Tax Table drop down list, choose the province or territory where the
employee works (not where the employee lives or where your company is located).

3 In the Subject To area, do the following:

m In the Federal TD1 field, enter the total claim amount (Line 12) from the
employee’s federal TD1 form.

m If the employee wants you to hold back extra income tax from his or her pay
cheques (say, to avoid paying a large sum when filing a tax return in the spring),
enter the amount to withhold from each pay cheque in the Additional Tax field.
You can only enter a dollar amount, not a percentage.

m In the Provincial TD1 field, enter the total claim amount from the employee's
provincial TD1 form (Line 12) or, in Québec, TP-1015.3 form (Line 20).

4 Click OK.

Often, employees only claim the basic amount. If your enter the basic amount into your Employee
Defaults, QuickBooks will prefill it when you set up payroll for an individual employee.

To learn about... Search the Help index for...

Setting up TD1 information for an TD1 forms, employees
employee

Entering default TD1 information TD1 forms, employee defaults

Setting up TP-1015.3 information TP-1015.3 forms
for an employee
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Summarizing amounts for this year to date

Note:

Skip this section if your company has not done payroll before or has not issued any pay cheques
so far this year. You are ready to start writing pay cheques.

If you're just starting to use QuickBooks for payroll and you've already issued pay cheques

in the current calendar year, you need to:

m  Enter year-to-date information to summarize your payroll transactions from January 1
up to your QuickBooks start date. (For information about start dates, see “Determining
a start date” on page 17.) You will need a summary of the transactions for each
employee and also one of any payments you've made for your payroll liabilities.

m  Enter your payroll transactions (pay cheques and liability cheques) for the period
between your QuickBooks start date and today.

A wizard will help you enter your year-to-date (YITD) information. To start it, from the
Employee menu, choose Enter YTD Amounts. After you've entered your YTD information,
QuickBooks updates it as you issue pay cheques during the remainder of the payroll year to
keep your payroll tax amounts correct.

Entering year-to-date summaries for each employee

194

For each employee (both current and former) you paid during the current calendar year,
you must enter a summary of his or her earnings and the amounts you deducted from it.
The summary should cover the period from January 1st of the year to the day you started
using QuickBooks. In the summary, include gross pay, income tax, Employment Insurance,
Canada Pension Plan or Québec Pension Plan, and any other amounts you tracked by pay
cheque from January 1st to your QuickBooks start date.

You need to enter both the amounts you withheld from the employee’s earnings and the
amounts that your company paid as a result of the employee’s earnings. For example, you
must enter both the employee’s and employer’s parts of CPP/QPP and EI.

Depending on how you've kept your records, you can enter amounts summarized by
month, by pay period, or for the entire year to date.

As you work though the Enter YTD wizard, it asks you to select the employee whose
year-to-date information you want to enter. When you click Enter Summary, QuickBooks
displays each payroll item you entered in that employee’s profile.

Filling in the Year-to-Date window:

m In the Salary and Hourly Wages area, enter payroll items for hours worked during the
period and amounts paid out for this work. This way, hourly totals will appear on
payroll reports and the employee's Record of Employment. Also enter any commissions
or bonuses paid out to the employee during this period.

m  Also in the Salary and Hourly Wages area, enter vacation pay and accrued time (such
as sick time) taken during this period and what you paid out for them. Do not include
these amounts in your totals for regular salary or hourly wages:
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Entering accrual time year-to-date amounts:

a

To insert a payroll item
above another, press
CTRL+INSERT.

You can skip over items
not used in this period.

In this area, enter totals
for all other earnings,
withholdings, and
company-paid taxes or
payroll expenses for
this employee.

Include taxes regardless

of whether you have
paid them yet.

In the employee’s profile, enter the amount of accrual time that the employee has
available as of the first day of this year, not what he or she has available now. See

“Setting up employees” on page 189.

In the Salary and Hourly Wages area of the Enter Year-to-Date Amounts window,

enter:

- in the Hours for Period column, the number of accrual hours that
the employee used this period, and

- in the Period Amount column, the total amount you paid out for

those accrual hours.

Be sure to use the correct payroll items: Sick Salary for a salaried employee or Sick
Hourly Rate for an hourly employee.

C

After you finish entering year-to-date information, go back to the employee's
profile and confirm that the accrual hours are correct. They should now take your

year-to-date entry into account.

Entering vacation pay year-to-date amounts

a

In the employee’s profile, enter the amount of vacation pay that the employee has
available as of the first day of this year, not what he or she has available now. See

“Setting up employees” on page 189.
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b In the Salary and Hourly Wages area of the Enter Year-to-Date Amounts window,
enter:

- inthe Hours for Period column, the number of vacation hours that
the employee used this period, and

- in the Period Amount column, the total amount you paid out for
those vacation hours.

Be sure to use the correct payroll items: Vacation Salary for a salaried employee or
Vacation Hourly for an hourly employee. If the employee did not take vacation so you
paid out the vacation pay owing, make the entry using VacPay Accrual Paid Out or
VacPay Paid Out. (Only one of these payroll items appears depending on how you set
up your employees.)

¢ In the Other Employee and Company Payroll Items area of the Enter Year-to-Date
Amounts window, enter the amount of vacation pay that the employee accrued
this period using the VacPay Accrued payroll item.

d After you finish entering year-to-date information, go back to the employee's
profile and confirm that the vacation pay amount is correct. It should now take
your year-to-date entry into account.

In the Other Employee and Company Payroll Items area, enter totals for all other
earnings, withholdings, company-paid contributions, and payroll expenses for this
employee for this period. Enter all liabilities created because of compensation paid,
even if you have already paid them or they were company expenses. For example, if
you provide an employee benefit and track it as a payroll expense for each pay period,
you must enter amounts for this employee in this window. Later, you will also enter
the amounts you've already paid towards this liability so that QuickBooks can keep
track of how much you still owe. You do not have to enter non-payroll adjustments
such as reimbursements for office supplies.

In this area, also enter all accrued taxes for this employee regardless of whether you
have paid them yet. These include the amounts for the employee and company portion
of CPP/QPP and EI. Enter separate amounts for the employee and company portions
of CPP/QPP and EI. QuickBooks uses the employee amount to track employee with-
holding; it uses both amounts to track your total payroll liability.

If you decide to track company-paid expenses, such as insurance, as a payroll expense
for each pay period, you must enter amounts for the employee in the Other Employee
and Company Payroll Items area of this window. Later in the wizard, you must also
enter amounts you paid, so that QuickBooks can keep track of how much you owe.

Also in the Other Employee and Company Payroll Items area, enter vacation pay
earned or accrued. (See "Entering vacation pay year-to-date amounts," above.)

Leave the Period Amount field blank if there was no amount for the payroll item you
are entering during this period. (Do not enter $0.00.)

After you've entered the amounts for this period, click OK to finish. If you have another
period to enter, click Next Period instead.
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Option

To learn about... Search the Help index for...
Entering YTD amounts for year-to-date amounts, employee
employees

Should my YTD information affect my accounts?

When to choose

Do not affect accounts Most people should choose this

option at setup.

= You need to enter all your account
opening balances in QuickBooks as
of your start date, and you do not
want these amounts to change the
balances of your accounts.

m If your start date is midyear, and
you make an adjustment for all
income and expense accounts, you
do not want these amounts to
affect that adjustment.

What QuickBooks does

Affects no balance sheet accounts
and adds no expenses.

Adjusts year-to-date amounts to
print on pay cheques; to display in
payroll reports; and to observe
annual limits for taxes, deductions,
and additions.

Affect liability and You may want to choose this option
expense accounts but  at setup if you have never used a pay-
not the bank account roll liability account before, and you

want a correct balance in the account.

This option is also appropriate after
you start using payroll if you need to
adjust the amount owed for a payroll
item.

Enters an increase in each liability
account associated with a payroll
item used for the period.

Tracks an expense for each
expense account associated with a
payroll item used for the period.

Enters a decrease in the Opening
Bal Equity account for the net
amount paid the employee during
the period. (This adjustment keeps
your books in balance.)

Affect liability,

You are unlikely to want to choose

expense, and bank this option at setup since it affects

accounts

your bank account balance.

Enters a payment in the designated
bank account for the net amount
paid the employee during the
period.

Enters an increase in each liability
account associated with a payroll
item used for the period.

Tracks an expense for each
expense account associated with a
payroll item used for the period.
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About wage bases

A "wage base" is the portion of an employee’s earnings that’s actually used to calculate
payroll withholding amounts. It does not include any earnings or wages that may be tax
exempt. It’s also called taxable income, insurable earnings, or pensionable earnings.

For every government-withholding payroll item (such as income tax, CPP/QPP, and EI) in
the lower half of the YTD Adjustment window, QuickBooks tracks the employee’s wage base
for reports. You can view the employee’s wage bases by clicking Show Wage Bases.

QuickBooks calculates wage bases for government withholding amounts in this way:

m  First, it totals all salary, hourly wages, and commissions.

m  Then it adds the payroll items that increase the gross amount.

= Finally, it subtracts the payroll items that decrease the gross amount.

If the year-to-date total of a wage base for a withholding amount exceeds the maximum
annual earnings limit for that withholding amount, the wage base equals the maximum

earnings limit. If you entered amounts for earlier periods this year, QuickBooks counts the
wage base from the earlier periods towards the maximum.

To learn about... Search the Help index for...

Wage bases wage base

Entering year-to-date summaries of liability payments

198

Note:

Skip this section if your company has not made any payments for payroll withholdings (such as
deducted income tax) this calendar year.

For this adjustment, you'll need to know how much you paid from January 1 of this year

up to your QuickBooks start date for each of the following:

m Income tax and other payroll withholding amounts (Employment Insurance, Canada
Pension Plan or Québec Pension Plan, and other payroll taxes), whether withheld from
employees or paid as a company expense.

m  Each deduction you withheld and then paid (for example, for benefits such as an
employee-paid dental plan).

m  Fach company contribution you paid (for example, for benefits such as a company-
paid health plan).

This adjustment is just for your payroll liabilities and your expenses for employer-paid
payroll withholding. It is not for expenses paid directly to employees (such as salaries,
bonuses, or hourly wages).
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Entering YTD liability payments

To learn about...

for...

payments

Search the Help index

year-to-date amounts, liability

Making sure your payroll data is complete

Typethe ending date
of the period you are

Because QuickBooks bases new payroll transactions on existing ones, it’s very important
that you enter all of your payroll data accurately. After you set up your payroll information
in QuickBooks, you should make sure that it is complete and correct.

Search the
Procedure Comments Help index v
for...
Review your Employee list. The Employee list should include employees, reports |
names of all employees on your payroll  about
at any time during the current calendar  |ists, printing
year (even if they have now left).
Review your employees’ dates  Each employee’s profile should include  employees, editing N
of birth. his or her date of birth. Otherwise,
QuickBooks cannot calculate Canada or
Québec Pension Plan amounts for that
employee.
Review an employee contact The report should include Social employees, reports |
list report. Insurance Numbers, addresses, and about
phone numbers for all employees.
Review your Payroll Item list. The Payroll Item list should list payroll, reports |
everything you need to track on about
a pay cheque. lists, printing
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Procedure Comments Help index v
for...

Review your payroll summary  You should be able to match the employees, reports |
for all employees for this amounts for payroll items in Quick- about
entire calendar year. Books with amounts in the payroll

accounts of your prior payroll system.
Review your a payroll You should be able to match the payroll, reports |
liabilities as of December amounts for payroll items in Quick- about
31st of this year. Books with amounts on the liability

report of your prior payroll system.
Print a balance sheet as of It should match the balance sheet from  balance sheet, |
December 31st of this year. your prior accounting system as of reports

December 31 of this year.
Print a balance sheet as of It should match the balance sheet from  balance sheet, |
December 31st of last year. your prior accounting system as of reports

December 31 of last year.
Print a profit and loss state- It should match the profit and loss profit and loss |

ment for the entire calendar
year.

statement from your prior accounting
system for the entire calendar year.

reports

Managing payroll and employee information

As your business grows and changes, you will probably find it necessary to add or remove
payroll items, hire and sometimes release employees, and track additional information
about your payroll.

Changing payroll item information

By default, the Payroll Item list is organized by payroll item type. Earnings items (for yearly
salaries, hourly wages, and commissions) are at the top of the list. To re-sort the list, click a
column header.

You can use the same payroll item for many employees. For example, you can customize

the amount or percentage of earnings payroll items in the setup window for each employee

to allow for different rates of pay.

You can change the information for existing payroll items, although you probably do not
want to change whether the item is subject to income tax, how it appears in T4 and Relevé

1 forms, or how it is mapped to Record of Employment forms. You may want to change a
payroll item, for example, because

m The annual limit for a deduction changes.

®  Your accountant wants you to assign it to a different account.

200
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Changing

You can’t delete the payroll items for income tax and other government deductions that
QuickBooks creates for you, but you can hide these items if you don’t use them.

To learn about... Search the Help index for...

Changing payroll items payroll items, editing

What the changes to payroll items affect

Changes you make to payroll items are reflected in the new pay cheques you write. Certain
changes can also affect how payroll amounts are classified historically on tax forms, reports,
and pay cheque details.

Employee information and existing pay cheques are affected when you change any of the
following information for payroll items:

m  Payroll item name

m  Account(s) assigned to it (liability or expense)

m  Assigned box on T4 or Relevé 1 forms or its mapping to Record of Employment forms
Changing the following information affects future pay cheques only, unless you change an
existing pay cheque so that QuickBooks recalculates it:

m  Payroll taxes affected (for additions to or deductions from gross pay)

m  How the payroll item is calculated on the pay cheque

To learn about... Search the Help index for...

Making payroll items inactive, lists, hiding and showing entries
hiding them, or showing them

Deleting payroll items payroll items, deleting

Merging payroll items lists, merging two entries

employee information

You can change an employee’s personal or payroll information whenever necessary. The
changes will affect all future pay cheques you write to him or her. Changes to an employee’s
name, address, or Social Insurance Number are reflected in previously-written pay cheques
but do not affect the amounts of those pay cheques.

These types of information must be changed individually for each affected employee.
Changing the associated payroll item doesn’t affect the employees who use it.
®  Annual limits for a deduction.

m  Rate or amount changes for a deduction, addition, company contribution, or other tax
item.
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Note:

Change the information in the employee defaults first. In many cases, QuickBooks asks if you
want to also change the information for all matching employees.

QuickBooks also provides a notepad with which you can make notes about an employee.

To learn about... Search the Help index for...
Changing employee information employees, editing

Giving an employee a raise employees, raises

Adding custom fields for an employees, custom fields for
employee

Hiring and releasing employees

When you hire a new employee, add the employee to the Employee list (see “Setting up
employees” on page 190). If you have set up employee defaults (see page 189), this
information is copied from the defaults into the new employee profile. Then, if you need
to, you can change any of the information for this particular employee.

When an employee leaves the company, you need to enter the employee’s release date
into his or her profile and select the reason the employee is leaving from the Record of
Employment code drop-down list.

I's a good idea to enter a release date for an employee only after you have written his or her final
pay cheque. Once you enter a release date in the employee’s record, QuickBooks doesn’t display
the employee’s name in the Select Employees To Pay window when the pay period end date is
later than the release date.

You can’t delete a released employee if there are payroll transactions for him or her. You
can; however, make the employee inactive to hide his or her name in the Employee list.

Preparing a Record of Employment

When an employee leaves or is terminated or laid off, you must issue him or her a Record
of Employment (ROE) form within five calendar days. The ROE determines whether the
former employee qualifies for Employment Insurance benefits. The employee should
receive one copy and Human Resources Development Canada (HRDC) should receive one.

QuickBooks provides a report to help you fill in an ROE that looks the same as an ROE form
from HRDC. However, because HRDC requires that ROE forms have a unique serial number,
you cannot print an ROE form directly from QuickBooks or download blank ROE forms
from the HRDC Web site. Instead, you must copy the information from QuickBooks to an
official, blank ROE form or to HRDC software for creating these forms. You can order these
from the HRDC Web site.
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To prepare an ROE report:

1

From the Employees menu, choose Process Record of Employment.

®  QuickBooks may ask if you want to review Payroll Item Listing report (see “Trou-
bleshooting an ROE report:”, below) to confirm that your payroll items are set up
correctly. Click Yes to review the report or No to go on. If you click Yes, when you
are finished with the report, close it and perform Step 1 again.

2 Choose the employee who is leaving, then click OK.

Troubleshooting an ROE report:

QuickBooks uses payroll items to generate ROE reports. That means your payroll items must
be set up and used properly before the report will provide the information you need. Before
creating an ROE report, you should:

confirm you have entered the employee’s release date in his or her profile, selected the
reason the employee is leaving from the ROE code drop-down list, and clicked OK in
the employee profile to save your changes.

review the way your payroll items map to ROE forms, if you changed from the default
settings in the payroll item wizard. (Note: Intuit recommends not changing from the
default settings.) Create a Payroll Item Listing report (at the bottom of the Payroll Item
list, click the Reports menu button, then select Payroll Item Listing) and look in the
ROE Period column (you may have to scroll to the right to see it):

- Most payroll items should be mapped as "For which they are paid." This option
means you are assigning the employee’s earnings to the pay period during which
the employee actually did the work, even if you are paying for that work later. For
example, an employee earns his or her salary or hourly wages when he or she does
the work for you, not when you issue his or her pay cheque two weeks later.

If you have no payroll items mapped with the "For which they are paid" option,
QuickBooks cannot create an ROE report.

- Some payroll items can be mapped as "In which they are paid." This option means
you are assigning the employee’s earnings to the day you issued the pay cheque,
regardless of when the employee did the work. For example, if you give an
employee a bonus, HRDC believes that you are not rewarding any specific hour or
day of work — just his or her performance in general. Therefore, the employee is
considered to have earned the bonus on the day you issue the cheque for it.

If your payroll items are not mapped to the ROE properly, in the Payroll Item Listing
report, double-click the payroll item to change. QuickBooks starts the payroll item
wizard. Click Next until you reach the Record of Employment Tracking screen, then
choose the correct options for this payroll item. Click the Help button in the payroll
item wizard for more information.

confirm you have used the correct payroll items to pay the employee, so that he or she
has "For which they are paid" payroll items QuickBooks can use to calculate the ROE.
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To learn about... Search the Help index

for...
Hiring a new employee employees, adding
Releasing an employee employees, releasing

Creating a Record of Employment record of employment
for an employee

Hiding, showing, or merging employees

You can'’t delete an employee who has existing payroll transactions. Instead, you can hide
an employee on the Employee list by making the employee inactive.

When you make an employee inactive, QuickBooks keeps the information for the employee
but hides the employee’s name on the Employee list and removes it from most drop-down
lists that use employees. However, the employee’s payroll figures still appear on payroll
reports. You do not need to change or delete any transaction that uses the employee. You
can make an employee active again at any time.

If the same employee appears in your Employee list twice, you can merge the two names if
there are no payroll transactions for either instance. Merging employees is not reversible.

To learn about... Search the Help index for...

Making employees inactive, hid- employees, hiding and showing
ing them, or showing them

Merging employee names employees, merging two names

Deleting an unused employee employees, deleting

Contacting your employees by mail

In all QuickBooks editions except Basic, you can use your QuickBooks data in conjunction
with prewritten Microsoft Word letters to mail your employees notices about such matters
as accrued vacation and sick time.

To learn about... Search the Help index

for...
Using your QuickBooks data with letters using QuickBooks data in
Microsoft Word letters Microsoft Word
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Running payroll and paying taxes

Note: Before you begin writing pay cheques, be sure that your payroll system is set up completely and
correctly (see page 175). Also, go online to get the latest payroll update, which includes the most

current tax information available.

Selecting employees to pay

To select which employees you want to pay:
m  From the Employees menu, choose Pay Employees.
QuickBooks draws

the cheque from this
bank account.

If all your employees are salaried and
receive a standard pay cheque for this
pay period, select this option.

If you enter hours worked, commission bases,
vacation pay, accrued time, or other variations
from pay period to pay period, select this option.

If you print cheques,

2. Select Employees To Pay Ask a help question

select this checkbox.
Y
' Cree Cptons e ]
If you write them \ \ - ® Enter hours and preview cheque Sieste
by hand, clear the Bank Account | Chequing Accourt - before creating.

checkbox and enter
the number of the first
cheque in the field.

The Pay Period Ends
field shows the next
date that an employee
inthe list should be paid
according to the pay
frequencies you set up.
If you have not yet paid
an employee in the list,
the field shows today’s
date.

The cheque field

defaults to today’s date.

O To be handwritten
or direct deposited

First Cheque Mu. .. @) Create cheque withauk preview
using hours below and last quantities.

[ Creae |

Eheque 26/08/2003 Pay Period Ends |28/08/2003 )
Send Direct Deposit
S Employves Pay Period Rate Hours Lask Date |
J|Carol L Walking Tonthly 1,000.00 1072003 e
J |Richard Black. Biveeekly 1,000.00 31/07)2003
\ \ _~
\

\

QuickBooks creates a pay cheque for each employee
you select. You can sort the list by either the
employee’s first or last name, according to the setting
in Payroll and Employee Preferences

When you create a pay cheque,
this date changes to the next
pay period end date.

When you've selected the employees you want to pay, click Create to display pay cheque
information for the first employee.

Tip:

You can pay employees in groups. For example, first select all of your salaried employees whose

pay cheques you don’t need to review and the "Create cheque without preview" option, then click
Create. Next select your hourly employees and the "Enter hours and preview" option, then click
Create. The pay cheques of the hourly employees appear so you can enter their hours worked.
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Previewing, adjusting, and creating pay cheques

When you select Enter hours and preview cheque before creating in the Select Employees To
Pay window, then click Create, QuickBooks displays the Preview Pay Cheque window.

T N - - - -~ s~ oo ] To prevent vacation
If the employee is \E% PayPeiod [1zi01j2005 |- [1znsro: || | pay and accrued
paid by the hour, type | Eanings e —— s A— o H hours from accruing
K Cetomerdol s -
or edit the number of 7 =] 100000 = LE‘ on this pay cheque
Sick Avail frs] [ 000 f
hours worked at each vacatonaval I nog| | only (for example, if
rate of pay. et l“f;lm 2| | itisacommission or
ac. Accrue
(QuickBooks Pro fills T Dorstacae bonus pay cheque),
in hours worked Other Payroll ltems Emplayes Summary ~ select this checkbox.
either from time data Item Name Fiate Quantity :‘ ~ ltem Name Amount YTD
Urion Dues 14.00] | Ky 1.000.00 Y
or from the last pay — Unien Duse 140
h ) / CFP - Emplopee 762
cheque. El - Employee 240
| \Federallrceme Tax 74.70)
If an addition, /sm/anysummaw
deduction, or @y—A:“;;ﬂe:ame s i The Empl
company contri- CFP - Company 2762 1048 N\ Ihe ployee
buti is b d El - Company 32.60) 134.40 Summary shows
ution Is based on = .
. N — — =l | wages, commis-
quantity, enter the (7| [Cheaue Amaun:

sions, withheld
amounts, and other
additions and

quantity here. / e |

The Company Summary shows company- The cheque total. deductions that
paid taxes and contributions that do not print on the voucher
affect the amount of the pay cheque. of the cheque.
m QuickBooks is more accurate than printed tax tables.
You may notice differences between the calculations in QuickBooks and the CRA’s

printed tax tables for different wage brackets. Because QuickBooks uses a very accurate
method to calculate withholding amounts and tax tables that are annualized (rather
than weekly, biweekly, or monthly), it may differ from printed tables by a few dollars.

In the Preview Pay Cheque window, you can do all of the following:

m  View the amounts QuickBooks calculated for each payroll item (including gross
earnings, government withholding, and all other additions, deductions, and company
contributions) for the pay cheque.

Type or edit the number of hours worked.
Enter accrued time or vacation pay, or prevent these from accruing on this pay cheque.

Enter the base quantity on which to calculate commissions and additions, deductions,
or company contributions that are based on quantity.

®  Add or delete wage, commission, bonus, addition, deduction, or company contribution
payroll items. (You cannot delete "other tax" payroll items in this window.)

Note: To suppress payment of regular salary on a bonus cheque, delete the salary item in the Preview
Pay Cheque window (select it and press CTRL+DEL) or edit the amount of the salary to zero in
the Rate column.
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Edit the amount for any payroll item.

After reviewing the employee’s pay cheque, click Create to go on the next employee, or, if
you've paid all your employees, return to the Select Employees to Pay window.

If you're using direct deposit, when you click Send Direct Deposit after you've entered all of
your employees’ pay cheques, QuickBooks asks if you want to send the pay cheques to the
payroll service now. Click OK to go online and send the pay cheques.

When you pay an employee, QuickBooks does the following:

Updates the pay period end date of the last cheque written for the employee.

Creates a pay cheque for your employee for the net amount, showing the deductions
in the voucher area, or a direct deposit payment to be sent to the payroll service later.
Increases or decreases the employee’s accrued time by the number of hours and
vacation pay by the amount entered for the pay cheque.

If you selected the Do not accrue checkbox in the Preview Pay Cheque window, you
prevented the accrued time and vacation pay from accruing for this pay cheque only.
Updates year-to-date balances for the employee.

Draws the amount of the pay cheque from the bank account you chose.

If you are using direct deposit, QuickBooks does not draw the amount from your
account until you go online and send the pay cheque to the payroll service.

Records an increase in each affected liability account, showing the extra liability
resulting from this payroll transaction (for both the employee’s pay cheque deductions
and company contributions).

If you are using direct deposit, QuickBooks increases your Direct Deposit Liabilities
account, which returns to a $0.00 balance after you go online and send the payment
to the payroll service.

Updates and tracks your payroll expenses in expense accounts.

Updates any other accounts you have assigned to any payroll items used in the payroll
transaction.

To learn about... Search the Help index for...

Previewing and adjusting pay cheques, checking amounts in
pay cheques
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Reviewing and correcting pay cheques

After you've recorded a pay cheque, you can review it at any time. You should rarely need
to make changes to pay cheques or void them, but you can do so if necessary (from the
Employees menu, select Edit/Void Pay Cheques).

For example, you may want to:

m  Void a pay cheque if there was a payroll error in a recent pay cheque that your
employee has not yet cashed.

If you file payroll tax forms (such as a PD7A) for the period covering a pay cheque, then void that
pay cheque, you may have to re-file your tax forms. It may be easier to write a “regular’ cheque
(using the Write Cheques window) to the employee for the difference and adjust your payroll
liability amounts manually, but you should consult your accountant before doing so.

m  Delete a pay cheque if it is a duplicate and you haven't printed it yet.

To learn about... Search the Help index for...
Editing existing pay cheques pay cheques, changing

Voiding pay cheques pay cheques, voiding

Deleting pay cheques pay cheques, deleting

Printing pay cheques and pay stubs

208

Tip:

You can print all your pay cheques at one time, but you must print them separately from
other cheques. Set up your printer for pay cheques the same way as for other cheques.

For information about aligning pay cheques in your printer, see “Solving printing problems” on
page 132.

If you don’t print pay cheques with vouchers, you can print pay stubs for your employees
instead, from the same screen (the Select Employee to Pay window). Like pay cheques, pay
stubs provide all required legal information, including:

m  The employee’s full name, address, and Social Insurance Number.

m  Pay period start and end dates.

m  Salary or hourly rate and hours, and amount of pay for the pay period.
]

Government withholding amounts (such as income tax, EI, and CPP/QPP), and other
deductions from and additions to wages.

m Taxable company contributions, such as the taxable portion of company-paid group
life insurance.

(Optional) Accrued time and vacation pay used and remaining.
Net pay.

Year-to-date amounts for the preceding items.
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To select what information appears in voucher pay cheques and pay stubs, click the Printing
Preferences button in the Payroll & Employees preferences (from the Edit menu, select
Preferences, select Payroll & Employees from the options on the left, and click the Company
Preferences tab). QuickBooks prints pay stubs in portrait format.

Employees who are set up for direct deposit should receive an Advice of Deposit form
instead of a pay stub.

For information on purchasing blank voucher cheques, pay stubs, or Advice of Deposit
forms from Intuit, visit the Web site at http://www.intuitsupplies.ca/

To learn about... Search the Help index for...
Printing pay cheques pay cheques, printing

Printing pay stubs pay stubs

Creating direct deposit payments pay cheques, direct deposit

Paying

payroll liabilities and filing payroll forms

When it’s time to pay your payroll liabilities, QuickBooks shows you how much you owe
and to whom, lets you choose which liabilities to pay, and creates the cheques for you. It
also helps you fill in the forms to send to the government with your payment.

Some types of businesses and businesses in some regions have to complete different payroll
forms from the ones discussed here. Be sure to discuss your business with the CRA and your
accountant to ensure your payroll meets all the regulations that apply to it.

Step Procedure

1 Create a Payroll Liabilities report (from the Reports menu, select Employ-
ees & Payroll, then Payroll Liability Balances) to see how much you owe,
to whom, and for what.

2 Adjust the amounts you owe, if necessary. (It usually isn't!)

3 Use the Pay Payroll Liabilities window to create cheques for the amounts
you owe.

4 Fill in a PD7A form to send to the CRA along with your payment.

5 In Québec, fill in a TPZ-1015 form to send to the Minister of Revenue with

your payment.
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Enter the date
you want this

Adjusting a payroll liability

In rare cases, you may find that the amount for a payroll item tracking a liability doesn’t
match what you actually owe. For example, there may be a discrepancy due to rounding.
You can adjust your payroll liabilities with the Liability Adjustment window.

1 From the Employees menu, choose Process Payroll Liabilities, then Adjust Payroll Liabil-

adjustment to adjustment is for:

affect your
payroll liability
account.

Select a payroll—T]

item to adjust.

?

@

ities.
Date [12/15/2005 | Effective Date [12]15/2005 | Mext: Adjustment |
/ Prev Adjustment |
€ Company (% Employes  [Alison Logan-Smith x| s -l
—
Taxes and Liabilities

Item Marme Amaunt IMema oK |

Federal Income Tax 27,59 |CCRA Adjustment =
- Cancel |
Accounts Affected. ., |
Show Wage Bases, .. |

=]

Enter the amount of the
adjustment.

A positive amount increases
what you owe. A negative
amount reduces what you owe.

For example, if the Liability by
Payroll Item report says that
you owe $450 but you know
you owe $477.89, enter the
difference: 27.89.

2 (Optional) Click Accounts Affected to select how the adjustment will affect your
accounts.

m If your liability and expense accounts have the wrong totals as well as your liabil-
ities (the usual case), you should choose to affect your accounts.

m  If your liabilities are wrong but your liability and expense accounts have the

correct totals, choose to not affect your accounts.

3 Click OK.

4  If you chose to affect your liability and expense accounts in Step 2 and the payroll item
you are adjusting is used to withhold amounts from pay cheques, QuickBooks asks you
to choose an expense account to adjust so your accounts will be balanced.

Type the name of the expense account you want to adjust, then click OK. (Most people
choose Payroll Expenses.)

To learn about...

Adjusting payroll liabilities

Search the Help index for...

payroll liabilities, adjusting
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The window show:

month that are not yet paid. Change these dates if you
pay more than once a month.

If you use QuickBooks _|

to print cheques,

select this checkbox.
If you write cheques

by hand, clear it.

This is the date the /

transaction affects
your chequing
account.

Select this checkbo
to show all payroll

liabilities for the

period, including any

credits and zero
amounts.

Creating a cheque to pay your payroll liabilities

Most businesses must send a cheque to the CRA for last month'’s payroll deductions by the
15th of the current month. Check with the CRA or your accountant to see what's right for
your business. Then consider setting up a reminder note in the To Do list.

To pay your payroll liabilities:

Always use the Pay Payroll Liabilities window to write cheques for your
payroll liabilities.

Do not use the Write Cheques window! If you do, QuickBooks does not update your
payroll liability accounts, and your payroll reports will not be accurate.

1 From the Employees menu, choose Process Payroll Liabilities, then Pay Payroll Liabil-
ities.

2 Type the date range for the liabilities you want to pay, then click OK.

Check these dates carefully as QuickBooks uses them to create the PD7A report. You use this
report to fill in a PD7A form to submit with your liability payment each month.

3

In the Pay Payroll Liabilities window, mark the payroll items you want to pay.

These liabilities can be selected and paid only as a group: CPP Employee, CPP
Employer, EI Employee, EI Employer, Federal Income Tax Withholding, and other
federal withholding items.

QuickBooks displays
this date on the
liability cheque as the
paid-through date.

s liabilities owed as of the end of last Click here to generate a Payroll

Liabilities report for this period.

sk a help quesin | Ask]]  How Do 17 [ |

Create |

Cancel

=, Pay Liabilities

£ Create liahilly cheque
without reviewing

" To be printed

iChequing Accounk

- pos (& Review liability chegue to

Cheduing J enter expensesipenalties Report |
Payment Date

I Mark all
12/15/2003 E how Payroll Lisbilities

/ [ Dates  |ECTLT From  [11/01/z003 E Through |11/30/2003
Sort By IPayahIa Ta ~
Vi Payroll Item Paryable To Ak, Due Ak, To Pa

Mark the liabilities
you want to pay.
QuickBooks creates
one cheque per
liability payee (like
the Receiver
General), not one
cheque per liability.

To add a name that's
missing in the
Payable To column of
this window, edit the
payroll item.

559,25
559,25
447,34
319,52

1,696.13

(CPP - Company Receiver General 0,00
PP - Employes
EI - Companry
E1 - Employes

Federal Incame Tax

Receiver General J
Receiver General

Receiver General
Receiver General

.

60,549.74 |

3.581.49 0,00

I show all lisbilties Ending Bank Balance

A
If you want, you can
change the amount
you're paying in this
column.
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Select whether you want to review the cheque(s), then click Create.

m  After you create a cheque, the Payroll Liabilities report shows a decrease in the
amount you owe to reflect the payment. However, the PD7A Summary report
shows the amount you owed for the period regardless of payments you've made.

To learn about... Search the Help index for...
Paying payroll liabilities payroll liabilities, paying
Adding a name missing in the payroll items, editing

Payable To column

Creating a report that shows your payroll, reports about
payroll liabilities

Entering a discount for payroll payroll liabilities, discounts
liabilities

Entering a penalty for payroll payroll liabilities, penalties
liabilities

Entering a refund cheque for payroll liabilities, refund cheque

overpayment of payroll liabilities

Creating a PD7A report

Along with your monthly payment to the CRA, you need to submit a PD7A (Current Source
Deductions Remittance) form. On this form, you report the federal income tax amounts, EI
premiums, and CPP contributions you withheld from your employees’ pay cheques over
the past month.

To help you prepare this form, QuickBooks provides a PD7A Summary report.

1
2

3

From the Reports menu, choose Employees & Payroll, then PD7A Report.

Check that the dates show the correct payroll deductions period (they probably don’t!),
and type new dates if necessary.

Click OK to generate the report.
Use the information on this report to fill in your PD7A form.
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Creating a TPZ-1015 report

In Québec, along with your monthly payment to the Minister of Revenue, you need to
submit a TPZ-1015 form. On this form, you report the Québec income tax amounts and
QPP contributions you withheld from your employees’ pay cheques over the past month.

To help you prepare this form, QuickBooks provides a Québec Remittance report.

1 From the Reports menu, choose Employees & Payroll, then Québec Remittance Report
(TPZ-1015).

2 Check that the dates show the correct payroll deductions period (they probably don’t!),
and type new dates if necessary.

3 Click OK to generate the report.
4  Use the information on this report to fill in your TPZ-1015 form.

Gathering information for other tax forms

Your business may also be required to file other payroll forms. Though you cannot prepare
these forms in QuickBooks, you can generate reports to help you gather the information
you need to prepare the forms. For more information about these reports, see “Getting
information about your payroll” on page 217.

Creating year-end T4 and Relevé 1 slips

T4 (Statement of Remuneration Paid) and Relevé 1 (RL-1) slips are end-of-year payroll
forms that show an employee’s wages and payroll deductions for the past year. In January
or February, you need to create these slips for your employees, the Canada Revenue Agency,
and, in Québec, the Minister of Revenue.

You also need to complete a T4 Summary form (which summarizes your employee’s T4
slips) for the CRA and, in Québec, an RLZ-1 form (which summarizes your employee’s
Relevé 1 slips) for the Minister of Revenue. QuickBooks helps you fill in these forms, too.

Preparing year-end payroll forms

Step Procedure

1 Consult your accountant, the CRA, and provincial guidelines about how to
report any benefits or amounts you’'re not certain about.

2 In QuickBooks, create and review a T4 slip for each employee who
worked for you during the last year (see “Creating and reviewing year-
end payroll slips” below). Enter any adjustments you need to make.

3 For each employee, print two copies of his or her T4 slip. Give them to the
employee by the last day of February.
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Step Procedure

4 If you created 70 or fewer T4 slips, file them electronically with the CRA
through the Internet.
If you created more than 70 slips or you do not have an Internet connec-
tion, print one T4 slip per employee and to mail to the CRA by the last day
of February.

5 If you printed T4 slips for the CRA, fill in a T4 Summary form to send to
the CRA along with the slips.

If you E-Filed the T4 slips, you do not need to fill in a T4 Summary form.

6 In Québec, repeat Steps 2 and 3 for Relevé 1 forms.

7 In Québec, fill in an RLZ-1 form to send to the Minister of Revenue.

Creating and reviewing year-end payroll slips

You create both T4 and Relevé 1 slips the same way.
1 From the Employees menu, choose either Process T4s or Process Relevé 1s.

2 Choose the correct year from the drop-down list. Usually, you create year-end slips for
the year that just ended.

Select the employees to create year-end slips for.
Click either Review T4s or Review Relevé 1s.

Carefully review the first employee’s slip.

oo hW

To correct employer or employee information, click Cancel and make the changes in
the following places:

m  To correct the name, address, or business number of the employer (that is, your
company), select Company Information from the Company menu.

m  To correct the employee’s name, address, or Social Insurance Number, select
Employee List from the Employee menu, then double-click the employee to edit.

7 To adjust the amount in a box, double-click the box, then enter the adjustment in the
window that appears.

m  (Optional) Type a description to remind you about what this adjustment is for.
m  Type the adjustment, then click OK.

QuickBooks adds the adjustment to the amount in the box. To reduce the amount in
the box, put a minus sign (-) before the adjustment.

8 To approve the form (with changes, if any), click Next.
9 Repeat Steps 5 through 8 for the remaining employees.
10 On the last form, click OK.
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Printing or E-Filing year-end payroll slips

After you've created and reviewed year-end T4 and Relevé 1 slips for your employees (see
“Creating and reviewing year-end payroll slips” on page 214), you can print them out.
QuickBooks allows you to print on either blank paper or preprinted forms.

QuickBooks prints only six T4 codes per slip.

If you have an employee who requires more than six ‘other’ or ‘special’ boxes
on a T4 slip, create a second slip for him or her after you print all other slips.
The second T4 slip should show only the extra codes. For more information,
look in the help index for T4 slips, six codes or more.

To print year-end T4 or Relevé 1 slips:

1
2
3

Confirm that the employees whose slips you want to print are selected.
Click Print T4s or Print Relevé 1s.

Choose the printer to use; whether to print on blank paper or preprinted forms; and

whether the forms you are printing are for you, the employee, or for the government;

then click Print.

Distribute the slips:

m  Give each employee two copies of the T4 slip and send one copy to the CRA. You
may want to print another copy for your records.

Although QuickBooks displays your business number when you preview T4 slips,

QuickBooks will not print it on the employees’ copies of the T4 slips.

m  Give each employee two copies of the Relevé 1 and send one copy to the Québec
Minister of Revenue. You may want to print another copy for your records.

E-Filing year-end T4 slips with the CRA

If you created fewer than 70 T4 slips, you can submit them to the CRA through the Internet
rather than through the mail. If you do, be sure to:

m  install MSXML 4.0 or later on your system (available at no cost through
http://download.microsoft.com/ ), if QuickBooks prompts you to.

m  contact the CRA for a Web Access Code and a Magnetic Media Number (also called
a Transmitter Number), if you do not have one. You can visit their Web site at
http://www.ccra-adrc.gc.ca/tax/business/t4internet/menu-e.html

E-File all your T4s at once rather than in batches.

ensure that T4s for employees with more than six ‘other’ or 'special’ boxes have
been returned to their original state (after printing their second T4 slips).

Check the business number that the CRA issued to you. (From the Edit menu, select Prefer-
ences, then select Employees & Payroll from the list on the left and click the Company tab.) The
business number should be in this format: your nine-digit registration number, then a two letter
program identifier, then four more numbers. If your business number does not contain the letters
"RP", contact the CRA. You cannot E-File T4 slips until your business number is updated.
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To E-File year-end T4 slips with the CRA:
1 Confirm that the employees whose slips you want to E-File are selected.
2 Click E-File T4s.
3 Fill in the E-File window:
m  Enter your Magnetic Media number in the Transmitter Number field.

m If your company is a sole proprietorship or partnership, enter your and your
partner’s Social Insurance Numbers in the SIN fields.

4 Click Send.

®  QuickBooks compiles an .xml file containing your T4 data. This file has the name
'_T4Slips.xml' and is stored in your QuickBooks directory. You will need to enter
the path to and name of this .xml file, your Business Number, and your Web Access
Code when QuickBooks opens the CRA Web site for you.

Filling in a T4 Summary form

Along with your employees’ T4 slips, you need to send a T4 Summary form to the CRA. To
help you prepare this form, QuickBooks provides a T4 Summary report.

If you sent your employees’ T4 slips to the CRA through the Internet (E-File), you do not need to
create a T4 Summary form.

1 From the Reports menu, choose Employees & Payroll, then T4 Summary.

Make sure the date range is correct for your reporting period (it probably isn’t!), and
enter new dates if necessary.

3 Click OK to generate the report.

4  Use the figures on the report to fill in your T4 Summary form.

Filling in an RLZ-1 form

In Québec, when you send your employees’ Relevé 1 slips to the Minister of Revenue, you
also need to include an RLZ-1 form. To help you prepare this form, QuickBooks provides a
Relevé 1 Summary report.

1 From the Reports menu, choose Employees & Payroll, then Relevé 1 Summary.

2 Make sure the date range is correct for your reporting period (it probably isn’t!), and
enter new dates if necessary.

3 Click OK to generate the report.

4  Use the figures on the report to fill in your Relevé 1 Summary form.
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Getting information about your payroll

QuickBooks Payroll Reports

Use these QuickBooks reports to gather the payroll information you need:

Report

Payroll summary

Description

Shows the total wages, taxes withheld, deductions from net
pay, additions to net pay, and employer-paid taxes and contri-
butions for each employee on your payroll.

Payroll item detail

Lists the payroll transactions on which each payroll item
appears. For example, you could use this report to find out
which pay cheques had deductions for disability insurance.

Payroll detail review

Provides detailed information about how QuickBooks calcu-
lates tax amounts on employee pay cheques and in year-to-
date transactions. You can use this report as a research tool to
see exactly what numbers QuickBooks used to calculate the
tax amounts.

Employee earnings
summary

Shows information similar to the payroll summary report, but
in a different layout.

Payroll transactions
by payee

Lists payroll transactions, grouping them by payee. For exam-
ple, you could use this report to create a listing of the pay
cheques your company paid to each employee.

Payroll transaction
detail

Shows the line item detail that appears on each payroll trans-
action.

Payroll liability bal-
ances

Lists the payroll liabilities your company owes to the agencies,
such as the CRA, insurance plan administrators, and labour
unions.

Employee withhold-
ing

Shows withholding information for each employee.

Employee Quick-
Report

Lists chronologically the transactions related to a particular
employee.

Payroll item listing

Shows detailed information about each payroll item you use to
track payroll-related expenses and liabilities.

Payroll item Quick-
Report report

Lists chronologically the payroll transactions that contain a
particular payroll item
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Finding out how much you owe for payroll liabilities

Let’s say you want to see how much you currently owe for each payroll tax for the current
payroll period.

You can find out quickly by creating a payroll liability balances report. The report shows
liabilities incurred during the date range specified that are still unpaid.

I@iPayroll Liability Balances
[ Print... | Excel... Hide Header Refresh
Dates *| From [01/01j2003 | B To [12j15/2003 B8] Colmns [Manth
2:21PM Mountain Sports Equipment
1211503 Payroll Liability Balances
January 1 through December 15, 2003
@ et 03 +  Hou 03 «Dec1-15,03 « BALAHNCE -«
Payroll Li es
Federal Income Tax 0.00 169613 24550 1941 63
CPP - Employee ooo 559.25 T 63716
CPP - Company ooo 559.25 T 63716
El - Employee ooo 319.52 46.09 365 61
El - Company 0.00 447 .34 B64.53 51187
QPP - Employee 0.00 0.00 0.00 000
QPP - Company 0.00 0.00 0.00 000
Guebec Income Tax ooo o.00 000 o.oa
Het Vacation Accrued B14 27 614 27 _B3.80 6565 43
Total Payroll Liabilities 614.27 4.195.76 595.74 10.682.86

Finding out how much you spend on your payroll

Let’s say you want to know how much money you spend on your payroll. You can run a
payroll summary report to see your payroll totals by employee and for the whole company
for a single payroll period.

You can change the date 2:34PM Mountain Sports Equipment

range to cover this year 12/15/03 Payroll Summary
to date' last quarter, or December 1 - 15, 2003
any period you want. TOTAL

o Hours k3 Rate <« Dec1-15, 03
Employee Wages, Taxes and Adjustments

The gross pay includes Gross Pay

commissions and Salary 155 175000
oar . Hourly 30 34500

additions to gross. This Commission as0

represents the total Total Gross Pay 228000

The net pay is the actual
justed Gross Pay 22:0m0| @mount of money the
employee(s) received.
This amount is usually

payroll expenses, not
including the employer-
portion for employment Taxes Withheld

Federal Income Tax -24550
taxes_and_ other CPP - Employee ekl less than gross pay due to
contributions. E1- Emplayee —#0|  taxes withheld and other
Total Taxes Withheld -368.50 .
_/——- after-tax deductions.
The adjusted gross pay Het Pay 191050
equals gross pay minus Employer Taxes and Contributi For taxes and company
deductions from gross. oo Company 9] contributions, the amounts
- Company 6453 N . )
Total Employer Taxes and Contributions 142.44 are liabilities accrued duri ng
the period.
Vacation Pay Acerued
VacPay-Accrued 53.80
Total Vacation Pay Acerued 33.80
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Figuring out what wage amount each tax is based on

For each tax amount on employee paycheques, you want to check the amount of wages it
is based on. You can generate the payroll detail report to see the amount for every wage base
and tax transaction on paycheques.

T:50 AM Mountain Sports Equipment 1=l
1211503 Payroll Item Detail
December 2003
o Hlum o Date =+ Sourcellame o Payrollltem = Type - WageBase =  Amount .
CPP - Employee
349 12152003 Alizon Logan-Smith CPP-Emplo... Pay Chegue 750.00 -28.40
350 12152003 Anita Joly CPP - Emplo...  Pay Chegue 345.00 -8.36
351 121572003 Luis Barata CPP - Emplo Pay Cheque 1,000.00 -40.15
Total CPP - Emplayee 2,085.00 Fra

CPP - Company

349 12152003 Alizon Logan-Smith CPP - Compa...  Pay Chegue 750.00 -28.40
350 12152003 Anita Joly CPP - Compa...  Pay Chegue 345.00 -8.36
391 12152003 Luis Barata CPP - Compa...  Pay Checue 1,000.00 -40.15
Total CPP - Comparry 2,085 00 grm —

El - Employce

349 12152003 Alizon Logan-Simith El - Employes Pay Cheue 750.00 -168.50
350 12152003 Anita Joly El - Employes Pay Chegue 345.00 -7.58
391 12152003 Luis Barata El - Employes Pay Checue 1,000.00 -22.00
Total El - Employss 2,085 00 4609
El - Company
349 12152003 Alizon Logan-Simith El - Company Pay Cheoue 750.00 -2310
350 12152003 Anita Joly El - Company Pay Chegue 345.00 -1063
391 12152003 Luis Barata El - Company Pay Checue 1,000.00 -30.80
Tetal EI - Company 2,085 00 6453
-
To learn about... Search the Help index for...
payroll reports payroll, reports about
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Time tracking, available only in QuickBooks Pro,
QuickBooks Premier editions, and QuickBooks
Enterprise Solutions, allows you to track hours
worked by yourself, employees, or subcontractors.
You can make the time billable for specific jobs.
QuickBooks can then transfer the tracked time to pay
cheques, regular cheques, and bills from

subcontractors.

Cost tracking allows you to pass costs along directly

to your customers.
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Should | track time?

QuickBooks Pro and better provide time-tracking capability to suit your needs:

m  The Stopwatch: When you're working in QuickBooks and want to take a stopwatch
approach (that is, turn on a timer, work, and then stop the timer), use the Stopwatch
on the Time/Enter Single Activity window.

m  The QuickBooks Timer: The Timer is a separate program that runs on Windows on any
computer. Because it’s separate, you can distribute copies of the Timer to people who
don’t have access to QuickBooks, such as employees and subcontractors. Then you can
merge their time data into the QuickBooks company file.

B You can also enter time data manually into QuickBooks in the Weekly Timesheet
window or Time/Enter Single Activity window.

Tracking time can help you make better decisions about work capacity, future hiring needs,
and employee productivity.

Furthermore, if you track the time you, your employees, or your subcontractors spend on
each job, you'll be able to do the following:

Invoice customers based on the number of hours of work done for them.
Automatically fill in hours on pay cheques.

When paying subcontractors, automatically fill in hours on cheques and bills.

Track payroll costs by job, class, or type of work.

Report hours worked by person, job, or type of work.

Track billable versus non-billable time.

Should | make time billable?

222

When you record time worked for a particular customer or job, one option is to mark it as
billable. Then, when you invoice the customer, you can add the billable time to the invoice
with a few clicks. After you put the time on a sales form, QuickBooks marks it as billed, so
you won'’t charge a customer twice for the same thing.

If the work done by employees is billable to customers, it becomes billable as soon as you
record the time in QuickBooks. It doesn’t matter whether you have paid the employees yet.

Some businesses track time without making it billable. For example, if you agree to do a job
at a fixed price, you would not invoice for time. However, you might still want to track time
so you can decide after completing the job whether you set the right price.

Also, you can track accrued time (like sick time), which is normally not billable.
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Should | track time for subcontractors?

Most businesses don’t need to track time for subcontractors, with a few exceptions:

On time reports, you want to see all time for a particular job, whether for an employee,
a subcontractor, or an owner.

Glenn’s company has only one employee now. By tracking time worked by subcon-
tractors, he’ll know what to expect when he has employees doing this type of work in
the future.

You want to track subcontractor time independently of the time subcontractors report
on the bills they submit to you.

Jill gives subcontractors copies of the Timer program and asks them to return time data
to her weekly so she can track how many hours have been spent on her project long
before she receives the bills.

You want to pay subcontractors based on time worked, using the time information
entered in QuickBooks.

Eric tracks time for subcontractors and pays them within 30 days. On a weekly basis,
Eric enters a bill for each subcontractor and transfers the time worked during the
previous week.

How much detail should | track for time activities?

You track time based on activities. Each activity needs, at a minimum, the following to
describe it:

Name of person who did the work
Date the work was done

Time spent doing the work

The level of detail you include when tracking an activity depends on whether or not it’s
billable and how much detail you want in your reports.

Describe an activity
e - Comment
by specifying ...

Name of person who did Required.
the work
Date the work was done Required; each activity can be for only one date.

Time spent doing the work  Required. (If you use the Timer or the Stopwatch to time an activity, fill in

the time spent.)

Customer (and job) the Required only if you plan to invoice for the time.

work is for

Even if you don't invoice for the time:
m Allows you to report on hours worked by customer and job.
m Allows you to track payroll expenses by customer and job.
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Describe an activity
by specifying ...

Type of work (described
by a service item from the
Item list)

Comment

Required only if you plan to invoice for the time.

Even if you don’t invoice for the time:

= Allows you to report on hours worked by type of work.
m Allows you to track payroll expenses by type of work.

Whether time is billable

Time must be billable if you plan to invoice for the time.

Class If your company does class tracking, you can do the following:
m Filter time reports by class.
= If you are set up to split payroll expenses by class, you can assign
classes to employee time. Then you can automatically track all payroll
expenses by class.
Choosing a method to track time
QuickBooks Pro and better come with a separate Timer program that can run on a computer
regardless of whether QuickBooks is on the same computer. You have a choice between
m tracking time via the Timer and then transferring the time data to QuickBooks,
m  using the Stopwatch on the Time/Enter Single Activity window,
m or entering time data directly into QuickBooks manually on the Weekly Timesheet
window or the Time/Enter Single Activity window.
Situation How to track time See...
You have access to QuickBooks and Use the Stopwatch in the m “Setting up QuickBooks to
want to use a stopwatch approachto  Time/ Enter Single Activity track time” on page 225
time tracking: turn on a timer, work, window in QuickBooks Pro = “Using the Stopwatch to
then stop the timer. or better. time an activity” on
page 233
You want people who don’t have Distribute copies of the m “Setting up QuickBooks to
access to QuickBooks to track their QuickBooks Timer to these track time” on page 225
own time. people and have them give m “Setting up and using the
you their time data. Timer” on page 227
= “Importing Timer data into
QuickBooks” on page 232
= “” on page 243
You (and others in your company) Enter time data directly into m “Setting up QuickBooks to
have access to QuickBooks and want  QuickBooks Pro or better, track time” on page 225
to enter time data after the work is either on a weekly timesheet g “Entering time manually into
done. or as separate activities one QuickBooks"” on page 234
at a time.
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Situation How to track time See...

Your employees submit paper One person can enter every- = “Setting up QuickBooks to

timesheets. one’s time data directly into track time” on page 225
QuickBooks Pro or better on g “Entering time manually into
a weekly timesheet for each QuickBooks"” on page 234
person.

Setting up QuickBooks to track time

The following list is for tasks you must do in QuickBooks to prepare for tracking time.

A QuickBooks user must do this preparation before Timer users can set up
A their own Timers.

Search the Help v

What to do Comments .
index for...

Turn on time tracking and indicate The weekly timesheet starts with  preferences, time |
the first day of your work week the day of the week you specify.
On the Customer:Job list, set up m customers, adding ]
the customers and jobs for which new
time will be tracked. = jobs, adding new
On the Item list, set up service Service items are required only if = service items, ]
items that describe the type of you make the time billable to a setting up
work that will be tracked. customer or job. m subcontractors,

Be sure to create different service service items for

items for subcontracted services.
On the Class list, set up classes for  Class tracking is optional. classes, adding ]
the work to be tracked
On the Payroll Item list, set up Required only if you will track = hourly wages ]
salary or hourly wage payroll items  time for employees and pay = salaries
to use when paying employees for  them using the QuickBooks Pay-
time tracked roll
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Search the Help v

What to do Comments .
index for...
Set up the people whose time will If you plan to use time trackingto = employees, adding |
be tracked. help with payroll for any employ- g other names, list of
Each person must be on one of the ~ €€s, you must also set up payroll '\ enqors, adding
following lists: information for those employees.

See:

m “Setting up to use time track-
ing with payroll” below

m “Setting up employees” on
page 189

= Employee

m Other Name (for owners and
partners)

m Vendor (for subcontractors)

Setting up to use time tracking with payroll

As part of the payroll setup for employees, be sure
to select the checkbox Use time data to create pay
cheques on the employee’s Payroll Info tab.

|ﬁ |ze time data to create pay cheques

Pay cheques will then automatically have the employees’ time data (including job, class,
and type of work) for the period covered by the pay cheque. QuickBooks keeps track of your
payroll expenses for hourly or salaried gross pay, employer taxes, and other payroll
overhead by job, class, and type of work.

Viewing, editing, and printing time data

In addition to creating reports about time data, you can view, print, and edit time data as
follows:

View a timesheet for one person’s work during a particular week.

m Print timesheets (each with one person’s work for one week or part of a week).
m  View the full text of the note entered for a particular activity.
m  Edit time data.
? To learn about... Search the Help index for...
@
Viewing and printing timesheets timesheets
Adding notes about an activity to invoices, time and cost
an invoice
Adding notes about an activity to time, reports about

a time report

Editing time data time, entering
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Setting up and using the Timer

How the Timer works with QuickBooks

The QuickBooks Timer is designed to track and record time data which you can then export
to QuickBooks Pro or better. Use the Timer when you want to gather time data from people
who don’t have access to QuickBooks but do have access to a computer.

You can make copies of the Timer program to give to other people whose time you want to
track in QuickBooks. When you do, photocopy the two-page Quick Reference Sheet on
page 244 for them as well.

Note: If you distributed the Timer program that came with an earlier version of QuickBooks, replace
those copies with the Timer program that comes with this version of QuickBooks. The newer
version of the Timer can update company files created by the earlier version.

This flowchart shows the relationship between the Timer and QuickBooks.

Time
Activities

QuickBooks Pro Timer
[=] Export File *iif #8

QuickBaooks Pro
[=] ListFile *.

Export: .
Import Time
Lists Activities
T S T

OuickBooks Pro Timer

The two programs share information this way:

®  QuickBooks exports lists for the Timer to use.

m  The Timer imports those lists.

m  The Timer records data about time activities for the jobs, then exports it.
]

QuickBooks Pro, QuickBooks Premier editions, or QuickBooks Enterprise Solutions
imports the time data and makes it part of the company file.

Note: If you simply want to time an activity in QuickBooks—not gather time data from others—use the
Stopwatch instead. See “Using the Stopwatch to time an activity” on page 233.
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Setting up the Timer

228

Before you can set up the Timer, you must first install it. Refer to the reference sheet on
page 244. Also, be sure to do all the tasks on the following task list. The task list for setting
up the Timer shows whether the QuickBooks user or the Timer user has to do the task (in
case they are not the same person).

Which user

Task and which el dus kel
. index for...

Help index?
Export QuickBooks lists for the QuickBooks Timer, exporting liststo [
Timer and give the file to the
Timer user.
Prepare Timer install disks (if the ~ QuickBooks Timer, creating disks |
Timer user can’t use the Quick- for
Books CD-ROM).
Install the Timer on the user’s Timer See “Timer Reference |
computer. Sheet” on page 244.
Create a Timer data file for the Timer data files, creating |
QuickBooks company file that (search the Timer help)
will be using the Timer data.
Import the QuickBooks lists in Timer lists, importing |
the IIF file into the Timer data (search the Timer help)
file.
From the Timer’s list of users, Timer default user |
choose the name of the person (search the Timer help)

whose work will be recorded in
this Timer file.

Exporting lists from QuickBooks for the Timer

The first step in getting the Timer ready to use is to prepare a file with the information the
timer needs in order to work with QuickBooks. The Timer must describe activities using the
same names that are on the lists in QuickBooks.

To create an IIF file for the Timer, from the File menu in QuickBooks, select Timer, then
Export Lists for Timer. Now follow the instructions on your screen. If the Timer will be used
on another computer, the exported IIF file should be copied either to a 3.5-inch disk or on
a network that both computers can access.

Information Timer needs Source in QuickBooks
Names of possible Timer users Employee, Vendor, and Other
Names lists
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Information Timer needs Source in QuickBooks

Names of customers and jobs (if time will be Customer:Job list
billable to a customer or job)

Type of work that the customer may be invoiced  Service-type items from the ltem
for (if time will be billable) list

Names of QuickBooks classes (if time will be Class list
assigned to classes)

To learn about... Search the Help index for...
Preparing a file of information Timer, exporting lists to

from QuickBooks that the Timer

can use

Using the Timer

You can run the
Timerin alarger
window that
shows detail or
in a very small
one (far right).

After you have done the tasks described in “Setting up QuickBooks to track time” on
page 225 and in “Setting up and using the Timer” on page 227, you are ready to track time
with the Timer.

Recording activities in the Timer

You can use the Timer either to time an activity while you are doing it, or to record the time
after you have finished.

@ DAN - QuickBooks Pro Timer S EI & Timer

File Time “iew Help

New dctiviy... | Edit Activy | 02 . 1 5 S |
| |

Current Activity:

IMeIton,Johnny:DentaI office Repairs -Timing- j Click this button to switch
between minimal size and
full size.

The first time you do an activity for a given customer, job, and type of work, you have to
set up the activity in the Timer. To understand how much detail you should include in an
activity, see “How much detail should I track for time activities?” on page 223.
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v

v

Mew Activity ]

Date |9£9£uz Your Name IJocelynHeinbignEI

Custorner.Job ISpade, Sam: Study
Service tem ISurface Preparation j
Class IFiemodeI j

Motes:

Begin work. on extension.

[
=l “Eilble Pev_ |
Diuration oK |
| 0 3 : 2 3 Cancel |
;l Help |

[~

If you have previously set up an activity for a given customer, job, and type of work, you
can choose the activity from a drop-down list and use it as a template for the new day’s work
instead of setting up a similar activity for the new day.

You can add a note while timing an activity or after completing it.

To learn about...

Timing an activity while you are
doing it
Recording an activity after doing it

Recording notes about an activity

Search the Timer Help (not
the QuickBooks Help) for...

m activities, setting up for timing
m activities, timing

activities, entering time for manually

activities, adding notes to

Viewing and editing recorded activities

You can view a list of the activities you
this list (or anything else) in the Timer

've recorded in the Timer. However, you can’t print
. After you export time data to QuickBooks, the

QuickBooks user can print the list of activities.

To learn about...
Viewing a list of all recorded activ-
ities within a specified date range

Changing information about a
recorded activity

Deleting a recorded activity

Search the Timer Help (not
the QuickBooks Help) for...

activities, viewing data about

activities, editing data about

activities, deleting the record of
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Viewing and changing customer information

When you import information from the lists in QuickBooks, you import customer contact
information as well as the customer’s names.

If a customer is on the list imported from QuickBooks, or if you already exported Timer data
using the customer, you can’t change information about the customer. Instead, the
QuickBooks user must change the information and give you an updated list file.

You can add a new customer to use when recording an activity. However, you cannot add
a job for a new or existing customer. The Help topic suggests what to do instead.

Search the Timer Help (not

To learn about... the QuickBooks Help) for...

Viewing contact information customers, contact information for
about a customer

Adding, editing, or deleting a cus- m customers, adding
tomer m customers, editing
m customers, deleting

Managing Timer data files

From time to time, you will need to update the lists in your Timer data to make them match
those in the QuickBooks company file. The QuickBooks user must prepare the updated list
file and make it available for importing into the Timer.

If you track time for more than one QuickBooks company, you must have separate Timer
data files.

You can back up a Timer data file. To back up a Timer file, from the Timer’s File menu, select
Backup. To use the backed up file again, from the Timer’s File menu, select Restore.

You can reduce the file size by using the Condense feature. The Condense feature in the
Timer, unlike the one in QuickBooks, doesn’t remove or consolidate any information.
Select Condense from the Timer’s File menu.

Search the Timer Help (not

To learn about... the QuickBooks Help) for...

Updating the Timer’s lists of cus- lists, updating
tomers, jobs, service items, and

classes to match changes in the

QuickBooks file

Backing up your Timer data onto data files, backing up
a 3.5-inch disk or your hard disk

Restoring a backup of Timer data data files, restoring from a backup
SO you can use or view it disk
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Search the Timer Help (not

To learn about... the QuickBooks Help) for...

Reducing the size of your Timer data files, condensing to save disk
file space
Creating a new Timer data file to data files, creating for the Timer

use with a different QuickBooks
company file

Switching to a Timer data file for a data files, opening
different QuickBooks company

Exporting Timer information to QuickBooks

When you are finished recording time, you need to export your recorded activities to an IIF
file that QuickBooks can import. From the Timer’s File menu, select Export Time Activities.

To learn about Search the Timer Help (not
the QuickBooks Help) for...
Exporting activities to an IIF file activities, exporting to QuickBooks
that QuickBooks can read

Importing Timer data into QuickBooks

After the Timer user exports the data from the Timer into an IIF file (see “Exporting Timer
information to QuickBooks” on page 232), you can import the data into the QuickBooks
company file.

After importing information from the Timer, check the Timer Import Detail
report (available only from the Import Summary window) to ensure that the
correct payroll items are assigned to each activity.

In addition to activities, QuickBooks imports any items on lists (that is, names, service
items, classes) that are not currently on the corresponding QuickBooks lists. You can view
reports of the imported list items.
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The time reports in QuickBooks report on all activities, including those imported from the
Timer. To create a report similar to the Timer import detail report, you can customize a time
by job detail report to add columns for payroll item and import date.

Search the QuickBooks
Help index for...

v

To learn about...

Importing data from a Timer file Timer, importing timed activities
into the QuickBooks company file from

Viewing a report of the imported Timer, reports about imported
Timer activities or the imported activities

items on lists

Editing an imported activity in time, entries
QuickBooks

Viewing a report on activities time, reports about
exported to or recorded in Quick-

Books

Using the Stopwatch to time an activity

Use the Stopwatch on the Time/Enter Single Activity window in QuickBooks Pro or better
when you want to time an activity—simply start the Stopwatch, work, and stop it when
you've completed the work.

m  From the Employees menu, select Time Tracking, then Time/Enter Single Activity.

Time,/Enter Single Activity [ |

4@Previous  EPNext [ speling ] Timeshest

i Once recorded, the time
Not Billed | shows up in both this

Date 1271572002 ]| M Bilable window and in the Weekly
Name IMicheIe Battorff v[ Payroll Item |Hegu|a, Pm = Timesheet window.
Customer.Job IDean Hamp:Kitchen vl

Service ltem IHepairs 'l Notes
Diuration
. d
:j 0:09
Start I | |
Save & Cloze | Save & Newl Clear |

To see how much detail to include when you time an activity, see “How much detail should
I track for time activities?” on page 223.
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Entering time manually into QuickBooks

If you want to enter time data a week at a time and you generally don’t enter a lot of detailed
notes about your activities, use the Weekly Timesheet window to enter time data manually.

Weekly Timesheet Ask a help question | Ask w HowDol?
d@Previous EPMext LEPrint v B Edt Single Ackivity,

On the weekly
[ Timesheet || timesheet, the far-
right column shows
whether the time is

Marme ITracey Stewart

Fay Period Dec b to Dec 12, 2002

[ Tu W Th F Sa  Su
CustomerJob Service ltem  Paproll ltem  Motes E 7 8 9 10 11 12 Total

Haris, Pior |Cansuling  |Rlegular Pay 200] &00] &00] EOO zm fg |} | billable, not billable,
Natiello, Eme: Sick Hourly &:00 &:00 or already billed.
Pretell Real E |Framing Fegular Pay 200 800 10:00

Totals 000 800 600 E:00 800 16:00 0:00  44:00 <1|

SetDate ... | Copy Last Sheet | Save & Cloze | Save & New | Fevert |

If you enter a lot of detailed notes about your activities or prefer to enter time data as you
complete each activity, use the Time/Enter Single Activity window.

Time/Enter Single Activity Ask a help question | Ask [ < How Do |7
4@Previous  EPNext Speling [ Timeshest
Not Billed
Date 08412 /2002 E ¥ Billable
MName Tracey Stewart j Payroll ltem Fegular Pay j
CustomerJob  Harris, Piatr j
Service ltem  Consulting - Time - | Motes
Consulting on how to manage multimedia
Diuration development timelines
Start I Stop I Fause I
Save & Cloze | Save & Newl Clear |

When you fill in and record a Time/Enter Single Activity window, you can later view the
information on a weekly timesheet.

Conversely, when you fill in and save a weekly timesheet, you can view Time/Enter Single
Activity windows that each show the work on one job on one day. The two are simply

different views of the same data, similar to views of individual cheques versus your cheque
register.
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To learn about... Search the Help index for...
Blank timesheets timesheets, blank

Filling out a weekly timesheet timesheets

Entering details for a single single activity entries

activity

Using the Stopwatch to time an Stopwatch

activity

Paying

for time worked

QuickBooks does not track whether you have paid workers for time or not,
only whether you have passed time costs on to your customers.

If you pay a worker (employee, owner, or subcontractor) for time and then edit the time
data or import new information from the Timer, QuickBooks does not track which time
has been paid for and which has not. All it tracks is the end date of your last payment
for time to the worker.

To avoid paying for the same time twice, make sure your worker has submitted all his
or her time data for a period before you create a pay cheque covering that period —
that is, pay a worker only for work that takes place after the end date of your last time
payment to him or her. If you accept late time data, print a Time by Job Detail report
and mark the activities you are paying for.

QuickBooks automatically transfers time data when you create pay cheques for employees
who are set up for transferring time data. That is, it fills in the number of hours for each
payroll item for salary or hourly wages included in the time data for the payroll period.

If customers or jobs, service items, or classes are assigned to an employee’s time activities,
this detail is also included. For example, out of 40 hours altogether, 19 may be assigned to
Job A, 11 to Job B, and the remaining 10 hours to Job C. QuickBooks then splits the payroll
expenses for the employee according to how you assigned the time.
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Tip:

v

Paying nonemployees for time worked

Some businesses need to pay people who are not employees (such as owners, partners, or
subcontractors) based on time worked. QuickBooks can transfer time data for a specified
date range to your payment. That is, it can fill in the number of hours worked and the rate
you pay for that type of work.

To pay a subcontractor or other vendor, you can either write a cheque (if you want to pay
immediately) or enter a bill (to be paid at a later time). To pay an owner or partner (someone
on your Other Names list), you can write a cheque.

Always set up subcontractors as vendors and use their vendor names when you track time and
pay them. Then QuickBooks will show payments to subcontractors for time worked on reports.

Remember when you set up a subcontractor as a vendor, select the T4A tracking checkbox in
the vendor profile so you can create reports to make it easier to create year-end T4A slips. If you
have the Contractor edition of QuickBooks Premier, you can track T5018 data the same way.

To learn about... Search the Help index for...

Setting up an owner or partner = owners
m partners, setting up

Adding a name to the Vendor list vendors, adding

Setting up a vendor for T4A forms T4A forms

Service items for nonemployee time data

If you plan to transfer time for nonemployees to a cheque or bill, the time data should have
a service item assigned to it. QuickBooks uses the rate for "purchases" of the service item
when calculating how much to pay a nonemployee for the hours worked.

m  Service items for subcontractors (vendors)

When you pay a subcontractor set up as a vendor, the payment is an expense to the
business. Therefore, you need to have at least one service item that affects an expense
account when used in payments to the person. This service item should not be used for
owners or partners.
When tracking time for a vendor, assign the time to a service item set up to track costs
in an expense account.

m  Service items for owners or partners
When you pay an owner or partner, the payment is a draw against equity, rather than
an expense to the business. Therefore, you need to have at least one service item that
affects the person’s equity account when used in payments to the person. This service
item should not be used for vendors.
When tracking time for an owner or partner, assign the time to a service item set up to
track costs in the person’s equity account.
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To learn about... Search the Help index for...
Setting up a service item that service items, billing work by
includes both costs and income subcontractors or owners

Transferring nonemployee time to a cheque or bill

When you pay a nonemployee for time worked, use the Write Cheques window. (To pay
employees, always use the payroll system!)

When you write the cheque or enter the bill, QuickBooks alerts you if there is time data for
the payee for dates after the end period for the last-time payment to this payee. If you
answer that you want to pay for time, you can specify the date range of the time to pay for.
Then QuickBooks prefills the Items tab of the cheque with the service item, customer and
job (if any), rate, number of hours, and amount.

QuickBooks does not track whether time is paid for.

If you pay for time and then edit the time data (or import data from the Timer), Quick-
Books does not track which time has been paid for and which has not. All it tracks is the
end date of the last payment for time.

If you always pay for time dated after the end date of the last payment, you will not pay
for the same time twice. Otherwise, print a time by job detail report and mark the activ-
ities you are paying for.

To learn about... Search the Help index for...
Paying nonemployees for time time, paying nonemployees for
worked
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Charging customers for time worked and
other costs
Charging your customer for the actual time and costs for a job is a two-step process:

1 Track the time and costs, assigning them to the specific job.

2 Transfer the time and costs to a sales form (with or without a markup) or to the register

for the job.
The following table shows what you must do to track time or costs so that you can charge
for them.
To track... You must...
All expenses incurred for the job Record a bill, cheque, or credit card charge,
Misce”aneous costs incurred for USing the EXpenseS tab or Time/COStS tab to
this job (costs you prefer not to identify the accounts and amounts for other

record by using items) (QuickBooks ~ costs incurred for this job.
Pro and better only)

Time billable to this job Record hours spent on this job, using the Timer,
(QuickBooks Pro and better only) the Stopwatch, or entering time manually into
QuickBooks.

m Assign the hours to the service item that
should be used on the invoice.

m To show the service date for each time entry
on the invoice, customize the invoice to add a
Service Date column.

m Be sure to mark the hours as billable.

Subcontracted services, products, Record a bill, cheque, or credit card charge,
materials, and other charges bill- using the Items tab to identify goods and ser-
able for this job (QuickBooks Pro vices purchased for this job. Be sure to mark
and better only) these items as billable.

You can transfer time data to invoices and statement charges as long as the time data has a
customer:job and service item and is currently marked as billable.

As you create an invoice, you can display the unbilled time for the job and select which time
to include. When you record the invoice, QuickBooks marks the time you selected as billed,
so you won't bill for it again by mistake. (You can also charge for time as a statement charge
instead of writing an invoice.)
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Reimbursable expenses in QuickBooks

When you have billable expenses in QuickBooks and are ready to invoice for them, click
the Expenses button on an invoice for the customer or job. (If you are using QuickBooks
Pro or better, see “Reimbursable time and costs in QuickBooks Pro and better” on

page 240.)

QuickBooks displays the Choose Reimbursable Expenses window. It shows the expenses
you have marked billable but have not yet billed to this customer or job. In this window
you mark which billable expenses to add to the invoice.

This window is in Choose Reimbursable Expenses [ %]
QuickBooks Basic only, not :

QuickBooks Pro or better.

Use  Date Pavee tema Amaunt Hide Cancel
(12410437 |Sena Lumber & Buildic 25.00 - .
/ 12410497 |Sena Lumber & Buidi 300.00 | HeEp I Click the
~ Hide field
. only if you
To h_|de a markup on an _ don't ever
invoice, be sure to select this want to
checkbox. - charge this
Tatal Selected Evpenses 325,00 customer for
For a percentage markup, f’ Prirt selected expenses as one invoice item W Selected expenses are taxable the expense.
add a % sign after the \ (The bill is
number. QuickBooks prefills MakupAmountorz[100; Tatal expersses with markup unaffected.)
your preset markup M arkup Account Wﬂ 357.50
percentage if you set one up /
in sales and customer /
preferences.

To make the marked expenses taxable
Most people use an income on the invoice, select this checkbox.
account for markup.

After you click OK in the window, QuickBooks puts all the marked expenses on the invoice.
Note: You can set up QuickBooks so that it assigns income for a reimbursed expense to an income

account. If you don’t do this setup, the income cancels the original expense in the expense
account. See “Items for reimbursable costs (QuickBooks Pro and better)” on page 38.
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Reimbursable time and costs in
QuickBooks Pro and better

In QuickBooks Pro and better, when you click the Time/Costs button on an invoice for a

customer or job, it displays a window with three separate tabs, one for billable items,
billable expenses, and billable time.

On the Items tab, you mark which billable items to add to the invoice.

This window shows all
billable but not-yet-billed
time and job costs for this
particular job.

Time tab displays only
if time tracking is on.

Click the Hide field only if you don’t ever
want to charge this customer for the item.
(The bill is not affected.)

\

Each of the three tabs
displays the dollar total for T~
the lines that have a mark in

Time and Costs For:

Choose Billable Time and Costs

Melton, Johnny:Dental office

[ HowDol?]

the Use field. These amounts Items $2.250.00 | Expenses 30.00 | Time 30.00]
will be added to the invoice. \
Select All |
Use  Date Item D escription Gty Rate Ammount Hide
To use all lines on this tab, J |114104198) Subs:Diywal |Install drywal 1 1,000.00 1.000.00 J
click Select All. To unmark 1114195 Subz:Metal b |Metal Wark 1 400.00 400.00
all lines, click Clear All (the S [11424195 Subs:Dipwal [Install diywal 1 750.00 7R0.00
button name changes). 114304135 | Subs:E lectric |Electrical work 1 1.500.00 1.500.00
12/08/13%|Equip Renta |Equipment Rental 1 550.00 RA0.00
12/08./19¢|Permit Building permit 1 175.00 175.00
124114195 Subz: Plumnbil| Plumbing 1 1,200.00 1.200.00
Select this checkbox to print 124124195 Subs:Paintin |Painting 1 E00.00 B00.00
only the overall total and a 12412195 Subz: R oofim| R oofing -1 850.00 -850.00 j
general description for the =

group of marked items on all
three tabs.

To print an overall total but

I Frint gelected time and costs as one invoice item

OK |

| Total billable time and costs

2,250.00,

LCancel |

Help

/

no detail for one tab alone,
mark the lines on only one
tab, select the checkbox, and

The Description and Rate fields show the sales

/

Thisisthetotalamount

click OK.

240

for marked items on all
three tabs.

description and rate for each item from the item setup.
They may differ from the purchase description and rate.

On the sales form, QuickBooks Pro and better use the sales price, not the cost, for each
inventory part and for each resale non-inventory part, subcontracted service, and
reimbursable other charge item. You can change the price on the sales form. If you set up
the item with a sales price of 0.00 because costs vary, be sure to enter a sales price on the
sales form.

On the Expenses tab of QuickBooks Pro or better, you mark which billable expenses to add
to the invoice. You may add a markup to your actual expenses.
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For a percentage markup,
add a % sign after the
number. QuickBooks prefills
your preset markup
percentage if you set one up
in sales and customer
preferences.

Most people use an income
account for markup.

To make the marked
expenses taxable on the
invoice, select this checkbox.

To hide the markup on an ~_

invoice, be sure to select this
checkbox.

Note:

Choose Billable Time and Costs [ %]
Time and Costs For:  Melton, Johnny:Dental office
[ ltems $2.250.00 | Expenses $201.25 | Time $0.00 |
Markup Amount or % Markup Account
Select Al 15.0% |E0nstruction:MisceIIarj
Use  Date FPayes Memo Amaunt Hide
J [12/08/98 [City of Middlefield BEuilding permit 175.00 -

Can

.

Total Selected Charges 175.00 _I|
\l' . This total
Selected expenses are tayable Total expenses with markup 2.5 includes
[+ Brirt selected time and costs as one invoice item | Total billable time and costs 2451 .25| the
markup.

cel | Help |

You can set up so that QuickBooks assigns income for a reimbursed expense to an income

account. If you don’t do this setup, the income cancels the original expense in the expense
account. (Your net income is the same in either case.)

Finally, on the Time tab of QuickBooks Pro or better, you mark which billable time to add
to the invoice.

Choose Billable Time and Costs

Time and Costs For:

Melton. Johnny:Dental office

I

Items $2.250.00 l Expenzes

$2011.25 ] Time

Options

Transfer item descriptions; combine activities.

$1.567.50 I
Change... | e

Use  Date Employee  Service ltem Hours Fate Amount Description  Hide

J [11410497 (Dan T. Miller  (Framing 8.00 BR.00 440, 00|Framing labor ﬂ
J [11/09/98 (Dan T. Miller  (Framing 8.00 BR.00 440, 00|Framing labor

J [11/10498 (Dan T. Miller  (Framing 8.00 BR.00 440, 00|Framing labor

J [11/11/98 [Dan T. Miller  (Framing 450 BR.00 247 B0|Framing labor

=l

0K

[ Prirt selected time and costs as one invoice item

| Tatal billable time and costs

4ma.75|

Cancel

Help |

L— The Time tab shows all time that is
billable for this job but has not yet been
billed.

[~ Click Change to specify the following:

m Whetherto copy your time notes or the
description of the service item into the
Description field of the sales form.

m Whether to show each activity as a

separate line or to combine all
activities for the same service item.

The rates shown are the rates set up for
each service item.

In this window and on the sales form, QuickBooks Pro and better use the hourly rate for the
service item you assigned to the activity, not the payroll rate of the employee. If the service
item has the subcontractor checkbox marked, QuickBooks uses the sales price. You can

change the rate on the sales form.
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To change how time activities are grouped and described on a sales form, click Change.

After you click OK in the window, QuickBooks puts all the marked time and costs on the
invoice. If you return to the window Z¢/orerecording the invoice, the items already on the
invoice have an invoice symbol in the Use field.

Items $0.00 ] Expenses $0.00 ] Time $0.00 ]
The invoi bol in th  Select All
e Invoice symbol In e
. .y Use  Date Item D escription Oty Rate Amount Hide
.Use field indicates that the \ T 1141098 |Subz:nsulati|install inzulation 1 500.00 500.00 j
item has already been added 1110498 |Subs: Diywal[Install drywal 1 1,000.00 1,000.00
to the invoice. 11/14/98 |Subs:Metal s |Metal Wik 1 400.00 400.00
A@ You can put given job costs on a sales form only once.

If you record a sales form that has actual job costs on it and then discover
you made a mistake, the actual job costs you used previously are no longer
available to use again. The only way you can reinstate such costs is to

go to the original record (that is, weekly timesheet, single activity, bill,
cheque, or credit card charge). Click the Billable field to make the cost
billable again.

Search the QuickBooks

To learn about... Help index for...

v

Transferring time to invoices and m invoices, time and cost
statement charges m statements, time and cost
Making time billable again if you time, making billed time billable
billed for it mistakenly again
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Recording the cost of work vs. invoicing for it

Don’t make both a worker’s time and your payment to that worker for the
time billable.

m If you make a subcontractor’s bill for time worked billable, you can invoice your cus-
tomer in turn for the subcontractor’s charges. When you invoice the customer, open
the Choose Billable Time and Costs window and select the subcontractor’s bill from
the Expenses or Items tab (whichever you used on the subcontractor’s bill). This is
the recommended method.

m If you pay a subcontractor, owner, or partner for time worked by using the Write
Cheques window, you can make the service items on the cheque billable. Then,
when you invoice your customer, open the Choose Billable Time and Costs window
and select the time from the Items tab.

m If you make the time itself billable, you can invoice for the time from the Time tab of
the Choose Billable Time and Costs window.

= If you make both the time and the bill or payment billable, you are in danger of
invoicing the customer twice for the same work!

When you record time, you are not recording any costs. To record costs, you have to take
additional action. (The same is true when you bill your customer for time worked: you are
not recording its cost to you.) The following table shows how you record costs for time
worked and what you have to do to invoice customers for work.

The work is

You record the cost of

To invoice other

done by ... the work when you ... people for the work...
Employees Pay the employees. Make the time billable.
Subcontractors Enter bills from the subcon- On the bills, cheques, or credit
(vendors) tractors (or write cheques or card charges, make the items
enter credit card charges for or expenses billable.
the work). OR
Track the time and make the
time billable.
Owners or Payments to owners or part- Make the time billable.
partners ners for time worked are a OR

draw against equity, not an
expense, and therefore do not
affect net the profit.

Write a cheque to pay for the
time worked, and make the
items on the cheque billable.

Because recording time has no direct effect on costs, the reports about time show hours but

they don’t show costs.

If you enter bills for subcontractors or if you pay subcontractors, owners, or partners for
time worked, you must guard against making their work billable twice.
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Timer Reference Sheet

The Timer and QuickBooks

' QuickBooks Pro

21 Ipn !
Time
Activities

QuickBooks Pro Timer
I=] Export File *iif {8

QuickBooks Pro
[=] List File =ir 8
Export | -

Time

Import
Activities

Lists

e

QuickBooks Pro Timer

m  Before you can use it, the Timer needs to import
information from QuickBooks.

Then use the Timer to time your activities.

Finally, export a file of time data for Quick-
Books Pro and QuickBooks Premier editions to
import.

Installing from the QuickBooks
CD-ROM

Other users can only install the Timer from the
QuickBooks CD-ROM.

1 Insert the Installation CD-ROM in your CD-
ROM drive.

2 If the Installer asks you if you want to install
QuickBooks, select No.

Open the Timer Installer from the CD:
m  Select Run from the Start menu.

m  Type theletter of your CD-ROM drive, then
:\gbtimeninstall.exe
For example: D:\gbtimer\install.exe

m Click OK.

3 Follow the instructions on your screen.

Installing from 3.5-inch disks

1

2
3

4

Insert the first Timer install disk in your
3.5-inch disk drive.

Select Run from the Start menu.

Type the letter of your floppy drive, then
\sinstall (for example, a:\install), then click OK.

Follow the instructions on your screen.

Starting the Timer

Click Start, Programs, then QuickBooks Pro (or
whatever name you chose for the program group
during installation), then QuickBooks Timer.

Setting up the Timer

1

In the Open Timer File window (displayed the
first time you start the Timer), choose Create
New Timer File, then click OK.

Type a name for the Timer file and the location
to save it, then click OK.

From the File menu of the Timer, choose Import
QuickBooks Lists.

Select the name of the .IIF file to import from
QuickBooks. (You may have to navigate to a
new drive or folder.) Click OK.

The person who works with QuickBooks must
make this IIF file available to you.

From the File menu of the Timer, choose Prefer-
ences, then Default Name.

Choose your own name from the drop-down
list.

If your time is always billable to a customer or
job, select the checkbox, then click OK.

Fill in the fields you need and click OK.

For help with this window, click Help.
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Setting up an activity to time
1 In the main Timer window, click New Activity.
2 Fill in the fields you need and click OK.

Timing an activity
1 If the activity you want to time is not already in

the Current Activity field, choose it from the
drop-down list.

m If you choose from Today’s Activities, the
Timer will add time to the time already
shown for today.

m  If you choose from Activity Templates, the
Timer will start with zero time.

2 To start timing, click Start (or Resume).
3 To stop timing, click Stop.

Entering time manually

1 Choose the activity from the Activity Templates
section of the drop-down list in the Current
Activity field.

If the activity is not on the list, set it up first.

2 When the activity is in the Current Activity
field, click Edit.

3 In the Edit Activity window, change the date if
you did not perform the work today.

4 In the Duration field, type the time.

You may enter time in any of the following
formats:

®  Hours and minutes (for example, 01:30)
m  Hours as decimals (for example, 1.5)

m  Hours as fractions (for example, 1 1/2)
®  Number of minutes (for example, 90)

No matter which format you use, the Timer
displays hours and minutes when you tab out of
the field.

5 Click OK to record the activity and its time.

Shrinking the Timer
m  Click the Resize button (to the right of the Start
button).

m  To make the timer full size again, click the
Resize button on the shrunken Timer.

Exporting Timer data for
QuickBooks

1 From the File menu of the Timer, choose Export
Time Activities.

2 In the Export Activities window, change the
date through which to export all unexported
activities if the date is not correct.

3 Click Export.
4 In the Create Export File window, specify a

name, drive, and folder (or directory) for the IIF
file you are creating.

5 Click OK.

Using the Timer’s Help system

For onscreen help while using the Timer, press F1 or
choose Help for this Window from the Help menu.

To find out how to use other Timer features (such as
entering notes or viewing your activity data),
choose Help Contents from the Help menu.

System requirements for the
Timer

The Timer requires the following hardware and
software:

m 486 PC (or higher) with a minimum of 8 MB
(megabytes) of RAM (random access memotry);
16 MB is recommended.

m  Hard disk with at least 8 MB of free disk space
(plus space for your data file)

Windows 3.1 or later

VGA monitor or better
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Contacting
Intuit
Telephone 248
support Getting your
Web-based 248 .
support questions
Miscellaneous 249 a N S \VAV/ e r e d

services

Solving problems 249
on your own

Speaking with a 250
QuickBooks

Product Expert If you're unable to solve a problem, you can get
Imtuit Contact 281 assistance through the help built into your software,

via the Internet, or by phone. Intuit Canada also
offers services to help you make the most of your

software.
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QuickBooks Support

We have added many help enhancements to QuickBooks 2006 to help you get your
questions answered. These include a Follow-Me-Help window and an exhaustive search
engine that accesses the Frequently Asked Questions (FAQ) knowledge base on our Web
site. If you are experiencing a problem with your software, be sure to look to this new Help
system before contacting a QuickBooks Product Expert. It could save you money! See“Using
the Help system in QuickBooks” on page 96 for more details.

Telephone support

To find out more about this these telephone support options, visit our Web site at
http://www.quickbooks.ca or see “QuickBooks product support” on page 253 to get contact
information.

Before you call a QuickBooks Product Expert about a problem you have with QuickBooks,
read through the section “Solving problems on your own” on page 249.

Free consultation call

You receive one free consultation call to a QuickBooks Product Expert from 60 days of the
purchase of QuickBooks. With this free consultation call, you get help up front, when you
need it most to get your business up and running as quickly as possible. See “QuickBooks
product support” on page 253 for contact information.

QuickBooks support plans

With the QuickBooks support plan you receive unlimited telephone support from a
QuickBooks Product Expert for you and your employees, email support, live-chat support
and priority service. As part of your support plan, you also have unlimited access to our
members-only Web site with training materials and tips for your business; and future
upgrades and enhancements at no extra cost.

Pay-per-incident telephone support

If you choose not to purchase a QuickBooks support plan, we also offer pay-per-incident
support. With this plan, you pay for each call that you make.

Web-based support

248

QuickBooks.ca (http://www.quickbooks.ca) is the official site for Canadian QuickBooks
users. Visit the QuickBooks Web site to get answers to many QuickBooks questions from our
knowledge base (FAQs) where you can search for questions. We also have a user-to-user
forum where you can get advice from other QuickBooks users.

You can access the QuickBooks Web site from within QuickBooks under the Help menu.




Mliscellaneous services

Data recovery

If your QuickBooks company file becomes unreadable, a data recovery service is available.
(Depending on the support options you choose, a fee may be charged for this service.) See
“QuickBooks product support” on page 253 for contact information.

Password removal
If you forget your password, a password removal service is available. (Depending on the

support options you chose, a fee may be charged for this service.) See “QuickBooks product
support” on page 253 for contact information.

Solving problems on your own

Note:

We recommend you back up your data on CD-ROMs or to the Internet before you start. For more
information, see “Backing up your company data” on page 107.

Guidelines for solving typical problems

Use the following examples as a guide to solving the problems you are having.

Try the procedure again

Start at the beginning. Examine windows where you filled in fields to be sure you are asking
the program for what you want.

For example, if invoices you just entered are not showing on your Profit and Loss statement.
You should ask questions such as:

Does the date of the report include those invoices?

m Do the invoices appear if you change the report from Cash to Accrual basis?
m  Does this problem occur with only invoices for one particular customer?
m  Have you changed any filters on the report? (Try to create a new report from scratch to

see if the problem is solved.)

Try a related procedure

For example, if you have a printing problem:

m  Ensure the printer is working by trying to print something else. If you have trouble
printing cheques, try printing a report. If you can’t print one of the sales forms, try
printing a similar form.

m  If you can't print from QuickBooks, try printing from another program such as
Microsoft’s Notepad. If nothing prints from Notepad, you know the problem is related
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Note:

Note:

to the printer, not the software. Check the printer connections, the printer driver, the
print queue, and so forth.

Think about what has changed

If something used to work but no longer works, think about what’s changed.
m  Have you changed or added other programs on your computer recently?
m Have you added a new printer?

m  Have you moved the QuickBooks company file to a new location?

]

Have you changed a setting in the Preferences window?

If the program “hangs” or locks up on you

There can be a number of reasons why your system freezes while using QuickBooks or any

program. Try restarting your computer to see if that solves the problem. If restarting doesn’t

help, go through the following list of questions and take any related action:

m  Does your computer system (and network) meet the minimum requirements necessary
for QuickBooks? (See the hardware and software requirements section in the "Installing
& Learning to Use QuickBooks Guide" that came with your software.)

®  Are you making the best use of available system resources by shutting down other
programs that may be running? (Check for programs that may be running in the back-
ground without your knowledge.)

m Do you have enough hard disk space available? (This is particularly common for those
working in a multi-user, peer-to-peer network situation.)

m Do you have any conflicts with sound or video drivers?

If you encounter system freezes while using QuickBooks, you may want to call for technical
support. See “QuickBooks product support” on page 253. But first see “Speaking with a Quick-
Books Product Expert”, below.

The Rebuild utility requires that you back up your company first. If a technical support represen-
tative asks you to run Rebuild, you will need to have formatted disks on hand for the backup.

Speaking with a QuickBooks Product Expert
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Be prepared when you call

If you need to call for assistance, you can speed up the time it takes to get an answer by
doing the following before you call:

m  Please have your License Key and Customer Number available. To display this infor-
mation, choose My License Information from the Help menu.

m  Be at your computer with QuickBooks running.




m  Make notes of the windows you opened and the tasks you did prior to encountering
the problem. Know the exact wording of any message that appeared on the screen.

Have a pencil and paper handy to take notes.

If your company file is set up for multiple users who have access to different areas of
QuickBooks, you'll need to have access to most of the software. You might also want to
switch to single-user mode.

m  Have the following information available:

®  Model of computer, amount of memory (RAM) and available hard disk space

Accessory manufacturer, type, and model (monitor and printer, for example)

]
m  Operating system type and version
]

Network configuration and software version

Using the QuickBooks utilities

A QuickBooks Product Expert may ask you to run the Verify Data or Rebuild Data utility to
recover damaged transactions. The Verify utility detects most data errors; the Rebuild utility
attempts to correct data errors, but some errors cannot be corrected.

Because Rebuild can cause additional problems to your company file that can increase the
difficulty of recovering your data, we do not recommend running Rebuild on your own.

Intuit Contact Information

Ordering QuickBooks products and services

If about...

Ordering QuickBooks
products and services

= QuickBooks services
m Payroll support plans
m Support plans

Try...

Visiting www.intuit.ca

Or call...

1-888-333-8580

Mon. - Fri., 9 a.m. - 8 p.m.
Eastern Time

Ordering QuickBooks supplies

m Cheques

m Business forms &
statements

m Other small business
supplies

Visiting www.intuitsupplies.ca

1-877-445-3233

Mon. - Fri., 9a.m. - 8 p.m.
Eastern Standard Time
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QuickBooks activation

If about...

Activating QuickBooks

Try...

From the File menu, choose
Activate QuickBooks, then

follow the onscreen instructions.

Or call...

1-888-333-8580

Mon. - Fri., 9 a.m. - 8 p.m.
Eastern Time

QuickBooks delivery, billing, and account inquiries

If about...

Billing inquiries
m General billing inquiries

= Updating credit card
information

m Updating banking
information

Other service inquiries

m Order and shipping status
= Exchanges

m Replacement CDs

Call...

1-888-333-8580

Mon. - Fri., 9 a.m. - 8 p.m.
Eastern Time
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QuickBooks product support

If about... Try... Or call...
QuickBooks product sup- QuickBooks in-product help 1-877-772-9158
port or how to use Quick- = Many windows in QuickBooks have an Mon. - Fri., 8a.m.-8 p.m.
Books “Ask a help question” area at the top. Eastern Time
Type your question there, then click Ask (product support or
for the answer. membership fees may
m For step-by-step instructions about tasks apply)

most commonly performed in a window,
click the How do | menu at the top.

m The new Follow-Me Help window dis-
plays help topics related to what you are
doing in QuickBooks. Refer to it when
you need help with a task.

m Use the 1-2-3 Help to search the in-prod-
uct help. You can also search the knowl-
edge base on our Web site which has
hundreds of FAQs and tips.

m For Help on a specific subject, search the
Help Index from the Help menu. The
Index is also accessible from the Follow-
Me Help window.

QuickBooks Learning Centre

m The Learning Centre provides interactive
tutorials to help you learn some of the
basic features in QuickBooks. To open
the Learning Centre, from the Help
menu, choose Learning Centre.

Installing & Learning to Use Quick-
Books Guide

Read this guide to install QuickBooks, set
up your company file, and learn more
about some of QuickBooks essential fea-
tures such as adding customers/vendors,
setting up sales tax tracking and setting up
payroll.
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Glossary of terms

accounts payable

The record of outstanding bills a business must pay.
Called A/P for short.

accounts receivable

The record of money owed to a business, that is,
outstanding invoices or statement charges for which
the business has not received payment. Accounts
receivable is called A/R for short. (Even though the
word accounts is plural, QuickBooks uses a single
account on the chart of accounts to track all the
money that different people owe you.)

accrual basis

A method of bookkeeping in which you regard
income or expenses as occurring at the time you ship
a product, render a service, or receive a purchase
rather than at the time you pay or receive cash. With
this method, the first time you enter the transaction
into your records and the moment when you pay or
receive cash may be two separate events.

accrual hours

Time that your employees accrue ("earn") as they
work. Examples include sick time and time off in lieu
of paid overtime.

aging

The tracking of due dates and amounts of
outstanding invoices (and of your unpaid bills).
QuickBooks has preset accounts receivable and
payable aging reports.

assets

Assets include what you have and what people owe
you. Examples include:

m cash on hand and in your chequing account

®  money you are owed

m furniture

m  vehicles

total assets = total liabilities + equity

balance sheet

A report that summarizes the financial position of a
business. A balance sheet shows the value of your
company'’s assets, liabilities, and equity as of a
particular day. It is called a balance sheet because the
value of the assets is always exactly equal to the
combined value of the liabilities and equity.

billable

Time worked or purchases made for a particular
customer or job, that you want to charge back to that
customer or job in QuickBooks.

After you put the time or purchase on a sales form,
QuickBooks marks it non-billable, so you won'’t
charge twice for the same thing.

cash basis

A method of bookkeeping in which you regard
income or expenses as occurring at the time you
actually receive a payment or pay a bill.

CRA

Canada Revenue Agency, formerly Canada Customs
Revenue Agency.

class

Anything in your business (other than a customer or
job) for which you need to track both income and
expenses.

condense

To remove detail you no longer need from older
transactions in your QuickBooks company file, with
the result that your company file shrinks in size and
QuickBooks performs better.

corporation

A business organization that has been incorporated.
A corporation is owned by its stockholders.
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customer

Any person, business, or group that buys or pays for
the services or products that your business or organi-
zation sells or provides

equity

The net worth of a company, equal to the total assets
minus the total liabilities. All the equity belongs to
the owners.

equity = assets - liabilities

inventory

The most common kinds of inventory are:
merchandise or stock in trade; raw materials; work in
process; finished products; and supplies that physi-
cally become a part of the item intended for sale.

item

A service you provide or a product you sell, which
you set up on your Item list. In addition, you can
have items for miscellaneous charges and for various
calculations on your sales forms.

job

A project for a particular customer.

liabilities

Liabilities include what your company owes to other
people or your company debts. Examples include:

m unpaid bills or credit card accounts

®  loans

®  money you collect for the government, like

income tax from employee pay cheques or
GST/PST from customers.

maintenance release (R)
Also called an update or a patch.

A revision of QuickBooks that you download or
install over an existing version of QuickBooks.
Maintenance releases are offered free of charge
throughout the year (some shipping and handling
charges may apply) and can include bug fixes, latest
payroll or legal requirements, and feature additions.

When we publish a maintenance release, a number is
associated with it (for example, R4, RS etc.). This
number is important when it comes time to install a
newer version of QuickBooks, as it is a way for Quick-
Books to determine which maintenance release you
have installed. To see what version and release you
currently have installed on your computer, press
CTRL+1 with QuickBooks open.

multicurrency

A feature that, when turned on, gives you the ability
to deal in foreign currencies.

multi-user mode

More than one person can access your company file
at the same time.

net profit

The sum remaining after all expenses have been met
or deducted, synonymous with net earnings and net
income or net loss.

online banking

Doing bank transactions through the Internet.

partnership

An unincorporated company owned by two or more
persons.

patch

See maintenance release.

payroll taxes

A blanket term for all deductions you withhold from
an employee’s pay cheque and remit to a level of
government. Examples are income tax deductions,
Employment Insurance premiums, and Canada or
Québec Pension Plan contributions.

payment item

A type of item on your Item list. You can set up a
different payment item for each method of payment.

Use payment items on cash sales receipts only when
you need to show two or more kinds of payments on
the same receipt.
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profit and loss statement

This report shows how your cash position changed
over a period of time. It shows the amount of cash
earned from profit, where you received additional
cash, and where your cash was spent.

progress invoice

One of a series of invoices all based on the same
estimate for the same job. Use progress invoices
when you want to invoice for the job in phases—that
is, by milestone or by percentage complete.

QuickBooks keeps track of the amount you have
already invoiced and the amount not yet invoiced.

QuickReport

A report that shows a list of transactions you are
likely to want to see for the name you have selected.
The particular report depends not only on the name
you select but also where you select it.

realized gains and losses

For transactions that involve foreign currencies, the
difference between what the foreign currency was
worth when the customer paid you and what it was
worth when you converted it to your home currency
(by depositing it into your financial institution) or, if
you haven’t converted the foreign currency to your
home currency, what it is worth today. Contrasts
with "unrealized gains and losses".

reconcile accounts

An analysis explaining the difference between a
company'’s book balance of cash and it’s bank
statement balance.

reimbursed expenses

Expenses you have incurred on behalf of a customer,
and for which you have requested reimbursement.

restore

To expand a company file from a compressed backup
into a functioning company file again.

retained earnings account

An equity account that QuickBooks automatically
adds to your chart of accounts when you set up a new
QuickBooks company. QuickBooks uses the account
to track profits from earlier periods that have not
been distributed to owners. At the beginning of a
new fiscal year, QuickBooks automatically transfers
net income into your Retained Earnings account.

sales tax

A tax you collect from a customer when he or she
pays for the sale. There are several types of sales tax
in Canada: the Goods and Services Tax (GST), the
Harmonized Sales Tax (HST), and provincial sales
taxes such as the Québec Sales Tax.

single-user mode

Only one person can access your company file at any
time.

sole proprietorship

An unincorporated company owned by one person.

start date

The date QuickBooks will have complete infor-
mation about your company finances. The start date
can be in the past if you enter historical records; it
can be the current date; or it can be some day in the
future if you prefer to enter information gradually.

time tracking

Keeping a record of the hours that you, your
employees, or your subcontractors work so that you
can then pass the expense on to your customers.

trial balance

In traditional accounting, a document that adds up
all the debits and credits so that mistakes can be
traced if debits don’t equal credits. Because Quick-
Books always adds correctly, you do not need to do a
trial balance. Nevertheless, QuickBooks provides a
trial balance report if you want to see your data in
this format.
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unrealized gains and losses

For transactions that involve foreign currencies, the
difference between what the foreign currency was
worth when the customer paid you and what it was
worth when you received it or, if you haven’t
received it, what it is worth today. Contrasts with
"realized gains and losses".

Many accountants prefer you take your unrealized
gains and losses into account when you create
reports about your company’s net worth.

upgrade

The process by which you promote an earlier version
of QuickBooks to a newer version. For example, if
you currently have QuickBooks 2000 and you
bought QuickBooks 2006, you would be upgrading to
the QuickBooks 2006 version.

update

(noun) A newer release for the version of QuickBooks
that you're currently using. This is also referred to as
a maintenance release and it typically contains bug
fixes. (verb) The process of converting the format of
an existing company file so that it can be opened
with a newer version of QuickBooks.

version (v)

An annual release of QuickBooks which is available
through stores. Versions include enhancements and
new features. (For example, QuickBooks version
2001, 2002, etc.)

wage base

The total amount of employee wages or earnings on
which a payroll tax is calculated.

zero rated

Under the GST, certain goods and services are taxed
at a rate of 0% instead of the usual 7%. These items
are called zero rated.

Zero-rated items are not tax exempt. If you sell a
zero-rated item, you charge your customers 0% GST
on it. This means that you do not collect any GST to
remit to the government. However, because the item
is taxable, you can claim input tax credits (the GST
you paid on the materials you needed to produce the
item) for it.
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Index

If you don’t find the topic you are looking for here, try the QuickBooks Help.

Symbols

.ATF, 104

.QBA, 104
.QBB, 104
.QBW, 104
.QBX, 104

Numbers

123 help, 98
3.5 floppy disk(s), 111

A

account numbers
chart of accounts, 48

accountant’s review feature, 86-89
accountants, 4

accounting
accrual, 6
cash basis, 6

accounting software
transferring data to and from QuickBooks, 85

accounts
account numbers for, 49
affecting during payroll setup, 197
creating, 51
editing, 49
foreign, 160
opening balance for, 51
payroll, 178
Quicken, equivalent of, 71
tax lines, assigning to, 129

accounts (types)

accounts payable, 8
accounts receivable, 8
asset, 8

balance sheet, 7
bank, 8

credit card, 8

equity, 8

fixed asset, 8

liability, 8

long term liability, 8
non-posting, 7

other asset, 8

other current asset, 8
other current liability, 8

accounts (working with)

alphabetical order, 48
automatically-created accounts, 7
items, choosing for, 26
names, changing, 48
numerical, 48
opening balances
changing, 48
payroll, 178
reconciling, 118
reorganizing order of, 48

accounts payable

account for, 8
converting from Quicken, 69
historical transactions, 49

accounts receivable

account for, 8
after converting from Quicken, 68
historical transactions, 49

accrual basis bookkeeping

adjustment during setup, 52
defined, 6

accuracy of QuickBooks payroll compared to printed

tax tables, 206

activating QuickBooks, 252
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activities
detail, how much to track, 223
editing or viewing Timer data about, 230
exporting from the Timer, 232

importing into Pro or Premier from the Timer, 232

invoicing for, 241

recording in the Timer, 229

recording time manually in Pro or Premier, 234
single, recording, 235

timing with the Stopwatch, 233

additions, payroll item for, 181

adjusting
income and expense accounts, 53
item prices or rates, 46
liabilities for GST/PST, 151
liabilities for payroll items, 210

administrator, 124
advisor, 4

alignment
adjusting for printing, 133

alphabetical order for accounts and lists, 48
amortization of loans, only in Quicken, 73
archiving, see condensing data

assets
accounts for, 8
balance sheet, viewing on, 14
current, accounts for, 8
defined, 14

audit trail, 126
autoload printer feature, aligning forms with, 134

Automatic Update
turn off, 58

backing up, 107-114
overview, 107
recommended routine, 108
restoring backups, 114
testing your backups, 112
to a tape, 110
to CD, 109
to floppy disk(s), 111
to Zip drive, 110

with QuickBooks Backup Service, 111
backups, searching for, 113
bad debt, adjusting GST or PST owed, 151

balance sheet accounts
types of, 8
balance sheet, described, 14

bank accounts
description, 8
reconciling, 118

benefits for employees, payroll item for, 181

billable status
deciding whether to make time billable, 222
making billed time billable again, 242

bills
paying foreign vendors, 171

blank timesheets, 226, 235

bonuses
payroll item for, 181

bookkeepers, 4

bookkeeping methods
accrual basis, 6
cash basis, 6

bookkeeping software, transferring data to and from

QuickBooks, 85
books, closing, 125
business number, 141
business segments, tracking, 5, 12

buying units, 32

C

calculating
by using items on sales forms, 31
payroll taxes and discrepancies, 206

calendar year, 129

Canada Pension Plan
calculations and employee’s date of birth, 190
payroll items for, 180

Canada Revenue Agency
GST and, 140
income tax and, 127
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If you don’t find the topic you are looking for here, try QuickBooks Help.

payroll liabilities and, 209
capital investments, 54
cash basis bookkeeping, 6
cash flow forecast reports, 16

cash vs. accrual
choosing, 6
reporting, 131

categories in Quicken, equivalent of, 71

CD
backing up to, 109
installing Timer from, 244
updating QuickBooks from, 60
changing
how dates display, 60
Internet connections, 56

chart of accounts
adding accounts, 49
automatically-created accounts, 7
described, 7
numerical, 48
reorganizing, 48

checklist for setting up payroll, 176-177

cheques
alignment adjustments for, 133
pay stubs, printing, 208
payroll
creating, 207
printing, 208
reviewing and correcting, 208

chequing accounts
historical transactions and, 50
reconciling, 118

classes
adding, 5, 12
compared to jobs, customer types, and job types,
13
employees, grouping by, 191
payroll expenses, tracking by, 183
turning on preference for, 5, 12
uses for, in QuickBooks, 5, 12

closing books or period, 125

closing the follow-me help, 97

columns
changing for reports, 102
changing on forms, 106

combining names after converting from Quicken, 66
commission, for PST, 148

commissions
employee template, adding to, 189
employees on, 192

company
backing up to a tape, 110, 111
backing up to CD, 109
backing up to Zip drive, 110
backing up with QuickBooks Backup Service, 111
backup up, 107
company file, described, 4
described, 4
multicurrency and, 158
passwords, 123
restoring data, 114
sample, 99
setting up, 20
setup, preparing for, 20
testing, 112

company contributions
employee template, adding to, 189
employees, individual, setting up for, 191
payroll item for, 181

company files, 5

compensation
payroll items for, 181
PST and, 148
sales tax and, 148

condensing data, 114
how it affects reports, 117
summary transactions, 116
when using Payroll Service, 115

connecting
QuickBooks to the Internet, 55

connection
changing for the Internet, 56
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construction industry
standard categories, tracking, 5, 12

consultants, 4
contacting technical support, 247
context-sensitive help, 97, 98

converting
MYOB data, 74-83
Quicken data, 62-73

corporations
described, 18
officer salaries, 181

CPP (Canada Pension Plan), payroll items for, 180

creating
foreign invoices, 168
sales order, 36

credit cards
accounts, 8
reconciling, 118

currency list, 163
currency, see multicurrency
current assets, accounts for, 8

custom fields
filtering reports for, 103
for employees, 190
for items, 38

customers
foreign, 168
opening balances
changing, 23
payroll expenses, tracking by, 183
products and materials purchased for, 40
tax codes for, 145

customizing reports, 102

D

data
audit trail of, 126
backing up overview, 107
backing up to a tape, 110
backing up to CD, 109
backing up to floppy disk(s), 111
backing up to QuickBooks Backup Service, 111
backing up to Zip drive, 110

condensing, 114

exporting, 84

exporting from the Timer, 232

files, 5

importing from other software, 84
refreshing, 123

restoring, 114

Timer, importing into Pro or Premier, 232
transferring to and from QuickBooks, 85

dates
changing how they display, 60
report ranges, 103
start date, 17

deductions, payroll
employee template, adding to, 189
employees, individual, setting up for, 191
payroll item for, 181

defaults
accounts created, 7
employee, for payroll, 189

delivery charges, item for on invoice, 31
departments, tracking, 5, 12
descriptions of file types, 95

disable, Automatic Update, 58

discount items
creating, 38
description, 31
using on sales forms, 44

discounts, and GST/PST, 146

discrepancies between QuickBooks and printed tax
tables, 206

disks
saving disk space, 114

downloading
transactions, 122

duplicate names, after converting from Quicken, 66

EasyStep Interview, 20

turning on GST/PST tracking, 141
E-filing

t4 forms, 215
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If you don’t find the topic you are looking for here, try QuickBooks Help.

EI (Employment Insurance), payroll items for, 180 how they affect transactions, 165
employee defaults, 189 see a[;o multicurrency, 158

TDI information in, 189, 192 updating, 165

TP-1015.3 information in, 189, 192 expense accounts
employees opening b.alances, 52

adding, 204 uncategorized, 52

advances for, 178 expenses, payroll, 182

benef1t§ fpr, 181 exporting

categorizing, 191 data. 84, 85

commissions, 192

custom fields, 190

defaults, 189

deleting, 204

duplicate names, 204

editing information about, 191

lists for use in Timer, 228
Timer data for use by Pro or Premier, 232
vs. other methods of transferring data, 85

hiding, 204 F

loans for, 178

merging names, 204 F1 key for help, 98

notes about, 191

paying, 205, 207 FaQs, 98

payroll information federal income tax, payroll items for, 180
changing, 191 federal payroll taxes
setting up, 189 employees, setting up for, 191
year-to-date summaries, 194 paying, 212

preferences for, 175 fields

raises, 202

adding to forms, 105
changing on forms, 106
custom for employees, 190
filtering reports with, 103

releasing, 202, 204

removing from list, 204

setting up, 190

sharing QuickBooks on a network, 123

tracking time for, 235 file types, 104
Employment Insurance, payroll items for, 180 described, 95
equity files
accounts, 8 backing up overview, 107

backing up to a tape, 110

backing up to CD, 109

backing up to floppy disk(s), 111

backing up to Zip drive, 110

backing up with QuickBooks Backup Service, 111
condensing, 114

restoring, 114

testing backing up, 112

created by QuickBooks, 53
setting up, 53
balance sheet, viewing on, 14
redistributing during setup, 53
retained earnings from, 53
sole proprietorships in, 54
transferring from Opening Bal Equity, 53, 68

errors in payroll tax calculations, 206 filing payroll tax forms, 209

exchange rates, 158 PD7A, 212
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Relevé 1, 213 editing filed transactions, 154

T4, 213 filed vs. unfiled transactions, 152
TPZ-1015, 213 filing a transaction manually, 153
how QuickBooks calculates, 140

filtering reports, 103 .
instalment payments, 149

find interest on late payments, 151
using 123 help to find answers, 98 late payment fees, 151
using the index, 98 liabilities, 142

finding liability reports, 147
a backup file, 113 locking after paying, 125, 155

out-of-province customers and, 146

firing an employee, 202 paying by instalments, 149

fiscal year, 108, 129 paying liabilities, 148
adjusting for mid-year QuickBooks start date, 52 penalties, 151
flowcharts, 92 preferences, 141

purchases including, 145

follow-me help, 97 refunds for overpayments, 150

closing, 97 reporting period, 142
fonts sales including, 145

changing on reports, 102 tax codes, setting up, 144

forms, 106 tracking, 141
foreign currency, see multicurrency turning on in EasyStep Interview, 141
forms uncategorized amounts, 138

unfiled vs. filed transactions, 152

unfiling a transaction manually, 153

what you owe, 147

freight charges Zero Rated tax code, about, 144
item for on invoice, 31

described, 94
printing, alignment, 133

H

hardware requirements

G

Goods and Services Tax see GST/PST, 141 for Timer, 245
group items help, 97
compared to subitems, 32 123 help, 98
creating, 38 closing help window, 97
description, 31 F1 key, 98
uses of, 43 follow-me help, 97
using to hide details, 43 how-do-I menus, 98
GST Payable account, 151 index, 98

Learning Centre, 99
onscreen, 97
GST/PST opening help window, 97

adjusting liabilities, 151 resetting help windows, 97
amount owed as of start date, 52

applying to sales, 145
business number, 141
codes, setting up, 144
customer tax codes, 145
discount items and, 146

adjusting, 151

hiding and showing
details on sales forms, using group items, 43
employees, 204
items, 46
items in lists, 93
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historical transactions, 49
entering for payroll, 50

hours worked
entering on pay cheques, 206

recording manually in Pro or Premier, 234

recording with the Stopwatch, 234
recording with the Timer, 229
viewing on timesheets, 226

how-do-I menus, 98

Icon bar, 92
IIF file format, 84

importing
activities from the Timer, 232
Pro or Premier lists into Timer, 228

income accounts
choosing for items, 26
opening balances, 52
uncategorized, 52

income statement, described, 15

income tax
form, 19, 129
preparing information, 129
QuickTax, 129
reports about, 130
setting up and tracking, 127

index, 98

international business, see multicurrency

Internet
changing your connection, 56
connecting QuickBooks to, 55
requirements, 55
setting up a connection, 56
updating QuickBooks from, 57

Intuit
phone numbers, 251-253
product support, 248
Web sites, 251-253

inventory assembly items vs. groups, 32

inventory part items
description, 30

investment tracking, only in Quicken, 73

invoices
payment items on, 44

items, 32
about, 51
accounts, how affected by, 26

adding to forms with units of measure set, 35

benefits of setting up, 24
calculating, 31
changing prices, 46
custom fields for, 38
deleting, 47
editing, 47
foreign prices, 162
GST/PST codes for, 144
hiding, 46
inventory assembly, 30, 32
list of, 28
non-inventory part, 30, 37
other charge, 31, 37
payroll, 179-201
prices, changing, 46
reimbursable costs, for, 38
service, 30, 37
setting up units of measure, 34
subitems, 32, 38
types

restrictions on changing, 46

table of, 30

J

jobs

compared to classes, customer types, and job

types, 13
opening balances, changing, 23
payroll expenses, tracking by, 183

products and materials purchased for, 40
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K adjusting for reports, lists, and graphs, 132

markup
keyboard shortcuts, 95 item prices, 46
memorizing reports, 102
merging
L employee records, 204
names after converting from Quicken, 66
Learning Centre, 99 payroll items, 201
learning QuickBooks with the Learning Centre, 99 ~ midyear setup, 52
liabilities miscellaneous charges
accounts for, 8 items for, 37
adjusting for payroll item, 210 reimbursable charges, 40
adjusting GST/PST, 151 modifying your Internet connection, 56
balance sheet, viewing on, 14 L . .
defined, 14 mortgage amortization, only in Quicken, 73
GST/PST, 142, 148 multicurrency
payroll, see payroll liabilities adding foreign prices to items, 162
line items an oYerview, 158
defined, 41 creating

currencies, 163

see also items .
foreign accounts, 160

lists POs for foreign vendors, 170
activating inactive entries, 47 currency calculator, 165
alpha.betizing, 48 depositing foreign money, 169
descrlbgd, 93 exchange rates, 158, 165
exporting, 85 foreign customers
exporting for use in Timer, 228 creating, 161
item, 2§ . invoicing, 168
reorganizing, 48 payments from, 169
sorting, 29 foreign vendors
updating for Timer, 231 creating, 161

loan amortization, only in Quicken, 73 paying, 171

locat] tracking. 5. 12 POs for, 170

ocations, tracking, o, home-currency adjustments, 166

locking sales tax after paying, 125, 155 items, adding a foreign price to, 162

login, 124 printing

realized gains & losses report, 168

unrealized gains & losses report, 166
realized gains & losses, 167
setting up, 158-162
M transferring funds, 172

unrealized gains & losses, 166

Macintosh using, 158-172

converting Quicken for, 64 multiple users
maximum number of, 124
update QuickBooks for, 59

multi-user mode, 123

long term liability accounts, 8

manually updating QuickBooks, 58

margins
adjusting alignment when printing forms, 132
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MYOB
converting your data to QuickBooks, 74-83
setting up your payroll in QuickBooks, 76-83

names, Quicken conversion and, 66
navigators, 92
net worth, 8

networks
how QuickBooks works on, 122
sharing QuickBooks on, 123

non-inventory part items
creating, 37
description, 30

non-posting accounts on chart of accounts, 7
notes, adding to Timer activities, 230

numbers
changing how numbers display, 60
for accounts, 49
formats in reports, 102

numerical accounts on chart of accounts, 48

O

officer salaries, 181

online accounts
downloading transactions, 122
PIN/password, 120
reconciling, 121
re-enabling after converting, 67

online banking
converting from Quicken, 64, 67
going online, 120
setting up, 120

online registration (activation) for QuickBooks, 252

onscreen help, 97, 98
how-do-I menus, 98

Learning Centre, 99
Open Window list, 92

Opening Bal Equity account, 53
adjusting balance during setup, 53
described, 53

opening balances
balance sheet accounts, changing,
customer or job, changing, 23
entering in EasyStep Interview, 19
for accounts, 51

order
creating sales, 36

other asset accounts, 8

other charge items
creating, 37
description, 31

other current asset accounts, 8
other current liability accounts, 8

Other Names list, after Quicken conversion, 65

other tax items, 181
Other, on reports, 104

overpayments

GST/PST liability, refund cheque for, 150

48

payroll liability, refund cheque for, 212

owner’s draws, 54
owner’s equity, 54

owners
commission sales, 192
paying, 189
paying for time worked, 236

P

partial payment on invoice, 44

partners
commission sales, 192
paying for time worked, 236

partnerships
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described, 18 class, tracking by, 183
income and expenses, tracking by partner, 5, 12 customer, tracking by, 183
time worked, paying partners for, 236 job, tracking by, 183
reports, 182

passwords, 123 . .
service item, tracking by (Pro and better only), 183

changing, 125

close books or period with, 125 payroll forms
deleting, 125 PD7A, 212
pay cheques Recorfl of Employment, 202
deleting, 208 Relev? 1 forms, 213
editing, 208 Relevé 1, printing, 215

RLZ-1.S-V report, 216
T4 forms, 213

T4 forms, E-filing, 215
T4 forms, printing, 215
T4 Summary report, 216
TPZ-1015 report, 213

payroll items, 179-201

historical, entering, 194
pay stubs for, 208
printing, 208

voiding, 208

writing, 207

pay stubs, printing, 208

paying additions, 181
employees, 207 bonus, 181
foreign vendors, 171 changes, effects of, 201
GST/PST liabilities, 148 company contributions, 181
nonemployees (subcontractors), 236 created by QuickBooks, 179
payroll liabilities, 209, 212 creating new, 180
payment items deductions, 181
creating, 38 displayed by QuickBooks, 179
description, 31 editing, 200-201
using on sales forms, 44 examples of common items, 185
payments hourly wages, 181

liabilities, adjusting, 210

partial on invoice, 44 merging, 201

payroll officer salaries, 181
accounts, 178 order of, effect on amounts and gross pay, 190,
checklist for setting up, 176-177 191
condensing payroll data, 115 other tax items, 181
customizing accounts for, 178 reports, 219
employee template, adding to, 189 salaries, 181
employees, individual, setting up for, 191 showing, 201
expenses, 182 vacation, 180
historical transactions, entering, 194-199 N
MYOB payroll liabilities

adjusting, 210

discounts for, 212

how QuickBooks tracks, 184
paying, 209, 212

PD7A, 212

penalties, 212

Relevé 1 forms, 213

Relevé 1 forms, printing, 215
report, 218

RLZ-1.S-V report, 216

setting up in QuickBooks, 76-83
paying employees, 205
preferences for, 175
reports, 218
service for, 174
setting up, 175
subaccounts, 178
tracking expenses, 184
turning on or off, 174

payroll expenses
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T4 forms, 213

T4 forms, E-filing, 215

T4 forms, printing, 215

T4 Summary report, 216

TPZ-1015 report, 213

year-to-date summaries for setup, 198

payroll reports, 217
Payroll Service, 174

payroll taxes
employees, setting up for, 191
historical, 194
on employee defaults, 189
other forms for, 213
other, payroll items for, 181
paying, 209, 212

payments, entering year-to-date summaries, 198

PD7A forms, filing, 212
refunds for overpayments, 212
Relevé 1 forms, 213
Relevé 1 forms, printing, 215
RLZ-1.S-V report, filing, 216
T4 forms

filing, 213
T4 forms, E-filing, 215
T4 forms, printing, 215
T4 Summary report, filing, 216
tax forms, filing, 209
TPZ-1015 report, 213

PD7A forms, filing, 212

phone numbers
Intuit, 251-253
ordering cheques and other supplies, 251
ordering software and other products, 251

PIN/password for online accounts, 120
POs for foreign vendors, 170

preferences
employee, 175
GST/PST, 141
multicurrency, 159
payroll, 175
using classes, turning on, 5, 12, 23

price levels

setting up for items, 27
prices of items, changing, 46
printing

alignment, adjusting, 133

files to disk, compared to other methods of

transferring data, 85

margin issues, 132

pay cheques, 208

pay stub reports, 208

realized gains & losses report, 168

Relevé 1 forms, 215

T4 forms, 215

timesheets, 226

troubleshooting, 132

unrealized gains & losses, 166

prior liability payments, 198

problems
printing, solving, 132
solving before you call Intuit, 249

product lines, tracking by, 5, 12

product support
calling, 251

professional advisor, 4
profit and loss statement, described, 15
provincial sales tax see GST/PST

PST
commission, 148
compensation, 148
Payable account, 151
adjusting, 151
tracking, 141

Q

QPP (Quebec Pension Plan), payroll items for, 180

Quebec income tax, payroll item for, 180

Quebec Pension Plan

calculations and employee’s date of birth, 190

payroll items for, 180
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questions
getting answers with 123 help, 98
using the index, 98

QuickBooks
Administrator, 124
company files, 5
comparing with Quicken, 71
dates, changing format, 60
file types, 95, 104
network, sharing on, 123
numbers, changing format, 60
Payroll Service, 174
sample company, 99
technical support, 253
transferring data, 84
updating, 57
updating from a CD, 60
updating from Web site, 59
updating multiple users, 59

QuickBooks Backup Service, 111

Quicken, 62-72
accounts payable, converting, 65, 69
accounts receivable, after conversion, 68
categories, equivalent of, 71
comparing with QuickBooks, 71
converted data, differences, 72
converted data, fine-tuning, 65
converting

to QuickBooks, 62-67

converting from, 65
for Macintosh, converting from, 64
setting preferences, 67

QuickStatement for online accounts, 121
QuickTax, 129

rates
items, changing, 46

realized gains and losses, 167

reconciling
accounts, 118
canceling before completing, 118
online accounts, 121
skipped months, 118
transactions added earlier, 118

Record of Employment report
payroll items and, 182
preparing, 202
troubleshooting, 202

refreshing data, 123

refund cheques
GST/PST, 150
payroll liability, 212

registering (activating) QuickBooks, 252

registers
described, 94
entering transactions in, 50

reimbursable expenses
items for, 38
miscellaneous charges, items for, 40
QuickBooks, 239
QuickBooks Pro, 240-241

release date for an employee, 202

Relevé 1 forms, 213

printing, 215

tracking information in QuickBooks, 182
reorganizing

accounts on chart of accounts, 48

columns on forms, 106

fields on forms, 106

lists, 48

transactions in reports, 102

Rep field in New Employee window, 192
Report Finder, 101
reporting period for GST/PST, 142

reports
changing the scope of the information, 103
condensing data & how it affects reports, 117
customizing, 102
date ranges, 103
descriptions of
payroll, 217-219
payroll item detail, 219
payroll liabilities, 218
payroll summary, 218
filtering, 103
finding the report you want, 101
fonts on, 102
GST/PST liability, 147
memorizing, 102
“Other” on, 104
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realized gains & losses, 167 turning on in EasyStep Interview, 141
saving the customization and filtering, 102 what you owe, 147

unrealized gains & losses, 166 sales tax codes

resetting help windows, 97 customer, 145
item, setting up, 144

restoring company data, 114
Zero Rated, about, 144

retained
earnings, adjusting for during setup, 53 sample company, 99
transactions, 116 searching

for a backup file, 113

retained earnings .
using 123 help, 98

account, 53 . ;
description, 8 using the index, 98
RLZ-1.8-V report, 216 security
passwords, 123, 125
selling units, 32
s service businesses
benefits of setting up items, 24
salaries Service for Payroll, 174

employee, changing, 202
employee, entering, 191
officer, Payroll item for, 181 description, 30

payrol% item for, 181 tracking payroll expenses by (Pro and better only),
removing from bonus check, 206 183

year-to-date, entering for setup, 194

service items
creating, 37

setting up
an Internet connection, 56
employee defaults, 189
employee payroll information, 189
employee year-to-date payroll summaries, 194

sales
commission tracking, 192
foreign customers, 168
forms described, 94

sales orders foreign accounts, 160
creating, 36 foreign customers, 161
sales tax foreign vendors, 161

multicurrency, 158-162

applying to sales, 145 . .
MYOB payroll in QuickBooks, 76-83

business number, 141
codes, setting up, 144 payroll, 175

historical data, 52 units of measure, 34

how QuickBooks calculates, 140 your business, 20

liabilities, 142 sharing QuickBooks on a network, 123
liability reports, 147

locking after paying, 125, 155
paying liability, 148
preferences, 141 shortcuts, keyboard, 95

shipping charges
item for on invoice, 31

reimbursable expenses, 239, 241 sick time
tracking, 141
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accrual period and hours, entering on employee contacting technical, 253
defaults, 189
employees, setting up, 191
entering, 191
year-to-date, entering, 194

support plans, explained, 248

single activities T

entering details about in QuickBooks, 235

timing, 233 T4 fOIIIlS, 213

) ) E-filing, 215

sole propnetorshlps, 54 filing, 213

described, 18 prepare, 213
sorting printing, 215

lists, 29 tracking information in QuickBooks, 182
spreadsheets T4 Summary

transferring data to and from QuickBooks, 85 prepare, 213
start date, 17 report, 216

choosing, 17 T4A forms, setting up, 236
GST/PST liabilities, 142

statement of cash flows, 16

tape drive, 110

tax codes
statements adjustments, 151
reconciling, 118 customer, 145

for items, 144

stocking units, 32 ;
items for, 181

Stopwatch paying GST/PST liability, 148
timing activities with, 233 Zero Rated, about, 144
when to use, 224
tax forms
subaccounts payroll, 209
adding to chart of accounts, 48 PD7A, 212
payroll, 178 Relevé 1 forms, 213
subclasses, 5, 12 Relevé 1, printing, 215
RLZ-1.S-V report, 216
subcontractors T4 and T4 S ing. 213
deciding whether to track time for, 223 an maLy, prepatiig,
. T4 forms, 213
paying, 189

T4 Summary report, 216
T4, E-filing, 215

T4, printing, 215
TPZ-1015 report, 213

services performed by, 39
T4A forms for, 236
time worked, paying for, 236

subitems tax lines, assigning to accounts, 129
compared to group items, 32 ! gning !
creating, 38 taxes

preparing information, 129
QuickTax, 129
reports about, 130

subtotal items
creating, 38
description, 31
using on sales forms, 42 TD1 forms

subtotals on reports, 102 employee defaults and, 189, 192

technical support, 248
phone numbers and Web sites, 251-253

templates, for payroll, 189

summary transactions, 116

support
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testing
testing backing up, 112

time tracking, 235
deciding whether to make time billable, 222
options for tracking, 224
recording time manually in Pro or Premier, 234
recording time with the Stopwatch, 233

time, paying nonemployees for, 236

Timer

data
backing up, restoring, or condensing, 231
exporting to Pro or Premier, 232
files, creating, 228
importing into Pro or Premier, 232

hardware requirements, 245

installing from CD, 244

lists
exporting from Pro or Premier, 228
importing from Pro or Premier, 228
updating to match changes in Pro or Premier,

231

recording activities in, 229

setting up, 227

when to use, 224

timesheets
blank, 226, 235
filling out, 235
viewing, 226
titles, changing
forms, 106
TP-1015.3
employee defaults and, 189, 192

TPZ-1015 report, 213
tracking

GST/PST, 141

payroll expenses, 184
tracking different units, 32

transactions
audit trail, 126
deleted during condensing, 115
downloading, 122
historical, 49

retained, 116
sorting
in reports, 102
summary, created during condensing process, 116

transferring
data between other software and QuickBooks, 84
foreign funds, 172

troubleshooting
printing problems, 132
problems, 249
support plans, 248

turning on
audit trail, 126
class tracking, 5, 12
numerical accounts on chart of accounts, 48
payroll, 174

tutorials, Learning Centre, 99

types
customer
compared to classes, jobs, and job types, 13
item
restrictions on changing, 46
table of, 30
job
compared to classes, jobs, and customer types,
13

U

uncategorized
expenses, 52
account, adjusting at setup, 52
income, 52
account, adjusting at setup, 52
sales tax amounts, 138

units of measure
adding to forms, 35
tracking, 32

unrealized gains & losses report, 166

updating
automatically, turn off, 58
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exchange rates, 165

QuickBooks, 57 W
QuickBooks automatically, 58
QuickBooks by Internet, 57
QuickBooks for multiple users, 59

wage bases
employee year-to-date setup, viewing, 198

QuickBooks from a CD, 60 viewing on reports, 219
QuickBooks from Web site, 59 wages
QuickBooks manually, 58 employee

changing hourly rates or salary, 202

US dollar, see multicurrency entering hourly rates, 191

users entering salary, 191
auditing, 126 hourly, payroll item for, 181
login, 124 officer salary, payroll item for, 181
maximum number of, 124 salary, payroll item for, 181
passwords, 123 year-to-date, entering for setup, 194

tti 124
setiing up, Web sites

connecting QuickBooks to, 55
updating QuickBooks from, 59

v Windows

) converting Quicken to QuickBooks, 62-72
vacation pay software requirements for Timer, 245
employees, setting up for, 191

entering, 191 windows within QuickBooks, 92

payroll item, 180 word processors
year-to-date, entering, 194 transferring data to and from QuickBooks, 85
vacation time write-offs, adjusting GST or PST Payable account, 151

accrual period and hours, entering on employee writing, pay cheques, 207
defaults, 189

vendors
foreign, 170 Y
paying subcontractors, 189
T4A forms for, 236

time worked, paying for, 236 year-to-date amounts

] payroll, entering, 194-199
version

information, accessing, 256

voiding, pay cheques, 208 Z

Zero Rated tax code, 144
Zip drive, 110
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